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Configurazione del TI-Nspire™ Navigator™
Teacher Software

Il sistema TI-Nspire™ Navigator™ fornisce gli strumenti hardware e software
necessari per configurare una rete wireless per la classe. In un ambiente di
classe wireless, il TI-Nspire™ Navigator™ Teacher Software consente di:

» Utilizzare Test rapido per inviare test agli studenti, riceverne le risposte e

rivedere i risultati con gli studenti.

»  Utilizzare Cattura schermo per acquisire gli schermi dei palmari degli
studenti o dai computer automaticamente o a intervalli prestabiliti.

» Utilizzare Live Presenter per visualizzare il lavoro mentre viene svolto sullo
schermo del palmare dellinsegnante o sugli schermi dei palmari degli

studenti.

« Utilizzare Area di lavoro Revisione per ritirare e rivedere gli elaborati degli
studenti, vedere i risultati delle risposte degli studenti in tempo reale e
analizzare i dati di tutta la classe o di singoli studenti.

Informazioni sull'hardware

In base ai requisiti della classe, il sistema TI-Nspire™ Navigator™ puo includere
il seguente hardware, utilizzato per creare una rete di comunicazioni wireless
che permette al computer di comunicare con i palmari degli studenti.

Nome
hardware

Scheda direte
wireless
TI-Nspire™

Immagine

Utilizzi

Si collega ai palmari TI-Nspire™
CX e TI-Nspire™ CX CAS per
abilitare la comunicazione
wireless su una banda da 2,4
GHz.

Scheda direte
wireless Tl-
Nspire™ CX - v2

vd

Si collega ai palmari TI-Nspire™
CX e TI-Nspire™ CX CAS per
abilitare la comunicazione
wireless su una banda da 2,4
GHz o 5 GHz.
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Nome
hardware

Alloggiamento
wireless
TI-Nspire™
Navigator™

Immagine

Utilizzi

Si collega ai palmari TI-Nspire™
CX e TI-Nspire™ per abilitare la
comunicazione wireless su una
banda da 2,4 GHz.

Punto di
accesso a
TI-Nspire™
Navigator™

i-1spire navigator access point

Si collega al computer
dell'insegnante per offrire un
collegamento per la
comunicazione wireless su 2,4
GHz.

Punto di
accesso a
TI-Nspire™ CX
Navigator™

Si collega al computer
dell'insegnante per offrire un
collegamento perla
comunicazione wireless su 2,4
GHz 0 5 GHz.
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Prima di cominciare

Quando si lancia per la prima volta una nuova versione del TI-Nspire™
Navigator™ Teacher Software, si apre la procedura guidata Avvio del sistema
TI-Nspire™ Navigator™ che guida l'utente attraverso il processo automatico per
configurare la classe wireless. Prima di cominciare il processo di
configurazione wireless:

Accertarsi di aver installato e attivato il TI-Nspire™ Navigator™ Teacher
Software sul computer.

Se si stanno utilizzando alloggiamenti wireless TI-Nspire™ Navigator™,
accertarsi che ogni alloggiamento sia carico (D LED é giallo fisso o
verde fisso).

Nota: se si stanno utilizzando schede di rete TI-Nspire™ wireless, non
occorre caricarle. Le schede di rete wireless sono alimentate dai palmari.

Scollegare il punto di accesso di TI-Nspire™ Navigator™ o TI-Nspire™ CX
Navigator™ dal computer.

Avvio automatico del sistema

Quando si avvia il software, la procedura guidata Avvio guidera l'utente
attraverso le fasi necessarie per:

Aggiornare tutti i palmari degli studenti e delle classi all'ultima versione del
sistema operativo (SO). Il SO sui palmari deve corrispondere alla versione
del software installata sul computer.

Importante! Quando si aggiorna il SO, i palmari devono essere collegati al
computer utilizzando un cavo USB o una TI-Nspire™ CX docking station.

Collegare il punto di accesso e, se necessario, aggiornare il firmware del
punto di accesso.

Denominare la rete della classe.
Se necessario, selezionare un canale per il punto di accesso.
Aggiungere i client wireless alla rete.

Creare una copia di backup della configurazione della rete della classe.

Configurazione del TI-Nspire™ Navigator™ Teacher Software 11



Carica degli alloggiamenti

Gli alloggiamenti wireless TI-Nspire™ Navigator™ contengono batterie
ricaricabili. E necessario caricare le batterie per tutta una notte prima di poterle
usare in classe. Quando gli alloggiamenti sono completamente carichi,
possono essere fatti funzionare un giorno intero in uso continuo. Si consiglia di
ricaricarli tutte le notti.

Il caricabatterie alloggiamenti TI-Nspire™ Navigator™ puo ospitare da uno a
cinque alloggiamenti. Dopo averli inseriti nel caricabatterie, gli alloggiamenti
vengono caricati contemporaneamente fino a quando non sono
completamente carichi. Se le batterie sono completamente scariche, &
possibile che la carica completa impieghi fino a 12 ore.

Nota: non si danneggiano le batterie lasciandole in carica oltre il tempo
necessario per caricarle. Inoltre, non occorre scaricarle completamente prima
di ricaricarle.

Accertarsi che vi sia un numero di prese di corrente sufficiente (da 3 a 4) perle
apparecchiature ricevute. Se necessario, procurarsi una ciabatta con massa a
terra.

1. Inserire I'estremita piccola del cavo dell'adattatore AC9940 nel jack del
caricabatterie.
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2. Inserire l'altra estremita del cavo dell'adattatore in una presa di corrente.

3. Inserire ogni alloggiamento TI-Nspire™ Navigator™ nel caricabatterie
alloggiamenti TI-Nspire™ Navigator™. Accertarsi che il LED sia giallo.

Nota: € possibile caricare una sola basetta wireless utilizzando un adattatore
AC9926 (venduto separatamente).

Controllo dei LED

Due LED (indicatori luminosi) nella parte superiore di ogni alloggiamento
wireless TI-Nspire™ Navigator™ lampeggiano o cambiano colore a indicare
operazioni o stati diversi.

\ 4
—
(€=
)
CEI 3
 —)
J— >,
/

IILED = indica attivita di rete. Il LED D indica lo stato di carica della
batteria.
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Quando gli alloggiamenti sono ancora nel caricabatterie alloggiamenti Tl-
Nspire™ Navigator™:

* UnLED D giallo fisso indica che l'alloggiamento wireless € in fase di
ricarica.

* UnLED D rosso fisso indica che l'alloggiamento wireless non &
correttamente in contatto con il caricabatterie. Riposizionare
l'alloggiamento in modo che il contatto avvenga correttamente e il LED
diventi giallo.

* UnLED D verde fisso indica che I'alloggiamento wireless &
completamente ricaricato.

Aggiornamento del sistema operativo del palmare

Quando si installa o si aggiorna il TI-Nspire™ Navigator™ Teacher Software, la
finestra di dialogo Avvio viene visualizzata quando si lancia il software per la
prima volta. E necessario aggiornare tutti i palmari degli studenti e delle classi
all'ultima versione del sistema operativo.
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TI-Nspire™ Navigator™ System Startup

All handhelds and desktop software must be updated to version 3.9 to
enable wireless connectivity.

Disconnect the access point from the computer.

If the access point is connected to the computer, please disconnect it now
before connecting your Tl-Nspire™ handhelds.

Connect your TI-Nspire™ handhelds.

Connect the T-Nspire™ handhelds to the computer with a docking station or
USB cable and press the "Detect Handheld 0S” button to determine if
handheld 05 updates are required. NOTE: It may take several seconds
after connecting handhelds for the "Detect Handheld 08" button to
become available.

TIP: If you cannot connect all handhelds to the computer at one time, connect
as many handhelds as possible and update the OS on those handhelds. After
the OS5 update is complete, disconnect the handhelds and repeat the 05
update process until all handhelds are updated

| Detect Handheld 05

I

D All handhelds are updated to OS version 3.9.

[ -Help|

Completare i seguenti passaggi per accertarsi che tutti i palmari siano

aggiornati.
1. Scollegare il punto di accesso se questo & collegato al computer.
2. Collegare i palmari al computer.
piu palmari utilizzando le TI-Nspire™ docking station.
3. Fare clic su Rileva SO del palmare.

E necessario collegare i palmari utilizzando un cavo USB o collegando

Se il SO per tutti i palmari collegati corrisponde alla versione del
software, viene visualizzata la finestra di dialogo Aggiornamento SO
del palmare che informa l'utente che tutti i palmari sono aggiornati.
Fare clic su Chiudi per tornare alla finestra di dialogo Avvio.

Se il SO sui palmari collegati non & aggiornato, viene visualizzata la
finestra di dialogo Aggiornamento SO palmare necessario. Fare clic

su Aggiorna SO.

La finestra di dialogo Aggiungi all'elenco di trasferimento si apre.

Configurazione del TI-Nspire™ Navigator™ Teacher Software
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Add to Transfer List Li}

Setup | Status

File Name Folder / HandheldID Status
! TI-NspireCXCAS-#.#.#... TI-Nspire™ Operating Sy... 0 of 10
[ TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04...

TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04...
[T TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04...
[ TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04...
[ TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04...
[ TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04...
[ TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04...
[T TI-NspireCXCAS-#.#... @ 1008000007206D3C3C04...
[T TI-NspireCXCAS-#.#... [ 1008000007206D3C3C04...

Done

I file del SO corrispondenti sono trasferiti ai palmari collegati. E
possibile aggiornare i palmari TI-Nspire™ CX e TI-Nspire™
contemporaneamente. Se non & possibile collegare tutti i palmari
contemporaneamente, collegare quanti pit palmari possibile e
aggiornare il SO. Dopo il completamento dell'aggiornamento del SO,
scollegare i palmari e ripetere il processo di aggiornamento del SO
fino all'aggiornamento di tutti i palmari. Il software rilevera il SO
necessario e comincera il trasferimento quando si collegheranno i
palmari.

»  Fare clic su Fatto per interrompere il processo di trasferimento quando
tutti i palmari sono aggiornati.

- Lafinestra di dialogo Aggiungi SO all'elenco di trasferimento si
chiude.

- Viene visualizzata la finestra di dialogo Avvio.

4. Selezionare la casella di controllo Tutti i palmari sono aggiornati alla
versione 3.9.

5. Fare clic su Avanti.
La finestra di dialogo Collega punto di accesso si apre.
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Collegamento del punto di accesso a TI-Nspire™
Navigator™

Quando l'aggiornamento del sistema operativo € completo su tutti i palmari, la
fase successiva nel processo di avvio del sistema prevede il collegamento al
punto di accesso. Quando si collega il punto di accesso al computer, viene
acceso e pronto a comunicare con le schede di rete wireless e gli
alloggiamenti.

Startup

TI-Nspire™ Navigator™ System Startup

Reconnect the access point.

Connect the access point to the computer using a USB cable and
click Next.

| Mext

1. Collegare il punto di accesso al computer utilizzando un cavo USB.
a) Collegare I'estremita piccola del cavo USB al punto di accesso.

Collegare il punto di accesso direttamente al computer. Non collegare
il punto di accesso a un hub USB o a una docking station.

b) Collegare l'altra estremita del cavo alla porta USB del computer.

c) Accertarsi che la spia del punto di accesso sia accesa. La luce di
alimentazione indica che il punto di accesso riceve corrente dal
computer. La luce di segnalazione indica attivita del link wireless.

| signallight

>~ power light

signallight

powerlight
USB connection
usB
connection
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Punto di accesso a TI-Nspire™ Punto di accesso a TI-Nspire™ CX
Navigator™ Navigator™

Nota: se il software non rileva un punto di accesso collegato entro un
minuto, si visualizza un messaggio di errore. Chiudere il messaggio di
errore e quindi scollegare e ricollegare il punto di accesso.

2. Fare clic su Avanti.

Il software rileva i tipi di punto di accesso e controlla la versione del

firmware sul punto di accesso. Se & disponibile una versione piu

aggiornata del firmware, il software aggiorna il firmware.

Nota: il software potrebbe impiegare fino a 60 secondi per la rilevazione

del punto di accesso.

Importante! Non interrompere il processo di aggiornamento né scollegare

il punto di accesso fino al completamento dell'aggiornamento del

firmware.

Quando l'aggiornamento € completo, il software controlla il punto di

accesso per individuare una rete della classe configurata.

+ Se e presente una rete della classe, il software ricorda all'utente che &
possibile mantenere la configurazione attuale o apportare delle
modifiche.

Setup Complete
Your TI-Nspire™ Navigator™ system setup is complete.
The access point is configured with a classroom network. To make changes or to set up a new classroom network, go to
Tools = Network Manager and then click Network Setup Wizard
(#) Back up my class network
Backing up your class network allows you to reload it later, if needed.
() Skip Backup

» Se non sono presenti reti della classe, il software guida l'utente nella
procedura guidata Configurazione della rete della classe.

3. Selezionare Backup della rete della classe per salvare una copia della
configurazione della rete della classe.
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Le informazioni di rete salvate includono I'elenco di ID client wireless, il
nome della rete e il canale e il paese selezionati sul punto di accesso.

Il salvataggio di una rete consente di ricaricare la configurazione in un
secondo tempo utilizzando Gestione reti. Per impostazione predefinita, il
file € salvato nella cartella Documenti/TI-Nspire/Navigator Network.

Per terminare senza salvare una copia di backup, selezionare Salta il
backup.

4. Fare clic su Fine per completare l'installazione.

Nota: & possibile configurare una rete alla volta o modificare una rete
esistente, utilizzando Gestione reti.

Risoluzione dei problemi

Se l'aggiornamento del firmware non avviene correttamente, si apre la finestra
di dialogo Attenzione SO .

0OS Warning [ij

@ Access Point (AP) Update Failed

The AP firmware did not successfully update. The following step
may resolve the update issue you are experiencing

Disconnect and reconnect any cables connected to the AP.

If this does not solve the issue, please contact customer support
at www.education.ti.com for further assistance.

Close

Per risolvere il problema, scollegare e ricollegare qualsiasi cavo collegato al
punto di accesso e il software avviera automaticamente il processo di
aggiornamento. Se questo non risolve il problema, contattare I'Assistenza
clienti.

Conferma della versione del SO del palmare

Se i palmari non sono stati aggiornati durante I'avvio, la procedura guidata
chiede di confermare che i palmari della classe e degli studenti siano
aggiornati all'ultima versione del SO. La versione del SO sui palmari deve
corrispondere alla versione del software prima che sia possibile configurare la
rete della classe.
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Identify Handheld OS Version |

Identify Handheld OS Version

TI-Nspire™ handhelds must be running OS version <sw version> to complete
the class setup. Complete the following steps to verify the OS version
installed on the handheld.

1. Press Home ( MJ to turn the handheld(s) on.

2. Select Settings > Status.

Is the handheld OS version <sw version>?
@ Yes

() No

. Cancel Next ]

Per controllare la versione del SO su un palmare:
1. Premere per accendere il palmare.

2. Selezionare Impostazioni > Stato per aprire la finestra Stato palmare.

|Handheld Status

Eatteries:

ersion: 32.6.0.169

Storage Capacity: 114.3 MB

Storage Available: 100.9 MB

MNetwork: Wireless client is not attached, ™

3. Accertarsi che il SO sul palmare corrisponda alla versione del software sul
computer.

+ Selaversione del SO & aggiornata, selezionare Si.

+ Selaversione del SO non ¢ aggiornata, selezionare No.
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4. Fare clic su Avanti.

+ Selaversione del SO non ¢ stata aggiornata, si visualizza la finestra
di dialogo Aggiornamento SO palmare necessario. Fare clic su
Aggiorna SO per aprire lo Strumento di trasferimento per I'aggiunta
del SO e aggiornare i palmari.

+ Selaversione del SO e aggiornata, si apre la finestra di dialogo
Nome della rete della classe ed € possibile continuare il processo per
configurare la rete della classe.

Attribuzione di nome alla rete della classe

Quando viene visualizzata la finestra di dialogo Nome della rete della classe,
completare i passaggi seguenti per attribuire un nome alla rete della classe.

——

Class Network Name

Create a class network name that is unique and easily identifiable. Avoid
using a name that is already used by another TI-Mspire™ Mavigator™ system
in your school.

The class network name can be up to 22 characters long, and the following
characters cannot be used: ? " §\V[] +

TI-NAV-N- | Room 217 Hour 3

| Advanced | | Cancel || Mext |

1. Digitare il nome da assegnare alla rete della classe nel campo TI-NAV-N.

Utilizzare un nome che sia unico, facile da ricordare e da identificare. Il
nome della rete della classe puo contenere fino a 22 caratteri. | nomi
possono essere costituiti da lettere, numeri, spazi ma non possono
contenere ? "$\![]+.

2. Fare clic su Avanti per configurare il punto di accesso senza alcuna
modifica.

—oppure—
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3. Fare clic su Avanzate per selezionare una banda o un canale operativo
diverso.

* Seil punto di accesso a TI-Nspire™ Navigator™ e
collegato, & possibile selezionare un canale operativo diverso.

Advanced Access Point Options Lij

Access Point Options

If multiple TI-Nspire™ Navigator™ systems operate in close proximity to each
other, it is recommended the access points use different channels to avoid
interference issues. Always check with your IT administrator before
changing access point channels.

Select Band:

2.4 GHz v

Select Channel:

r

Channel 6 | &
1 I
2
3
4
5 ———
6 Cancel Done
L] - (mance) =)} )
8
9
10 ‘
11 - Default v
+ Seil punto di accesso a TI-Nspire™ CX Navigator™ ==& & collegato,

€ possibile selezionare una banda 2,4 GHz o una banda 5 GHz e
selezionare un canale operativo diverso.

Nota: i canali operativi disponibili per la selezione sono determinati dalla
versione di software installata.
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Advanced Access Point Options &J

Access Point Options

If multiple TI-Nspire™ Navigator™ systems operate in close proximity to each
other, it is recommended the access points use different channels to avoid
interference issues. Always check with your IT administrator before
changing access point channels.

Select Band: ) \
[ 5GHz ™=
Select Channel: h
36 Default . IMPORTANT!
40 If using the 5GHz band, all
44 wireless network adapters
48 inthe classroom must be the v2 model.
149
153
157 Cancel | | Done |
.| 161 i —
165 -

Importante! Se si utilizzano schede di rete wireless TI-Nspire™ CX - v2, &
possibile selezionare la banda 2,4 GHz o 5 GHz. Se si utilizza una
combinazione di reti di schede wireless, & necessario selezionare la

banda 2,4 GHz.

Fare clic su Fatto.

La finestra di dialogo Configurazione del punto d'accesso si apre € il
software configura il punto di accesso e applica il nome della rete della

classe.

Importante! Non scollegare il punto di accesso durante la configurazione.
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Configuring the Access Point li.J

Configuring the Access Point...

IMPORTANT! Do not disconnect the access point while it Is being configured.
This may take up to <#> seconds.

Quando il processo di configurazione & completo, € possibile associare i client
wireless.

Aggiunta di client wireless alla rete

Dopo aver assegnato un nome alla rete della classe e aver configurato i punti
di accesso, € necessario associare i client wireless (schede wireless e
alloggiamenti wireless) alla rete. Il modo in cui completare questo processo
dipende dalla disponibilitd di docking station che permettono di operare con
piu palmari e client wireless contemporaneamente.

+ Se si possiede una docking station, collegare le schede ai palmari e
quindi inserire i palmari in una docking station che sia collegata al
computer. E possibile unire altre due docking station alla docking station
collegata.

* Se non si possiede una docking station, collegare le schede o gli
alloggiamenti wireless ai palmari.
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Prepare Your TI-Nspire™ Navigator™ S =5

Prepare Your TI-Nspire™ Navigator™ System

Perform the following steps based on your TI-Nspire™ Navigator™ system equipment.

If you have a docking station Ifyou do not have a docking station:
+
- v v
S -
Sy l‘ 0l
Connect a docking station to the computer. Atiach Altach wireless network Insert handhelds into wireless
wireless network adapters to T-Nspire™ CX handhelds adaplers to T-Nspire™ CX cradies and switch cradle locks to
and insert handhelds into docking station. handhelds. “ON" position
You can link up to 2 additional docking stations to the v
docking station thatis connected to the computer using
USB cables. Each docking station must be connected to On the handheld, choose the class network by pressing the Home key
STl kdd and selecting Settings > Network.
‘ Back

Seguire le istruzioni sullo schermo per collegare i palmari alle rispettive
schede wireless, agli alloggiamenti e/o alle docking station e quindi fare
clic su Avanti.

Si visualizza la finestra di dialogo Aggiunta client wireless alla rete della
classe.

Il punto di accesso trova i client disponibili e li elenca nella casella Client
disponibili. Il punto di accesso pud impiegare fino a sei minuti per trovare
tutti i client disponibili. Controllare il numero di client disponibili per
assicurarsi che tutti i client siano elencati.
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Add Wireless Clients to Class Network L= ]

Add Wireless Clients to Class Network

If available wireless clients are not found by the access point after 6 minutes, detach
and reartach the handhelds to the wireless clients.

Select available wireless clients to add to your class network.

Available Clients: (28) Clients Added to Network: (0)

590779 =

590781

590785

590790 Add All >
590799

590803

590804 < Remove
590807
590810
590812

Add >

< Remove All

NOTE: After 6 minutes, if one or more wireless clients in your classroom are not listed
in the "Available Clients” section, finish adding available clients above and then go to
Network Manager (Tools > Network Manager) and click "Manually Add Wireless
Clients”,

Help | Cancel Back

2. Seguireipassaggia, b e c su tutti i palmari TI-Nspire™ che non sono
inseriti in una docking station.

a) Accendere ogni palmare.

b) Nello schermo principale del palmare, selezionare Impostazioni >
Rete. Il palmare elenca le reti disponibili che sono entro la portata.

c) Selezionare il nome assegnato alla rete della classe e fare clic su
Connetti.

3. Nella schermata Aggiungi client wireless alla rete della classe,
selezionare i client wireless da aggiungere.

»  Peraggiungere tutti i client disponibili, fare clic su Aggiungi tutti.

»  Peraggiungere client specifici, selezionare un ID client alla volta e
quindi fare clic su Aggiungi.

Importante! | client non fanno parte della rete della classe fino al
completamento del passaggio per aggiungerli.

4. Fare clic su Avanti per associare i client wireless alla rete della classe.
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Configuring the Access Paint m

Configuring the Access Point...

IMPORTANT! Do not disconnect the access point while it Is being configured.
This may take up to <#> seconds.

Il software associa i client wireless collegati alla rete della classe. Quando
il processo &€ completo, si apre la finestra di dialogo Installazione
completata.

I
Setup Complete
Your TI-Nspire™ Navigator™ system setup is complete
Todla > etwork Hanager and nen ok Network Seup Wz et e
(®) Back up my class network

Backing up your class network allows you to reload it later, if needed

() Skip Backup

Selezionare Backup della rete della classe per salvare una copia della
configurazione della rete della classe.

Le informazioni di rete salvate includono I'elenco di ID client wireless, il
nome della rete e il canale e il paese selezionati sul punto di accesso.

Il salvataggio di una rete consente di ricaricare la configurazione in un
secondo tempo utilizzando Gestione reti. Per impostazione predefinita, il
file & salvato nella cartella My Documents/TI-Nspire/Navigator Network.
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Per terminare senza salvare una copia di backup, selezionare Salta il
backup.

6. Fare clic su Fine per completare l'installazione.

Nota: € possibile aggiungere piu schede o alloggiamenti wireless alla rete
della classe in un secondo tempo utilizzando Gestione reti.

Collegamento dei palmari alle schede wireless

Le schede di rete wireless funzionano con i palmari TI-Nspire™ CX e
TI-Nspire™ CX CAS. Per collegare il palmare a una scheda wireless, attenersi
alla procedura seguente:

1. Posizionare la scheda wireless sopra il palmare in modo che il connettore
di questa sia allineato al connettore che si trova nella parte superiore del
palmare.

@ Connettore

@ Guide per I'allineamento al palmare

© Scanalature per I'allineamento della
scheda wireless

2. Farscorrere la scheda in posizione, accertandosi che le guide ai lati della
scheda scorrano nelle scanalature predisposte sul palmare.

3. Premere con decisione sulla scheda per inserirla in posizione.

28 Configurazione del TI-Nspire™ Navigator™ Teacher Software



Collegamento dei palmari agli alloggiamenti

Gli alloggiamenti wireless funzionano con palmari TI-Nspire™, TI-Nspire™ CAS,

TI-Nspire™ CX e TI-Nspire™ CX CAS. Per collegare il palmare a un

alloggiamento, attenersi alla procedura seguente:

1. Spostare dispositivo di blocco sul retro dell'alloggiamento in posizione
OFF.
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Lock in OFF
position

2. Percollegare il palmare, con lo schermo rivolto verso l'alto infilare il
palmare nella parte superiore della basetta wireless . Accertarsi che
entrambi i lati del palmare siano inseriti in entrambe le guide laterali.

3. Premere con decisione per garantire il corretto collegamento. Quando &
correttamente collegato, il palmare sembra "seduto" sopra l'alloggiamento.

4. Bloccare il palmare in posizione facendo scorrere I'apposito dispositivo sul
retro dell'alloggiamento in posizione ON.
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0

113088

Lock in ON
position

Inserire ogni alloggiamento nel caricabatterie. Accertarsi che il LED sia
giallo.

TlnSP'r e
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Al termine della giornata scolastica, rimettere gli alloggiamenti wireless nel
caricabatterie e lasciarli in carica per tutta la notte. Gli alloggiamenti sono

carichi quando tuttii LED D (stato carica) sono verdi o gialli fissi.

Creazione e gestione dell'account insegnante

E possibile creare I'account insegnante nella sezione Preferenze insegnante
del TI-Nspire™ Navigator™ Teacher Software. Un account insegnante consente
di accedere alla rete TI-Nspire™ Navigator™ dal palmare dell'insegnante. Dopo
aver creato un account insegnante, l'insegnante pud successivamente
cambiare la password o il nome utente.

Creazione dell'accountinsegnante

1. Utilizzare il selettore dell'area di lavoro per scegliere l'area di lavoro

Classe.

2. Fare clic su File > Impostazioni > Preferenze insegnante ‘

Viene visualizzata la finestra di dialogo Preferenze insegnante.

Teacher Account

Username: |

Password:

Options

Addteacherto classroom view

Randomize order in Screen Capture

[] Individualize Teacher Handheld in Screen Capture

| Reset |

OK

| [ cancel

Digitare un nome utente.

4. Digitare una password.

5. Selezionare o eliminare la preferenza per la visualizzazione dell'icona
dell'insegnante nella vista della classe.

Se si seleziona questa preferenza, l'icona dell'insegnante apparira nella
vista della classe e l'insegnante sara incluso come destinatario delle
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funzioni Invia alla classe, Ritira dalla classe ed Elimina dalla classe Lo
schermo del palmare dellinsegnante verra catturato assieme agli altri
schermi della classe.

6. Selezionare o eliminare le opzioni per catturare gli schermi in ordine
casuale e perindividuare il palmare dell'insegnante.

*  Ordine casuale in Cattura schermo. Selezionando questa opzione si
catturano e si visualizzano gli schermi degli studenti in ordine
casuale, non nell'ordine dell'elenco della classe. Cio consente agli
studenti di concentrasi sugli elaborati senza preoccuparsi di chi & lo
schermo che si sta visualizzando.

* Individua palmare insegnante in Cattura schermo. Selezionando
questa opzione lo schermo dell'insegnhante viene evidenziato rispetto
agli altri schermi catturati.

7. Fare clic su OK.

Madifica della password dell'account inseghante

1. Accertarsi che il proprio palmare non sia connesso alla rete TI-Nspire™
Navigator™.

2. Fare clic su File > Impostazioni > Preferenze insegnante ‘

Viene visualizzata la finestra di dialogo Preferenze insegnante.

Teacher Account

Username: |Ms. Smith I

f |
Password: |+t | Reset |
Add teacher to classroom view
Options
Randomize order in Screen Capture

D Individualize Teacher Handheld in Screen Capture

| OK | | Cancel

3. Fare clic su Reset.

Il software TI-Nspire™ Navigator™ elimina la password attuale.
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| Teacher Account

Usemame: |Ms. Smith ]

Password: | | R

Add teacher to classroom view

Options

Randomize order in Screen Capture

[C] Individualize Teacher Handheld in Screen Capture

[ OK ] [ Cancel

4. Digitare una nuova password.

5. Fare clic su OK.

Modifica del nome utente dell'account insegnante

1. Accertarsi che il proprio palmare non sia connesso alla rete TI-Nspire™
Navigator™.

2. Fare clic su File > Impostazioni > Preferenze insegnante '

Viene visualizzata la finestra di dialogo Preferenze insegnante.

| Teacher Account

Usemame: |Ms. Smith |

Password: | | R

Add teacher to classroom view

Options
Randomize order in Screen Capture

|:| Individualize Teacher Handheld in Screen Capture

0K ] [ Cancel

3. Immettere un nome utente nuovo.

4. Fare clic su OK.
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Connessione al sistema TI-Nspire™ Navigator™ dal
palmare

Il sistema per I'apprendimento per la classe TI-Nspire™ Navigator™ utilizza sia
il computer sia i palmari degli studenti. Per far si che l'insegnante e gli studenti

comunichino tramite la rete TI-Nspire™ Navigator™, gli studenti devono
connettersi alla rete dal proprio palmare.

Nota: I'insegnante non deve connettersi per comunicare con i palmari degli
studenti, ma pud usare lo Strumento di trasferimento per eliminare o inviare file
e sistemi operativi ai palmari degli studenti. Tuttavia, se desidera partecipare
con il proprio palmare alla sessione della classe di TI-Nspire™ Navigator™,
l'insegnante deve connettersi alla rete TI-Nspire™ Navigator™ dal suo palmare.

Per ulteriori informazioni sull'uso di un palmare, fare riferimento alle guide dei
palmari disponibili presso education.ti.com/guides.

Prima di connettersi accertarsi che siano stati completati i seguenti passaggi:

+  E stato creato l'account insegnante nella sezione Preferenze
insegnante

«  E stata avviata una sessione della classe sul computer
dellinsegnante.

» Il palmare TI-Nspire™ & pronto per connettersi. (L'icona 0
lampeggia).

Prima che gli studenti si connettano, accertarsi di completare i seguenti

passaggi:

*  Creare degli account studente.

. Fornire agli studenti il nome della rete della classe, i loro nomi utenti e, se
necessario, le password.

Connessione alla rete TI-Nspire™ Navigator™

1. Per connettersi, eseguire una delle seguenti operazioni:

* Nello schermo principale del palmare TI-Nspire™, selezionare
5:lmpostazioni > 5:Connetti.

+ In uno schermo diverso dallo schermo principale, premere >
8:Connetti.
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L'ultima rete a cui il client wireless & stato associato appare sullo schermo
del palmare.

Nota: se il palmare € collegato al computer con il cavo USB, sullo schermo
non appare alcun nome della rete ed & possibile continuare I'accesso.

2. Seil nome della rete che appare € corretto, continuare con l'accesso. Se
la rete non & corretta, fare clic su Rete.

Le schermate del palmare mostrano tutte le reti a cui € stato collegato e
mostra inoltre le altre reti.

H5pire Networks

3. Selezionare la rete dall'elenco e fare clic su Connetti.

Lo schermo di login mostra lo stato di connessione e il nome della rete
quando la connessione é corretta.

4. Digitare il proprio nome utente e la password.
Selezionare Connetti.

Viene visualizzato lo schermo di conferma della connessione.
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6. Fareclic su OK.

Icone di stato connessione del palmare TI-Nspire™

Le icone degli schermi dei palmari TI-Nspire™ CX, TI-Nspire™ CX CAS,
TI-Nspire™, e TI-Nspire™ CAS indicano lo stato delle comunicazioni tra il
palmare e il punto di accesso, la scheda wireless, I'alloggiamento wireless o la
rete TI-Navigator™. Le icone indicano lo stato nel seguente modo.

Icona Barra Descrizione

Nessuna Se non compaiono icone, il palmare

icona non sta cercando un punto di accesso.
Scollegare e ricollegare la scheda o
I'alloggiamento wireless.

= Lampeggiante | Il palmare sta cercando un punto di
accesso.

— . .

3 Fissa Il palmare ha trovato un punto di
accesso.

= Fissa Il palmare non sta comunicando con la
scheda o l'alloggiamento. Scollegare il
palmare dalla scheda o
dall'alloggiamento, attendere che
I'icona scompaia, quindi ricollegare il
palmare alla scheda o
all'alloggiamento.

0 Lampeggiante | Il palmare € collegato alla rete ed &
pronto per connettersi.

0 Fissa Il palmare € connesso alla rete.

Conservazione delle schede e degli alloggiamenti wireless

Quando si caricano i palmari durante la notte, non occorre togliere le schede di
rete wireless dai palmari prima di inserirli nella TI-Nspire™ CX Docking Station.
Quando la mattina successiva si ricomincia a utilizzare i palmari, questi
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saranno completamente carichi e con la scheda pronta per |'uso.

E possibile rimuovere la scheda wireless dal palmare e riporla nell'apposito
contenitore durante la notte.

Se si prevede di non utilizzare le schede wireless per piu di due settimane,
rimuoverle dal palmare e conservarle nell'apposito contenitore. Riporre il
contenitore in un luogo fresco e asciutto.

Se si prevede di non utilizzare gli alloggiamenti wireless TI-Nspire™
Navigator™ per piu di due settimane, rimuovere i palmari dagli alloggiamenti e
riporre questi ultimi in un luogo fresco e asciutto. Non si danneggiano le
batterie lasciandole in carica oltre il tempo necessario per caricarle oppure
lasciandole nel caricabatterie con la spina staccata.

Utilizzo di Gestione reti TI-Nspire™

Accesso a Gestione reti TI-Nspire™
» Fare clic su Strumenti > Gestione reti.

Si apre la Gestione reti TI-Nspire™.

File Edit View Actions Help

el =
\;‘ Network Setup Wizard é‘J Manually Add wireless client(s) Q Refresh

Wireless Client ID Name Status Battery Signal
= Wireless Clients

Access Point Connected Wireless Client  Disconne...

Metwork Name: Room 217 Hour 3 % 1213841 Wireless Client Connected | 75% || 100%
chamnel " T 1213936 Wireless Client Connected | 100% | 100%
Band: 24GHz

Firmware: 36.043

MAC Address 00:09:37:1F:13:EA

=
3] Manually Add wireless client(s)

Change Operating Channel

Change Metwork Name

Access Point detected

Nota: fare clic su G Aggiorna in qualsiasi momento per aggiornare la
finestra Gestione reti TI-Nspire™.

Apertura dell'lnstallazione guidata della rete

E possibile installare o modificare una rete della classe in qualsiasi momento
utilizzando I'Installazione guidata della rete.
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» Nella finestra Gestione reti TI-Nspire™, fare clic su Installazione guidata
della rete.

La procedura guidata conduce I'utente attraverso il processo di
installazione di una rete della classe, incluso:

»  Aggiornare tutti i palmari degli studenti e delle classi all'ultima
versione del sistema operativo (SO). Il SO sui palmari deve
corrispondere alla versione del software installata sul computer.

+ Collegare il punto di accesso e, se necessario, aggiornare il firmware
del punto di accesso.

+ Denominare la rete della classe.

*  Se necessario, selezionare un canale per il punto di accesso.

* Aggiungere i clientwireless alla rete.

+  Creare una copia di backup della configurazione della rete della

classe.

Verifica dello stato della rete
Lo stato della rete € mostrato nella barra laterale della finestra Gestione reti
TI-Nspire™.

Nota: se la barra laterale &€ nascosta, fare clic su Visualizza > barra laterale.
Fare clic su Aggiorna per aggiornare lo stato se la Gestione reti & gia aperta.

Access Point: Connected
Metwork Mame: Room 217 Hour 3
Channel: "

Band: 24 GHz
Firmware: 36.043

MAC Address: 000937V 1F13EA

Lo stato della rete mostra le seguenti informazioni:

*  Punto di accesso. Mostra se il punto di accesso & collegato o scollegato.
* Nome della rete. Il nome assegnato alla rete durante la configurazione.

* Canale. Il canale operativo del punto di accesso per la rete attuale.

* Banda. Il collegamento di comunicazione selezionato.
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»  Firmware. La versione del punto di accesso.

* Indirizzo MAC L'indirizzo di Media Access Control che identifica il punto di
accesso.

Dopo aver configurato la rete, tutte le schede e gli alloggiamenti aggiunti
compaiono nella finestra Gestione reti TI-Nspire™. Se la scheda o
I'alloggiamento wireless vengono caricati e collegati a un palmare TI-Nspire™
acceso, Gestione reti TI-Nspire™ riporta lo stato "collegato”. Possono essere
necessari 30 secondi perché il client wireless venga riconosciuto e venga
visualizzato il suo stato "collegato”. La finestra di stato visualizza inoltre lo stato
della batteria e la potenza del segnale.

Wireless Client ID Mame Status Battery Signal
= Wireless Clients
Wireless Client Disconnect.
ﬁ 1213841 Wireless Client Connected 75% 100%
F 1213936 Wireless Client Connected | 100% || 100%

Se l'alloggiamento non & carico, oppure se la scheda o I'alloggiamento non &
collegato a un palmare TI-Nspire™ acceso, Gestione reti TI-Nspire™ visualizza
lo stato "scollegato”. Gestioni reti TI-Nspire™ ricorda gli ID della scheda e
dell'alloggiamento aggiunti e la prossima volta che si accende un palmare
collegato a quella scheda o a quell'alloggiamento, Gestione reti TI-Nspire™ lo
riconosce.

LED degli alloggiamenti

I LED di ogni alloggiamento wireless TI-Nspire™ Navigator™ utilizzano vari
colori o motivi di lampeggiamento per indicare I'attivitd dei dati o lo stato della
carica. | LED funzionano sia quando gli alloggiamenti sono inseriti nel
caricabatterie sia quando non lo sono.

I LED indicano lo stato nel seguente modo.

=T Attivita LED

Colore e motivo Descrizione

Verde lampeggiante | Indica il trasferimento di dati al/dal punto di accesso.

D LED (stato carica) batteria
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Colore e
motivo

Descrizione

Nel caricabatterie

Giallo fisso La batteria € in carica.

Verde fisso Accesa, carica e alimentata da un caricabatterie o un
adattatore di corrente.

Rosso fisso La batteria € in carica, ma non & correttamente in contatto

con il caricabatterie. Riposizionare I'alloggiamento in
modo da ottenere un buon contatto. Il LED dovrebbe
diventare giallo a indicare che la carica & in corso.

Fuori dal caricabatterie

Verde
lampeggiante

Accesa, alimentata a batteria. La carica della batteria va
dal 30% al 99%.

Giallo
lampeggiante

Batteria quasi scarica (carica inferiore al 30%).

Rosso
lampeggiante

Batteria molto scarica (carica inferiore all'8%).

Aggiunta manuale di client wireless

E possibile aggiungere manualmente schede o alloggiamenti wireless in
qualsiasi momento.

Quando si aggiunge manualmente una scheda o un alloggiamento wireless,
questo appare immediatamente nella finestra Gestione reti TI-Nspire™.

1. Nella finestra Gestione reti TI-Nspire™, fare clic su Aggiungi client wireless
manualmente.

Si apre la finestra di dialogo Aggiungi client wireless per Numero ID.
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B Bl
Add Wireless Client by ID numi X

Type inthe ID number of the wireless client to add it to the network

Wireless client ID: i

Wireless client Mame (optional): ' '

|- Help—| | AddNext || Einish || Cancel |

2. Perognischeda o alloggiamento wireless da aggiungere, trovare il
numero ID sul retro della scheda o dell'alloggiamento e digitarlo nella
casella ID client wireless. L'ID € costituito dalle ultime sei cifre del numero
da otto cifre (ignorare i primi due zeri).

3. Inserire un nickname nella casella Nickname client wireless (opzionale).

I nickname possono contenere lettere, spazi e numeri. Un nickname deve
essere composto da almeno 1 carattere e pud contenere fino a 64
caratteri.

4. Fare clic su Aggiungi successivo per aggiungere un'altra scheda o un altro
alloggiamento se ci sono piu client wireless da aggiungere.

5. Dopo aver aggiunto tutte le schede e gli alloggiamenti, fare clic su Fine.

Dopo aver aggiunto manualmente i client wireless, & necessario associarli
alla rete utilizzando i palmari.

6. Accendere ogni palmare TI-Nspire™.

7. Collegare la scheda wireless o l'alloggiamento wireless a ogni palmare.
(Vedere le istruzioni per collegare schede o alloggiamenti wireless a
palmari TI-Nspire™).

8. Nello schermo principale del palmare TI-Nspire™, selezionare
5:lmpostazioni > 6:Rete.

Il palmare elenca le reti disponibili che sono entro la portata.
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9. Selezionare la rete aggiunta ai client wireless e fare clic su Connetti.

| client wireless ora sono associati al punto di accesso.

Modifica del canale operativo

1. Nella finestra Gestione reti TI-Nspire™, fare clic su Modifica canale
operativo.

La finestra di dialogo Opzioni avanzate del punto di accesso si apre.

Advanced Access Point Options lij

Access Point Options

If multiple TI-Nspire™ Navigator™ systems operate in close proximity to each
other, it is recommended the access points use different channels to avoid
interference issues. Always check with your IT administrator before
changing access point channels.

Select Band: \

[ 5GHz Ty ]
« Cam

Select Channel:

36 Default . IMPORTANT!

40 If using the 5GHz band, all

44 wireless network adapters

48 in the classroom must be the v2 model.

149

153

157 Cancel Done
.| 161 : -

165 -
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Importante! Se si utilizzano schede di rete TI-Nspire™ CX Navigator™ - v2,
€ possibile selezionare la banda 2,4 GHz o 5 GHz. Se si utilizza una
combinazione di reti di schede wireless, & necessario selezionare la
banda 2,4 GHz.

2. Selezionare un canale diverso dalla casella a discesa.
3. Fare clic su Fatto.

La finestra di dialogo Configurazione del punto d'accesso si apre € il
software configura il punto di accesso.

Salvataggio della configurazione diuna rete

Il salvataggio della configurazione di una rete consente di ricaricare la
configurazione in un secondo tempo utilizzando Gestione rete TI-Nspire™. Le
informazioni di rete salvate includono I'elenco di ID client wireless, il nome
della rete e il canale e il paese selezionati sul punto di accesso. Per
impostazione predefinita, il file & salvato nella cartella My
Documents/TI-Nspire/Navigator Network.

1. Nella finestra Gestione reti TI-Nspire™, fare clic su Azioni > Salvare
configurazione della rete.

Viene visualizzata la finestra di dialogo Salva.
2. Assegnare un nome alla rete e fare clic su Salva. E possibile salvare il file

in un'altra posizione, se lo si desidera.

Riutilizzo di una rete salvata

Il riutilizzo di una rete salvata permette di ricaricare la configurazione di una
rete salvata. Il riutilizzo di una rete consente di risparmiare tempo perché non &
necessario configurare nuovamente la rete.

1. Nella finestra Gestione reti TI-Nspire™, fare clic su Azioni > Applicare
l'installazione della rete salvata.

Viene visualizzata la finestra di dialogo Applicare una rete.
2. Selezionare la rete e fare clic su Applica una rete.
3. Il punto di accesso viene configurato con la configurazione della rete

salvata.

Identificazione di client wireless
Per identificare i client wireless che non rispondono, completare i passaggi
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seguenti.

1. Nell'elenco dei componenti hardware visualizzato nella finestra Gestione
reti TI-Nspire™, fare clic per selezionare i client wireless. Per selezionare
piu client wireless, premere e mantenere premuto il tasto Maiusc o Ctrl
(Mac®: tasto #), quindi fare clic sugli elementi da selezionare.

2. Fare clic su Azioni> Identifica selezionato.
3. Osservare la classe.

»  Se si utilizzano gli alloggiamenti, entrambi i LED sugli alloggiamenti
selezionati lampeggeranno rapidamente in verde.

. Se si utilizza una docking station, entrambi i LED sulla docking station
lampeggeranno rapidamente in verde.

E possibile identificare i client wireless che non funzionano perché i loro
LED non lampeggiano.

Una volta identificati, i client wireless possono essere nuovamente aggiunti
alla rete.
Rimozione di client wireless

Per rimuovere schede di rete o alloggiamenti dalla rete di una classe,
completare i passaggi seguenti.

1. Nella finestra Gestione reti TI-Nspire™, selezionare le schede e gli
alloggiamenti wireless da rimuovere dalla rete.

Fare clic su Azioni > Rimuovi selezionati oppure fare clic su %
Quando richiesto, fare clic su Rimuovi.

| client wireless selezionati sono rimossi dall'elenco.

Ripristino delle impostazioni predefinite in fabbrica per il punto di

accesso

1. Nella finestra Gestioni reti TI-Nspire™, fare clic su Azioni > Imposta le
impostazioni predefinite in fabbrica per il punto di accesso.
Il punto di accesso viene riconfigurato alle impostazioni predefinite in
fabbrica.

2. Fare clic su OK quando viene visualizzato il messaggio di conferma.
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Risoluzione dei problemi

Questa sezione descrive alcuni problemi che si possono riscontrare e offre
suggerimenti sulla loro risoluzione.

Per maggiore assistenza, contattare |'Assistenza clienti.

Il software non rileva tutti i palmari collegati.

La tecnologia USB 3.0 limita il numero di palmari che possono essere rilevati
da un computer.

Per scoprire se si dispone di una porta USB 3.0:

*  Su Windows®, andare in Device Manager nel Pannello di controllo.

*  Su Mac®, andare su Apple > Informazioni su questo Mac > Piu
informazioni > Resoconto di Sistema, e quindi selezionare Hardware >
USB nel riquadro a sinistra.

E possibile collegare e aggiornare un palmare alla volta utilizzando un cavo
USB, o un massimo di 10 palmari contemporaneamente utilizzando una
TI-Nspire™ CX Docking Station.

Durante l'installazione del software, I'aggiornamento del punto di
accesso non € riuscito.

Scollegare e ricollegare qualsiasi cavo collegato al punto di accesso. Il
software riavvia automaticamente il processo di aggiornamento.

Il sistema operativo aggiornato non viene installato sul palmare.

Verificare che il palmare sia completamente carico prima di avviare un
aggiornamento del SO .

Il software non ha accettato il nome della rete della classe.

I nome della rete della classe pud contenere fino a 22 caratteri. | nomi
possono essere costituiti da lettere (A...Z, a...z), (0...9), e spazi ma non possono
contenere caratteri speciali come ? " $\![] +. Utilizzare un nome che sia unico,
facile da ricordare e da identificare. Ad esempio: Ms. Smith Math Rm 65

Il punto di accesso riscontra problemi di connessione.

Verificare che non vi siano altri oggetti vicino al punto di accesso quando
questo & acceso.
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Il canale operativo o la banda del punto di accesso pud compromettere la
connessione.

Importante! Verificare sempre con I'amministratore IT prima di cambiare i
canali del punto di accesso.

Se il punto di accesso di TI-Nspire™ Navigator™ & collegato, & possibile
selezionare il canale operativo 1,6 0 11.

Se il punto di accesso di TI-Nspire™ CX Navigator™ & collegato e si stanno
utilizzando schede di rete wireless TI-Nspire™ CX - v2, &€ possibile
selezionare una banda 2,4 GHz o una banda 5 GHz e selezionare un
canale operative diverso.

Se si utilizza una combinazione di reti di schede wireless, &€ necessario
selezionare la banda 2,4 GHz.

Il canale operativo predefinito per 5 GHz negli Stati Uniti, in Canada e
China € il 36. Il canale operativo predefinito per 5 GHz in altri paesi € il
149.

Per selezionare una banda o un canale operativo diverso, andare su Strumenti
> Gestione reti e fare clic su Modifica canale operativo.

La rete wireless non funziona.

Il SO sui palmari deve corrispondere alla versione del software TI-Nspire™ sul
computer per utilizzare la rete wireless.
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Guida introduttiva a TI-Nspire™ Navigator™
Teacher Software

Lo schermo Benvenuto viene visualizzato la prima volta che si avvia il software
dopo che & stata completata l'installazione.

Per iniziare a lavorare con i documenti, fare clic su un'icona o un link, oppure
chiudere manualmente lo schermo.

Nota: in base all'installazione del proprio software, si potrebbe visualizzare
una schermata di Miglioramento del prodotto al primo avvio del software.

Welcome Screen B2([5)
(1} () TI-nspire navigator Teacher Software

EWINS )

Calculator
Create a new documentwith a Calculator application as the first page. @, view Content

9 (%] Manage Handhelds
[ Transfer Document(s).

5.9017 8 View dasses andstudents

356 _,—g,q:om-a.\zé [z open...
5647583

\\\ [ Recent Documents

i " open-ended-que

B - s  Test_Question

1 ﬁk \X - 10.39] ~~ OP_TrueFalse

IL‘: _1 = . - “~ aPDocument
[ '7” “ Poll 20511

o Always show this at startup

@ Nome. Mostra il nome del software.

@ Icone di Avvio rapido. Fare clic su una di queste icone per creare un
nuovo documento nell'applicazione selezionata. Le applicazioni sono
Calcolatrice, Grafici, Geometria, Foglio elettronico, Dati e statistiche,
Domanda, Notes e Vernier DataQuest™. Lo schermo Benvenuto si chiude
automaticamente e I'applicazione selezionata si apre.

© Area di anteprima. Quando il mouse si sofferma su un'icona di
applicazione o su un link in Strumenti insegnante, questarea mostra
un'anteprima dell'applicazione o dello strumento. Inoltre una breve
descrizione dell'icona o del link viene visualizzata nella parte superiore
dell'area.
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O Mostra sempre all'avvio. Deselezionare questa casella per non
visualizzare piu questo schermo all'apertura del software.

@ Chiusura dello schermo Benvenuto. Fare clic qui per chiudere questo
schermo e cominciare a operare nel software.

@ Strumenti Insegnante. Fare clic su uno di questi link per chiudere lo
schermo Benvenuto e aprire il software nello strumento selezionato.

*  Visualizzare contenuto. Apre I'area di lavoro Contenuto, dove &
possibile trovare contenuto presente sul computer, sul web o i palmari
collegati.

* Gestione dei palmari. Apre I'area di lavoro Contenuto per vedere tutti i
palmari collegati al computer e il relativo stato.

*  Trasferire documenti. Apre I'applicazione Strumento Trasferimento
nell'area di lavoro Contenuto dove € possibile inviare documenti,
cartelle o nuovi file del sistema operativo (SO) ai palmari collegati.

*  Visualizza classi e studenti Apre I'area di lavoro Classe dove &
possibile visualizzare gli studenti in una classe o aggiungere nuove
classi e studenti.

*  Apri Apre una finestra di dialogo dove €& possibile selezionare un file
da aprire esistente sul computer.

*  Documenti recenti Elenca i nomi dei documenti aperti di recente.
Quando il mouse si sofferma su ogni nome di documento, la prima
pagina di quel documento viene visualizzata nel riquadro Anteprima.
Fare clic sul nome di un documento nell'elenco per aprire il
documento.

Spostamento tra le icone dello schermo Benvenuto

» Premere Tab per spostarsi tra le icone.

» Premere MAIUSC + Tab per spostarsi indietro tra le icone.

» Fare clic per agire sull'icona selezionata.

Durante lo spostamento ftra le icone, I'area Anteprima mostra un'anteprima
dell'applicazione.

Apertura manuale dello schermo Benvenuto

Lo schermo Benvenuto si apre automaticamente all'apertura del software. Per
aprire lo schermo manualmente, seguire la seguente procedura:

» Fare clic su Help (?) > Schermo Benvenuto.
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Esplorazione del TI-Nspire™ Navigator™ Teacher Software

Quando lo schermo Benvenuto viene chiuso, il TI-Nspire™ Navigator™ Teacher
Software si apre sull'ultima area di lavoro usata. Se si utilizza il software per la
prima volta, I'area di lavoro Contenuto € aperta per default. Le aree di lavoro
sono trattate in dettaglio in seguito.

) Ti-Nspire™ Navigator™ Teacher Software o -®
File Edit View Tools Class Window Help
[RTWYRN  Cic  Documents  Review  Portolio
& -®E-8 A -
Resources
Ly i
R | Computer Content|
Local Disk (C:) lame
Local Disk (C) =
DA o
icomapps (Vetfs) (G:) icomapps (Vetfs) (G:)
£ icompuffiles (Vetfs\guidebooks) (Z) | | & icompdffiles (\etfs\guidebooks) (Z:)
= icomproj (\ETFS) (Y:) £ icomproj (\ETFS) (Y:)
= =2 icomproj (1lentap038) (F)
2 icomproj (Wxlentap038) (t) £ publc (ETFS) 0) I
2 public (\ETFS) (X)) 1 Deskiop
8 Desktop
s Documents Local Disk (C)
4 TI-Nspire: Details
[@ Links. Name: Local Disk (C:)
~ @ Web Content Type: Local Disk
@ Activities Exchange Total Space: 298.09 GB
@ Math Nspired Space Free: 1773368
@ Science Nspired 1
- -
Local Disk (C)
T Oclients connected & 0 of 11 Students logged in

Gli strumenti descritti di seguito sono disponibili in tutte le aree di lavoro del
TI-Nspire™ Navigator™ Teacher Software. Per ulteriori informazioni su altre
aree di lavoro del software, vedere il capitolo per ogni area di lavoro.

Q| © 1i-Nspire™ Navigator™ Teacher Software o |-
[200 Fie Edt View Tools Class Window Help

(3] Content Class [ Review Portfolio BeginClassmn
0\& = 8 ¢HBBs| TE-|H [5) [6)

© Barra del titolo. Mostra il nome del documento corrente e il nome del
software e include, nell'angolo a destra, i pulsanti di riduzione a icona,
ingrandimento e chiusura.

@ Barra dei menu. Fornisce gli strumenti per lavorare con i documenti
nell'area di lavoro corrente e modificare le impostazioni di sistema.

© Selettore dell'area di lavoro. Utilizzare queste schede per spostarsi tra le
aree di lavoro Contenuto, Classe, Documenti, Revisione e Portfolio.
Nota: alcune attivita in corso possono impedire il cambio immediato

dell'area di lavoro. Se una finestra di dialogo € in attesa di una risposta,
digitare la risposta e successivamente cambiare area di lavoro.
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O Menu Strumenti. Visualizza gli strumenti di uso frequente in ogni area di
lavoro. Ogni area di lavoro dispone di icone Test rapido, Cattura schermo
e Formato nome studente. Altre opzioni del menu studenti cambiano in
base all'area di lavoro aperta. Ogni strumento & trattato nel rispettivo
capitolo.

Il Formato nome studente permette di scegliere la modalita di
visualizzazione dei nomi degli studenti: per Cognome, Nome, Nome
utente, Nickname, ID studente o nascosto.

Lo strumento Cattura schermo consente di catturare unimmagine di
un documento attivo sul computer o di catturare la schermata di uno o
tutti i palmari collegati. E possibile catturare piti immagini e
copiarle/incollarle e salvarle Per ulteriori informazioni, consultare
Cattura Schermo.

Lo strumento Test rapido consente di inviare un test agli studenti, che
viene immediatamente ricevuto sui loro palmari, e di ricevere le
risposte degli studenti. Per ulteriori informazioni, vedere Test degli
studenti.

@® Elenco classi. Elenca le classi attualmente disponibili.

@ Pulsante Azioni di classe. Utilizzare questo pulsante per iniziare, mettere
in pausa, riprendere o terminare una classe (lezione).

Esplorazione delle aree di lavoro

TI-Nspire™ Navigator™ Teacher Software utilizza le aree di lavoro per
consentire di accedere facilmente alle attivita eseguite piu frequentemente.
TI-Nspire™ Navigator™ Teacher Software dispone di cinque aree di lavoro
predefinite. Ogni area di lavoro ¢ trattata in dettaglio nel rispettivo capitolo.

Area di lavoro Contenuto. Utilizzare quest'area di lavoro per trovare e
gestire contenuto dal computer, link ai siti web, palmari collegati o
contenuto web di Texas Instruments.

Area di lavoro Classe. Utilizzare questo spazio di lavoro per gestire classi
e studenti, utilizzare il pannello Registrazione della classe e scambiare file
con gli studenti. E possibile utilizzare una combinazione di palmari
TI-Nspire™ CX, TI-Nspire™ CX CAS, TI-Nspire™ e TI-Nspire™ CAS
all'interno della stessa classe.

Area di lavoro Documenti. Utilizzare quest'area di lavoro per creare
documenti e mostrare concetti matematici.
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» Area di lavoro Revisione. Utilizzare questo spazio di lavoro per rivedere
una serie di documenti ritirati, contrassegnare, mostrare o nascondere le
risposte degli studenti, passare tra le viste dati e organizzare dati.

* Areadilavoro Portfolio. Utilizzare quest'area di lavoro per salvare,
archiviare, rivedere e gestire elaborati degli studenti.

Esplorazione della barra di stato

Alcune informazioni nella barra di stato cambiano in base all'area di lavoro
aperta.

In tutte le aree di lavoro, la barra di stato fornisce informazioni sullo stato della
rete e sullo stato di connessione degli studenti.

= 1clients connected A 0 of 11 Students logged in

Network status Student login status

Lo stato della rete mostra quanti adattatori di rete wireless TI-Nspire™ CX e
quante basi TI-Nspire™ Navigator™ sono attualmente collegate al sistema. E
possibile fare clic qui per aprire la finestra Gestione rete.

Lo stato di connessione degli studenti mostra quanti studenti sono attualmente
collegati alla classe e quanti sono assegnati alla classe corrente.

Nell'area di lavoro Documenti, la barra di stato offre informazioni aggiuntive.

Page Size: Handheld Settings Boldness: [100% ~| - +

099 (4]

@ Dimensioni pagina. Mostra se il documento & nelle dimensioni pagina
Palmare o Computer. Fare clic qui per visualizzare le proprieta del
documento. Per maggiori informazioni sulle dimensioni della pagina e
sull'anteprima del documento, vedere Operazioni con i documenti di
TI-Nspire™.

@ Numero di attivita e di pagina. Sono riferiti al documento corrente. In
questo esempio, 1.1 indica I'attivita 1, pagina 1 del documento attivo.

© Impostazioni. Fare clic qui per visualizzare o modificare le Impostazioni
documento.

@O Zoom/Nitidezza. Quando si lavora con un documento in dimensioni
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pagina Palmare, usare la scala dello zoom per ridimensionare il
documento attivo da 10% a 500% Per impostare uno zoom, digitare un
numero specifico, utilizzare i pulsanti + e - per aumentare o diminuire con
incrementi del 10%, o in alternativa utilizzare il menu a tendina per
scegliere le percentuali predefinite.

Quando si lavora con un documento in dimensioni pagina Computer,
utilizzare la scala Nitidezza per aumentare o diminuire la nitidezza del
testo e lo spessore delle linee in un documento. Per impostare la
nitidezza, digitare un numero specifico, utilizzare i pulsanti + e - per
aumentare o diminuire con incrementi del 10%, o in alternativa utilizzare il
menu a tendina per scegliere le percentuali predefinite.

Nell'area di lavoro Revisione, le informazioni della barra di stato cambiano, in
base alla vista nell'Ordinatore pagine.

Data View: % -= |§|

Nella vista Documento, la barra di stato fornisce le stesse informazioni
della barra di stato dell'area di lavoro Documento.

Nella vista Risposte degli studenti, la barra di stato dispone di icone vista
Dati. Utilizzare le icone per passare tra le viste diagramma a barre, tabella
e grafico. Vedere Utilizzo dell'area di lavoro Revisione per ulteriori
informazioni sulle viste Dati.

@ Grafico

@ Istogramma
0 9 @ © Tabela

Nell'area di lavoro Classe, la barra di stato dispone di icone vista Studenti.
Utilizzare le icone per passare dalla vista Disposizione studenti alla vista
Elenco studenti. Vedere Utilizzo dell'area di lavoro Classe per ulteriori
informazioni sulle viste Studenti.

Student View: |

?| y @ Disposizione studenti

o 9 @ Elenco studenti

Cambio della lingua

Utilizzare questa opzione per selezionare una lingua preferita. E necessario
riavviare l'applicazione per rendere effettiva la modifica.
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1. Fare clic su File > Impostazioni > Cambia Lingua.

Viene visualizzata la finestra di dialogo Scegliere una lingua.

Choose a language @

Language changes will take effect after application restart.

Choose language: IEEninsh (Us) - ;l

| Quit Now || Quit Later || Gancel

2. Fare clic su w per aprire I'elenco a discesa per selezionare una lingua.
Selezionare la lingua desiderata.

Fare clic su Chiudi ora per chiudere immediatamente il software. Verra
richiesto di salvare tutti i documenti aperti. Al riavvio del software, il cambio
di lingua diventa effettivo.

—oppure—
Fare clic su Chiudi dopo per continuare a lavorare. La nuova lingua non

viene applicata fino a quando non si chiude e non si riavvia
successivamente il software.

Nota: se si seleziona Cinese semplificato o Cinese tradizionale come lingua
del software TI-Nspire™, si dovranno visualizzare i caratteri cinesi nei menu e
nelle finestre di dialogo. Se il computer utilizza il sistema operativo Windows®
XP e non si visualizzano i caratteri cinesi, potrebbe essere necessario
installare il pacchetto East Asian Language Support di Windows® XP.
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Monitoraggio e reportistica dell'uso del sistema

Gli istituti scolastici che partecipano a programmi di ricerca o che ricevono
fondi da iniziative di finanziamento sono tenuti a monitorare l'uso dei sistemi
TI-Nspire™ Navigator™ e a riportarne |'attivitd a scopo di verifica.

Per monitorare automaticamente I'uso di TI-Nspire™ Navigator™ da parte degli
studenti, gli insegnanti devono creare una cartella denominata "Log di
sessione" (SessionlLogs) all'interno della cartella di TI-Nspire™ Navigator™
pertinente sul loro computer. Se la cartella Log di sessione (SessionLogs) &
presente, il software genera i file necessari per monitorare i tipi di attivita, la
partecipazione, le informazioni relative alla classe e le attivita svolte durante
una sessione. | file sono interdipendenti e devono essere riuniti nella cartella
Log di sessione in modo che le informazioni riguardanti l'uso siano monitorate
e riportate in modo accurato.

Quando la cartella Log di sessione ¢ stata creata, il sistema acquisisce
automaticamente i dati sull'uso del sistema e aggiunge le informazioni per ogni
nuova sessione della classe nel file pertinente. Se il sistema non trova una
cartella Log di sessione, i dati non vengono monitorati.

Creazione della cartella Log di sessione (SessionLogs)

Utilizzando Explorer di Windows® (o Finder per Mac®), completare i seguenti
passaggi per creare la Cartella log di sessione (SessionLogs).

1. Andare nella cartella My Documents (Documenti) del computer.

2. Aprire la cartella che corrisponde al software installato. Questa ¢ la
cartella predefinita creata durante l'installazione del software TI-Nspire™
Navigator™.

*  TI-Nspire™ Navigator™ Teacher Software
*  TI-Nspire™ CAS Navigator™ Teacher Software
*  TI-Nspire™ Navigator™ NC Teacher Software
*  TI-Nspire™ CAS Navigator™ NC Teacher Software
3. Creare una cartella denominata SessionLogs (Log di sessione).

Nota: il nome della cartella distingue tra maiuscolo e minuscolo e deve
essere denominato come descritto.
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All'avvio del software TI-Nspire™, il sistema crea i file della sessione e li
salva nella cartella SessionLogs (Log di sessione).

o]

&P ) [~ vy TErspre Navigator Teacher Softnare ~ SessonLogs &3 [ search sessontogs )

| Fle Edt view Tools Hep
Name IDatEmudlﬁed |Twe |s\ze | |

E activities 11/4/201111:57AM  Microsoft Excel Comma Separated Values File 1¥B
B actvityTypes 1U/7/20119:41AM  Microsoft Excel Comma Separated Values File 1k
) attendance 11420111157 AM  Microsoft Excel Comma Separated Values File 1k8
) ClassSession 11/4/201112:01PM  Microsoft Excel Comma Separated Values File 1k8

Gestione dei Log di sessione

Il sistema genera automaticamente i seguenti file delimitati da virgole (csv) e li
archivia nella cartella SessionLogs (Log di sessione). A ogni avvio del
software TI-Nspire™, i log vengono aggiunti al log del giorno precedente per
mantenere un registro completo.

Nota: gli utenti sono responsabili della gestione della dimensione dei file.

File ActivityTypes.csv. Questo file & la tabella di ricerca a cui il sistema fa
riferimento durante la creazione di un rapporto sull'uso.

File Attendance.csv. In questo file sono registrate le informazioni
riguardanti ogni studente che accede a una sessione.

File ClassSession.csv. In questo file sono registrate le informazioni
riguardanti ogni sessione della classe.

File Activities.csv. In questo file sono registrate le attivita svolte durante le
sessioni della classe.

Utilizzo del File ActivityTypes

Il file ActivityTypes & una tabella di ricerca che include codici per
l'identificazione dei tipi di attivita e una breve descrizione di ogni attivita.

ID attivita Descrizione

CS Cattura schermo
RF Raccogli file

EF Elimina File

IF Invia file

RD Ridistribuisci
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ID attivita

Descrizione

SP Salva in Portfolio

RM Raccogli mancanti

IM Invia mancanti

IN Invio non richiesto

LP Live Presenter
TR-SM Test rapido - A scelta multipla
TR-RA Test rapido - A risposta aperta
TR-EQ Testrapido - Equazioni
TR-EC Test rapido - Espressione chimica
TR-EX Test rapido - Espressioni
TR-IE Testrapido - Immagine con etichette
TR-IP Testrapido - Immagine con punto/i
TR-PC Testrapido - Coordinate di punti
TR-FE Test rapido - Foglio elettronico

Utilizzo del File Attendance (Partecipazione)

Il sistema registra le informazioni per ogni studente che ha effettuato I'accesso
a una sessione nel file Attendance (Partecipazione). Le informazioni
includono:

ID della classe. Il numero unico di ID della classe per il programma di
finanziamento.

Nome della classe. Nome della classe cosi come definito nel software.

Cognome. Cognome dello studente.

Nome. Nome dello studente.

Data e ora. Data e ora in cui lo studente ha effettuato I'accesso. Le
informazioni sono utilizzate per identificare gli studenti che hanno
effettuato l'accesso in orario piuttosto che in ritardo.
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Utilizzo del File Class Session

Il sistema registra le informazioni per ogni sessione della classe per ID della
classe. Le informazioni includono:

* ID dellaclasse. Il numero unico di ID della classe per il programma di
finanziamento.

*  Nome della classe. Nome della classe cosi come definito nel software.

+ Inizio. L'ora di inizio della classe registrata quando l'insegnate seleziona
Inizio classe (Begin Class).

* Fine. L'ora di fine della classe registrata quando l'insegnate seleziona Fine
classe (End Class).

*  NumsStudent (N. studenti). Numero di studenti che hanno effettuato
l'accesso durante la sessione della classe.

Utilizzo del file Activities

Il sistema registra le informazioni riguardanti le attivitd che si svolgono durante

la sessione della classe in questo file. Le informazioni includono:

+ ID della sessione della classe. [l numero unico dell'ID della classe per il
programma di finanziamento.

*  Nome della classe. Nome della classe cosi come definito nel software.

+ ID del Tipo di attivita. Il tipo di attivita svolta durante la lezione. L'ID
corrisponde ai tipi di attivita definiti nel file Activity Type (Tipo di attivita).

»  Dettaglio dell'attivita. Dati aggiuntivi riguardanti il tipo di attivita, se
disponibili.

» Inizio attivita. L'ora di inizio dell'attivita.

*  Fine attivita. L'ora in cui termina l'attivita.

*  NumStudent (N. studenti). Numero di studenti che partecipano a questa
attivita.

Creazione del pacchetto e invio dei log di sessione

A intervalli regolari, 'amministratore del distretto deve riportare i dati relativi
all'uso alla fonte di finanziamento a scopo di verifica. Quando i file vengono
richiesti, gli insegnanti possono facilmente creare il pacchetto dei file della
sessione in un file zippato e inviarlo alllamministratore. Il file zippato preserva il
formato e le dipendenze dei file delle attivita e include un nome di file
predefinito che identifica il file zippato per I'amministratore.
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Completare i passaggi seguenti per creare il pacchetto dei file nella cartella
SessionLogs (Log di sessione) in un file zippato e inviare il file
all'amministratore.

1.

Dall'area di lavoro Contenuto, fare clic su File > Pacchetto log di sessione.

Nota: questa voce del menu € disponibile unicamente se ¢ stata creata la
cartella SessionLogs (Log di sessione).

Il software crea il pacchetto dei file in un file zippato e assegna un nome
predefinito (TI_PKG_SessionLogs_MMDDYYYY). Si visualizza la finestra
di dialogo Pacchetto log.

Logs package

The logs were successfully packaged. Do you want to open location of file?

b

Fare clic su Si per navigare nel percorso in cui € stato salvato il file
zippato.

Si visualizza Explorer di Windows® (o Finder). Il file zippato viene salvato
nello stesso percorso della cartella SessionLogs (Log di sessione). Per
esempio, in TI-Nspire™ Navigator™ Teacher Software, la cartella
SessionLogs (Log di sessione) viene archiviata nel seguente percorso:

PC:

..\Documenti\TI-Nspire™ Navigator™ Teacher Software\
Mac®

.../Documenti/TI-Nspire™ Navigator™ Teacher Software/
Inviare via email il file zippato all'amministratore.

| dati vengono aggiunti al file esistente a ogni avvio di una nuova
sessione. Se i file inviati all'amministratore non sono piu necessari,
rimuoverli dalla cartella SessionLogs (Log di sessione) e conservare il file
zippato. Il sistema generera dei nuovi file al prossimo avvio di una nuova
sessione.
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Utilizzo dell'area di lavoro Contenuto

L'area di lavoro Contenuto consente I'accesso e la navigazione a cartelle e file
memorizzati su computer, rete e dischi esterni, permettendo di aprire, copiare e
trasferire file agli studenti.

Esplorazione dell' area di lavoro Contenuto

T - @
~ & Computer Content 0 — = —
Me=IBEE) » | Agebra-t 0372372012 ~
=1 » L. apple-ipad-docs 1000512012
BaG\ > | ARCHNED FILES - Jupiter [3) 051712011 =
=P » | Ba 0812312010/
BavA > | Calculator 05/1712011
B » = Copy of Circles_Equation_of_a_Circle(2) 507 KB 02/19/2013
Bax » = Copy of Circles_Equation_of_a_Gircle 507 KB 01/1022013
88 Deskiop > = Copy of Linear_Equal..s_in_Two_Variables(2) 472KB 0211972013
B8 Documents > = Copy of Linear_Equalies_in_Two_Variables 472KB 01/1022013
= > | Dictionary 11/12/2012
ispi » | Downloads 04/09/2013
[@ Links > | Downloads? 051712011 -
v @ Web Content
® Actvies Exchange Circles_Equation_of_a_Circle
@ Math Nspired Files
@ Science Nspired [4) I
~ B TiNspire™ Connected Handhelds = Circles_Equation_of_a_Gircle_Stude.

@ ThNspire CX CAS 12F9
i ThNspire CX 7082

1]

1% Circles_Equation_of_a_Circle_Stude.

[Exploring the Equation of a Circle

! Circles_Equation_of_a_Circle_Teach
= 1= Circles_Equation_of_a_Circle_Teach

You will explore the relationship between right | =) Add Files to Lesson Bundle
triangles, distance, and the equation of a T —

circle

Details

Date Wodified: 11114/11

Name: Circtes_Equation_of_a_Circle |

Riquadro Risorse. Selezionare qui il contenuto. E possibile
selezionare cartelle e collegamenti sul computer, unita di rete, unita
esterne o contenuti web. Se si utilizza un software che supporta i
palmari TI-Nspire™, I'intestazione Palmari collegati & visibile quando
i palmari sono connessi.

Nota: € possibile aggiungere nuovi collegamenti ai siti Web preferiti
nella sezione Collegamenti. Si pud accedere a questi nuovi
collegamenti nel riquadro Contenuti. | nuovi collegamenti non
possono essere aggiunti alla sezione contenuti web.

Barra di navigazione. Navigare in qualsiasi posizione del computer
facendo clic su un elemento nel percorso della barra di navigazione.
Quando si seleziona una risorsa, le opzioni mostrate sono specifiche
della risorsa.

Riquadro Contenuto. Per impostazione predefinita, sono visualizzate
le cartelle del desktop. Utilizzare questo spazio per individuare e
visualizzare i file presenti sul computer. E possibile individuare e
accedere ai file su un palmare collegato se si utilizza un software
che supporti palmari. Utilizzare la meta superiore dell'area di lavoro
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come una finestra di gestione file. Il riquadro Contenuto € in grado di
mostrare i contenuti di solo un elemento selezionato alla volta.
Evitare di selezionare piu di un elemento alla volta.

O Riquadro Anteprima. Visualizza dettagli sul file o la cartella
selezionata.

Esplorazione del riquadro Risorse

Utilizzare il riquadro Risorse per individuare i documenti su un computer,
accedere a contenuti web e lavorare con palmari collegati se si utilizza un
software TI-Nspire™ che supporta i palmari collegati.

Resources

“‘ ¥ &l Computer Content
4 Local Disk (C)
BaD:\
==]cal
Bz
BE YA
Ba i
Baxa
@8 Desktop
9 Documents
= Ti-Nspirc
@ [Einks
@ ~ (@ Web Content
@ Activities Exchange
@ Math Nspired
@ Science Nspired
e ¥ & TI-Nspire™ Connected Handhelds
[&l Tl-Nspire CX CAS 12F9
1. Tl-Nspire CX 70B2

© Contenuto del computer. Consente la navigazione a tutti i file su un
computer, unita di rete e unita esterne. Contenuto del computer si
espande e collassa per fornire I'accesso ai collegamenti predefiniti
seguenti:
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+ Disco locale
* Unita esterne
*+ Unitadirete
* Desktop

+  Documenti

Quando si seleziona un elemento in Contenuto del computer, nel
riquadro Contenuto viene visualizzata la struttura del file. Quando si
seleziona una cartella o un file supportato, il riquadro Anteprima ne
visualizza i dettagli.

Collegamenti. Per impostazione predefinita, sono elencati i
collegamenti a siti utili di Texas Instruments. Quando si fa clic su
Collegamenti, viene visualizzato un elenco di link nel riquadro dei
contenuti. Se si clicca su uno di questi collegamenti, esso viene
lanciato nel web browser. E possibile aggiungere link personali a
questa sezione. Quando si effettua I'aggiornamento, vengono
aggiunti i link dell'ultima versione del software TI-Nspire™.

Gli utenti residenti negli Stati Uniti possono cercare standard o testi
scolastici USA selezionando l'opzione Cerca da Link.

Contenuto web. Elenca i link ai siti di Texas Instruments che
contengono attivita supportate da TI-Nspire™. Contenuto web &
disponibile se si & connessi a Internet. E possibile salvare sul proprio
computer il materiale trovato in questi siti e condividere elementi
tramite il riquadro Contenuto del computer o Palmari collegati se si
utilizza un software che supporta i palmari. Non € possibile salvare
link a siti web nella sezione Contenuto web.

Nota: il contenuto web disponibile varia a seconda dell'area
geografica. Se non ci sono contenuti online, questa sezione non &
visibile nel pannello Risorse.

Quando si seleziona un elemento in Contenuto web, l'elenco delle
attivita viene visualizzato nel riquadro Contenuto, con un'anteprima
dell'attivita selezionata nel riquadro Anteprima.

Palmari collegati. Mostra un elenco di palmari collegati al computer.
Fare clic sull'etichetta Palmari collegati per visualizzare informazioni
su ciascun palmare nel riquadro Contenuto. Per vedere cartelle e file
di uno specifico palmare, fare clic sul nome del palmare. Un simbolo
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di avviso accanto al nome di un palmare indica che il SO sul palmare
dello studente non corrisponde alla versione del software. La
versione del SO del palmare deve corrispondere alla versione del
software TI-Nspire™ per operare nell'ambiente aula. Spostare il
mouse sul simbolo di avviso per aprire una descrizione comando per
maggiori informazioni.

Nota: i palmari collegati non sono mostrati in caso di assenza di
palmari collegati o se si sta utilizzando TI-Nspire™ Navigator™ NC
Teacher Software.

Utilizzo del riquadro Anteprima

Lesson Bundle Example

Files
{ERREEEEL’ -
--- 3 calculator tns » 9
Question ¥ Cartoon Image jpg »
&2 color_notes tns 3
test test test @ = Lesson Plan Templatensp »
Add Files to Lesson Bundle
axis axis axis 7
= | Details
Answer v Name: Lesson Bundie Example o
Date Modified: 11/11/10
Size: 56 KB
Read Only: No
v

© Anteprima in miniatura di cartella, file .tns, icona tipo di file o unita
didattica selezionati. Fare doppio clic sulliicona tipo di file per aprire
il file nella sua applicazione associata.

Nota: Se un'unita didattica & vuota e questo spazio & vuoto, si ha la
possibilita di aggiungere file.

@® Se un documento TI-Nspire™ & formato da pil pagine, utilizzare la

freccia avanti ™ per visualizzare I'anteprima della pagina
successiva. La freccia indietro diventa attiva cosi che & possibile
spostarsi indietro tra le pagine. Se si lavora su un'unita didattica, con
questo metodo € possibile scegliere di visualizzare I'anteprima di un
documento TI-Nspire™ che fa parte dell'unita.

©® Se siseleziona un'unita didattica, viene visualizzata la finestra di
dialogo File sopra la finestra Dettagli con I'elenco dei file che
compongono l'unita didattica. Fare doppio clic su qualsiasi file in
un'unita didattica per aprire il file nella sua applicazione associata.
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Files

B4 calculator tns

¥ Cartoon Image jpg

&4 color_notes.tns

;Eﬂ Lessan Plan Template.tnsp
Add Files to Lesson Bundle

b . .

O Se ssiseleziona una cartella, la finestra Dettagli visualizza il nome e il
percorso della cartella e la data dell'ultima modifica.

Details

Name: Calculator
Path Na.. Ci\Documents and ..
Date Mo... 10/29/10

Per i file documento e i file delle unita didattiche, la finestra Dettagli
mostra il nome, la data dell'ultima modifica, la dimensione e se il file
e di sola lettura.

Details

Marne: Problem.tns
Date Mod... 1062010
Size: 3KB

Read Only: Mo

Accesso a Contenuto del computer

Contenuto del computer fornisce I'accesso a tutte le informazioni memorizzate
sul vostro computer, rete ed unita esterne.
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Utilizzo della barra di navigazione

La barra di navigazione del riquadro Contenuto fornisce gli strumenti
necessari per individuare cartelle e file.

(A Local Disk(C?) > Users > 0171199 > Documents > T-Nspire

0 2] ©

o Opzioni Fare clic su w per aprire il menu che consente di
accedere alle opzioni necessarie per lavorare con i file e le cartelle.

@ Percorso corrente: Contiene un percorso di navigazione cliccabile
della posizione corrente. Cliccare sul percorso di navigazione per
navigare in qualsiasi sezione del percorso.

© Cerca. Inserire una parola chiave da cercare e premere Invio per
trovare tutti i file nella cartella selezionata che la contengono.

Filtraggio di Contenuto del computer

Utilizzare questa opzione di filtraggio per un facile accesso e per la selezione
dei contenuti di insegnamento. E possibile selezionare mostra solo contenuti
TI-Nspire™ o mostra tutti i contenuti.

1. Selezionare una cartella nel Contenuto del computer nel riquadro Risorse.
2. Dalla barra dei menu, selezionare Visualizza> Filtra per.
3. Scegliere una delle seguenti opzioni:

*  Mostra solo contenuti TI-Nspire™

. Mostra tutti i contenuti

Mappatura di un'unita direte
Completare la seguente procedura per mappare un'unita di rete.

1. Selezionare Contenuto del computer dalla lista Risorse.

2. Fareclicsu ™ e quindifare clic su Crea collegamento.

La finestra di dialogo Aggiungi collegamento a Contenuto si apre.
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Add Shortcut location to Content

| | Browse

[ Add Location ] l Cancel ]

Fare clic suSfoglia.
Nota: € inoltre possibile digitare il percorso completo per l'unita di rete.

Viene visualizzata la finestra di dialogo Seleziona collegamento cartella.

Select Shortcut Folder X

Select a directory to use as a content shortcut

| Wy Corel Shows
@ My Music
. My Metwork Manager
[# My Pictures
o My Profiles
J My PSP Files
) My Shapes
. My TI-Nspire Navigator Teacher Software
| My TI-Mspire Navigator Teacher Software for Networked Compuf

+
+
+
+
+
*
+
+
+
+

28 My Videos
4 {1} 13
) WMake new folder Cancel

Selezionare I'unita di rete.
Fare clic su Seleziona.
Fare clic suAggiungi posizione.

Viene visualizzata la finestra di dialogo Inserire credenziali disco di rete.

Please enter network drive credentials.

Usemame |

Password

Digitare il nome utente e la password fornite dal proprio amministratore di
sistema.

Fare clic su Accetta.

La cartella viene aggiunta all'elenco delle cartelle sotto Contenuto locale
nel riquadro Risorse.
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Accesso a un'unita di rete protetta

Se l'accesso a un'unita di rete richiede l'autenticazione, completare la
seguente procedura per accedere alla rete protetta.

1. Fare clic sull'unita a cui si desidera accedere nel pannello Risorse.

Viene visualizzata la finestra di dialogo Inserire credenziali disco di rete.

Please enter network drive credentials.

Username

Password

2. Digitare il proprio nome utente e la password.

3. Fare clic su Accetta.

Utilizzo dei collegamenti

Utilizzare questa opzione per aggiungere all'elenco Contenuti del computer
cartelle o unita didattiche contenenti file di uso frequente.

Aggiunta di un collegamento

Per aggiungere un collegamento a una cartella contenente i file a cui si
accede spesso:

1. Spostarsi sulla cartella in cui € ubicato il file.

ey
2. Fareclicsu ™ e quindifare clicsu Crea collegamento.
La cartella viene aggiunta all'elenco delle cartelle sotto Contenuto del
computer nel riquadro Risorse.

Eliminazione di un collegamento
Per eliminare un collegamento:
1. Nell'elenco Contenuto del computer, selezionare la cartella da eliminare.

2. Fare clic con il pulsante destro del mouse sulla cartella selezionata e
quindi fare clic su Rimuovi collegamento.

La cartella viene rimossa dall'elenco di collegamenti.

Nota: non € possibile rimuovere i collegamenti predefiniti.
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Operazioni con i link

Per impostazione predefinita, I'elenco Link contiene un elenco di link ai siti
web di Texas Instruments. Fare clic su un link per avviare il browser web e
accedere al sito web.

Utilizzo della barra degli strumenti Link

Quando si seleziona Link nel riquadro Risorse, gli strumenti visualizzati nella
barra degli strumenti sono specifici per i link. Utilizzare questi strumenti per
aggiungere, modificare o eliminare link dall'elenco. E inoltre possibile spostare
un link in alto o in basso nell'elenco.

cEEBE®E

Opzioni. Fare clic su w per aprire il menu che consente di
accedere alle opzioni specifiche peri link.

Fare clic su questa icona per aggiungere un link all'elenco.

Selezionare un link esistente e quindi fare clic su questa
icona per modificare gli attribuiti del link. Non & possibile
modificare un link di default.

Fare clic su questa icona per eliminare un link. non &
possibile eliminare un link predefinito.

B B

Selezionare un link e fare clic su questa icona per spostare il
link in alto nell'elenco.

. X

Selezionare un link e fare clic su questa icona per spostare il
link in basso nell'elenco.

A
0

Aggiunta di un link

Completare la procedura seguente per aggiungere un link all'elenco Link nel
riquadro Risorse.
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1. Fareclicsu .

Viene visualizzata la finestra di dialogo Aggiungi link.

Add Link

Name ||

Address |http:y

| AddLink || cancel |

2. Digitare il nome del link.
Digitare I'URL nel campo Indirizzo.
4. Fare clic su Aggiungi link.

Il link viene aggiunto in fondo all'elenco dei link esistenti.

Madifica di un link esistente
Completare la seguente procedura per modificare un link esistente.

1. Selezionare il link da modificare.

2. Fareclicsu .

Viene visualizzata la finestra di dialogo Modifica link.

Edit Link

Name |Google

Address 'http:ffwww.google.com

| Editlink || cancel |

Apportare le modifiche necessarie al nome del link o all'lURL.
4. Fare clic su Modifica link.

Le modifiche vengono applicate al link.
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Rimozione di un link
Completare la seguente procedura per eliminare un link.

1. Selezionare il link da eliminare.

=
2. Fareclicsu .

Viene visualizzata la finestra di dialogo di conferma.
3. Fare clic su Rimuovi.
Il link viene rimosso dall'elenco.

Nota: non & possibile eliminare un link predefinito.

Spostamento di link in alto o0 in basso nell'elenco
E possibile modificare I'ordine dei link nell'elenco in base alle esigenze.

@
» Fare clic su per spostare un link selezionato di una posizione in alto
nell'elenco.
(-\J\_L-.
» Fareclicsu 4
basso nell'elenco.

per spostare un link selezionato di una posizione in

» Fareclicsu " quindi selezionare Sposta all'inizio dell'elenco per
spostare un link selezionato in cima all'elenco.

» Fareclicsu " e quindi selezionare Sposta alla fine dell'elenco per
spostare un link selezionato in fondo all'elenco.

Utilizzo di Contenuto web

Contenuto web fornisce link a materiali online sui siti web di Texas
Instruments. E possibile salvare sul proprio computer il materiale trovato in
questi siti e condividere elementi tramite Contenuto locale e Palmari collegati.

Le informazioni fornite per ciascuna attivita includono il nome dell'attivita,
l'autore, la data in cui & stata postata l'attivita, la dimensione del file e la fonte.
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Q|- swiectlar  ~ | Topican ~ | category /Al -
Name Author Date Posted = | Size Source
Forensics with Texas Instruments 4/1/13 934 KB Activities Exchange =
orel e - 4 936 KB A e ange =
orensics wit Texas Instruments 4113 834 KB Activities Exchange
e NASA - Diving Down ~ NASA and Tl 3126113 1585 KB Activities Exchange
Exploring Ellipses and  Texas Instruments 2/25113 1477 KB Activities Exchange
Exploring Hyperbolas ~ Texas Instruments: 2125113 1367 KB Activities Exchange
Exploring Parabolas Texas Instruments 24113 1065 KB Activities Exchange
The Radian Sector Texas Instruments 1124113 814 KB Activities Exchange
Blood Pressure Texas Instruments 1/9/13 820 KB Activities Exchange
3D Parametric Texas Instruments 1/8/13 1090 KB Activities Exchange
Health and Nutrition - Texas Instruments 12/4112 8594 KB Activities Exchange
Health and Nutrition - Texas Instruments: 1214112 363 KB Activities Exchange
Stay Tuned Lab Sound _Lauren Jensen 912 168 KB Activities Exchange =
‘ Forensics with TI-Nspire™™ - Case 2: Bouncing Back ‘ Save this Activity to Computer =
In this activity, students will be using the motion sensor as a sonar detector, o Files
through air to locate and identify a missing object in a box. [ Case_2_Bouncing_Back tns
[ Case_2_Bouncing_Back_Student.pdf
[ Case_2_Bouncing_Back_Teacher.pdf

@ |petais

Name: Forensics with T-Nspire ™ -
Author: Texas Instruments
Date Posted: 4/113

Size: 986 KB
Source: Activities Exchange
Activity Time: 45 Minutes I
Device: Ti-Nsbire™ Navioator™. TI-Ns. i

Barra degli strumenti di spostamento.
Titoli delle colonne.
Elenco delle attivita disponibili.

Elenco dei file contenuti nell'attivita.

00O

Dettagli sull'attivita selezionata.

Nota: € richiesto il collegamento a Internet per poter accedere ai siti web di
Texas Instruments.

Ordinamento dell'elenco delle attivita

Utilizzare i titoli delle colonne per ordinare le informazioni contenute
nell'elenco delle attivita. Per impostazione predefinita, lI'elenco € visualizzato in
ordine alfabetico in base al nome.

»  Fare clic sul titolo Nome per elencare le attivita in ordine alfabetico
inverso. Fare clic nuovamente sul titolo per ripristinare I'ordine alfabetico
daAaZz

+  Fare clic sul titolo Autore per elencare le attivita in ordine alfabetico in
base al nome dell'autore.

» Fare clic sul titolo Data di pubblicazione per elencare le attivita in ordine
cronologico, dalla piu recente alla meno recente o viceversa.
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Fare clic sul titolo Dimensione per ordinare le attivitd in base alla
dimensione del file.

Fare clic sul titolo Origine per elencare le attivita in base all'origine.

Tasto destro del mouse sull'intestazione della colonna per personalizzare
le intestazioni della colonna visualizzata.

Filtraggio dell'elenco delle attivita

Per impostazione predefinita, tutte le attivita sono elencate nel riquadro
Contenuto. Le opzioni della barra di navigazione consentono di filtrare le
attivita in base a soggetto, argomento e categoria. E anche possibile cercare
un'attivita utilizzando la ricerca per parola chiave.

Per trovare tutte le attivita collegate a un particolare soggetto:

1.
2.

Nel campo Soggetto, fare clic su w per aprire il menu a discesa.
Selezionare un soggetto.
Vengono visualizzate tutte le attivita collegate al soggetto selezionato.

Per restringere I'ambito della ricerca, fare clic su w nel campo Argomento
per visualizzare e selezionare un argomento collegato al soggetto
selezionato.

Utilizzare il campo Categoria per restringere ulteriormente la ricerca. Fare
clic su w per selezionare una categoria collegata al soggetto e
all'argomento selezionati.

Utilizzo di parole chiave per cercare un'attivita

Completare la seguente procedura per cercare un'attivita utilizzando una
parola chiave o una frase.

1.
2.

Digitare una parola chiave o una frase nel campo Filtra per parola chiave.
Premere Invio.

Vengono elencate tutte le attivita che contengono la parola chiave o la
frase.

Apertura di un'attivita

1.

2.

Selezionare I'attivita da aprire.

Fare clicsu “* e quindi selezionare Apri.
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Viene visualizzata la finestra di dialogo Apri attivita con un elenco di tutti i
documenti collegati all'attivita selezionata.

E possibile aprire un file .tns o .tsnp nel software TI-Nspire™. Altri file, quali
file di Microsoft® Word e di Adobe® PDF, vengono aperti nelle rispettive
applicazioni.

I Measuring Segments and Angles
: MeasuringSegmentsandAnagles.tns
IEIJ MeasuringSegmentsandanglesStudentFile.doc

'@ MeasuringSegmentsandanglesStudentFile. pdf
IEIJ MeasuringSegmentsandAnglesTeacherFile.doc
ﬁ.‘l MeasuringSegmentsandAnglesTeacherFile. pdf

3. Selezionare il file e fare clic su ), quindi selezionare Apri.
» lIfile .tns viene aperto nell'area di lavoro Documenti.

« llfile .doc o .pdf viene aperto nell'applicazione associata.

Salvataggio di un'attivita sul computer
Completare la seguente procedura per salvare un'attivita sul computer.

1. Selezionare I'attivita da salvare. | dettagli del file vengono visualizzati nella
meta inferiore della finestra.

| screaming for Ice Cream: Maximizing Volume of a Gone ([ save this Acivity to Gomputer—| ) *

A cone will be constructed from  circle of given radius. The objectis to cut a sector from the circle and forma | Files
right circular cone of maximum volume. The volume of the cone will depend upon the angle of the sector B EZsrEn e
removed and the radius of the original circle. These variables will be determined during the project The =
calculator document accompanies a project assignment and explains the construction of the cone and leads | L) ProjecticeGream doc
the student through the process of building a volume function (3 ProjecticeCream.pdf

Details
Name: Screaming for e
Author: Luajean Bryan
Date Pos... /30110
Size: 214 KB

Source: Actiifies Exchange
Activity T... 120 Minutes

Device: THNspire™ CAS, T-..
Grade Le.. 9-12
Subject ... Math:Calculus:Other. =

2. Fare clic su Salva questa attivita sul computer nel riquadro Anteprima, per
salvare i suddetti file.

Nota: € anche possibile fare clic con il tasto destro del mouse sull'attivita
selezionata e scegliere Salva su computer.
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Viene visualizzata la finestra di dialogo Salva file selezionati.
Evidenziare la cartella in cui si desidera salvare il file.
4. Fare clic su Salva.

L'attivita viene salvata sul computer come unita didattica.
Copia di un'attivita

Completare la seguente procedura per copiare un'attivita. Una volta copiata
I'attivita negli Appunti, & possibile incollarla in una cartella sul computer, quindi
trascinarla nell'elenco di collegamenti nel riquadro Contenuto locale.

1. Fare clic sull'attivita da copiare per selezionarla.
2. Utilizzare uno dei metodi seguenti per copiare |'attivita negli Appunti:
+ Selezionare I'attivita e trascinarla in una cartella nell'elenco
Contenuto locale.

. Fare clic su =, quindi fare clic su Copia.

»  Fare clic con il pulsante destro del mouse su un file nell'elenco File e
quindi selezionare Copia.

F‘_|
* Fareclicsu (Copia icona) nella barra degli strumenti.
L'attivita viene copiata negli Appunti.

3. Aprire una cartella sul computer, quindi fare clic su Modifica > Incolla per
copiare l'attivita nella cartella selezionata.

Invio di file a una classe

I file e le cartelle possono essere inviati all'intera classe, ai membri della classe
che sono connessi o0 a singoli studenti La sessione della classe deve essere
attiva per inviare i file.

Quando si invia un file a tutta la classe, tutti gli studenti correntemente collegati
riceveranno immediatamente il file. Gli studenti che non sono collegati lo
riceveranno non appena effettueranno il collegamento.

Note:

+ soloitipidifile di TI-Nspire™ (.tns) e PublishView™ (.tnsp) si aprono nel
software TI-Nspire™.
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»  Altri tipi di file (se supportati) come per esempio immagini, elaborazione di
testo, oppure file di foglio elettronico si aprono nell'applicazione che il
sistema operativo ha associato al tipo di file.

Invio di file dalle aree dilavoro Documenti o Contenuto
1. Selezionare il file da inviare alla classe.

. Dall'area di lavoro Contenuto, fare clic sul file nel riquadro Contenuto.

. Nell'area di lavoro Documenti, fare clic sul file in Esplora contenuto.

2. Fare clic su Invia alla classe % oppure fare clic su File >Invia a > Invia
alla classe.

Viene visualizzata la finestra di dialogo Seleziona studente/i.

Step 2 of 2 - Selectindividual{s)

Baker, Susan
@ Chopra, Laxmi
Garcia, Rafe
Huang, Shen
Kapur, Samir

Li, Song
Lopez, Maria

Individuals Moore, Jacob
Ortega, Carlos
simmons, Nadine
[Thompson, Olivia

Send to handheld folder: |Algebra | =~

] Logged in only

[ =Back Ii Finish i‘ [ Cancel l

3. Selezionare lo studente o gli studenti a cui inviare il file:

. Per inviare il file all'intera classe, fare clic su Classe (ﬂ Per inviare
il file solo ai membri della classe che sono attualmente connessi,
selezionare la casella Solo studenti connessi.

. Per inviare il file a un solo studente, fare clic su Studenti & e
quindi fare clic sullo studente interessato.

78 Utilizzo dell'area dilavoro Contenuto



Nota: se sono gia stati selezionati studenti nella scheda Classe, il
software ne mantiene la selezione.

+  Utilizzare I'elenco a discesa Invia a cartella del palmare per
selezionare dalla cartella della classe in corso, la cartella principale
sul palmare o le ultime 10 cartelle a cui sono stati inviati i file.
(Disponibile solo sul software TI-Nspire™ che supporta i palmari).

Fare clic su Fine.

Il trasferimento del file appare nel record della classe nell'area di lavoro
Classe.
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Operazioni con i Palmari Collegati

Il software TI-Nspire™ consente di visualizzare contenuto, gestire file e
installare gli aggiornamenti del sistema operativo sui palmari collegati al
computer.

Per utilizzare le funzioni descritte in questo capitolo, i palmari devono essere
accesi e collegati tramite uno dei mezzi seguenti:

+  TI-Nspire™ Docking Station o TI-Nspire™ CX Docking Station
+ Alloggiamento per TI-Nspire™ Navigator™ e punto d'accesso
*  Scheda di rete wireless TI-Nspire™ CX e punto d'accesso

»  Scheda di rete wireless TI-Nspire™ CX - v2 e punto d'accesso
*  Collegamento diretto tramite cavo USB standard

Nota: le attivita descritte in questa sezione possono essere eseguite solo con
palmari TI-Nspire™. Per abilitare la connettivita wireless, il TI-Nspire™
Navigator™ Teacher Software per palmari e il SO installato sui palmari TI-
Nspire™ devono essere della versione 3.9 o successiva.

Visualizzazione del Contenuto sui Palmari Collegati

Quando si seleziona un palmare nel riquadro Risorse nell'area di lavoro
Contenuto, tutti i file e le cartelle presenti sul palmare vengono visualizzati nel
riguadro Contenuto. Per visualizzare un'anteprima del documento, selezionare
Fare clic qui per visualizzare I'anteprima del documento nel riquadro
Anteprima.
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o Palmari collegati - Elenca tutti i palmari collegati e accesi

@® Opzioni - Le opzioni disponibili variano in base all'attivita selezionata
sotto Risorse.

©® Riquadro Contenuto - Quando si seleziona Palmari Collegati, nel
riquadro Contenuto vengono visualizzati i seguenti dettagli relativi ai
palmari collegati e accesi:

* Tipo Palmare: nomi dei palmari.
* ID prodotto: identificazione prodotto palmare.

* Boot 1: bootstrap interno che esegue operazioni di livello inferiore
per l'avvio del dispositivo.

* Boot2: bootstrap esterno che esegue operazioni di livello inferiore
per l'avvio del dispositivo.

*  Sistema Operativo: il sistema operativo in uso.

*  Spazio disponibile: quantita di spazio libero e disponibile sul
palmare.

«  Batteria (Li-ion): carica della batteria agli ioni di litio (ricaricabile)
(critica 2%, 25%, 50%, 75%, 100% o "--" per indicare che la batteria
non € presente).

. Batteria (AAA): carica della batteria AAA (critica 2%, 25%, 50%, 75%,
100% o "--" per indicare che la batteria non € presente).
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9 Riquadro Anteprima - Fornisce informazioni sul palmare quando si fa clic
su Palmari Collegati nel riquadro Risorse e selezionare un palmare nel
riquadro Contenuto. Se si seleziona un file TI-Nspire™ nel riquadro
Contenuto, il riquadro Anteprima mostra un'anteprima disponibile per
quel file.

Quando si seleziona un palmare, tutti i file e le cartelle presenti sul palmare
vengono visualizzate nel riquadro Contenuto. Quando si selezionano un file o
una cartella, i dettagli relativi vengono visualizzati nel riquadro Anteprima. Fare
clic sull'icona per visualizzare I'anteprima del documento.

Name Size
¥ £ Tth Period Geometry -
¥ £ Algebral
¥ 5 Algebral
5 Algebrall =
[ 00 Getting Started tns 9 KB
[ 01 Percentage Explorertns 12 KB
[ 02 Introducing Functions.ins 8 KB
[ 03 Linear Equations Explorer.ins 10 KB
[ 04 systems of Equations Explorerins 11KB
[ 05 Introducing Geomegtry tns 19 KB -

| dettagli relativi alla cartella o al file selezionato vengono mostrati nel riquadro
Anteprima.

7th Period Geometry 00 Getting started.tns.
(os | Detais

\ Name: 71 Period Geomery Wame: 00 Getng Staesins.
) Pathtia.. 7 Perod Geomety Saer 9k
Road ony:

7ihPerod Geometry

Dettagli della cartella selezionata Dettagli del file selezionato

» Pervisualizzare i file contenuti in una cartella, fare doppio clic sul nome
della cartella nel riquadro Contenuto. | file della cartella vengono elencati
nel riquadro Contenuto.

» Per visualizzare un'anteprima del contenuto di un file .tns, selezionare Fare
clic qui per visualizzare un'anteprima del documento nel riquadro
Anteprima.
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01 Percentage Explorer.tns

Details

Name: 01 Percentage Expl...
Size: 12 KB
19 jeans Read Only: Mo
res 38 %
A .
e S0 JOANS i

Gestione di file su un palmare collegato
Quando si lavora con i file dei palmari collegati nell'area di lavoro Contenuto,

utilizzare il menu Opzioni "™ o il menu contestuale per gestire i file.

Nota: se viene selezionato un tipo di file non supportato dal palmare, alcune
selezioni presenti nel menu Opzioni non sono attive.

Opzione Descrizione

Open (Apri) Apre un file su un palmare collegato:
»  Fare clic sul file da aprire.

»  Fare clic su Apri. Il documento viene aperto nell'area di
lavoro Documenti.

Salva nel Salva una copia del file selezionato sul computer:
computer »  Fare clic sul file da salvare.

»  Fare clic su Salva sul computer. Viene visualizzata la
finestra di dialogo Salva file selezionati.

. Evidenziare la cartella in cui si desidera salvare il file.

. Fare clic su Salva.

Copiallncolla  Crea una copia di un file:
»  Fare clic sul file da copiare.
»  Fare clic su Opzioni > Copia per copiare il file negli
Appunti.
. Per incollare il file in un'altra cartella, aprire la nuova
cartella e quindi selezionare Opzioni > Incolla.
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Opzione

Descrizione

Nota: Se non si seleziona una nuova posizione, il file
copiato viene inserito con un nuovo nome del tipo
"Copia di...".

Elimina

Elimina un file su un palmare collegato:
. Fare clic sul file da rimuovere.
*  Fare clic su Elimina.

»  Fare clic su Si nella finestra di dialogo Avvertenza che
appare. Fare clic su No per cancellare.

Aggiorna

Per aggiornare I'elenco dei file, fare clic su Opzioni >
Aggiorna.

Rinomina

Per rinominare un file su un palmare collegato:
*  Fare clic sul file da rinominare
«  Fare clic su Opzioni > Rinomina.

» Digitare il nuovo nome e premere Invio.

Su un livello

Sale di un livello nella gerarchia della cartella. Questa
opzione ¢ disponibile quando si seleziona un file in una
cartella

Nuova
cartella

Crea una nuova cartella:
. Fare clic su Nuova cartella.
+ Digitare un nome per la nuova cartella.

. Premere Invio.

Aprire Documenti su un palmare Collegato
Per aprire un documento su un palmare collegato nel software TI-Nspire™:

1. Accertarsi che il palmare sia collegato al computer.

2. Fareclicsu

" per aprire Esplora contenuto.

I nome del palmare collegato € elencato nel riquadro Palmari Collegati.

3. Fare doppio clic sul nome del palmare.

Le cartelle e i file presenti sul palmare vengono elencati.
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4. Selezionare il documento che si vuole aprire, quindi fare doppio clic sul
nome del file.

I documento viene aperto nell'area di lavoro Documenti.

Salvare File in Palmari Collegati

Quando si salva un file dal PC al palmare, i file vengono convertiti in
documenti TI-Nspire™ (file .tns). Per salvare un file dal pc a un palmare
collegato:

1. Accertarsi che il palmare sia collegato al computer.

2. Fareclicsu " per aprire Esplora contenuto.
Le cartelle e i file su pc sono elencati nel riquadro Contenuto.
Evidenziare la cartella o il file che si desidera salvare sul palmare.

4. Fare clic sul file per selezionarlo.

5. Trascinare il file a un palmare elencato nel riquadro Palmari collegati.
Il file & stato salvato nel palmare collegato.

Nota: per salvare il file in una cartella presente nel palmare, fare doppio
clic sul nome del palmare per visualizzare le cartelle e i file presenti su di
esso, e quindi trascinare il file nella cartella del palmare.

Se il file & gia presente sul palmare, viene visualizzata una finestra di
dialogo che chiede se si vuole sostituire il file. Fare clic su Sostituisci per
sovrascrivere il file esistente. Fare clic su No o Annulla per abbandonare il
salvataggio.

Invio di file a palmari

E possibile trasferire attivita, cartelle, unita didattiche e file supportati da un
computer ai palmari collegati, da un palmare collegato a un altro o da un
palmare collegato a tutti i palmari collegati.

E possibile trasferire i seguenti elementi:
+ cartelle
»  File supportati

tcc
.tco
tilb
inc
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Invio di un'attivita a un palmare collegato

Nell'area di lavoro Contenuto, & possibile inviare un'attivita dal link di
contenuto web ai palmari collegati.

1. Utilizzare il selettore dell'area di lavoro per selezionare I'area di lavoro
Contenuto.

2. Fare clic su Contenuto web nel riquadro Risorse.
Fare clic sull'attivita da inviare ai palmari collegati.

4. Utilizzare una delle opzioni seguenti per inviare il file ai palmari
selezionati:

+ Trascinare il file sull'etichetta Palmari selezionati per trasferire il file a
tutti i palmari collegati. Per trasferire il file su un dato palmare,
trascinare il file sul nome del palmare.

. Per trasferire il file utilizzando lo Strumento Trasferimento:

Nota:non ¢ possibile utilizzare lo Strumento Trasferimento per
trasferire file a palmari durante una sessione della classe.

=

- Nella barra degli strumenti, fare clic su e quindi selezionare
Invia a palmari collegati.

—Oppure—

- Fareclicsu *** e quindi selezionare Invia a palmari collegati.

Viene aperto lo Strumento Trasferimento.
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Setup | Status |

| Add to Transfer List | D Delete all folders and files before transfer
File Mame Destination Folder Size
5 Geometry Tools Matrices Re... £ Transfers-11-15-10 0k

Edit destination Folder:

| Start Transfer || Close |

Selezionare il file, e quindi fare clic su Avvia trasferimento.
I file e le cartelle selezionati vengono trasferiti ai palmari selezionati.

Una volta completato il trasferimento, chiudere lo Strumento
Trasferimento.

Invio difile a tutti i palmari collegati

E possibile inviare un file a tutti i palmari collegati quando una classe non & in
corso. Per trasferire file o cartelle da un palmare collegato o da un computer a
tutti i palmari collegati, completare la procedura seguente:

1.

utilizzare il selettore dell'area di lavoro per selezionare I'area di lavoro
Contenuto.

Selezionare i file o le cartelle da trasferire dal riquadro Risorse.

Nota: E possibile scegliere i file da Contenuto Computer, Contenuto web
oppure Palmari collegati.

Fare clicsu “* e quindi selezionare Invia a palmari collegati.

Viene visualizzata la finestra Strumento Trasferimento
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« Transfer Tool

Setup | status |

| Add to Transfer List | [£] Delete all folders and files before transfer

File Mame Destination Folder
2 aPDocumentins E4 Transfers-10-27-10

Edit destination Folder:

Start Transfer || Close |

4. Fare clic su Avvia trasferimento.

Nota: per aggiungere altri file all'elenco di trasferimento, fare clic su
Aggiungi all'elenco di trasferimento.

| file e le cartelle selezionati vengono trasferiti ai palmari collegati. Per
impostazione predefinita, i file vengono trasferiti ad una cartella sul
palmare chiamata Trasferimenti-m-g-aa

Trasferimento di File tra Palmari

Se ci sono piu palmari collegati, € possibile inviare una cartella o un file da un
palmare a un altro presente nell'elenco Palmari collegati nel riquadro Risorse.

1. Utilizzare il selettore dell'area di lavoro per selezionare I'area di lavoro
Contenuto.

2. Nelriquadro Risorse, fare clic sul palmare che contiene i file da trasferire. |
file sul palmare sono elencati nel riquadro Contenuto.

3. Fare clic sulla cartella o file da inviare.
4. Trascinare il file a un altro palmare nell'elenco Palmari collegati.

Nota: E anche possibile copiare e incollare un file da un palmare in un altro.
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Verificadella disponibilita di un aggiornamento del sistema
operativo
Quando i palmari sono collegati, € possibile verificare la disponibilita di

aggiornamenti del sistema operativo dall'area di lavoro Contenuto o dall'area
di lavoro Documenti.

Nota: il computer deve essere collegato a Internet.

1. Mostrare tutti i palmari collegati.

. Nell'area di lavoro Contenuto, fare clic su Palmari collegati nel
riquadro Risorse.

* Nell'area di lavoro Documenti, aprire Esplora contenuto e fare clic su
Palmari collegati.

2. Fare clic sul palmare da verificare e quindi selezionare Guida > Controlla

aggiornamento SO del palmare/alloggiamento Lab.

+ Se il sistema operativo & aggiornato, si apre la finestra di dialogo
Controlla aggiornamento SO del palmare che specifica che il sistema
operativo del palmare € aggiornato.

Check for OS Update i

0 Your T-Nspire CX operating system is up to date.

W 4

+ Se il sistema operativo non & aggiornato, il software TI-Nspire™
chiede di installare il sistema operativo piu recente, con la possibilita
di scaricarlo sul computer.
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Check for 05 Update

===

i3 Texas

Anewer version of the 08 (3.6.0.262) is available.
You are currently running 3.6.0.207.

Continue || Close |

L

3. Perdisattivare le notifiche automatiche, deselezionare la casella di
controllo Controlla automaticamente gli aggiornamenti.

Fare clic su OK per chiudere la finestra di dialogo oppure selezionare

Continua e seguire i suggerimenti per installare il sistema operativo sul

palmare.

Installazione di un aggiornamento del SO

Quando i palmari sono collegati, € possibile installare gli aggiornamenti del
sistema operativo dall'area di lavoro Contenuto o dall'area di lavoro

Documenti.

Nota: I'aggiornamento del sistema operativo non sostituisce né rimuove

documenti.

Accertarsi di aver scaricato il file del sistema operativo piu recente. Visitare il
sito education.ti.com/latest per scaricare i file del sistema operativo piu

aggiornato.

Aggiornamento del SO su un singolo palmare

1. Mostrare tutti i palmari collegati.

. Nell'area di lavoro Contenuto, fare clic su Palmari collegati nel

riquadro Risorse.
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* Nell'area di lavoro Documenti, aprire Esplora contenuto e fare clic su
Palmari collegati.

2. Fare clic sul palmare da aggiornare e quindi chiudere I'opzione di
installazione.

. Nell'area di lavoro Contenuto, fare clic con il pulsante destro del
mouse sul palmare e quindi selezionare Installa SO su
palmare/alloggiamento Lab.

+  Nell'area di lavoro Documenti, fare clicsu “* e quindi selezionare
Installa SO su palmare/alloggiamento Lab.

Viene visualizzata la finestra Seleziona file SO palmare.

Select Handheld OS5 File

LookIn: () Downloads

o4
) New Lesson Bundle.tilb
=h TI-Mspire tco

File Name:

Files of Type: |Handheld OS5 File

| instanos | | cancel |

3. Evidenziare sul computer la cartella in cui si trova il file del sistema
operativo.

Nota: il software TI-Nspire™ mostra automaticamente il tipo di SO per il
palmare selezionato.

4. Fare clic su Installa SO.
Fare clic su Si per confermare che si desidera continuare I'aggiornamento.

6. Attendere il download del software sul palmare selezionato e quindi
seguire i messaggi per terminare I'aggiornamento del SO.
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Per aggiornare il SO su piu palmari

1. Nell'area di lavoro Contenuto, fare clic su Contenuto Computer nel
riquadro Risorse.

2. Fare clic suStrumenti >Installa SO su palmare/alloggiamento Lab.

Viene visualizzata la finestra Seleziona file SO palmare.

Select Handheld OS File

Please select a handheld/lab cradle.
Install OS for all connected handhelds/lab cradles.

MName 05 Version
() [& TI-Mspire CX CAS CE1E tcc3.2.0.634
too 3.2.0.634
no3.2.0634

Continue || Cancel

3. Fare clic su Installa il SO per tutti i palmari/alloggiamenti lab collegati.

Nota: E possibile aggiornare un solo SO cliccando il pulsante di scelta
vicino al nome del palmare, cliccare quindi su Continua.

Viene visualizzata la finestra d'installazione del SO.
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05 Instalfation

Setup | Status
Add OS5 file. Remaove 5 =d | [] Delete all files and folders before transfer

File Name Destination Folder

Edit Destination Folder: | T

4. Fare clic su Aggiungi File SO.

Viene visualizzata la finestra di dialogo Aggiungi a Lista Trasferimento.
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Add to Transfer List

Files | Folders

Look In: . Downloads

] TI-Mspire tcc
< TI-Mspire.tco
J THNspire.tmo
< THNspire tno

File Name:

Files of Type: |THNspire™ Family Handnelds

|-~ caneel|

5. Evidenziare sul computer la cartella in cui si trova il file del sistema
operativo.

6. Selezionare i file del SO opportuni.
»  Peraggiornare un palmare TI-Nspire™ CX, selezionare TI-Nspire.tco.

* Peraggiornare un palmare TI-Nspire™ CX CAS, selezionare
TI-Nspire.tcc.

+ Peraggiornare un palmare TI-Nspire™ , selezionare TI-Nspire.tno.

»  Peraggiornare un palmare TI-Nspire™ CAS, selezionare
TI-Nspire.tnc.

7. Fare clic su Seleziona.
L'Installazione del SO rivisualizza i file del SO selezionati.
8. Fareclic su Installa SO.

Le informazioni sugli aggiornamenti del SO, e la finestra di dialogo
Seleziona File SO sul palmare vengono rivisualizzate per ulteriori
selezioni.

Rinomina Palmari

E possibile rinominare i palmari dall'area di lavoro Contenuto.
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Nota: la ridenominazione di un palmare non influisce sulle informazioni di
connessione degli studenti.

1. Fare clic con il pulsante destro del mouse sul nome del palmare nel
riguadro Contenuto.

2. Fare clic su Rinomina.
Digitare il nuovo nome.

4. Premere Invio per andare al nome successivo da modificare.

Resources

v
&8 Desktop
E5 My Documents
Links
v

@ Activities Exchange
|5} Connected Handhelds
[ Stanley's Handheld

54 Karen's Handheld

5. Peruscire dalla modalita di modifica, fare clic su un'area dello schermo
esterna ai nomi dei palmari. In alternativa, si esce dalla modalita di
modifica dopo aver premuto Invio sull'ultimo nome modificato.

Utilizzo di Identifica selezionato per individuare palmari

Se si stanno utilizzando TI-Nspire™ Docking Station o TI-Nspire™ CX Docking
Station, € possibile utilizzare questa funzione per individuare palmari.

1. Accertarsi che i palmari siano accesi e che la docking station sia collegata
al computer.

2. Utilizzare il selettore dell'area di lavoro per selezionare I'area di lavoro
Contenuto.

3. Fare clic su Strumenti > Identifica palmare/alloggiamento Lab selezionato
oppure fare clic con il pulsante destro del mouse sul riquadro Contenuto.
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Entrambi i LED sulla docking station sotto I'alloggiamento del palmare
lampeggeranno per 30 secondi.
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Utilizzo dell'area di lavoro Classe

Utilizzare quest'area di lavoro per aggiungere e gestire classi e studenti e per
scambiare file con gli studenti.

Fie Edit View ndow  Help

Content Documents Review Portfolio

&u-s BLB XD 888

Action | File Name Status.

(2]

= 2clents comected | & 2 of 11 Students logged in

© Registrazione della classe. Mostra le azioni relative ai documenti. E
possibile aprire un documento nell'Area di lavoro Revisione; salvare un
documento nell'Area di lavoro Portfolio; raccogliere file dall'Area di lavoro
Registrazione della classe; inviare ed eliminare file usando la barra degli
strumenti e visualizzare le proprieta del documento in Registra proprieta
elemento.

@ Area Classe. Mostra gli studenti della classe, quelli che sono collegati e lo
stato del trasferimento dei file selezionati nella Registrazione della
Classe. E possibile visualizzare gli studenti in base alla vista Disposizione
Studenti o alla vista Elenco studenti.

© Vista Studente. Consente di mostrare gli studenti nell'area Classe in base
alla vista Disposizione studenti o alla vista Elenco studenti.

Aggiunta di classi

Quando si inizia a usare il software TI-Nspire™, occorre per prima cosa creare
le classi. Accertarsi di creare una classe per ciascuno dei periodi di
insegnamento previsti.
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Se si sta compiendo questa operazione per la prima volta con il software
TI-Nspire™, I'area classe pu0 essere vuota. Completare la procedura seguente
ogni volta.

La Procedura Guidata Aggiunta di classi conduce l'utente attraverso il
processo di impostazione delle classi. Il software chiede di aggiungere una
classe e di aggiungervi gli studenti. E' possibile scegliere di aggiungere le
classi manualmente o usando un file CSV.

Aggiunta di classi manuale

1. Utilizzare il selettore dell'area di lavoro per selezionare I'Area di lavoro
Classe.

=yt

2. Fare clic su Classe > Aggiunta di classi o su F’)’
Viene visualizzata la finestra di dialogo Aggiunta di classi.

Add Classes -

Create classes to save student files and assesment results and track
student performance.

There are two ways to create classes:

& Manually
" Mame your classes and manually add students to each class

~ Upload a CSV file
" Upload a comma-delimited file to create your classes

|-Next| |- cancer|

Selezionare Manualmente dalla finestra di dialogo Aggiunta di classi.
4. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Aggiunta di classi manuale.
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Add Classes Manually 7. -

Create Class(es)

To create class(es), simple type the class name and click Add. When you're
finished, click Mext to add students to your class(es).

Tip: Use names that are easily identifiable in a list.

Class Name

Section(optional) |

| Back |

Digitare il Nome della Classe. Se necessario, & possibile inserire una
Sezione.

Un nome della classe deve avere una lunghezza compresa tra 3 e 32
caratteri. Il nome della classe non puo contenere i caratteri speciali /\: " | *
? <>, e non pud contenere queste parole:

Ipt1, Ipt2, Ipt3, Ipt4, Ipt5, Ipt6, Ipt7, Ipt8, Ipt9, com1, com2, com3, com4,
com5, com6, com7, com8, com9, aux, con, prn, nul.

Nota: nel TI-Nspire™ Navigator™ NC Teacher Software, & opportuno
aggiungere al nome della classe un unico identificatore come ad esempio
I'ID del corso o il nome dell'insegnante. Questo consente allo studente di
selezionare la classe corretta in caso, per esempio, di piu classi di
Algebra lin corso.

Fare clic su Aggiungi.

La finestra di dialogo Aggiunta di classi manuale mostra le classi elencate.
Continuare ad aggiungere classi e, al termine, fare clic su Avanti.

Una finestra di dialogo mostra la corretta creazione della classe e chiede
se si vuole aggiungere studenti.
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8.

Add Classes Manually 7. -

Your class(es) have been succesfully created.
Find them listed in the class drop down menu.

Ready to add students to your class(es)?
You can assign a student to multiple classes by using the Assign Classes button. Once
you're done, click Finish

Ifyou select Finish atthis time, you can always add students to your class(es) later by

selecting the Add Student to Current Class icon in the menu bar or by selecting Add
Studentin the Class menu.

|- Back| Add Student

Fare clic su Aggiungi studente.

Nota: fare clic su Fine per Aggiungere Studenti successivamente.

Aggiunta di classi caricando un file CSV

E possibile aggiungere classi caricando un file CSV e importare un elenco di
studenti nella classe. Usare I'opzione carica file CSV per importare le
informazioni degli studenti da un file con valori separati da virgola (CSV) o da
un file di testo (.txt).

Il file CSV o .txt deve includere queste informazioni:

Nome della classe

Nome della sezione (facoltativo)
Nome dello studente

Cognome dello studente

Nome utente dello studente

ID dello studente (facoltativo)
Password (facoltativa).

Utilizzare il selettore dell'area di lavoro per selezionare I'Area di lavoro
Classe.

Fare clic su Classe > Aggiunta di classi o su € —%

Viene visualizzata la finestra di dialogo Aggiunta di classi.
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Add Classes x

Create classes to save student files and assesment results and track
student performance.

There are two ways to create classes:

~ Manually
"~ Name your classes and manually add students to each class.

@ Upload a CSV file
"~ Upload a comma-delimited file to create your classes.

| Next || Cancel |

Selezionare Carica un file CSV dalla finestra di dialogo Aggiunta di classi
4. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Aggiunta di classi caricando un
File CSV

Add Classes by Uplniding aCSVFile

Upload a CSV file from your computer

Uploading a comma-delimited file automatically creates your classes and assigns your
students to the correct class. This file can contain student rosters for multiple classes

Be sure your file contains the following categories or headers: Class Mame, Section Name
(optional), Student First Name, Student Last Name, Student User Name, Student D
(optional), and Password (optional).

[ | | Browse

Back|

|--cancei-|

5. Fare clic su Sfoglia per individuare il file sul computer.
6. Selezionare il file contenente gli studenti da importare.

7. Fare clic su Apri.
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Il file viene visualizzato nella finestra di dialogo Aggiunta di classi
caricando un File CSV.

8. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Campi di mappatura.

'Add Classes by Uploading a CSV File

Mapping fields
Mavigator fields Imported file fields
Class Name®  |ClassName ~ |
SectionName  |Blank -
FirstName®  [FirstName - |
Last Name* ILast Name >
User Name* !UserName -|
StudentD  |Studentin
Password  |Blank ~|
|- Back Cancei|

9. Fare clic su w e selezionare un campo dal menu a discesa per mappare i
titoli nel file con valori separati da virgola.

10. Fare clic su Avanti.

Viene visualizzata una finestra di dialogo che mostra lo stato di
avanzamento.
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11.

Add Cl'aﬂsses Manually

Your class(es) and student profiles have been successfully created.
Find them listed in the class drop-down menu.

Once you begin class, you can transfer files to your students and use features like
Quick Poll, Live Presenter, and Capture Class.

ok |

Fare clic su OK per chiudere.

Nota: se alcuni studenti non sono stati correttamente importati, fare clic su
Mostra dettagli per determinare il problema.

Aggiunta di studenti alle classi

Dopo aver creato le classi, & necessario aggiungervi gli studenti. E possibile
aggiungere studenti a una sessione della classe attiva oppure a qualsiasi
classe in qualsiasi momento.

Nota: le istruzioni seguenti spiegano come aggiungere studenti dopo aver
creato una classe.

1.

Selezionare la classe a cui aggiungere gli studenti.

+ Se ¢ attiva una sessione della classe, lo studente verra aggiunto alla
classe corrente. E comunque possibile aggiungere lo studente ad
altre classi.

. Se non é attiva alcuna sessione della classe, utilizzare i comandi di
Sessione della classe per selezionare la classe a cui aggiungere lo
studente.

File Edit View Tools Window Help

=
Content Documents Review Portfolio

Fare clic su Classe > Aggiungi studente oppure fare clic su %
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Viene visualizzata la finestra di dialogo Aggiungi studente.

Add Student X

First Name: | |

Last Name: |
User Name:

Password:  (® Student Chooses Q | |

Display Name: [ |

StudentID: | '

Classes: Algebral | Agsign Classes |

|- Add Next Student | | Finish I Cancel |

Digitare il nome e il cognome dello studente.
Digitare un nome utente.

Nota: il nome utente scelto deve essere univoco. Non puo esistere nella
classe corrente né in qualsiasi altra classe.

5. Se sidesidera che lo studente crei la propria password, selezionare
Sceglie lo studente.

—oppure—

Se si desidera creare una password per lo studente, selezionare la
casella vuota della password e digitarvene una nuova.

6. (Facoltativo) Digitare un Nome visualizzato.

Nota: se non si inserisce un nickname, il software utilizza in sua vece il
nome dello studente.

7. (Facoltativo) Digitare un ID studente.
8. (Facoltativo) Assegnare lo studente ad altre classi:
»  Fare clic su Assegna classi.

Viene visualizzata la finestra di dialogo Assegna classi.
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Assign Classes: x |

Modify class membership through the checkboxes below:

[] Concepts of Math
[v] Algebra |
[] Algebra
[] Geometry
[C] statistics

OK || Cancel

L —————— ]
. Selezionare le caselle di controllo accanto alle classi dello studente.

+ Deselezionare le caselle di controllo delle classi di cui non fa parte lo
studente.

» Fareclicsu OK.
Viene visualizzata la finestra di dialogo Aggiungi studente.

9. Peraggiungere un altro studente, fare clic su Aggiungi studente
successivo e ripetere i passaggi da 3 a 8.

10. Dopo aver aggiunto tutti gli studenti, fare clic su Fine.

Rimozione di studenti dalle classi

Se necessario, € possibile rimuovere gli studenti dalle classi. In questo caso, il
software TI-Nspire™ rimuove gli studenti solo dalla classe selezionata. Se gli
studenti sono presenti anche in altre classi, continueranno ad essere presenti
solo in quelle classi.

Note:

* Non é possibile rimuovere studenti che sono collegati alla rete TI-Nspire™
Navigator™.

* Non é possibile annullare la rimozione di studenti.
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«  E possibile accedere alle voci degli account degli studenti facendo clic
con il pulsante destro del mouse sull'icona dello studente nell'area Classe
e scegliendo un'opzione dal menu che appare.

Per rimuovere uno studente da una classe:

1. Fare clic sullo studente da rimuovere.

2. Fare clic su Classe > Rimuovi Studente oppure su ?9)
Viene chiesto di confermare I'operazione di rimozione.
3. Fareclicsu Si.

Il software rimuove lo studente.

Aggiornamento Registri classe

E possibile aggiornare un registro classe singolo o piu registri classe con le
nuove informazioni sullo studente importando un file CSV contenente gli
aggiornamenti.

Nota: non & possibile cambiare le informazioni sugli studenti esistenti o
rimuovere gli studenti gia presenti nel database del TI-Nspire™ Navigator™.
E possibile importare un file con valori separati da virgola (CSV) o *.ixt. Il file
CSV o .ixt deve includere queste informazioni:

Nome della classe

Nome della sezione (facoltativo)
Nome dello studente

Cognome dello studente

Nome utente dello studente

ID dello studente (facoltativo)
Password (facoltativa).

1. Utilizzare il selettore dell'area di lavoro per selezionare I'Area di lavoro
Classe.

2. Selezionare la classe per la quale si vuole aggiornare il registro.
Nota: Impossibile avviare la classe.
3. Fare clic su Classe>Aggiorna Registro Classe.

Viene visualizzata la finestra di dialogo Aggiorna Registro Classe.
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Update Class Roster |

Upload a CSV file from your computer

Update a CSV file to update the roster for one or more classes. New students will be added.
Students wha drop your class must be manually deleted. Existing students will not be affected

[ Browse...

| Next H Cancel |

Fare clic su Sfoglia per individuare il file sul computer.

Selezionare il file contenente i nuovi studenti che si vogliono importare.
Fare clic su Apri.

Il file viene visualizzato nella finestra di dialogo Aggiorna Registro Classe.
Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Campi di mappatura.

Update Class Roster |

Mapping fields
Mavigator fields Imported file fields
Class Mame* ‘Ellank -
Section Name ‘Ellank -
First Name* ‘Ellank ~|
LastName* | Blank -
UserName* |Blank -
StudentlD  Blank -
Password | Blank -
| Back | | Cancel |

Fare clic su w e selezionare un campo dal menu a discesa per mappare i
titoli nel file con valori separati da virgola.
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9. Fare clic su Avanti.

Viene visualizzata una finestra di dialogo che mostra lo stato di
avanzamento.

Upd al.é.class Roster

Your class(es) and student profiles have been successfully created.
Find them listed in the class drop-down menu.

Once you begin class, you can transfer files to your students and use features like
Quick Poll, Live Presenter, and Capture Class.

ok ]

10. Fare clic su OK per chiudere.

Nota: se alcuni studenti non sono stati correttamente importati, fare clic su
Mostra dettagli per determinare il problema.

Gestione delle classi

Non & possibile cancellare classi e rimuovere tutte le informazioni della classe
dal database del TI-Nspire™ Navigator™. E possibile scegliere di nascondere o
mostrare le classi in tutti i menu e viste.

Rimozione di una classe

Quando si rimuove una classe, si rimuove la classe dal software e si
rimuovono i file a essa corrispondente dal disco rigido.

Nota: non € possibile annullare la rimozione di una classe
1. Se c'é una sessione in corso, terminarla
2. Fare clic su Classe > Gestisci Classi.

Viene visualizzata la finestra di dialogo Gestisci Classi.
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Manage Classes

Select Classes

Class

Created

Show

Hide

[-] Algebra 101 - MGentry
[=] Trigonometry - MGentry
[] Geometry - MGentry

] calculus - MGentry
[*] Algebra | - MGentry
["] Algebra Il - MGentry

11211 10:41 AM
11211 1226 PM
11211 1232 PM
11211 1238 PM
1211 1:41 PM
111211 2:08 PM

v
v

Actions:

Dall'elenco Classe, selezionare la classe da rimuovere.

Selezionare Elimina dalla lista delle Azioni.

Fare clic su Applica.

Il software chiede di confermare l'operazione di rimozione.

6. Fareclic su OK.

Nascondere una classe

Quando si nasconde una classe, la classe viene rimossa da tutte le viste
dell'area di lavoro e dai menu, tranne dalla finestra di dialogo Gestisci Classi.

Nota: le classi nascoste non vengono cancellate dal database del TI-Nspire™

Navigator™.

1. Fare clic su Classe > Gestisci Classi.

Viene visualizzata la finestra di dialogo Gestisci Classi.
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Manage Classes

Select Classes

Class Created Show | Hide
[*] Algebra 101 - MGentry 112/11 10:41 AM v
D Trigonometry - MGentry 11211 1226 PM v
[] Geometry - MGentry 11211 1:32 PM

D Calculus - MGentry 11211 1238 PM
[*] Algebra | - MGentry 111211 1:41 PM
["] Algebra Il - MGentry 1112111 2:08 PM

Actions:

Dall'elenco Classe, selezionare la classe da nascondere.
Selezionare Nascondi dalla lista delle Azioni.

Fare clic su Applica.

Il software chiede se si € sicuri di voler nascondere la classe.
Fare clic su OK.

Nota: Selezionare Mostra dall'elenco delle Azioni quando si vuole
visualizzare nuovamente la classe.

Inizio e fine di una sessione della classe

Una sessione della classe ¢ il periodo durante il quale il software TI-Nspire™ &
attivo per una data classe. Mentre la sessione € in corso, I'insegnante puo
utilizzare le funzioni di comunicazione con la classe selezionata. Non &
possibile utilizzare il software per interagire con la classe fino a quando non si
inizia una sessione della classe; inoltre non € possibile iniziare un'altra classe
fino a quando non si termina quella corrente.

Inizio di una sessione della classe

1.

Fare clic su Classe > Seleziona classe, oppure fare clic sull'elenco
Sessione della classe.

Viene aperto un elenco delle classi disponibili.
Selezionare la classe da avviare.

Fare clic su Inizio classe.
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File Edit View Tools 55 Window Help

-
Content Documents  Review Portfolio

Fine diuna sessione della classe

Quando una classe (lezione) & terminata, oppure prima di iniziarne un'altra, &
necessario terminare la sessione della classe corrente. Cid comporta
l'interruzione di tutte le comunicazioni tra il computer dell'insegnante e i
palmari o i computer degli studenti. Gli studenti riceveranno un messaggio di
notifica dell'interruzione della classe e verranno automaticamente disconnessi.

» Perterminare una sessione della classe corrente, selezionare Termina
Classe dall'elenco a discesa Azioni classe.

Sospensione di una sessione della classe

Questa funzione & disponibile solo sul software TI-Nspire™ che supporta i
palmari. E possibile sospendere temporaneamente una classe. Se si sta
usando il software TI-Nspire™ che supporta i palmari, sospendere una classe
comporta la sospensione di tutte le attivita sui palmari degli studenti che
riceveranno un messaggio di notifica della sospensione. Alla ripresa della
classe, il messaggio verra cancellato e gli studenti saranno di nuovo in grado
di utilizzare i loro palmari. Gli studenti imangono collegati anche quando la
classe € sospesa.

1. Persospendere temporaneamente una classe, fare clic su Pausa Classe.

2. Perriprendere la classe, fare clic su Ripresa Classe.

Modifica della vista Studenti

Nell'area Classe € possibile visualizzare gli studenti della classe selezionata
nella vista Elenco studenti o Disposizione studenti. La vista Elenco studenti
mostra gli studenti in una tabella contenente nickname, nome, cognome, nome
utente e ID degli studenti. La vista Disposizione studenti mostra gli studenti
come icone con relativi nickname. E possibile cambiare la vista della classe in
qualsiasi momento.

In entrambe le viste, il simbolo di avviso accanto all'icona di uno studente
indica che il SO sul palmare dello studente non corrisponde alla versione del
software sul computer dell'insegnante. Quando si sposta il mouse sul simbolo
di avviso, si apre una descrizione comando che indica che € necessario

un aggiornamento del SO.
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Modifica della Vista della classe in Elenco studenti

» Fare clic su Visualizza > Elenco Studenti oppure fare clic su nella
barra di stato.

La vista della classe cambia in Elenco studenti.

Picture Display Name First Name: Last Name User Name Student ID

Olivia Oiivia Thompson 101

a Waria WMaria Lopez 102 2

8 Samir samir Kapur 103 3
Jacob Jacob Mocre 04

105 5

06 6

107 7

201 9

202

203

Modifica della vista della classe in Disposizione studenti

» Fare clic su Visualizza > Disposizione studenti oppure fare clic su
nella barra di stato.

La vista della classe cambia in Disposizione studenti.

3 &

Thomps... Lopez, M.. Kapur, S

Garcia, R... Ortega Moore, J... Huang, S

3 8

mimon... Chopra, ... Baker, 5 Li, Song

w0
3
s}

Organizzazione della disposizione studenti

Inizialmente, gli studenti sono mostrati nella vista Disposizione studenti
nell'ordine in cui sono stati aggiunti. E comunque possibile ridisporre gli
studenti in modo che abbiano nell'area di lavoro classe la stessa posizione
che occupano nell'aula. La Disposizione studenti pu6 essere modificata in
qualsiasi momento.
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Organizzazione della disposizione studenti
1. Selezionare la classe dall'elenco Sessione dalla classe.
2. Fare clic su Visualizza > Disposizione studenti.

Viene mostrata I'area Classe con la vista Disposizione studenti attiva per
la classe corrente.

3. Nell'area Classe, trascinare l'icona di ogni studente nella posizione
desiderata.

Il software sposta le icone degli studenti nelle nuove posizioni.

Queste posizioni vengono mantenute anche al successivo riavvio della
classe.

Nota: non posizionare l'icona di uno studente sopra l'icona di un altro
studente onde evitare di vedere solo una delle due icone.

Verifica dello stato di accesso degli studenti

E possibile visualizzare lo stato di accesso degli studenti dalla vista
Disposizione studenti. Il colore dellicona accanto al Nome visualizzato dello
studente ne indica lo stato di accesso e segnala anche lo stato della classe:

Icona | Stato della Stato dello studente Colore
classe

Sessione della | N/D Grigio
classe non
cominciata.

Sessione della | Studente non connesso. Azzurro
classe
cominciata.

Sessione della | Studente connesso. Blu
classe
cominciata.

Ge

[ Sessione della | Il SO dello studente non corrisponde | Blu
classe alla versione del software sul
cominciata. computer dellinsegnante.
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Ordinamento delle informazioni sugli studenti

La vista Elenco studenti dell'area Classe mostra le informazioni relative agli
studenti della classe selezionata, vale a dire Nome visualizzato, nome,
cognome, nome utente e ID degli studenti. In questa vista & possibile ordinare
le informazioni sugli studenti in base a ciascuna di queste categorie. Le
informazioni sono ordinate alfabeticamente dalla A allaZo dallaZallaAe
numericamente da 1-9 o da 9-1. E possibile ordinare le informazioni sugli
studenti in qualsiasi momento.

Ordinamento delle informazioni sugli studenti

1. Fareclic su Classe > Seleziona classe e selezionare la classe contenente
le informazioni da ordinare.

Nota: Se C'€ una sessione in corso, terminarla per poter selezionare la
classe.

2. Nel menu, fare clic su Visualizza > Elenco Studenti.
3. Fare clic sull'intestazione di colonna in base alla quale ordinare I'elenco.
L'elenco selezionato viene ordinato.

4. Perordinare le informazioni selezionate in senso opposto, fare
nuovamente clic sull'intestazione di colonna.

Modifica delle classi (lezioni) assegnate a uno studente

A volte gli studenti possono spostarsi in un‘altra classe oppure possono
partecipare a piu classi diverse. E possibile modificare le classi degli studenti
se necessario.

Nota: non & possibile cambiare le classi di studenti che sono connessi alla rete
TI-Nspire™ Navigator™.

Modifica della classe di uno studente

1. Selezionare una classe a cui appartiene lo studente.

2. Fare clic sullo studente da modificare.

3. Fare clic su Classe > Modifica studente oppure fare clic (%’

Viene visualizzata la finestra di dialogo Proprieta studente.
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Student Properties x|

First Name: |Jacoh| |

LastName: |Moore ]

User Name: |104
Passwaord: Reset

Display Mame: 'Jacob Moore ]

StudentID: [4 |

Classes: Algebral Assign Classes

Fare clic su Assegna classi.

Viene visualizzata la finestra di dialogo Assegna classi.

Assign Classes: X

Modify class membership through the checkboxes below:

[] Concepts of Math
[«] Algebral
[ Algebra 1

[C] Geometry
[] statistics

[ 0K ” Cancel

Selezionare le caselle di controllo accanto alle classi dello studente.
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7.
8.

Deselezionare le caselle di controllo delle classi di cui non fa parte lo
studente.

Fare clic su OK.

Nella finestra di dialogo Proprieta studente, fare clic su OK.

Modifica dei nomi e degli identificatori degli studenti

Una volta aggiunti gli studenti, pud accadere di doverne modificare i nomi o gli
identificatori. Ci sono cinque nomi e identificatori diversi associati agli studenti:

Nome

Cognome

Nome utente
Nome visualizzato

ID studente

Questo capitolo descrive come modificare questi tipi di nomi e identificatori.

Nota: non & possibile cambiare le informazioni degli account degli studenti che
sono connessi alla rete TI-Nspire™ Navigator™.

Nota: & possibile accedere a molte informazioni degli account degli studenti
facendo clic con il pulsante destro del mouse sullo studente e scegliendo
un'opzione dal menu che appare.

Modifica dei nomi e degli identificatori degli studenti

1.

Selezionare una classe a cui appartiene lo studente.

Nota: S€ C'€ una sessione in corso, terminarla per poter selezionare la
classe.

Fare clic sullo studente da modificare.

Fare clic su Classe > Modifica studente oppure fare clic (%’
Viene visualizzata la finestra di dialogo Proprieta studente.
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Student Properties x|

First Name: |Jacoh|

LastName: |Moore
User Name: |104

Passwaord: Reset

Display Mame: 'Jacob Moore

Student ID: |4
Classes: Algebral | Assign Classes |

| OK || Cancel |

4. Fare clic sul campo del nome o identificatore da modificare.
Apportare le modifiche necessarie.

6. Ripetereipassaggi 4 e 5 per qualsiasi altro nome o identificatore da
modificare.

7. Fare clic su OK.

Spostamento di uno studente in un‘altra classe

Se uno o piu studenti passano a una classe diversa, tale passaggio puo
essere replicato anche nel software TI-Nspire™.

Nota: non & possibile spostare studenti che sono connessi alla rete TI-Nspire™
Navigator™.

Nota: & possibile accedere a molte informazioni degli account degli studenti
facendo clic con il pulsante destro del mouse sullo studente e scegliendo
un'opzione dal menu che appare.

Spostamento di uno studente in un'altra classe
1. Selezionare una classe a cui appartiene lo studente.

Nota: S€ C'€ una sessione in corso, terminarla per poter spostare lo
studente.

2. Fare clic sullo studente da spostare.
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Fare clic su Modifica > Taglia oppure fare clic %

Il software rimuove lo studente dalla classe e sposta negli Appunti le
informazioni del relativo account studente.

Dall'elenco a discesa Sessione della classe, selezionare la classe in cui
spostare lo studente.

Fare clic su Modifica > Incolla oppure fare clic su E .

Il software sposta lo studente nella classe selezionata.

Copia di studenti in un'altra classe

Quando alcuni studenti sono presenti in piu classi, puo essere utile copiarli da
una classe a un'altra. Questo metodo consente di risparmiare tempo in quanto
non occorre ripetere l'inserimento delle informazioni.

Nota: non & possibile copiare studenti che sono connessi alla rete TI-Nspire™
Navigator™.

Nota: € possibile accedere a molte informazioni degli account degli studenti
facendo clic con il pulsante destro del mouse sullo studente e scegliendo
un'opzione dal menu che appare.

Copia di uno studente in un'altra classe

1.

Selezionare una classe a cui appartiene lo studente.

Nota: S€ C'€ una sessione in corso, terminarla per poter selezionare la
classe.

Fare clic sullo studente da copiare.

=

Fare clic su Modifica >Copia oppure fare clic su
Il software copia lo studente negli Appunti.

Dall'elenco a discesa Classe corrente, selezionare la classe in cui copiare
lo studente

Fare clic su Modifica > Incolla oppure fare clic su E .
Il software copia lo studente nella classe selezionata.
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Esplorazione della Registrazione della classe

Dalla Registrazione della classe, & possibile aprire un documento nell'Area di
lavoro Revisione; salvare un documento nell'Area di lavoro Portfolio;
raccogliere file dall'Area di lavoro Registrazione della classe; inviare ed
eliminare file usando la barra degli strumenti e visualizzare le proprieta del
documento in Registra proprieta elemento per tutti i documenti TI-Nspire™, ad
eccezione dei file Test Rapido.

Per impostazione predefinita, sono elencate 100 registrazioni. Per visualizzare
piu registrazioni, fare clic su Carica prossimi 100 oppure Carica tuttele voci.
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1 2 Class Record 3

Action File Mame Status

Unprompted-05-18 (2} »r =~

] BR 4.20 220f24 b e

¥ BR420 230f24 b
Unprompted-05-16 (71 » =

N BR 4.20.tns 230f24 » |

] BR419 2320f24 b

&  2011-12 A1 Geo... »

#  BR419 230f24 »
Unprompted-05-14 (10} P

| BR 4.19.tns 23024 »

= BR418 220f24 b

&  2011-12A1 Geo.. »

¥  BR418 220f24 »
Unprompted-05-10 (12} P

| BR 4.18tns 23024

] BR418 2320f24 b

= Golden_Ratio 230f24 b

&  2011-12A1 Geo.. »

| Golden_Ratio.ths 230f24 b

#  BR418 230f24 »
Unprompted-05-08 (8 »

| BR 4.16.tns 23024 »

= Graph_Theory Dof24 b

] BR 414 200f24 b

= Hamilton_Around... 200f24 » &

LAt [ P . WV | A afnd b

| LoadNext100 |

| Load All Entries |

© Azione compiuta sul file. Le icone indicano lo stato di un file.

¥

Inviato alla classe
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E" Ritirato dalla classe
Salvato in Portfolio

i Ridistribuito alla classe

e,
= Test rapido

Non sollecitato
| |
% Eliminato
@ Nome file. | nomi dei file utilizzati in questa classe.
© Stato. Indica la progressione di un'azione. Ad esempio, “23 di 25” indica
che 23 studenti su 25 hanno ricevuto un file.

@ Opzioni di menu. Fare clic su ) per accedere rapidamente ad alcune
opzioni di menu. Questa icona fornisce accesso alle stesse opzioni del
menu di scelta rapida (clic destro del mouse).

Invio di file a una classe

| file e le cartelle possono essere inviati all'intera classe, ai membri della classe
che sono connessi o0 a singoli studenti La sessione della classe deve essere
attiva perinviare i file.

Quando si invia un file a tutta la classe, tutti gli studenti correntemente collegati
riceveranno immediatamente il file. Gli studenti che non sono collegati lo
riceveranno non appena effettueranno il collegamento.

Note:

+ soloitipi di file di TI-Nspire™ (.tns) e PublishView™ (.tnsp) si aprono nel
software TI-Nspire™.

»  Altri tipi di file (se supportati) come per esempio immagini, elaborazione di

testo, oppure file di foglio elettronico si aprono nell'applicazione che il
sistema operativo ha associato al tipo di file.

Invio di file

| . £
1. Fare clic su Strumenti >Invio alla classe oppure fare clic “2%%.
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Viene visualizzata la finestra di dialogo Seleziona file da inviare.

Step 1 of 2 - Select file{s) to send x |

Files | Falgers |

Lookln: |5 Examples ~| Ea &6 “
[ Equations2 il £ 11 Optics Explorerins

[2) Mew Lesson Bundle1.tilb 3 12 Introducing CAS.ins

@ 00 Getting Started.ins 4 Plot Conics CAS.ns

@ 01 Percents tns @ Plot Differential Equation CAS.tns

B3 02 Functions tns £ Plot Sequence Order! CAS.ins

B3 03 Linear Eqns.ins 3 Plot Sequence Order2 CAS.ins

B 04 Systems of Eqns.tins 2 Plot Sequence System CAS.ins

@ 05 Geometry.tns

&4 06 Advanced Functions.ins
B3 07 Trig Functions.tns

£ 08 Calculus tns

B2 09 Statistics tns

B3 10 Simple Machines.ins

File Name: | |

Files of Type: |Ti-Nspire Family Handhelds - |

[ cancsl |

2. Fare clic sulla scheda File per scegliere i file, oppure fare clic sulla scheda
Cartelle per scegliere le cartelle.

Nota: E possibile inviare solo file o cartelle, non una combinazione dei
due.

+  TI-Nspire™ Navigator™ Teacher Software per palmari trasferisce solo i
file.tns.

+  TI-Nspire™ Navigator™ Teacher Software per computer collegati in
rete trasferisce tutti i file.

3. Perscegliereifile o le cartelle da inviare, eseguire una delle seguenti
operazioni:

* Andare alfile o alla cartella da inviare e farvi clic sopra. Per
selezionare piu file o cartelle contemporaneamente, premere e
mantenere premuto il tasto Ctrd (Mac®: &) mentre si fa clic su ogni
singolo nome file.

+ Digitare il nome del file o della cartella nella casella Nome file 0 Nome
cartella. | nomi delle cartelle possono utilizzare caratteri alfanumerici
ma non possono contenere i caratteri speciali/\:"|*? <>, enon
possono contenere queste parole:
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5.

Ipt1, Ipt2, Ipt3, Ipt4, Ipt5, Ipt6, Ipt7, Ipt8, Ipt9, com1, com2, com3, com4,
comb5, com6, com7, com8, com9, aux, con, prn, nul.

Nota: in alternativa € possibile trascinare i file per inviarli da una finestra di
gestione file al record della classe.

Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Seleziona studente/i.

Step 2 of 2 - Select individual{s)

Baker, Susan

@ Chopra, Laxmi

Garcia, Rafe
Huang, Shen

Kapur, Samir

Li, Song
& Lopez, Maria
Individuals Moore, Jacob
Ortega, Carlos

simmaons, Nadine
[Thompson, Olivia

Send to handheld folder: |Algebra | =~

[*] Logged in only

[ =Back Ii Finish i‘ [ Cancel l

Selezionare lo studente o gli studenti a cui inviare il file:

. Per inviare il file all'intera classe, fare clic su Classe "@ Perinviare il
file solo ai membri della classe che sono attualmente connessi,
selezionare la casella Solo studenti connessi.

. Per inviare il file a un solo studente, fare clic su Studenti (g quindi
fare clic sullo studente interessato.

Nota: se sono gia stati selezionati studenti nella scheda Classe, il
software ne mantiene la selezione.

» Utilizzare I'elenco a discesa Invia a cartella del palmare per
selezionare dalla cartella della classe in corso, la cartella principale
sul palmare o le ultime 10 cartelle a cui sono stati inviati i file.
(Disponibile solo nel software TI-Nspire™ che supporta i palmari.)
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- Einoltre possibile inserire un percorso cartella nell'elenco a
discesa.

6. Fareclic su Fine.

Il trasferimento del file appare nella Registrazione della classe.

Invio di file mancanti

La funzione Invio mancante diventa attiva dopo che si € concluso il
trasferimento originale. Questa funzione rimanda i file solamente a quegli
studenti che non erano connessi o indirizzati per il trasferimento originale.

1. Dalla Registrazione della classe, scegliere I'azione invia del file che &
stato inviato alla classe.

Nota: L'azione invia non puo essere attiva.

2. Cliccare File> Invia mancanti.

Ridistribuzione di file selezionati alla classe

La funzione Ridistribuisci quanto selezionato alla classe permette di rivedere,
modificare e rinviare gli elaborati agli studenti.

1. Dalla Registrazione della classe, selezionare I'azione raccogli del file/dei
file originale/i modificato/i.

2. Fare clic su File >Ridistribuisci quanto selezionato alla classe.

Nota: Rinviera solamente i file agli studenti ai quali sono stati ritirati.

Ritiro di file dagli studenti

E possibile ritirare qualsiasi file precedentemente inviato posto nelle cartelle
della classe di studenti utilizzando la Registrazione della classe. Inoltre &
possibile ritirare file dagli studenti digitando il nome completo del file.

Quando si utilizzano il menu o l'icona per il ritiro dei file, € possibile anche
eliminare file ritirati da cartelle della classe di studenti.

Nota: se uno studente cancella, rinomina o archivia un file in una posizione
diversa, il file non puo essere ritirato.

Per ritirare i file, la sessione della classe deve essere attiva. Se ci sono
studenti non connessi, i file ritirati vengono automaticamente trasferiti al
computer dellinsegnante non appena gli studenti effettuano il collegamento.
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Ritiro di file dalla Registrazione della classe

1. Nella Registrazione della classe, scegliere il file o i file che sono stati
inviati alla classe.

Nota: per impostazione predefinita, sono elencate le prime 100
registrazioni. Per visualizzare altre registrazioni, fare clic su Carica
prossimi 100 oppure Carica tutte le voci.

Class Record

Action File Mame Status
AlgebraTest! dofd b =~
-IF
@ Concepts of Math - KP...
Homework3 Gorff
—l
Concepts of Math - KP...
Concepts of Math - KP...
Concepts of Math - KP...
Concepts of Math - KP...
Concepts of Math - KP...

P
4
4
4

2 AQDDOD

AlgebraTestt Qorff
AlgebraTest1 20f2
AlgebraTest! 202
AlgebraTest1 202
AlgebraTest! tns 20f2
Concepts of Math - KP...
Concepts of Math - KP...
Concepts of Math - KP...

Lists 1of 1 b
AlgebraTest2 tns foft
—l

PEPEhe & &= 2

2. Fare clic su ) accanto a uno dei file evidenziati e scegliere Ritira
selezionati dalla classe.

Il trasferimento del file appare nella Registrazione della classe.

Ritiro di file tramite il menu o l'icona

1. Fare clic su Strumenti > Ritira dalla classe oppure fare clic @
Viene visualizzata la finestra di dialogo Seleziona file da ritirare.

2. Perscegliere ifile o le cartelle da ritirare, eseguire una delle seguenti
operazioni:
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. Fare clic su File recenti, quindi evidenziare e fare clic sul file da
ritirare. Per selezionare piu file o cartelle contemporaneamente,
premere e mantenere premuto il tasto Ctrl (Mac®: #) mentre si fa clic
su ogni singolo nome file.

+  Fare clic su Inserisci nome file e digitare il nome del file nella casella
Nome file, quindi fare clic su Aggiungi.

3. Fare clic su Avanti.
Viene visualizzata la finestra di dialogo Seleziona studente/i.

Step 2 of 2 - Select individual(s) X

Baker, Susan
e
Garcia, Rafe
Huang, Shen
Sl i Kzour, Samir
Li, Song

8 Lopez, Maria
Individuals Moore, Jacob
Onega, Carlos

simmons, Nadine

Thompson, Clivia

Class

D Logged in only
[Z] Delete from handheld after collecting

{ <Back l Finish H Cancel I

4. Selezionare lo studente o gli studenti da cui ritirare il file:

. Per ritirare il file dall'intera classe, fare clic su Classe &—% Per ritirare
il file solo dagli studenti della classe che sono connessi, selezionare
la casella Solo connessi.

. Per ritirare il file da un solo studente, fare clic su Studenti (% quindi
fare clic sullo studente interessato.

Nota: se sono gia stati selezionati studenti nella scheda Classe, il
software ne mantiene la selezione.

5. Se sidesidera rimuovere il file dai palmari degli studenti dopo averli ritirati,
selezionare la casella accanto all'opzione per cancellare il file interessato.
(Disponibile solo sul software TI-Nspire™ che supporta i palmari.)
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6. Fareclic su Fine.

Il file ritirato appare nella Registrazione della classe.

Ritiro di file mancanti

La funzione Ritira file mancanti si attiva per quei file che non sono stati ricevuti
dagli studenti.

1. Dalla Registrazione della classe, scegliere I'azione ritira file che ¢ stato
inviato alla classe.

2. Fare clic su File > Ritira file mancanti.

Nota: I'azione di ritiro non puo essere attiva.

Gestione di azioni non sollecitate

Quando uno studente connesso a una sessione della classe invia
all'insegnante un file che non rientra in un ritiro, viene creata un'azione non
sollecitata.

Questi file, che vengono archiviati in un database, sono mostrati nella
Registrazione della classe fino alla loro rimozione.

Revisione e apertura di azioni non sollecitate

I nome delle azioni non sollecitate viene assegnato automaticamente
combinando la dicitura "Unprompted" ("Non sollecitato") con il mese e il giorno
correnti. Per ogni sessione della classe esiste una cartella Non sollecitati
contenente tutti i file .tns e tnsp. inviati dagli studenti.

L'ultima azione non sollecitata viene visualizzata in cima alla Registrazione
della classe e contiene i file piu recenti inviati da uno studente durante una
sessione della classe. Durante la successiva sessione della classe, le azioni
non sollecitate piu recenti appariranno nella Registrazione della classe sopra
I'azione precedente.

Per aprire I'azione non sollecitata:

1. Fare doppio clic sull'azione oppure fare clic con il pulsante destro del
mouse e scegdliere Registra proprieta elemento.

Viene visualizzata la finestra di dialogo Non sollecitati. Per impostazione
predefinita, in questa finestra di dialogo non ci solo elementi selezionati.
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Nella finestra di dialogo Non sollecitati, € possibile visualizzare uno o piu
elementi, salvare gli elementi nell'’Area di lavoro Portfolio, rimuovere gli
elementi, esportare gli elementi in un'altra cartella oppure non eseguire
alcuna azione.

Visualizzazione di elementi di un'azione non sollecitata

1.

Dalla finestra di dialogo Non sollecitati, selezionare la casella di controllo
a sinistra dell'elemento o degli elementi da visualizzare.

Nota: € inoltre possibile fare clic sull'icona Visualizza accanto all'elemento
per accedere rapidamente ad esso.

Fare clic su Visualizza.

Gli elementi vengono aperti come file di sola lettura.

Rimozione di singoli elementi da un'azione non sollecitata

Le azioni non sollecitate imangono nella Registrazione della classe fino a
quando non vengono rimosse. Anche dopo averne esportato o salvato gli
elementi, I'azione non sollecitata continua a rimanere visibile fino a quando
non viene rimossa. Per rimuovere elementi da un'azione non sollecitata:

1.

3.

Nella Registrazione della classe, fare doppio clic sull'azione non
sollecitata per aprirla.

Dalla finestra di dialogo Non sollecitati, selezionare la casella di controllo
a sinistra dell'elemento o degli elementi da rimuovere.

Fare clic su Rimuovi.

Esportazione di elementi di un'azione non sollecitata

E possibile esportare elementi dal database al file di sistema. Per esportare
elementi da un'azione non sollecitata:

1.

Nella Registrazione della classe, fare doppio clic sull'azione non
sollecitata per aprirla.

Selezionare i file da esportare.

Fare clic su Esporta.

Viene visualizzata una finestra di gestione file.
Selezionare la cartella per I'esportazione.

Fare clic su Seleziona cartella.
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Salvataggio di file in un record di Portfolio

E possibile salvare file ritirati e non sollecitati in un record di Portfolio.
1. Selezionare i file nella Registrazione della classe.
2. Fare clic su ) e selezionare Salva selezionati in Portfolio.

Viene visualizzata la finestra di dialogo Salva in Portfolio.

3. E possibile salvare i file in una nuova colonna di Portfolio oppure inserirli
in una colonna di Portfolio esistente.

» Perinserireifile in una nuova colonna, fare clic su Aggiungi come
nuova colonna di Portfolio e digitare il nome della nuova colonna.

* Persalvare ifile in una colonna di Portfolio esistente, fare clic su
Aggiungi a colonna esistente di Portfolio e selezionare il nome della
colonna desiderata dall'elenco a discesa.

4. Fare clic su Salva.

Nota: i file salvati nell'area di lavoro Portfolio vengono visualizzati nel
record della classe e vi rimangono fino a quando non li si rimuove con il
comando Rimuovi.

Eliminazione di file da cartelle della classe

Se necessario, € possibile eliminare i file dalle cartelle della classe di studenti
che sono stati inviati alla classe o ritirati dalla classe. La sessione della classe
deve essere attiva per poter eliminare i file.

Nota: I'eliminazione di un file imuove unicamente il file specificato dalla
cartella classe. Se lo studente ha salvato una copia con un altro nome, o
copiato il file in un'altra posizione, il file sara ancora accessibile.

=

=

1. Fare clic su Strumenti > Elimina dalla classe o fare clic su “Z
Viene visualizzata la finestra di dialogo Seleziona file da eliminare.
2. Perscegliere ifile o le cartelle da eliminare, eseguire una delle seguenti
operazioni:
. Fare clic su File recenti, quindi evidenziare e fare clic sul file da
eliminare. Per selezionare piu file o cartelle contemporaneamente,

premere e mantenere premuto il tasto Ctrl (Mac®: #) mentre si fa clic
su ogni singolo nome file.
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»  Fare clic su Inserisci nome file e digitare il nome del file nella casella
Nome file, quindi fare clic su Aggiungi.

3. Fare clic su Avanti.

Viene visualizzata la finestra di dialogo Seleziona studente/i.

Step 2 of 2 - Select individual(s)

Baker, susan
@ HChopra, Laxmi

Class Garcia, Rafe
Huang, Shen
Kapur, Samir
Li, Song
S rErr———
Individuals | | Moore, Jacoh

| Ontega, Carlos

Hsimmons, Nadine

Thompsen, Olivia

[C] Logged in only

I = Back l Einish H Cancel I

4. Selezionare gli studenti di cui si desiderano eliminare i file.

* Perritirare il file dall'intera classe, fare clic su Classe é—% Per
eliminare i file solo dai membri della classe che sono connessi,
selezionare la casella di controllo Solo connessi.

. Per eliminare il file da un solo studente, fare clic su Studenti &
quindi fare clic sullo studente interessato.

Nota: se sono gia stati selezionati studenti nella scheda Classe, il
software ne mantiene la selezione.

5. Fareclic su Fine.

L'eliminazione dei file appare nella Registrazione della classe.

Verifica dello stato dei trasferimenti di file

Durante l'invio, il ritiro o I'eliminazione di file, & possibile verificare quali
studenti hanno ricevuto o inviato i propri file.
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» Nel record della classe, fare clic sul file di cui si desidera verificare lo stato.

Nell'area Classe, il software indica lo stato degli studenti come segue:

. B Lo sfondo verde indica che lo studente ha
inviato/ricevuto/eliminato il file

. C% Lo sfondo giallo indica che gli studenti hanno ricevuto I'azione di
ritiro o eliminazione, ma il file non & presente nella loro cartella
classe.

. B Lo sfondo rosso indica che lo studente non ha ancora
inviato/ricevuto/eliminato il file.

Nota: in alternativa & possibile verificare lo stato del trasferimento di un file
nella finestra di dialogo Proprieta del file.

Eliminazione di trasferimenti di file

E possibile annullare il trasferimento di file dalla Registrazione della classe.
L'operazione di annullamento interrompe il trasferimento di altri file da parte
del software. Qualunque file trasferito prima dell'annullamento rimane nella
cartella classe di studenti.

1. Nella Registrazione della classe, fare clic sul file di cui si desidera
annullare il trasferimento.

2. Fare clic su Modifica> Rimuovi dalla Registrazione della classe.
Viene chiesto di confermare |'operazione di rimozione.
3. Fare clic su Rimuovi.

Il software interrompe il trasferimento e rimuove il file dall'elenco della
Registrazione della classe.

Visualizzazione delle proprieta dei file

Ogni file inviato o ritirato possiede una serie di proprieta visualizzabili, ad
eccezione dei file Test Rapido. Le proprieta del file includono il nome, la
dimensione, la data di invio e lo stato. E possibile visualizzare le proprieta di
un file in qualsiasi momento.

1. Selezionare il file nella Registrazione della classe.
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2. Fare clic con il pulsante destro del mouse sul nome del file e selezionare
Registra > proprieta elemento.

Viene visualizzata la finestra di dialogo Proprieta statistiche con le
proprieta del file.

09 Statistics Properties 2 o

File Properties
Name:09 Statistics
Date Collected: 11/11/10 9:34 AM
Status:1 of 11

Targeted Collected
Su{:’%n B MNa
Laxmii C Mo
Rafe G MNa
ShenH Mo
Samir K MNa
Song L [}
Maria L Yes
Jacob M MNa
Carlos O No
MNadine 3 MNa
Olivia T No

Azzeramento delle password degli studenti

Poiché il software TI-Nspire™ mantiene la privacy delle password dello
studente, non & possibile recuperare le password per gli studenti che le hanno
dimenticate. Tuttavia, & possibile azzerare le password dello studente. E
possibile resettare le password di singoli studenti o di tutti gli studenti di una
classe.

Nota: non & possibile azzerare le password degli studenti che sono connessi
alla rete TI-Nspire™ Navigator™.

Azzeramento delle password di tutti gli studenti di una classe
1. Selezionare la classe.

Nota: lo studente deve essere selezionato per azzerare correttamente la
password.
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2. Fare clic su Classe > Azzera password studente.

Viene visualizzata la finestra di dialogo Conferma azzeramento password
studenti.

Confirm Reset Student Passwords

This action will reset the passwords of the selected
students wha are MOT currently logged in.

The students will set their passwords with their next login.

Cancel |

Fare clic su OK.
Al prossimo accesso degli studenti, chiedere di digitare una nuova
password.

Azzeramento delle password di singoli studenti

1. Fare clic sullo studente da modificare.

2. Fare clic su Classe > Modifica studente, oppure fare clic(%', oppure fare
clic con il pulsante destro del mouse sul nome studente e scegliere

Modifica studente dal menu che appare.

Viene visualizzata la finestra di dialogo Proprieta studente.

Student Properties |

First Name: [Jacob|

LastName: |Moore |

User Name: |104 |

Passwaord: Reset |

Display Mame: IJacob Moore

Student ID: |4 |
Classes: Algebral | Assign Classes |

| oK || Cancel |
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Fare clic sul pulsante Azzera accanto a Password.

4. Se sidesidera che lo studente crei la propria password, selezionare
Sceglie lo studente.

—oppure—

Se si desidera creare una password per lo studente, selezionare la
casella vuota della password e digitarvene una nuova.

5. Fare clic su OK.
Il software azzera la password dello studente.
6. La prossima volta che lo studente effettua I'accesso:

+ Se ¢ stato selezionato Sceglie lo studente, lo studente dovra digitare
una password.

. Se la password dello studente & stata creata dall'insegnante, sara
compito dellinsegnante comunicargliela.
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Cattura di schermi

La Cattura di schermi permette:
e Cattura pagina
- Catturare la pagina attiva in un documento TI-Nspire™ dal software o
dall'emulatore TI-SmartView™ come immagine.
- Salvare immagini catturate come file .jpg, .gif, .png o .tif, che possono
essere inserite in applicazioni TI-Nspire™ che accettano immagini.
- Copiare e incollare immagini in un'altra applicazione, quale ad
esempio Microsoft® Word.

e Cattura delle immagini in modalita palmare

- Nell'area di lavoro documenti, utilizzare la funzione DragScreen per
catturare lo schermo dell'emulatore o lo schermo laterale quando
TI-SmartView™ Emulator & attivo.

- Gliinsegnanti possono utilizzare questa funzione per trascinare e
incollare I'immagine su strumenti di presentazione, come SMART®
Notebook, Promethean’s Flipchart, e le applicazioni Microsoft® Office
tra cui Word e PowerPoint®.

Accedere a Cattura schermo

Lo strumento Cattura schermo & disponibile da tutte le aree di lavoro. Per
accedere a Cattura schermo:

» Dalla barra menu, cliccare su Strumenti > Cattura schermo.

» Dalla barra degli strumenti, fare clic su

Utilizzo di Cattura classe

Nella classe, utilizzare lo strumento Cattura schermo per visualizzare e
catturare gli schermi degli studenti. E possibile catturare lo schermo di uno
studente selezionato, di piu studenti selezionati oppure di tutti gli studenti della
classe.

E possibile selezionare di visualizzare solo I'area di lavoro del software sugli
schermi degli studenti o I'intero schermo del computer che puo includere tutte
le applicazioni che lo studente ha aperto al momento.
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Nota: per visualizzare e catturare gli schermi degli studenti, questi devono
essere connessi alla classe.

Cattura degli Schermi studenti

1. Se ancora non & stato fatto, iniziare la sessione della classe e chiedere
agli studenti di connettersi.

fe
Viene visualizzata la finestra di dialogo Seleziona studentef/i). Se sono
stati selezionati degli studenti nell'area di lavoro Classe, i nomi di quegli

studenti appaiono evidenziati. Se non & stato selezionato alcuno studente,
vengono selezionati tutti i nomi degli studenti della classe.

2. Cliccare su , quindi cliccare su Cattura classe.

Baker, Susan —
G@ Chopra, Laxmi
— Garcia, Rafe
eE=s Huang, Shen
Kapur, Samir =

Li, Song
Lopez, Maria
Individuals

QOrtega, Carlos
Simmons, Madine =

Logged in only
Show TI-Mspire Work Area only

| OK | | Cancel

3. Percambiare lo studente corrente o aggiungerne altri:

*+ Fareclicsu 5:% per visualizzare gli schermi dei palmari di tutti gli
studenti nella classe. Se uno studente non & connesso, sullo schermo
del palmare appare "Non connesso." Non appena lo studente si
connette, utilizzare Aggiorna per aggiornare lo schermo.

+ Fareclicsu & , quindi fare clic sul nome di ciascuno studente per
visualizzare gli schermi dei palmari dei singoli studenti. Per
selezionare piu studenti consecutivi, mantenere premuto il tasto
Maiusc. Per selezionare piu studenti non consecutivi, mantenere

138 Cattura dischermi



premuto il tasto Ctrl (Macintosh®: #) e cliccare sul nome di ogni
studente.

»  Fare clic sulla casella di controllo Solo connessi sotto il riquadro di
sinistra per visualizzare solo gli schermi degli studenti correntemente
connessi. All'aggiornamento dello schermo, tutti gli studenti che si
sono connessi dopo che é stato catturato lo schermo iniziale verranno
elencati nella parte inferiore della finestra Cattura schermi della
classe.

Fare clic su OK.

Per visualizzare solo I'area di lavoro e non l'intero schermo dello studente,
selezionare Mostra solo area di lavoro TI-Nspire.

Gli schermi degli studenti selezionati vengono visualizzati nella finestra
Cattura schermi dello classe.

Nota: L'esempio seguente mostra gli schermi dei palmari di due studenti
selezionati che sono connessi. La vista predefinita & Affiancata, vale a dire
che tutti gli schermi catturati sono visualizzati nella finestra.

File Edit View

P =
z@_i} Qx @x [] Show Student Names Auto-Refresh:| Off | view

25 doilars 2 dollars

Decidere se visualizzare o meno i nomi degli studenti. Per visualizzare o
nascondere i nomi degli studenti, selezionare o deselezionare la casella
di controllo relativa nella barra degli strumenti oppure fare clic su
Visualizza > Mostra nomi studenti.

Cattura dischermi 139



Nota: la selezione relativa alla visualizzazione o meno dei nomi degli
studenti rimane attiva fino a quando non la si modifica. Ad esempio, se si
seleziona di nascondere i nomi degli studenti, i nomi rimangono nascosti
anche quando si chiude la finestra Cattura schermi della classe e si ritorna
all'area di lavoro Classe. Se si seleziona di nascondere i nomi degli
studenti nell'area di lavoro Classe, i nomi rimangono nascosti anche
quando si apre la finestra Cattura schermi della classe.

Impostazione delle preferenze dell'insegnante per Cattura
classe

Utilizzare I'opzione Preferenze insegnante per impostare le preferenze relative
all'uso dell'opzioneOrdine casuale in Cattura schermo e alla visualizzazione
del palmare dell'insegnante. Creando un nome utente e una password si
consente agli insegnanti di connettersi a una classe attiva. E anche possibile
selezionare di personalizzare la vista dello schermo del palmare
dell'insegnante quando é visualizzato. Per ulteriori informazioni, vedere le
guide del palmare su education.ti.com/guides.

1. Dalle finestra del TI-Nspire™ Navigator™ Teacher Software, selezionare
File > Impostazioni > Preferenze insegnante.

Viene visualizzata la finestra di dialogo Preferenze insegnante.

Teacher Preferences @

Teacher Account

Username: | |
Password: | Reset |

Add teacher to classroom view
Options

Randomize order in Screen Capture

[} Individualize Teacher Handheld in Screen Capture

OK | | Cancel

2. Senon é ancora stato fatto, creare un nome utente e una password.

3. Selezionare "Aggiungi insegnante alla vista della classe" per visualizzare
il palmare dell'insegnante nella finestra Cattura schermi della classe.
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4. Per catturare gli schermi in ordine casuale, selezionare "Ordine casuale in
Cattura schermo".

5. Selezionare l'opzione "Individua palmare insegnante in Cattura schermo"
in modo che nella finestra Cattura schermi della classe lo schermo
catturato dal palmare dell'insegnante appaia diversamente dagli schermi
catturati dai palmari degli studenti.

6. Fare clic su OK per salvare le impostazioni.

Impostazione delle opzioni di visualizzazione in Cattura
classe

Quando si lavora con schermi catturati nella finestra Cattura schermi della
classe, sono disponibili diverse opzioni per ottimizzare la visualizzazione degli
schermi per la presentazione alla classe, tra cui:

+ Alternanza tra vista affiancata e vista galleria
*  Confronto di schermi selezionati in vista affiancata

+ Aggiornamento della vista secondo necessita o impostazione della
funzione di aggiornamento automatico per aggiornare automaticamente la
vista a intervalli prestabiliti.

+ Ingrandimento o rimpicciolimento della vista per aumentare o diminuire le
dimensioni degli schermi catturati nella finestra. E inoltre possibile
selezionare la percentuale di ingrandimento o di riduzione delle
dimensioni dello schermo.

* Visualizzazione o meno dei nomi degli studenti.

»  Accesso alle opzioni di Presentatore dal vivo. Per ulteriori informazioni,
vedere Utilizzo di Presentatore dal vivo.

Alternanza tra vista affiancata e vista galleria

Quando si catturano gli schermi degli studenti, la vista predefinita della finestra
Cattura schermi delle classe & affiancata. Passare alla vista galleria per
mostrare una vista ingrandita di uno schermo selezionato. Nel riquadro di
sinistra sono riportare le miniature di tutte gli schermi catturati che consentono
di trovare e selezionare rapidamente gli schermi.

Per alternare tra vista affiancata e vista galleria:
[=—

» Cliccare su ,quindi cliccare su Galleria oppure Affiancata.
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—Oppure—

» Selezionare Visualizza > Galleria o selezionareVisualizza > Affiancata.
—Oppure—

» Per la vista galleria, premere Ctrl + G (Macintosh®: & + G). Per la vista
affiancata, premere Ctrl + T (Macintosh®: # + T).

Nella vista galleria, le miniature degli schermi catturati sono visualizzate in una
colonna nel riquadro di sinistra della vista. Nel riquadro di destra &€ mostrata
una vista ingrandita di uno schermo selezionato.

) T-Nspire Navigator Teacher Software Class Capture F=EmE

& Make Presenter (7 Show Student Names Auto-Refresh:[30 seconds - View =

% Add to Stack

|Handheld Status

Batteries: 100%

Version: 3.6.0.207
Storage Capacity: 114.3 MB

‘Thompson, Olvia

Storage Available: 100.9 MB

Network: Wireless client is not attached.

*  Gli schermi catturati appaiono nello stesso ordine in cui sono mostrati
nella vista affiancata.

* Se si selezionano contemporaneamente piu miniature per la
visualizzazione nel riquadro di sinistra, esse appariranno nel riquadro di
destra.

+  Se siselezionano piu di quattro miniature, € possibile visualizzare gli
ulteriori schermi facendo scorrere verso il basso il riquadro di destra.

. Se si & selezionato di visualizzare il nome degli studenti, i nomi
appariranno al centro sotto lo schermo catturato di ciascuno studente.

» Le funzioni di Zoom sono disabilitate nella vista galleria.
+  E possibile modificare I'ordine degli schermi nella vista galleria.

» Lalarghezza della miniatura non puo essere variata.

Ridisposizione di schermi catturati

Completare la procedura seguente per modificare I'ordine degli schermi
catturati nella finestra Cattura schermi della classe.
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1. Fare clic sullo schermo desiderato per selezionarlo.

2. Tenendo premuto il pulsante sinistro del mouse, trascinare lo schermo
nella posizione desiderata e rilasciarlo.

Aggiornamento di schermi catturati

Mano a mano che gli studenti si connettono alla classe e lavorano sui palmari,
€ possibile aggiornare la vista degli schermi catturati. Quando si aggiorna la
vista nella finestra Cattura schermi della classe, vengono visualizzati gli ultimi
schermi degli studenti. E possibile aggiornare la vista quando necessario,
oppure impostare l'opzione di aggiornamento automatico per aggiornare
automaticamente la vista ad intervalli predefiniti.

Aggiornamento della vista quando necessario

[—4
&
» Fareclicsu
Vengono acquisiti gli ultimi schermi dei palmari connessi e visualizzati

nella finestra Cattura schermi della classe.

Nota: se il palmare di uno studente ha perso la connessione e non € stato
possibile aggiornarne lo schermo, lo schermo non aggiornato apparira
profilato di giallo.

ﬂ) TI-Nspire Navigator Teacher Software Class Capture E@

File Edit View
B 5} @\) @\3 (;QEI Make Presenter ] Show Student Names Auto-Refresh:[20 seconds - View 7]

[ Add to Stack

Connection Error

Thompson, Olivia
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Abilitazione della funzione di aggiornamento automatico degli schermi
caftturati

La funzione di aggiornamento automatico & utile per monitorare le prestazioni
della classe in quanto consente di aggiornare automaticamente la vista degli
schermi catturati a intervalli prestabiliti. Per impostazione predefinita, la
funzione di aggiornamento automatico € disabilitata. Per abilitare la funzione
di aggiornamento automatico:

1. Cliccare su Visualizza > Aggiorna automaticamente o selezionare
|:'"—
Auto-Refresh:])

- nella barra degli strumenti.

1 minute
2.5 minutes
5 minutes
10 minutes

2. Selezionare una delle opzioni di intervallo temporale disponibili.

Nota: questa funzione € disponibile nella vista affiancata o nella vista galleria.
Non ¢ disponibile in modalita Presentatore dal vivo.

Utilizzo delle funzioni diingrandimento e riduzione

Nella finestra Cattura schermi della classe, utilizzare le funzioni Zoom avanti e
Zoom indietro per aumentare o diminuire le dimensioni degli schermi catturati.

(+)

» Dalla barra degli strumenti, fare clic su % per ingrandire le dimensioni
degli schermi nella vista. E anche possibile selezionare Visualizza > Zoom
avanti dal menu.

» Dalla barra degli strumenti, fare clic su % per ridurre le dimensioni degli
schermi nella vista. E anche possibile selezionare Visualizza > Zoom
indietro dal menu.
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Impostazione di una percentuale di zoom

L'opzione Percentuale zoom consente di selezionare la percentuale di
ingrandimento o riduzione dellimmagine dello schermo quando si utilizzano le
funzioni Zoom avanti o Zoom indietro. Per selezionare una percentuale:

1. Nella finestra Cattura schermi della classe, selezionare Visualizza >
Percentuale zoom.

Viene visualizzato I'elenco a discesa delle percentuali.

"Ciled Cil+T 1] show Student
Gallery Ctri+G
{? Refresh now F5
Auto-Refresh b
{ €, Zoom In Ctrl+Up
{ &, Zoom Out Ctrl+Down
P 40 Fit All Cirl+0 |
+ Show Student Mames 50%  Cirl+1 B
Live Presenter k(& 100% Ctrl+2
==l 150% Cirl+2
&l 2 Press—to-Test | ;
- 200% Ctrl+4
250% Cirl+5 |
Thompsaon, Olivia 300% (Rkh
350% Ctrl+7
400% Cirl+8

2. Selezionare una delle percentuali disponibili.

Creare Pile di schermi studenti

Questa funzione consente di raccogliere una cronologia di schermi di uno o
piu studenti catturati nell'opzione Cattura classe. Queste raccolte sono
chiamati pile, ed & possibile aggiungere o rimuovere schermi dalla pila di ogni
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studente, cosi come di navigare all'interno e attraverso le pile degli studenti.
L'utilizzo di pile & un modo comodo per verificare i progressi in una lezione,
ritirare le presentazioni e i compiti degli studenti per rivederli e valutarli in
seguito, o per mostrare prestazioni e progressi nelle riunioni
genitore/insegnante.

E possibile aggiungere, rimuovere, navigare, e salvare le pile dalla finestra
Cattura classe, che diventa disponibile quando si utilizza I'opzione Cattura
classe.

» Per aprire la finestra Cattura classe, cliccare su Finestra > Finestra Cattura
classe.

Aggiungere schermi ad una Pila
» Dalla finestra Cattura classe, cliccare su Visualizza > Pile > Aggiungi a Pila,

l:_'_'(
o cliccare
» Peraggiungere un'altra serie di schermi, cliccare prima su Aggiorna
e quindi aggiungere la pila.

Quando la prima serie di schermi & aggiunta ad una nuova pila, viene
denominata Frame1 Ogni successiva aggiunta aumenta il numero di una unita,
per esempio: Frame2, Frame3 e cosi via.

Rimuovere i Frame dalla Pila
1. Selezionare il file da rimuovere.
bt

2. Cliccare su Visualizza > Pile > Rimuovere da Pila, o cliccare

Come i Frame vengono rimossi da una pila, i loro nomi sono adeguati per
rimanere sequenziali e riflettere I'eliminazione. Per esempio, se Frame6 viene
eliminato, Frame7 viene rinominato Frame6 e tutti i successivi numeri di Frame
vengono scalati di una cifra.

Navigazione attraverso Pile

E possibile navigare una pila di frame sia dalla vista affiancata che dalla vista
galleria.

» Per visualizzare frame differenti in una pila, utilizzare una di queste opzioni:

. Fare clic sulla freccia dell'elenco a discesa, quindi fare clic sul frame
desiderato dall'elenco.

146 Cattura dischermi



[
* Visualizza > Pile > Prossimo Frame, o cliccare su Iﬂfl

1
+  Visualizza > Pile > Frame precedente, o cliccare su @

Nota: Queste opzioni sono disponibili solo c'e€ un frame precedente o
successivo da visualizzare.

Salvare Pile

Quando si chiude la finestra Cattura classe, il software chiede se si desidera
salvare le pile.

1. Cliccare Si per salvare le pile.

La finestra di dialogo Seleziona o Crea cartella per salvare Pile si apre.

Select or Create Folder to Save Stacks

Save In: l . Stacks - B D Ea

Save || Cancel |

2. Cliccare su Salva per salvare le pile nella cartella predefinita, oppure
creare o navigare su un'altra cartella e cliccare su Salva.

Le pile vengono salvate come screenshot individuali con il nome dello
studente, numero immagine, data e ora. Ad esempio:

Laxmi Chopra_immagine1_21-10-2011_11-50
Laxmi Chopra_immagine2_21-10-2011_11-50

Utilizzare I'area di lavoro Contenuti nel sistema di gestione file del computer
per individuare ed aprire gli schermi salvati.

Gli schermi si aprono nel visualizzatore di foto predefinito del computer.
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Confronto di schermi selezionati

Questa funzione consente di confrontare gli schermi degli studenti in modalita
affiancata.

1. Selezionare gli schermi degli studenti da confrontare. Per selezionare piu
schermi consecutivi, mantenere premuto il tasto Maiusc. Per selezionare
piu schermi non consecutivi, mantenere premuto il tasto Ctrl (Macintosh®:
) e cliccare su ogni immagine che si desidera salvare. Quando si
seleziona uno schermo, il bordo cambia colore.

Nota: se si selezionano piu di quattro schermi, sara necessario far scorrere
il riquadro di visualizzazione per vederli.

2. Cliccare su Modifica > Confronta selezionati.

Se ¢ attiva la vista affiancata, viene attivata la vista galleria e gli schermi
selezionati appariranno nell'ordine selezionato.

Nota: questa opzione & disabilitata nella vista galleria.

3. Peruscire dalla modalita di confronto, fare clic all'esterno dello schermo
nel riquadro di sinistra della vista galleria.

Utilizzo di Dai la parola (Make Presenter)

Selezionare uno schermo catturato nella finestra Cattura schermi della classe,
quindi fare clic sull'opzione Dai la parola nella barra degli strumenti per avviare
Presentatore dal vivo (Live Presenter) e presentare lo schermo dello studente
alla classe. E possibile scegliere un solo studente alla volta per Presentatore
dal vivo. Per ulteriori informazioni, vedere Ultilizzo di Presentatore dal vivo.

Salvataggio di schermi con Cattura classe

E possibile salvare schermi catturati per |'uso in altri documenti TI-Nspire™ che
accettano immagini oppure per l'uso in altre applicazioni, quale per esempio
Microsoft® Word. E possibile salvare le immagini dello schermo nei seguenti
formati: .jpg, .png, .gif. E possibile salvare un'immagine alla volta, selezionare
piu immagini da salvare o salvare tutte le immagini catturate.

Salvataggio diimmagini dello schermo

Per salvare immagini dello schermo catturate con Cattura classe, attenersi alla
procedura seguente.
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Nella finestra Cattura schermi della classe, selezionare lo schermo o gli

schermi da salvare come file immagine.

* Perselezionare piu schermi consecutivi, fare clic sulla prima
immagine, quindi mantenere premuto il tasto Maiusc e fare clic sulle
ulteriori immagini. Per selezionare piu schermi non consecutivi,
mantenere premuto il tasto Ctrl (Macintosh®: #) e cliccare su ogni
immagine che si desidera salvare.

» Per selezionare tutti gli schermi catturati, cliccare su Modifica >
Seleziona tutti.

Cliccare su File > Salva schermo/i selezionato/i o premere Ctrl + S

(Mac®: & + S).

Viene visualizzata la finestra di dialogo Salva.

Save In: [ Math 101

File Name:  |image

Files of Type: IPNGImage(*.png}

| Save || Cancel |

Passare alla cartella sul computer in cui salvare il file o i file.
Digitare un nome per il file o i file nel campo Nome file.
Il nome file predefinito € Immagine.

Nel campo Tipo file, fare clic su w, quindi selezionare il tipo di file: .jpg,
.png, .gif. Il tipo di file predefinito € .jpg.

Fare clic su Salva.

Il file o i file vengono salvati nella cartella designata.
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. Se si salva una sola immagine, il relativo file viene salvato con il
nome specificato nel campo Nome file.

»  Se si salvano piu immagini, i relativi file vengono salvati con il nome
specificato nel campo Nome file a cui viene aggiunto un numero per
rendere univoco ogni nome. Ad esempio, Immagine1, Immagine 2,
ecc.

Stampa di schermi catturati

E possibile stampare gli schermi catturati utilizzando l'opzione Cattura classe.
E possibile stampare uno schermo alla volta, piti schermi
contemporaneamente o tutti gli schermi catturati. Per ogni pagina, viene
stampato il nome della classe nelliintestazione della pagina e la data e il
numero di pagina nel pié di pagina.

Nota: I'opzione Stampa non & disponibile con le opzioni Cattura pagina o
Cattura palmare selezionato.

Per stampare uno schermo catturato:
1. Selezionare lo schermo da stampare.
2. Cliccare su File > Stampa.

Viene visualizzata la finestra di dialogo Stampa.

Print Service

Name: [NDLES98WSPCN_05_01

Status:  Accepting jobs
Type:
Info: [] Print To File

Print Range Copies

&) Al Number of copies:

() Pages

Print Options... || Frint || Cancel

150 Cattura dischermi



© N o o

Se sono stati selezionati piu schermi, fare clic su Opzioni di stampa per
selezionare il numero di schermi catturati per pagina.

Viene visualizzata la finestra di dialogo Opzioni di stampa.

Print Options

Print Options

] - | Screens Per Page EEE

Show student names

| QK || Cancel

Selezionare le opzioni desiderate. E possibile selezionare di stampare
uno solo schermo per pagina, sei schermi per pagina o tutti gli schermi
sulla pagina. E inoltre possibile selezionare se stampare i nomi degli
studenti.

Fare clic su OK per tornare alla finestra di dialogo Stampa.
Selezionare le opzioni per la stampante in uso.
Selezionare il numero di copie da stampare.

Fare clic su Stampa per inviare il lavoro di stampa alla stampante
selezionata.

Utilizzo di Cattura pagina

Utilizzare I'opzione Cattura pagina per catturare un'immagine di una pagina
attiva in un documento TI-Nspire™ E possibile salvare le immagini nei seguenti
formati file: .jpg, .gif, .png, .tif. Le immagini salvate possono essere inserite in
applicazioni TI-Nspire™ che accettano immagini. L'immagine viene copiata
anche negli Appunti e puo essere inserita in un'altra applicazione, quale ad
esempio Microsoft® Word o PowerPoint.
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Cattura di una pagina
Per catturare un'immagine in una pagina attiva attenersi alla procedura
seguente.

1. Nell'area di lavoro Documenti, aprire un documento e portarsi nella
pagina da catturare per attivarla.

fe]
L'immagine viene copiata negli Appunti e nella finestra Cattura schermo.
Al termine della cattura, nell'angolo in basso a destra del desktop si apre

2. Fareclicsu , quindi fare clic su Cattura pagina.

|°c:_ | Screen Capture taken. View it
la finestra di dialogo.

3. Fare clic su Visualizza.
Viene visualizzata la finestra Cattura schermo.

E anche possibile selezionare Finestra > Finestra Cattura schermo per
aprire la finestra Cattura schermo.

File Edit View

BE R G 6 W By | & 203 <P

] 657

12-23-2010 Image02

) .

k.
<3

12-23-2010 Image003 -
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Per catturare ulteriori pagine, spostarsi in un'altra pagina del documento
corrente oppure aprire un nuovo documento per selezionare una pagina.

Mano a mano che si prosegue con la cattura, le immagini vengono copiate
nella finestra Cattura schermo, che ne pud contenere diverse. L'ultima
pagina catturata sostituisce il contenuto degli Appunti.

Utilizzo di Cattura palmare selezionato

Utilizzare I'opzione Cattura palmare selezionato per catturare lo schermo attivo
di un palmare collegato.

1.

In un palmare collegato, accedere al menu o a una pagina di un
documento da catturare.

Nel software, selezionare il palmare collegato:

. Nell'area di lavoro Contenuto, selezionare il palmare dall'elenco
Palmari collegati nel riquadro Risorse.

* Nell'area di lavoro Documenti, aprire Esplora contenuto dalla Casella
degli strumenti Documenti, quindi selezionare il palmare dall'elenco
Palmari collegati.

. Nell'area di lavoro Classe, selezionare uno studente connesso.

fed

Cliccare su , quindi cliccare su Cattura palmare selezionato.

—Oppure—

Cliccare su “** | quindi cliccare su Cattura palmare selezionato.

Lo schermo viene copiato negli Appunti e nella finestra Cattura schermo di
TI-Nspire™. Al termine della cattura, nell'angolo in basso a destra del

5| Screen Capture taken. WView it.

desktop si apre la finestra di
dialogo.

Fare clic su Visualizza.
Viene visualizzata la finestra Cattura schermo.

E possibile catturare ulteriori schermi da un documento aperto su un
palmare collegato oppure aprire un altro documento su un palmare
collegato per catturare schermi da esso.
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Mano a mano che si prosegue con la cattura, le immagini vengono copiate
nella finestra Cattura schermo che ne pud contenere diverse. L'ultimo
schermo catturato sostituisce il contenuto degli Appunti.

Visualizzazione di schermi catturati

Quando si cattura una pagina o uno schermo, questi vengono copiati nella
finestra Cattura schermo.

File Edit View

BEX O™ %egnp

[ 0 L " E L F I
H
la [% I'1(x)=:'(2
q Y
i x
g -i0 7 18
E)
L]
B [
[ar] L e 457

12-23-2010 Image001

12-23-2010 Image002

o 557

12-23-2010 Image003 =

Ingrandimento o riduzione della vista di schermi catturati

Nella finestra Cattura schermo, utilizzare le funzioni Zoom avanti e Zoom
indietro per ingrandire o ridurre le dimensioni degli schermi catturati.

(+)

» Dalla barra degli strumenti, fare clic su % peringrandire le dimensioni
degli schermi nella vista. E' possibile inoltre cliccare su Visualizza > Zoom

avanti dal menu.
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» Dalla barra degli strumenti, fare clic su

% per ridurre le dimensioni degli

schermi nella vista. E' possibile inoltre cliccare su Visualizza > Zoom

indietro dal menu.

Salvataggio di pagine catturate e di schermi del palmare

E possibile salvare pagine e schermi catturati come immagini per 'uso in altri
documenti TI-Nspire™ che accettano immagini oppure per l'uso in altre
applicazioni, quale per esempio Microsoft® Word. E possibile salvare
un'immagine alla volta, selezionare piu immagini da salvare o salvare tutte le

immagini catturate.

Salvataggio di schermi selezionati

1. Nella finestra Cattura schermi, selezionare I'immagine dello schermo da

salvare.

2. Fare clic su File > Salva schermo\i selezionatol/i.

Nota: nella finestra Cattura schermo & anche possibile fare clic su

=]

Viene visualizzata la finestra di dialogo Salva con nome.

Save In: I’;,_’l Screen Captures

BESE @E=E

‘ | Blue hills jpg
¥ problem2.jpg
=] Sunsetjpa

%] water lilies jpg
5] winter jpg

File Name: ‘12—13—201D\mag9001

Files of Type: |*jpg, *jpeg

| Save || Cancel ‘

3. Passare alla cartella sul computer in cui salvare il file.

4. Digitare un nome per il file.

Nota: il nome file predefinito € GG-MM-YYYY Immagine ###.
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Selezionare il tipo di file per il file immagine. Il tipo di file predefinito € .jpg.
Cliccare su w  per selezionare un altro formato: .gif, .tif, .png.

Fare clic su Salva.

Il file viene salvato nella cartella designata.

Salvataggio di pit schermi contemporaneamente

1.

Nella finestra Cattura schermo selezionare gli schermi da salvare.
Per selezionare piu schermi consecutivi, fare clic sulla prima immagine,
quindi mantenere premuto il tasto Maiusc e fare clic sulle ulteriori
immagini. Per selezionare piu schermi non consecutivi, mantenere
premuto il tasto Ctrl (Macintosh®: ) e cliccare su ogni immagine che si
desidera salvare.

1]
Cliccare su o selezionare File > Salva schermol/i selezionato/i. Per
salvare contemporaneamente tutte le immagini catturate, fare clic su File >
Salva tutti gli schermi.

Nota: I'opzione Salva tutti gli schermi non € disponibile con Cattura classe.
Viene visualizzata la finestra di dialogo Salva con nome.

Nel campo Salva in, passare alla cartella in cui si desidera salvare le
immagini.

Nel campo Nome file digitare un nuovo nome di cartella. Il nome di cartella

predefinito € GG-MM-AAAA Immagine, dove GG-MM-AAAA ¢ la data
corrente.

Selezionare il tipo di file peri file immagine. Il tipo di file predefinito € .jpg.
Cliccare su w  per selezionare un altro formato: .gif, .tif, .png.
Fare clic su Salva.

Le immagini vengono salvate nella cartella specificata con i nomi
assegnati dal sistema che riportano la data corrente e un numero
sequenziale. Ad esempio, GG-MM-AAAA Immagine 001.jpg, GG-MM-
AAAA Immagine 002.jpg, ecc.
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Copiare e incollare uno schermo

E possibile selezionare uno schermo catturato e copiarlo negli Appunti per
includerlo in altri documenti o applicazioni. Gli schermi copiati possono essere
anche stampati. Gli schermi copiati sono catturati al livello di zoom 100% e
vengono copiati nell'ordine in cui sono selezionati.

copia diuno schermo

1. Selezionare lo schermo da copiare.
=

2. Cliccare su o0 Modifica > Copia.

Lo schermo selezionato viene copiato negli Appunti.

Inserimento di uno schermo
A seconda dell'applicazione che si sta incollando, fare clic su Modifica >
Incolla.

Nota: & anche possibile trascinare uno schermo catturato in un'altra
applicazione. Il trascinamento puo essere utilizzato come "Copia e Incolla".
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Utilizzo di Presentatore dal vivo

Nel software per insegnanti TI-Nspire™ Navigator™, Presentatore dal vivo
consente agli insegnanti di proiettare e presentare operazioni in tempo reale
su un palmare selezionato, di proiettare lo schermo del proprio palmare o
quello di qualsiasi studente per mostrare il lavoro mano a mano che viene
svolto e di spiegare il procedimento passo passo alla classe. Durante la
presentazione dal vivo, & possibile visualizzare il palmare TI-Nspire™
corrispondente allo schermo mostrato e i tasti mano a mano che vengono
premuti dal presentatore.

Gli insegnanti possono anche impostare cid che viene visualizzato sullo
schermo della presentazione: il nome dello studente, lo schermo del palmare o
la cronologia dei tasti premuti. Inoltre possono registrare la sessione di
Presentatore dal vivo e salvare il file come filmato per riutilizzarlo in seguito.

Mentre Presentatore dal vivo € attivo, i palmari di tutti gli altri studenti non sono
coinvolti nella presentazione e possono essere utilizzati.

Visualizzazione e occultamento dei nomi degli studenti

Se ne é impostata la visualizzazione, il nome dello studente appare sotto lo
schermo del palmare in Presentatore dal vivo.

Utilizzo di Presentatore dalvivo 159



Baker, Susan

| start Recording Show Handheld Show Keypress History

I nome dello studente viene visualizzato nello stesso formato selezionato in
Cattura classe. Se si seleziona di visualizzare o di nascondere i nomi degli
studenti in Cattura classe, il nome dello studente verra visualizzato o nascosto
in Presentatore dal vivo.

Per nascondere il nome dello studente in Presentatore dal vivo:

[v] show Student Names

» Deselezionare facendo clic sulla casella di

controllo.

I nome dello studente viene nascosto.

Visualizzazione e occultamento del palmare del
presentatore

Per impostazione predefinita, il palmare viene visualizzato all'avvio di
Presentatore dal vivo. Il palmare visualizzato consente alla classe di vedere i
tasti che vengono premuti durante la presentazione. Quando il palmare &
visualizzato:
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+ Il tasto diventa rosso nel display in modo che la classe possa seguire il
presentatore mentre preme il tasto.

» L'ultimo tasto premuto rimane evidenziato fino a quando non ne viene
premuto un altro.

* Non é possibile premere o fare clic sui tasti nel display del palmare.
Questo display riproduce solo le pressioni dei tasti che il presentatore
effettua sul proprio palmare.

Occultamento del display del palmare

» Pernascondere il palmare, deselezionare Visualizza palmare nella barra
Opzioni di visualizzazione.

Il palmare viene nascosto e nel riquadro di sinistra viene mostrata la
cronologia tasti.

Ti-Nspire Navigator Teacher Software Class Capture
File Edit View

I}
Baker, Susan

| startRecording [ ] Show Handheld [v] Show Keypress History

Visualizzazione del palmare

» Se il palmare € nascosto, selezionare Visualizza palmare per visualizzare il
palmare del presentatore nel riquadro di sinistra.

Il palmare viene visualizzato nel riquadro di sinistra e sotto lo schermo del
palmare viene visualizzato il riquadro Cronologia tasti, se selezionato.
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Visualizzazione della Cronologia tasti

Per impostazione predefinita, il riquadro Cronologia tasti viene visualizzato
sotto lo schermo del palmare all'avvio di Presentatore dal vivo.

Mano a mano che vengono premuti durante la presentazione dal vivo, i
tasti appaiono nel riquadro Cronologia tasti.

| tasti premuti vengono visualizzati da sinistra a destra, quindi dall'alto in
basso.

Se il presentatore preme piu volte lo stesso tasto, ogni ripetizione del tasto
appare anche nel riquadro Cronologia tasti. Se il presentatore preme e
mantiene premuto un solo tasto (per esempio quando si sposta il cursore),
quel tasto viene registrato una sola volta.

E possibile copiare negli Appunti i tasti catturati nel riquadro Cronologia
tasti e successivamente incollarne le immagini in un altro documento. E
anche possibile cancellare il contenuto del riquadro Cronologia tasti.
(Questa operazione non puo essere eseguita dagli studenti).

Durante sessioni particolarmente lunghe di Presentatore dal vivo, i tasti
premuti possono estendersi oltre I'area di visualizzazione. In questi casi,
appare una barra di scorrimento che consente di rivedere tutti i tasti
premuti durante la sessione.

Occultamento della Cronologia tasti

>

Per nascondere il riquadro Cronologia tasti, deselezionare Visualizza
cronologia tasti.

Il riquadro Cronologia tasti viene chiuso.
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TI-nspire CX

P statRecording [+ Show Handheld (| Show Keypress History

Visualizzazione della Cronologia tasti

» Seil riquadro Cronologia tasti € nascosto, fare clic sulla casella di controllo
per selezionare Visualizza Cronologia tasti.

+ Seil palmare ¢ visualizzato, il riquadro Cronologia tasti viene aperto
sotto lo schermo del palmare del presentatore.

+ Seil palmare non ¢ visualizzato, il riquadro Cronologia tasti viene
aperto a sinistra dello schermo del palmare del presentatore.

Copia della Cronologia tasti

E possibile copiare negli Appunti i tasti catturati nel riquadro Cronologia tasti,
quindi copiare le immagini dei tasti in un documento di Microsoft® Word o in
una presentazione di PowerPoint.

1. Nelriquadro Cronologia tasti, selezionare i tasti da copiare.

2. Selezionare Modifica > Copia oppure Ctrl + C (Macintosh®: # + C).
Le immagini dei tasti vengono copiate negli Appunti.

Cancellazione della Cronologia tasti

Per cancellare il contenuto del riquadro Cronologia tasti:

» Selezionare Visualizza > Presentatore dal vivo > Cancella Cronologia tasti.

| tasti visualizzati nel riquadro Cronologia tasti vengono rimossi.
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Visualizzazione solamente dello schermo del palmare

Per visualizzare solo lo schermo del palmare del presentatore durante la
sessione di Presentatore dal vivo:

» Deselezionare le opzioni Visualizza palmare e Visualizza Cronologia tasti.
I riquadri Palmare e Cronologia tasti vengono chiusi e nella finestra
appare lo schermo del palmare.

TI-Nspire Navigator Teacher Software Class Capture

File Edit View

=] Stop Presenter [¢] Show Student Names

Baker, Susan

| startRecording || ShowHandheld [ | Show Keypress History

Registrazione della presentazione dal vivo

E possibile registrare e salvare come filmato (file .avi) la presentazione dal
vivo. | filmati sono utili per presentare spiegazioni alla classe, per fornire
ulteriori dettagli su concetti difficili oppure per offrire la possibilita di vedere la
lezione agli studenti che non erano presenti. Quando si registra la
presentazione, viene catturato solamente lo schermo del palmare. Non
vengono registrati il display del palmare e i tasti premuti. Quando si salva una
presentazione registrata, il file viene salvato con I'estensione .avi (Audio Video
Interleave).
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Avvio della registrazione

» Fareclicsu oppure selezionare Visualizza > Presentatore dal
vivo > Avvia registrazione.
La registrazione inizia. Una volta premuto, il pulsante si modifica in
Interrompi registrazione. Tutto il lavoro del presentatore sullo schermo del
palmare viene registrato fino a quando non si interrompe la registrazione.

Interruzione e salvataggio della registrazione

Completare la procedura seguente per interrompere la registrazione e salvare
il file del filmato.

1. Fareclicsu oppure selezionare Visualizza > Presentatore dal
vivo > Interrompi registrazione.
Viene visualizzata la finestra di dialogo Salva. Il nome predefinito per il
filmato & "presentation” e la cartella predefinita per il salvataggio € la
cartella della classe attiva. E possibile modificare sia il nome del file sia la
cartella di salvataggio.

Nota: se non si desidera salvare la registrazione, fare clic su Annulla.

Save In: [ Math 101

File Name:  |presentation.avi

Files of Type: I.A\\\a’l file {*.avi)

| Save || Cancel |

2. Evidenziare la cartella in cui si desidera salvare il file .avi, se diversa dalla
cartella predefinita.

3. Digitare un nuovo nome per il file.
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4. Fare clic su Salva.

Il file viene salvato nella cartella designata.

Riproduzione e condivisione della registrazione

Dopo aver salvato la registrazione come file .avi, € possibile riprodurla sul
computer. E anche possibile inviare il file come allegato email.

Per riprodurre la registrazione sul computer:

1. Utilizzando la finestra di gestione file, accedere alla cartella in cui & stato
salvato il file (.avi) della presentazione.

2. Fare doppio clic sul nome del file .avi.
Viene aperto il riproduttore predefinito e viene riprodotto il filmato.

Nota: se il formato file .avi non & compatibile con il riproduttore predefinito,
viene visualizzato un messaggio di errore.

Interruzione di Presentatore dal vivo

) _ _ Stop Presenter
» Perinterrompere Presentatore dal vivo, fare clic su

oppure selezionare Visualizza > Presentatore dal vivo > Interrompi
Presenter.

La finestra della presentazione viene chiusa e viene visualizzata l'area di
lavoro Classe. La classe € sempre attiva. Quando si & pronti per terminare

End Class |

la classe, fare clic su
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Utilizzo dell'area di lavoro Documenti

Utilizzare quest'area di lavoro per creare, modificare e visualizzare documenti
TI-Nspire™ e PublishView™ e per spiegare concetti matematici.

Esplorazione dell'area di lavoro Documenti
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© Casella degli strumenti Documenti. Contiene strumenti quali il menu

Strumenti del documento, I'Ordinatore pagine, I'emulatore
TI-SmartView™, Utilitd ed Esplora contenuto. Fare clic su ciascuna
icona per accedere agli strumenti disponibili. Quando si lavora in un
documento TI-Nspire™, gli strumenti disponibili sono specifici di quel
documento. Quando si lavora in un documento PublishView™, gli
strumenti sono specifici di quel tipo di documento.

Riquadro Casella degli strumenti.. Visualizza le opzioni dello
strumento selezionato. Ad esempio, fare clic sull'icona Strumenti del
documento per accedere agli strumenti necessari per lavorare con
I'applicazione attiva.

Nota: in TI-Nspire™ Teacher Software, quando si inserisce una
domanda, lo strumento per la creazione delle domande viene aperto
in quest'area. Per ulteriori informazioni, vedere Utilizzo di Domanda
in Software TlI-Nspire™ per insegnanti.

Area di lavoro. Mostra il documento corrente e consente di svolgere
calcoli, inserire applicazioni e aggiungere pagine e attivita. E attivo
un solo documento (selezionato) alla volta. Gli altri documenti sono
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visualizzati come schede.

O Informazioni sul documento. Mostra il nome di tutti i documenti aperti.
Quando vi sono troppi documenti aperti da elencare, fare clic sulle
frecce avanti e indietro per scorrere i documenti aperti.

Utilizzo della Casella degli strumenti Documenti

La Casella degli strumenti Documenti, a sinistra nell'area di lavoro, contiene gli
strumenti necessari per lavorare sia con documenti TI-Nspire™ che
PublishView™. Quando si fa clic sulliicona di uno strumento, gli strumenti ad
esso associati vengono visualizzati nel riquadro Casella degli strumenti.

Documents Toolbox

Esplorazione di Strumenti del documento

Nell'esempio che segue, il menu Strumenti del documento & aperto e mostra le
opzioni dell'applicazione Calcolatrice. Nei documenti TI-Nspire™, il menu
Strumenti del documento contiene gli strumenti disponibili per lavorare con
un'applicazione. Gli strumenti sono specifici per lI'applicazione attiva.

In un documento PublishView™, il menu Strumenti del documento contiene gli
strumenti necessari per inserire applicazioni TI-Nspire™ e documenti
TI-Nspire™ cosi come oggetti multimediali, quali riquadri di testo, immagini e
link a siti web e file. Per ulteriori informazioni, vedere Operazioni con
documenti di PublishView™.
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o Documents Toolbox
2 & __ .

Calculator B 9
f-+/_1:.£\|:1i0ns L4
9 %D_S 2:Number >
X= 3Algebra »
fd 4:Calculus »
%y sProbability ,
X G:Statistics ,
o Bl 7:Matrix & Vector »
$€ 8Finance 4
gag 9Functions & Programs L4

Menu della Casella degli strumenti Documenti.

®eQ

Strumenti disponibili per I'applicazione Calcolatrice. Fare clic su p per
aprire il sottomenu di ciascuna opzione.

o »
Fare clicsu “ perchiudere e fare clicsu ™ per aprire gli
Strumenti del documento.

Esplorazione dell'Ordinatore pagine

L'esempio che segue mostra la Casella degli strumenti Documenti con
I'Ordinatore pagine aperto. Utilizzare I'Ordinatore pagine:

* Pervisualizzare il numero di attivita nel documento e la pagina attiva.
* Per passare da una pagina all'altra, fare clic sulla pagina desiderata.

+ Consente di aggiungere, tagliare, copiare e incollare attivita all'interno
dello stesso documento o tra documenti.

Nota: quando si lavora in un documento PublishView™, I'Ordinatore pagine
non ¢ disponibile nella Casella degli strumenti Documenti.
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Documents Toolbox
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Menu della Casella degli strumenti Documenti.

®eQ

Fare clic sul segno meno per comprimere la vista. Fare clic sul segno
+ per aprire la vista e visualizzare le pagine nel documento.

Barra di scorrimento. La barra di scorrimento € attiva solo quando ci
sono piu pagine di quante ne possa mostrare il pannello.

Esplorazione della funzione TI-SmartView™

La funzione TI-Smartview™ emula il funzionamento del palmare. Nel software
per insegnanti, il palmare emulato facilita le presentazioni in classe. Nel
software per studenti, la tastiera emulata fornisce agli studenti la possibilita di
utilizzare il software come sul palmare.

Nota: il contenuto viene visualizzato nello schermo piccolo di TI-Smartview™
solo quando il documento & in modalita palmare.
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Quando si lavora in un documento PublishView™, 'emulatore TI-SmartView™
non é disponibile.

Nota: la seguente figura mostra il riquadro TI-SmartView™ nel software per
insegnanti. Nel software per studenti, € mostrata solo la tastiera. Per ulteriori
informazioni, fare riferimento a Utilizzo dell'emulatore di TI-SmartView™.

Documents Toolbox

® -
@ 2 - |Handheld + SideScreen ~ | 9

n-tispire C

Menu della Casella degli strumenti Documenti.

®Q

Selettore palmare. Fare clic su w per selezionare il palmare da
mostrare nel riquadro:

*  TI-Nspire™ CX o TI-Nspire™ CX CAS
*  TI-Nspire™ Touchpad o TI-Nspire™ CAS con touchpad
*  TI-Nspire™ Clickpad o TI-Nspire™ CAS con clickpad

Quindi selezionare come visualizzare il palmare:
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« Normale
. Contrasto elevato

. Profilo

@® Selettore vista. Nel softiware per insegnanti, fare clic su w per

selezionare la vista del palmare:

*  Solo palmare

+ Tastiera + Schermo affiancato

+  Palmare + Schermo affiancato

Nota: & possibile modificare queste opzioni anche nella finestra

Opzioni di TI-SmartView™. Fare clic su File> Impostazioni >
TI-Opzioni Smartview™ per aprire la finestra.

Nota: il selettore vista non & disponibile nel software per studenti.

Se & attiva la vista Solo palmare, selezionare Sempre in primo piano
per mantenere il palmare in primo piano rispetto a tutte le altre
applicazioni. (solo software per insegnanti).

Esplorazione di Esplora contenuto

Utilizzare Esplora contenuto:

Per visualizzare un elenco dei file presenti sul computer.
Per creare e gestire unita didattiche.
Se si utilizza un software che supporta palmari collegati, & possibile:

- Visualizzare un elenco dei file presenti su qualsiasi palmare
collegato.

- Aggiornare il SO sui palmari collegati.

- Trasferire file tra un computer e i palmari collegati.
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Nota: se si utilizza un software TI-Nspire™ che non supporta palmari collegati,
l'intestazione Palmare collegato non si visualizzera nel riquadro Esplora
contenuto.

Documents Toolbox

9 ) Backups
1 Calculatar

O @

» s « 5

Lookin: |TI-Mspire v] O

©

E4 computer
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) Downloads
) Examples
) Foldert
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) Graphs
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& Connected Handhelds P

Lookin: [Conneded Handhelds - v @

Mame =
& Ti-Nspire CX 2342

Menu della Casella degli strumenti Documenti.

Mostra i file presenti sul computer e il nome della cartella in cui sono
memorizzati. Fare clic su w per passare a un'altra cartella sul computer.

Elenco di cartelle e di file all'interno della cartella specificata nel campo
Cerca in:. Fare clic con il pulsante destro del mouse su un file o una
cartella evidenziati per aprire il menu contestuale che elenca le azioni
disponibili per il file o la cartella.

3

..
Fare clic su per chiudere I'elenco dei file. Fare clicsu =™ per aprire
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I'elenco dei file.
0 « Menu Opzioni. Fare clic su w per aprire il menu delle azioni che si
possono eseguire su un file selezionato:
»  Aprire un file o una cartella esistenti.
»  Salire di un livello nella gerarchia delle cartelle
+  Creare una nuova cartella.
«  Creare una nuova unita didattica.
* Rinominare un file o una cartella.
+  Copiare un file 0 una cartella selezionati.
* Incollare un file o una cartella copiati negli Appunti.
*  Eliminare un file o una cartella selezionati.
+ Selezionare tutti i file di una cartella.
»  Creare pacchetti di unita didattiche.
+ Aggiornare la vista.
* Installare SO.
@ Palmari collegati. Elenca i palmari collegati. L'elenco conterra piu palmari

se ci sono piu palmari collegati al computer oppure se si utilizzano le
TI-Nspire™ Docking Station.

@ Nome del palmare collegato. Per mostrare le cartelle e i file di un
palmare, fare doppio clic sul nome del palmare.
Fare clic su w per passare a un'altra cartella sul palmare.

Esplorazione di Utilita

Il pannello Utilita fornisce accesso a modelli e operatori matematici, simboli
speciali, elementi del catalogo e librerie necessarie quando si lavora con i
documenti. Nell'esempio che segue, € aperta la scheda Modelli matematici.
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Documents Toolbox
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© Menu della Casella degli strumenti Documenti.

@ | modelli matematici sono aperti. Fare doppio clic su un modello per
inserirlo in un documento. Fare clic sulla scheda Modelli matematici

per chiudere la vista dei modelli.

Per aprire i simboli, il catalogo, gli operatori matematici e le librerie,

fare clic sulla scheda.

© Casella di controllo Wizards On (Procedure guidate attive).
Selezionare questa opzione per utilizzare una procedura guidata per

inserire gli argomenti di una funzione.

@ Schede per l'apertura di viste in cui & possibile selezionare e inserire
in un documento simboli, elementi del catalogo, operatori matematici,
elementi delle librerie. Fare clic sulla scheda per aprire la vista.
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Utilizzo dell'area di lavoro

L'area a destra dell'area di lavoro rappresenta lo spazio in cui creare
documenti TI-Nspire™ e PublishView™ e lavorare con essi. Quest'area di lavoro
fornisce una vista del documento in cui & possibile aggiungere pagine, inserire
applicazioni e svolgere tutto il lavoro. E attivo un solo documento alla volta.

Quando si crea un documento, &€ necessario specificare le sue dimensioni
pagina come Palmare o Computer. Questo mostra come la pagina viene
visualizzata nell'area di lavoro.

* Le dimensioni pagina Palmare sono ottimizzate per gli schermi di
dimensioni ridotte di un palmare. Queste dimensioni pagina possono
essere visualizzate su palmari, schermi di computer e tablet. Il contenuto &
scalato quando viene visualizzato su uno schermo piu ampio.

* Le dimensioni Computer sfruttano lo spazio piu ampio dello schermo di un
computer. Questi documenti possono mostrare dettagli senza che siano
necessari troppi scorrimenti. Il contenuto non € scalato quando viene
visualizzato su un palmare.

E possibile cambiare I'anteprima di pagina per visualizzare in che modo il

documento apparira nelle dimensioni pagina diverse.

» Per cambiare I'anteprima di pagina, fare clic su Anteprima documento nella
barra degli strumenti e quindi fare clic su Palmare o Computer.

I - o | )
| B | B msen - @ -

® - Q M - é - | TI-Nspire Sans 11 ~| A A B I

J
-
Il

Click the up or down arrow key‘co change a,
h, and k. How does each affect the graph?

<] Co—
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Per maggiori informazioni sulle dimensioni pagina e sull'anteprima del
documento, fare riferimento a Operazioni con i documenti di TI-Nspire™.

Modifica delle impostazioni documento

Le impostazioni documento regolano la modalita di visualizzazione di tutti i
numeri, compresi elementi o matrici e liste, nei documenti di TI-Nspire™ e
PublishView™. E possibile modificare le impostazioni predefinite in qualsiasi
momento, nonché selezionare impostazioni per un documento specifico.

Madifica delle impostazioni documento

1. Creare un nuovo documento o aprirne uno esistente.
2. Dal menu File di TI-Nspire™, selezionare

Impostazioni > Impostazioni documento.

Viene visualizzata la finestra Impostazioni documento.

Quando si apre questa finestra per la prima volta, vengono visualizzate le
impostazioni predefinite.

3. Premere Tab oppure utilizzare il mouse per spostarsi nell'elenco delle
impostazioni. Fare clic su w per aprire I'elenco a discesa e visualizzare i
valori disponibili per ciascuna impostazione.

Campo Valore

Float (Mobile)

*  Float1 - Float12 (Mobile1 - Mobile12)
+  Fix0 - Fix12 (FissaO0 - Fissa12)
Angolo + Radiante

+ Grado

+ Gradiante

Mostra cifre

Formato *+ Normale
esponenziale|.  Scientifica

*+ Tecnica
Formato * Reale
reale o * Rettangolare
complesso Polare
Modalita  Auto
calcolo
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Campo

Valore

CAS: Esatto

Approssima

Nota: il modo Auto mostra qualsiasi risultato che non sia un
numero intero in forma frazionaria, a meno che nell'attivita
sia usato un decimale. Il modo Esatto (CAS) mostra in
formato frazionario o simbolico qualsiasi risultato che non
sia un numero intero, a meno che nell'attivita sia usato un
numero decimale.

Formato
vettoriale

Rettangolare
Cilindrico
Sferico

Base

Decimali
Esa
Binario

Sistema di
unita (CAS)

SI
Inglese/USA

Fare clic sull'impostazione desiderata.

Scegliere una delle seguenti opzioni:

»  Perapplicare impostazioni personalizzate a TUTTI i documenti, fare
clic su Rendi predefinito.

+  Perapplicare le impostazioni solo al documento aperto, fare clic su

OK.

« Perripristinare le impostazioni predefinite, fare clic su Ripristina.

+  Fare clic su Annulla per chiudere la finestra di dialogo senza
effettuare modifiche.

Modifica delle impostazioni di Grafici & geometria

Le impostazioni di Grafici & geometria regolano la modalita di visualizzazione
delle informazioni nelle attivitd aperte e nelle successive nuove attivita.
Quando si modificano le impostazioni di Grafici & geometria, le nuove
selezioni diventano le impostazioni predefinite.
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Completare la procedura seguente per personalizzare le impostazioni di

grafici e geometria.

1. Creare un nuovo documento grafici e geometria o aprire un documento

esistente.

2. Nella casella degli strumenti Documenti, fare clic su ‘ﬁ‘? per aprire il menu
dell'applicazione Grafici & geometria.

3. Fare clic su Impostazioni> Impostazioni.

Viene visualizzata la finestra di dialogo Impostazioni di Grafici &

geometria.

Graphing Angle: IRadian - |

Geometry Angle: IDegree -

[ Automatically hide plot labels

[l Show axis end values

[[] Show tool tips for function manipulation

[] Automatically find points of interest

'\ Restore | iake Defaut | ok | cancel |

4. Premere Tab oppure utilizzare il mouse per spostarsi nell'elenco delle
impostazioni. Fare clic su ) per aprire I'elenco a discesa e visualizzare i
valori disponibili per ciascuna impostazione.

Campo
Mostra cifre

Valori

Auto
Float (Mobile)

Float1 - Float12 (Mobile1 -
Mobile12)

Fix0 - Fix12 (Fissa0 - Fissa12)

Graphing Angle (Angolo Grafico)

Auto
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Campo

Valori
. Radiante
. Grado

*  Gradiante

Geometry Angle (Angolo Geometria) |

Auto
. Radiante
« Grado

e Gradiante

5. Selezionare l'impostazione desiderata.

6. Selezionare una casella di controllo per abilitare un'opzione o cancellarne
il segno di spunta per disabilitare la relativa opzione.

le etichette del
grafico

Casella di Quando ¢ selezionata

controllo

Nascondi Le etichette del grafico vengono visualizzate solo
automaticamente quando sono selezionate, afferrate o ci si sofferma

sopra con il puntatore del mouse.

Mostra valori finali
assi

Viene visualizzata un'etichetta numerica in
corrispondenza dei valori minore e maggiore visibili
Su un asse.

Mostra
suggerimenti per
la manipolazione

Mostra informazioni utili mentre si manipolano i grafici
delle funzioni.

punti di interesse

di funzioni
Trova Mostra gli zeri, i punti di minimo e i punti di massimo di
automaticamente funzioni e oggetti rappresentati graficamente mentre si

percorrono i grafici delle funzioni.

7. Scegliere una delle seguenti opzioni:

»  Perapplicare le impostazioni personalizzate a TUTTI i documenti
grafici e geometria, fare clic su Rendi predefinito.
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Per applicare le impostazioni solo al documento aperto, fare clic su
OK.

Per ripristinare le impostazioni predefinite, fare clic su Ripristina.

Fare clic su Annulla per chiudere la finestra di dialogo senza
effettuare modifiche.
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Utilizzo di Domanda nel software per insegnanti

L'applicazione Question (Domanda) nel Software per insegnanti consente di
creare domande a scelta multipla, risposta aperta, equazioni, espressioni,
punti di coordinate, liste, immagini e domande di chimica.

Gli studenti non possono creare domande, ma possono aprire documenti
contenenti domande, rispondere alle domande e verificare il proprio lavoro in
modalitd Controllo-automatico.

L'applicazione Question (Domanda) si trova nel menu Inserisci nell'area di
lavoro Documenti.

& -5 o -E [ Ensent - €3 5 | @ Document Preview - | )
Documents Toolbox % A- = B 6
) “r e -
Question =
@ - el 1.1 ‘P *Unsaved <
&” 1.Clear Answers 3
[ 2:Check Answer 4
JE 3insert 3
M 2:Format r = OlA
-
[&]5:Teacher Toal Palette » ols
e Configuration 2 olc
~ Muliple Choice Properties olp
Response Type: | Single Respon... ~ |
¥ Correct Answer
x
A | ~| | “pocumentt x| <> @

@ Menu Inserisci. Fare clic su Inserisci e selezionare Domanda per
aggiungere una domanda o selezionare Immagine per aggiungere
un'immagine a una domanda.

@ Strumenti documento. Fare clic su questa icona per aprire il riquadro
casella degli strumenti.

@ Strumento Domanda. Contiene gli strumenti disponibili per lavorare con
l'applicazione Domanda.

@ Strumento Configurazione. Permette di impostare alcune proprieta per
ognhi domanda inserita.

@ Area Domanda. Il luogo in cui vengono digitate le domande e visualizzate
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le risposte dello studente.

@® Barra degli strumenti di formattazione. Consente di applicare la
formattazione al testo.

@ Anteprima documento. Visualizzare il documento in modalita Palmare o
Computer. L'anteprima cambia ma non le dimensioni della pagina. Per
maggiori informazioni sull'anteprima del documento, vedere Operazioni
con i documenti di TI-Nspire™.

Nozioni fondamentali sulla barra degli strumenti di
Domanda
Quando si aggiunge una domanda, si apre I'applicazione Domanda. Se

L
necessario, fare clic su Strumenti Domanda ¢ per aprire il menu degli
strumenti.

Nota: La Tavolozza strumenti dell'insegnante non sara disponibile per gli
studenti.

Nome Strumento Descrizione Strumento

~¢’| Cancellale Consente allinsegnante o allo studente di
B risposte eliminare le risposte nella domanda o nel
documento corrente.

Controlla Se si seleziona Controllo automatico

risposta (Autovalutazione) come tipo di documento nella
finestra di dialogo Proprieta domanda, gli
studenti possono verificare la risposta alla
domanda.

"\L,.E Inserisci Consente allinsegnante o allo studente di
— inserire una casella di espressione o di
equazione chimica nella domanda o nella

risposta.
A“l Formato Consente all'insegnante o allo studente di
formattare il testo selezionato come apice o

pedice. (Il iquadro equazione chimica utilizza il
suo strumento di formattazione, quindi questo
strumento Formato non funziona nella finestra di
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Nome Strumento Descrizione Strumento

equazione chimica.)

[ f‘\] Tavolozza Consente di aggiungere le informazioni sul
- strumenti copyright e imposta il tipo di documento come
dellinsegnante  Controllo-automatico (Autovalutazione) o Esame.

Utilizzo del menu Inserisci

Il menu Inserisci negli strumenti Documento consente di aggiungere riquadri di
=k H-

espressioni matematiche i.5.i e di equazione chimica all'area Domanda,

Risposta suggerita o Correggi risposta di alcuni tipi di domande. Nei tipi di

domande che consentono espressioni matematiche o equazioni chimiche,

posizionare il cursore nel punto in cui si desidera inserire la casella e quindi

seguire i passaggi seguenti.

1. Aprire lo strumento Domanda.
2. Fare clic su Inserisci > Riquadro espressione o Riquadro chimica.

Il software inserisce una casella vuota nel punto in cui & posizionato il
cursore.

3. Digitare I'espressione matematica o I'equazione chimica desiderata e
quindi fare clic all'esterno della casella per continuare a digitare il testo.

Utilizzo della Tavolozza strumenti dell'Insegnante

La Tavolozza strumenti dell'insegnante consente di aggiungere le informazioni
sul copyright e impostare il tipo di documento come Controllo automatico
(Autovalutazione) o Esame.

Aggiunta di informazioni sul copyright

Utilizzare la finestra di dialogo Proprieta domande per aggiungere le
informazioni relative al copyright sulla domanda corrente.
]
[&]

1. Fare clic sull'icona Tavolozza strumenti dell'insegnante
domande.

> Proprieta

Viene visualizzata la finestra di dialogo Proprieta domande.
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Question Properties

Author I |

Copyright | - |

Year ICJ |

|
Owner |

Document Properties

Document Type |Exam - |

[ OK l Cancel |

2. Digitare il nome dell'autore e spostarsi sul campo Copyright.

Nota: Il software TI-Nspire™ consente di utilizzare domande formulate da
piu di un autore nello stesso documento. Di conseguenza, le informazioni
immesse sull'autore e sul copyright non sono globali. E necessario
immettere informazioni rilevanti per ogni domanda diversa.

3. Selezionare se la domanda € di dominio pubblico o dispone di un
copyright assegnato e passare al campo Anno.

4. Digitare I'anno nel quale la domanda é stata protetta dai diritti d'autore e
passare al campo Proprietario. Se si sta proteggendo con i diritti d'autore
una nuova domanda, digitare I'anno corrente (esempio: 2012).

5. Digitare il nome della persona o l'ente che tutela il copyright.

6. Fare clic su OK.

Impostare Tipi di documento Controllo automatico ed Esame

Quando si definisce un documento come Controllo automatico o Esame, tutte
le domande in quel documento vengono segnalate come Controllo automatico
o Esame.
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* Quando viene definito il tipo di documento come Controllo automatico, gli
studenti possono verificare le risposte confrontandole con quelle fornite
dallinsegnante.

* Nella modalita Esame, quando viene immessa una risposta suggerita a
una domanda, gli studenti non possono verificare le risposte. E possibile
utilizzare la modalita Esame per valutare automaticamente le risposte

degli studenti.
[&]

1. Fare clic sull'icona Tavolozza strumenti dell'insegnante
domande.

> Proprieta

2. Nel campo Tipo di documento, fare clic su Esame o Controllo automatico
(Autovalutazione).

3. Fare clic su OK.

Nozioni fondamentali sullo strumento Configurazione

Lo strumento Configurazione consente di impostare alcune proprieta
specifiche per ogni tipo di domanda inserita. Le proprieta includono il tipo di
risposta, il numero delle risposte (se applicabile), la risposta corretta e altre
opzioni.

Ad esempio, € possibile specificare la risposta corretta a una domanda,
impostare la scala, gli assi e la griglia su un grafico. E possibile aggiungere
un'espressione matematica bidimensionale alle tipologie di domande che
contengono un campo Risposta corretta.

Ogni tipologia di domanda dispone di un set di opzioni univoco. Le opzioni per
ogni tipo di domanda sono spiegate nella sezione Aggiunta di domande.

Le impostazioni di configurazione rimangono inalterate quando si copia e
incolla una domanda da un documento all'altro.

Aggiunta di opzioni di configurazione

1. Fare clic sulla freccia giu nella barra di Configurazione nella casella degli
strumenti Documenti per aprire lo strumento Configurazione.
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Documents Toolbox

| Question ¥ |
E Configuration (_i

2. Fare clic sulla freccia giu accanto alle scelte che si desidera modificare e
digitare il testo applicabile.

-

Configuration

¥ (Open Response Properties

Fesponse Type: [Text Match (scored) = l

* Correct Answer

”Ir'}pe correct word or phrase here

lgnore case

3. Chiudere il pannello di configurazione. Le opzioni scelte vengono salvate
nel momento in cui viene salvato il documento.

Formattazione di Testo e Oggetti

Utilizzare gli strumenti di formattazione del testo per formattare il testo nelle
sezioni delle domande che consentono I'immissione di testo.

La barra degli strumenti di formattazione contiene inoltre I'icona Strumenti del

documento %\a per fornire un facile accesso agli strumenti Domanda e
Configurazione.
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Per ulteriori informazioni sulla formattazione di testi e oggetti, vedere
Operazioni con documenti di TI-Nspire™.

Aggiunta di immagini alle domande

E possibile aggiungere immagini nell'area di testo Domande della maggior
parte delle domande. Per alcune tipologie di domande, € possibile aggiungere
un'immagine nell'area Risposte studenti o Risposte suggerite di una domanda.

E possibile aggiungere immagini come supporto visivo al fine di spiegare il
contesto della domanda o come sfondo di un grafico.
Scegliere I'immagine da una selezione presente sul computer o copiare e

incollare un'immagine da un'applicazione diversa nell'area di testo Domande.
Per ulteriori informazioni, vedere Operazioni con immagini.

Tipi di immagini disponibili
Le seguenti tipologie di file possono essere utilizzate nell'applicazione
Domande:

* Jpg

*  Jpeg
. .bmp
* .png

Nota: La funzione Transparency (Trasparenza) dei file .png non &
supportata. Qualsiasi sfondo .png trasparente verra visualizzato come
bianco

Aggiunta di immagini utilizzando il comando Inserisci

1. Fare clic su Inserisci > immagine.

Si visualizza la finestra di dialogo Inserisci immagine.
2. Spostarsi nella posizione dellimmagine e selezionarla.
3. Fareclic su Apri.

L'immagine viene visualizzata nella domanda.
Aggiunta di immagini utilizzando gli Appunti

Per copiare un'immagine negli Appunti da un documento TI-Nspire™, file
immagine, o un altro programma, premere Ctrl + C (Mac®: # + C).

Perincollare Iimmagine alla domanda, premere Ctrl + V (Mac®: & + V).
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Aggiunta di domande

E possibile aggiungere le seguenti tipologie di domande:

»  Scelta multipla

- Personalizzato

- ABCD

- Vero/Falso

- Si/No

- Sempre/A volte/Mai

- D’accordo/In disaccordo

- Totalmente d'accordo...Totalmente in disaccordo
* Risposta aperta

- Spiegazione (non valutata in automatico)

- Corrispondenza del testo (valutata in automatico)
* Equazioni ed espressioni

- y=

- f(x)=

- Espressione
» Coordinate di punti e liste

- inputnumerico (x,y)

- Indica puntoli

- Listal/Liste
*+ Immagine

- Etichetta

- Puntosu
+ Chimica

Quando si seleziona un tipo di domanda, nella parte inferiore della finestra di
dialogo Scegli tipo di domanda viene visualizzata una breve descrizione della
domanda.
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Choose Question Type...

Multiple Choice
Custom Choice
True/False
Yes/No
Always/Sometimes/Never
Agres/Disagres
Strongly Agree... Strongly Disagree

Open Response
Explanaticn
Text Match

Equations and Expressions
¥=
flxp=
Expression

Coordinate Points & Lists
{x. y) Numerical Input
Drop Points
List{s)

Image
Label
Point on

Chemistry

Insert a Multiple Choice question containing the
choices of A B, C, and D. You can change the
choices to fit your needs. Also, this question can be
single or multi-response.

| Insert || Cancel |

Quando viene aperto un modello di domanda, il cursore si trova nell'Area di
testo della domanda.

Aggiunta di una domanda a scelta multipla

Questo esempio mostra come aggiungere una domanda a scelta multipla
personalizzata. Una domanda a scelta multipla personalizzata consente di
specificare risposte che gli studenti possono selezionare. E possibile
selezionare una o piu risposte corrette per una valutazione piu semplice o
facilitare gli studenti nella verifica delle domande in modalita Controllo
automatico.
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Which of the following are roots of x2=97
Mark all that apply.

oooooDoao

Per aggiungere una domanda a scelta multipla personalizzata:
1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

N

Fare clic su Scelta personalizzata sotto il titolo Scelta multipla .
3. Fare clic su Inserisci.

I modello Scelta personalizzata viene aperto con il cursore nell'Area testo
domanda.

Per impostazione predefinita sono presenti due opzioni nel modello.

&

Digitare la domanda.

+  E possibile digitare qualunque combinazione di testo, espressione
matematica ed equazione chimica nell'’Area domanda e nell'Area
risposta suggerita.

+  E possibile aggiungere unimmagine nell'area testo domanda.

5. Premere Enter per aggiungere un'altra domanda o Tab per andare al
primo pulsante di scelta Risposta corretta.

o

Digitare le opzioni di risposta. Aggiungere un'immagine, se lo si desidera.

7. Premere Enter per aggiungere altre opzioni di risposta e aggiungere il
testo di risposta.
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* Premere il tasto Canc (Elimina) per cancellare o eliminare una
risposta.

+  Utilizzare il tasto di arretramento (Backspace) per eliminare una
risposta.

8. Se sidesidera, fare clic sull'opzione accanto alla risposta suggerita.

Nota: Nella modalita Controllo automatico (Autovalutazione), lo studente
puo verificare la propria risposta confrontandola con la risposta suggerita.

9. Aprire lo strumento Configurazione. Scegliere il tipo di risposta e fare clic
sull'opzione che corrisponde alla risposta corretta.

Aggiunta di una domanda a risposta aperta

Una domanda a risposta aperta richiede allo studente di scriverne la risposta.
Una tipologia di domanda a spiegazione consente agli studenti di rispondere
senza risposte predefinite. Una tipologia di domanda a corrispondenze
consente all'insegnante di specificare le risposte tra cui lo studente dovra
optare per quella corretta. Le domande a corrispondenza sono valutate
automaticamente; le domande a risposta aperta non sono valutate
automaticamente.

Cne word that describes two lines that never meet but are in the same
plane;

Questo esempio mostra come aggiungere una domanda a risposta aperta.
1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.
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2. Fare clic su Spiegazione sotto a Risposta aperta.
3. Fare clic su Inserisci.

Il modello Risposta aperta viene aperto con il cursore nell'Area testo
domanda.

4. Digitare la domanda.

+  E possibile digitare qualunque combinazione di testo, espressione
matematica ed equazione chimica nell'’Area domanda e nell'Area
risposta suggerita.

+  E possibile aggiungere unimmagine nell'area testo domanda.

+  Utilizzare il tasto Tab o il cursore del mouse per passare da un campo
all'altro.

5. Aprire lo strumento Configurazione. Selezionare la tipologia di risposta
come Explanation (Spiegazione) o Text Match (Corrispondenza di testo) e
digitare la risposta corretta.

+ Latipologia di risposta Spiegazione consente allo studente di fornire
le risposte che si avvicinano alla risposta suggerita.

+ Latipologia dirisposta Corrispondenza di testo richiede allo studente
di abbinare esattamente le risposte suggerite. Selezionare la casella
Ignore case (Ignora maiuscole) se le maiuscole non sono importanti.

+  E possibile digitare qualsiasi combinazione di testo, espressione
matematica ed equazione chimica nell'area Risposta corretta.

Aggiunta di un'equazione

Un'equazione richiede allo studente di scrivere un'equazione nella forma y=o f
(x)=, o di rispondere con un humero o un'espressione.

Questo esempio mostra come aggiungere una domanda y=.
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Expand the right side of the 6.67 1»
equation:
y =[x+ 3)fx - 5]

v=|

-10 1 10

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.
2. Selezionare y= sotto Equazioni ed espressioni.
3. Fare clic su Inserisci.

I modello di equazione viene aperto con il cursore nell'Area testo
domanda.

4. Digitare la domanda.

+  E possibile digitare qualunque combinazione di testo, espressione
matematica ed equazione chimica nell'area Domanda.

+  E possibile aggiungere un'immagine nell'area testo domanda.

» Utilizzare il tasto Tab o il cursore del mouse per passare da un campo
all'altro.

Se lo si desidera, immettere una risposta suggerita.

Premere Enter per aggiungere altre opzioni di risposta e aggiungere il
testo di risposta.

* Premereil tasto Canc (Elimina) per cancellare o eliminare una
risposta.

* Premere il tasto di arretramento (Backspace) per eliminare una
risposta.
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7. Aprire lo strumento di configurazione per impostare il numero di risposte,
la risposta corretta e se gli studenti devono visualizzare il lavoro. Inoltre, &
possibile aggiungere un grafico che verra visualizzato nell'area Domanda.

Configuration *

* Equation Properties

Fesponse Type: I].r:—*-"l
Mumber of responses: ﬁ
Include a Graph Preview

Prompt Location ILeﬂ - |

I:I Allow students to show their work

* Correct Answer

Accepted response(s):

I |
v=|x2-2.-15 @Y S
D Accept equivalent responses as ...

How does this work?

* Il numero delle risposte pud variare da 1 a 5.

* L'opzione Mostra il tuo lavoro include le aree per gli studenti al fine di
scrivere il loro punto di partenza, il loro percorso e la risposta finale.
L'opzione per visualizzare il lavoro viene disabilitata se sono
consentite le risposte multiple.

» Peraggiungere un grafico all'area Domanda, selezionare la casella
Includi anteprima grafico. L'area testo Domanda viene divisa per
mostrare un grafico a destra.
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»  Per aggiungere funzioni, nel grafico & disponibile la casella degli
strumenti Grafici e geometria.

Nota: solo l'insegnante pu6 modificare il grafico. Gli studenti possono
solo visualizzare ed eseguire lo zoom del grafico.

«  Fare clicsu W per aggiungere ulteriori campi per risposte multiple
corrette. Ad esempio, € possibile accettare sia y=(x+1)(x+2) e y=(x+2)
(x+1) come risposte corrette.

»  Selezionare se accettare 0 meno risposte equivalenti come corrette.

- Se Accetta le risposte equivalenti come corrette non &
contrassegnata, la risposta dello studente & contrassegnata
corretta se c'é€ un'esatta corrispondenza di testo con una delle
risposte accettate inserite.

- Se Accetta le risposte equivalenti come corrette € contrassegnata,
la risposta dello studente € valutata corretta se € equivalente a
qualsiasi risposta accettata inserita. Per esempio, se si digitato
Xx+2 come risposta corretta e lo studente invia 2+x, questa
risposta equivale alla risposta accettata e viene automaticamente
valutata corretta. Vengono ignorati gli spazi, le differenze tra
maiuscole e minuscole, le parentesi in piu quando il software
valuta le risposte dello studente. Per esempio, y=2x+1 viene
valutato come Y =2X + 1.

Aggiunta di una domanda Espressione

Una domanda Espressione avvisa lo studente di rispondere con un valore
numerico o un'espressione.
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The dog walker earns $12 per hour, and she spends $2 on gas getting to
and from her client's house. She walks the dog for 30 minutes each day.
Write an expression showing how much money she earns in one day.

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.
2. Fare clic su Espressione sotto Equazioni ed espressioni.
3. Fare clic su Inserisci.

Il modello Espressione viene aperto con il cursore nell'Area testo
Domanda.

4. Digitare la domanda.

+  E possibile digitare qualunque combinazione di testo, espressione
matematica ed equazione chimica nell'area Domanda.

+  E possibile aggiungere un'immagine nell'area Domanda.

5. Se lo si desidera, inserire un'espressione iniziale nella risposta tipo di
Espressione. Lo studente visualizza l'espressione iniziale.

6. Se lo si desidera, immettere una risposta suggerita.

»  Se si stabilisce che il tipo di risposta sia Numero, i campi della
risposta saranno caselle matematiche e accetteranno solo valori
numerici quali 1/3.

» Se siimposta il tipo di risposta come Espressione, i campi di risposta

sono caselle di espressioni e accettano solo inserimenti di
espressioni quali 2(3+5).
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Aprire lo strumento Configurazione per impostare il tipo di risposta come
Numero o Espressione, la risposta corretta e se gli studenti devono o
meno visualizzare il lavoro. E inoltre possibile impostare una tolleranza
per i tipi di Numero o risposte equivalenti per i tipi di Espressione.

¥ Expression Properties

Response Type: IE:{pressinn - |

D Allow students to show their work

* Correct Answer

Accepted expression response(s)

IE_' |

2 noe

2 |

Accept equivalent responses as

How does this work?

* L'opzione Mostra il tuo lavoro include le aree per gli studenti al fine di
scrivere il loro punto di partenza, il loro percorso e la risposta finale.

* Nellarisposta di tipo Numero, inserire la risposta numerica accettata e
la tolleranza. Qualsiasi riposta dello studente & contrassegnata come
corretta se rientra nell'intervallo di tolleranza specificato.

»  Specificare una tolleranza pari a zero indica che si sta cercando la
risposta del numero esatto. Non specificare una tolleranza & uguale a
specificare una tolleranza pari a zero.

Utilizzo diDomanda nel software perinsegnanti 199



* Lerisposte degli studenti sono considerate corrette se equivalgono
numericamente alla risposta corretta. Vengono ignorati gli spazi, le
differenze tra maiuscole e minuscole, le parentesi in piu quando il
software valuta le risposte dello studente.

* Nella risposta di tipo Espressione, & possibile aggiungere ulteriori
campi (fino a 10) per risposte multiple corrette.

* Nella risposta di tipo Espressione, fare clic su = per aprire il
catalogo Modelli e simboli, che consente di immettere le espressioni
di matematica bidimensionali.

* Nella risposta di tipo Espressione, & possibile selezionare se
accettare o meno risposte equivalenti come corrette.

- Se Accetta le risposte equivalenti come corrette non &
contrassegnata, la risposta dello studente & contrassegnata
corretta se c'é€ un'esatta corrispondenza di testo con una delle
risposte accettate inserite.

- Se Accetta le risposte equivalenti come corrette € contrassegnata,
la risposta dello studente € valutata corretta se € equivalente a
qualsiasi risposta accettata inserita. Per esempio, se si digitato
x+2 come risposta corretta e lo studente invia 2+x, questa
risposta equivale alla risposta accettata e viene automaticamente
valutata corretta. Vengono ignorati gli spazi, le differenze tra
maiuscole e minuscole, le parentesi in piu quando il software
valuta le risposte dello studente. Ad esempio, x+2 viene valutato
come X + 2.

Importante: gli studenti possono inserire I'espressione iniziale
fornita e far valutare automaticamente questa risposta come
corretta. Per esempio, se si & chiesto agli studenti di fattorizzare
x2-7x+12 e viene impostato (x-3)(x-4) come risposta corretta, lo
studente pud inviare una risposta di x>-7x+12. Questa risposta
equivale alla risposta accettata e sara automaticamente valutata
corretta. E necessario contrassegnare manualmente questa
risposta errata dello studente nelle aree di lavoro Revisione o
Portfolio. Vedere i capitoli per queste aree di lavoro per maggiori
informazioni su come contrassegnare e valutare le risposte.
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Aggiunta di una domanda a input numerico (x,y)

Una domanda a input numerico (x,y) avvisa gli studenti di rispondere con una
coordinata.

Write the ardered pair for 0Ty
each given peoint in order: J,
N, P .
N

C LD 1

C LD 0 : 3

C LD

-
Y10

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.
2. Fare clic su input numerico (x,y) sotto Coordinate di punti e liste.
3. Fare clic su Inserisci.

I modello viene aperto con il cursore nell'Area testo domanda.
4. Digitare la domanda.

+  E possibile digitare qualunque combinazione di testo, espressione
matematica ed equazione chimica nell'area Domanda.

+  E possibile aggiungere unimmagine nell'area Domanda.

» Utilizzare il tasto Tab o il cursore del mouse per passare da un campo
all'altro.

5. Selo sidesidera, immettere una risposta suggerita.

* lcampi dirisposta sono caselle di espressioni e accettano solo gli
input delle espressioni.
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6. Premere Enter per aggiungere altre opzioni di risposta (fino a cinque) e
aggiungere il testo di risposta.

* Premere il tasto Canc (Elimina) per cancellare o eliminare una
risposta.

» Utilizzare il tasto di arretramento (Backspace) per eliminare una
risposta.

7. Aprire lo strumento Configurazione per impostare il numero di punti,
aggiungere un'anteprima di un grafico, immettere la risposta corretta e
stabilire le risposte equivalenti corrette.

* Coordinate Point Properties

Mumber of Points: '3
D Include a Graph Preview

Prompt Location o

* Correct Answer

Acceptable Answer(s):

E |
(I ; ©e

"

(3 '

k 6O
(6 |

- o e

D Accept equivalent responses as ..
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* Il numero di punti puo variare da 1 a 5.

«  Fare clicsu W per aggiungere ulteriori campi per risposte multiple
corrette. E possibile digitare qualsiasi combinazione di testo,
espressione matematica ed equazione chimica nei campi di risposta
corretti.

* Fareclicsu 5] per aprire il catalogo Modelli e simboli, che consente
di immettere le espressioni di matematica bidimensionali.

+  Peraggiungere un grafico all'area Domanda, selezionare la casella
Includi anteprima grafico. L'area testo Domanda viene divisa per
mostrare un grafico a destra e I'area di prompt dello studente a
sinistra. Per cambiare la posizione del grafico, fare clic sulla freccia
giu accanto a Posizione del prompt e scegliere la posizione
desiderata per il grafico nell'area di prompt dello studente.

. Per aggiungere funzioni, nel grafico sono disponibili gli strumenti
Grafici e geometria.

Nota: solo l'insegnante pu6 modificare il grafico. Gli studenti possono
solo visualizzare ed eseguire lo zoom del grafico.

+ Selezionare se accettare 0 meno risposte equivalenti come corrette.

- Se Accetta le risposte equivalenti come corrette non &
contrassegnata, la risposta dello studente & contrassegnata
corretta se c'é un'esatta corrispondenza di testo con una delle
risposte accettate inserite.

- Se Accetta le risposte equivalenti come corrette € contrassegnata,
la risposta dello studente € valutata corretta se € equivalente a
qualsiasi risposta accettata inserita. Per esempio, se si € digitato
(-0,5, ,75) come risposta corretta € lo studente invia (-,5,,75) o
(-1/2, 3/4) e cosi via, questa risposta equivale alla risposta
accettata e sara automaticamente valutata corretta.

Aggiungere una domanda Indica punti

Una domanda indica punti inserisce un grafico e avvisa gli studenti di indicare
i punti sul grafico nella risposta alla domanda.
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Plot the following peints on the 15.06 Ty
coordinate grid.

(6.2)
(0.2)
(0.-4)

10 1 10

-15.06

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.
2. Seleziona Indica punti sotto Coordinate punti e Liste.
3. Fare clic su Inserisci.

I modello indica punti viene aperto con il cursore nell'area testo
Domanda.

Il grafico si trova nell'area di risposta studente.

»  Per aggiungere funzioni, nel grafico sono disponibile gli strumenti
Grafici e geometria.

Nota: solo l'insegnante pu6 modificare il grafico. Gli studenti possono
solo visualizzare, eseguire lo zoom o posizionare punti nel grafico.

4. Digitare la domanda.

+  E possibile digitare qualunque combinazione di testo, espressione
matematica ed equazione chimica nell'area Domanda.

+  E possibile aggiungere unimmagine nell'area Domanda.

» Utilizzare il tasto Tab o il cursore del mouse per passare da un campo
all'altro.

5. Aprire lo strumento di configurazione per impostare il numero di punti,
nascondere o mostrare le coordinate e immettere una risposta corretta.
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* Il numero di punti puo variare da 1 a 5.

» Lavisualizzazione delle coordinate viene disattivata per impostazione
predefinita. Selezionare la casella di controllo per visualizzare le
coordinate nel grafico.

+ Fareclicsu “ per aggiungere ulteriori campi per risposte multiple
corrette. E possibile digitare qualsiasi combinazione di testo,
espressione matematica ed equazione chimica nei campi di risposta
corretti.

* Fareclicsu 5] per aprire il catalogo Modelli e simboli, che consente
di immettere le espressioni di matematica bidimensionali.

Aggiunta di una domanda Liste

Una domanda Liste inserisce una lista e avvisa gli studenti di inserire dati nelle
liste in risposta alla domanda.

3

Submit the following data - distance Bltime
distance in miles between home

and work (distance) and the

travel time in minutes (time)

£

1. Fare clic su Inserisci > Domanda.
Si apre la finestra di dialogo Scegli tipo di domanda.

2. Selezionare Listalliste alla domanda Coordinate di punti e liste dalla
finestra di dialogo Scegli tipo di domanda.

3. Fareclic su Inserisci.

I modello Liste viene aperto con il cursore nell'area testo Domanda.
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4. Digitare la domanda.

«  E possibile aggiungere colonne e righe, modificare il nome delle liste
e inserire dati nelle liste, utilizzando le stesse funzioni consentite
nell'applicazione Foglio elettronico.
5. Se lo si desidera, immettere i dati iniziali nelle liste.
6. Aprire lo strumento Configurazione per impostare il numero di liste per le
risposte dello studente.
* Il numero delle liste puo variare da 1 a 5.

. Le liste devono avere un nome. Questi nomi predefiniti sono List1,
List2 e cosi via.

Aggiunta di un'immagine: Domanda etichetta

Un'immagine: La domanda etichetta inserisce un'immagine. E possibile
aggiungere degli spazi vuoti all'immagine e chiedere agli studenti di riempire
gli spazi vuoti con la risposta.

Label the Earth's layers.

1. Fare clic su Inserisci > Domanda.
Si apre la finestra di dialogo Scegli tipo di domanda.
Selezionare Etichetta sotto Immagine.

Fare clic su Inserisci.
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L'Immagine: Il modello Etichetta viene visualizzato con uno sfondo bianco
e un'etichetta. Questo € il punto in cui I'immagine per la domanda viene
inserita.

Digitare la domanda.

+  E possibile digitare qualunque combinazione di testo, espressione
matematica ed equazione chimica nell'area Domanda.

* Premere Tab o usare il cursore del mouse per passare da un campo
all'altro.

Inserire un'immagine nella parte inferiore del modello della domanda.

Aprire lo strumento Configurazione per impostare il numero di risposte e
inserire le risposte per ogni etichetta.

kel

Configuration

* Image Analysis Question Properties

Mumber of Hesponses: '4

* Answers
| |
A | crust [EE|
[
g  mantle B8] |
l outer core |
C (B
[ - |
D | INner core [EE |

Ignore Case
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* Il numero di risposte determina il numero di etichette sullimmagine.
Ogni nuova risposta da all'etichetta un identificatore unico, quale per
esempio A, B, C, e cosi via. Trascinare le etichette nella posizione
desiderata sull'immagine.

Nota: se si impostano piu di 26 risposte, le etichette sono identificate
con numeri, partendo da 1. E possibile inserire un massimo di 35
etichette.

* Nell'area della risposta, fare clic su E] per aprire il catalogo Modelli e
simboli, che consente di immettere le espressioni di matematica
bidimensionali.

+ Se il testo dell'etichetta & troppo grande per adeguarsi alle
dimensione dell'etichetta predefinite, afferrare e trascinare i bordi
dell'etichetta per ridimensionarla.

7. Selo sidesidera, digitare una risposta suggerita nelle etichette.
Selezionare la casella Ignora maiuscole se le maiuscole non sono
importanti.

«  E possibile digitare qualunque combinazione di testo, espressione
matematica ed equazione chimica nell'area Risposta.

* Quando si digita una risposta suggerita, un'immagine "fantasma" della
risposta appare nella rispettiva etichetta sullimmagine. Se la risposta
suggerita € troppo grande per adeguarsi alle dimensione
dell'etichetta predefinite, afferrare e trascinare i bordi dell'etichetta per
ridimensionarla.

Aggiunta di un'immagine: Domanda punto su

Un'immagine: La domanda punto su inserisce un'immagine. Aggiungere una
casella di controllo allimmagine e fare inserire un segno di spunta agli studenti
nelle caselle corrette in risposta alla domanda.
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responsible for photosynthesis.

The picture below shows a plant cell. Identify which organelle is ‘
i

Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

Selezionare Punto su sotto Immagine.

Fare clic su Inserisci.

L'Immagine: Il modello Punto su si visualizza con uno sfondo vuoto e un
punto. Questo € il punto in cui l'immagine per la domanda viene inserita.

Digitare la domanda.

E possibile digitare qualunque combinazione di testo, espressione
matematica ed equazione chimica nell'area Domanda.

Premere Tab o usare il cursore del mouse per passare da un campo
all'altro.

Aprire lo strumento Configurazione per impostare la tipologia di risposta, il

numero di risposte e la risposta corretta.

La Tipologia di risposta trasforma il punto in un cerchio per Risposta
singola e cambia in un quadrato per Risposte multiple per indicare
agli studenti la possibilita di selezionare piu caselle.

Il numero di risposte determina il numero di punti sull'immagine. Ogni
nuova risposta da al punto un identificatore unico, quale per esempio
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A, B, C e cosi via. Trascinare i punti nella posizione desiderata
sullimmagine.

Nota: se si impostano piu di 26 risposte, i punti sono identificati con
numeri, partendo da 1. E possibile inserire un massimo di 35 punti.

6. Selo sidesidera, fare clic su uno o piu punti come risposta suggerita.

Aggiunta di una domanda sulla Chimica

Quando si aggiunge una domanda sulla Chimica, gli studenti rispondono con
una formula chimica o un'equazione.

Balance the following equation:
I + H: » ITHs

1. Fare clic su Inserisci > Domanda.

Si apre la finestra di dialogo Scegli tipo di domanda.

Fare clic su Chimica.

Fare clic su Inserisci.

I modello Chimica viene aperto con il cursore nell'area testo Domanda.
4. Digitare la domanda.

+  E possibile digitare qualunque combinazione di testo, espressione
matematica ed equazione chimica nell'area Domanda.

+  E possibile aggiungere uniimmagine nell'area Domanda.

5. Se lo si desidera, immettere una risposta suggerita.
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Aprire lo strumento Configurazione per immettere la risposta corretta.

Fare clic su ib per aggiungere ulteriori campi per risposte multiple
corrette. E necessario inserire tutte le possibili risposte. Il software non
valuta I'equivalenza per le risposte sulla Chimica.
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Test degli studenti

Lo strumento di test rapido abilita il test degli studenti Un test € un questionario
mandato agli studenti che viene ricevuto in tempo reale sui loro palmari o
portatili. Una volta ricevuto il test, gli studenti possono mandare risposte al
computer. Test rapido € disponibile in tutte le aree di lavoro. Quando
I'insegnante riceve le risposte degli studenti, puo utilizzare I'area di lavoro
Revisione per controllarle.

Content Documents Review Portfolio [rigonomeiy | -EndClass—{=

8 8- §0==T-BEBN K (T @ F-R A
Documents Toolbox -
=~ Problem 1 -
D Which of these is not a rational number? Choose all that 2pply =
gl;
aff Ofo734
=l e =
3
| O3
S| ol
[J]3.33333
1
) J¢] 2
Find o scoe o o T S
e b I ] 0 | - | | #2Trigonomety pa7 0301 x| ]

e,

Quando si fa clic sullicona del Test rapido lIEJ da qualsiasi area di lavoro,
I'area di lavoro Documenti si apre e si pud cominciare il test rapido.
Cominciare il test rapido apre l'area di lavoro Revisione Si pud cambiare 'area
di lavoro mentre si sta completando il test, ma si pud fermare il test solo dalle
aree di lavoro Documenti o Revisione.
E possibile inviare i seguenti tipi di domande:
+  Scelta multipla

- Risposta personalizzata

- ABCD

- Vero/Falso

- Si/No
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Quando si seleziona una tipologia di domanda, viene visualizzata una breve
spiegazione della domanda in fondo alla finestra di dialogo Scegli tipo di

- Sempre /A volte / Mai

- D’accordo/In disaccordo

- Totalmente d'accordo...Totalmente in disaccordo
Risposta aperta

- Spiegazione (non valutata in automatico)

- Corrispondenza del testo (valutata in automatico)
Equazioni ed espressioni

- y=

- f(x)=

-  Espressione

Coordinate di punti e liste

- (%, y) Input numerico

- Colloca punti

- Lista/(liste)

Immagine

- Etichetta

- Puntosu

Chimica

domanda.

Apertura dello strumento Test rapido

Si pud aprire lo strumento di test rapido da qualsiasi area di lavoro. Si pud
mandare un test da un documento esistente o se ne pud aprire uno nuovo per

iniziare un test.

Prima di cominciare, accertarsi che per la classe ci sia una sessione attiva.

1.

Al

=

Si apre la finestra di dialogo Scegli tipo di domanda.

Fare clic su Strumenti > Test Rapido o click
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Choose Question Type...

Multiple Choice
Custom Choice
True/False
Yes/No
Always/Sometimes/Never
Agree/Disagree
Strongly Agree... Strongly Disagree
Open Response
Explanation
Text Match
Equations and Expressions

y=
fix
Expressicn
Coordinate Points & Lists
{=, ¥) Numerical Input
Drop Points
List(s)
Image
Label
Peint on

Chemistry

—=——| Insert a Multiple Choice guestion containing the

—— | Choices of A, B, C, and D. You can change the

="' choices ta fit your needs. Also, this question can be
single or multi-response.

[ele]elel

Cancel

Selezionare un tipo di domanda e fare clic su Inserisci.

Viene aperto un nuovo documento con il modello di domanda ed il
cursore posizionato nella casella di testo della domanda.
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| True
() |False

Viene assegnato un nome ai documenti di test rapido <Nome della classe,
#di gruppo del test rapido, mm-dd.tns>. Ad esempio: Algebra1 - Mrs. Smith
QP2 10-26.tns. Questi documenti possono essere rinominati in fase di
salvataggio.

Nota: Tutti i test rapidi per una sessione di classe sono contenuti su una
scheda nell'area di lavoro Documenti Una nuova scheda viene iniziata
quando il numero di domande in un test & superiore a 30 o quando si
inizia una nuova sessione di classe.

Nota: Per ulteriori informazioni a riguardo dei tipi di domande e della
creazione e configurazione di domande, fare riferimento a Uso di
domande nel software dell'insegnante.

Invio di un Test rapido

Dopo aver selezionato la domanda di Test rapido ed aver inserito i dati e le
eventuali opzioni, si € pronti per inviare il test agli studenti.

» Perinviare la domanda di Test rapido, fare clic su Avvia test @

Il test viene mandato agli studenti immediatamente. Quando si invia un Test
rapido agli studenti, questo interrompe il documento TI-Nspire™ attivo e il Test
rapido diventa il documento attivo.
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E possibile interrompere un test e riavviarlo in qualsiasi momento.

Utilizzo delle Opzioni Test rapido

Quando il test rapido € attivo, il menu Strumenti > Opzioni test Rapido sono
attivati. Le opzioni disponibili variano a seconda del fatto che si sta usando
software che supporta palmari o portatili collegati. L'opzione Consente
accesso documenti non € disponibile in TI-Nspire™ Navigator™ NC Teacher
Software per computer in rete.

+ Consente accesso documenti Consente di concedere o negare agli
studenti I'accesso agli Appunti ed a tutti i documenti presenti sul loro
palmare. Gli studenti possono accedere a un documento, svolgere alcuni
calcoli matematici e copiare i risultati nel test.

Nota: se al computer o al palmare viene collegato un sensore per
I'acquisizione di dati durante un Test rapido in cui I'opzione Consenti
accesso ai documenti & disabilitata, il Test rapido viene chiuso e viene
avviata l'acquisizione dei dati.

+ Consenti nuovo invio. Permette agli studenti di inviare diverse volte le loro
risposte.

Arresto Test

E possibile interrompere i test in qualsiasi momento. Gli studenti non devono
fare nulla sui loro palmari o computer per interrompere il test. Una volta
interrotto il test, gli studenti non possono piu inviare le risposte.

» Perinterrompere un test, cliccare su Interrompi Test — .

Nota: se si sospende una lezione durante lI'esecuzione di Test rapido, il test
rimane nei palmari degli studenti, ma gli studenti non posso rispondere o
inviare il test fino a quando non viene ripresa la lezione. Questa opzione non &
disponibile in TI-Nspire™ Navigator™ NC Teacher Software per computer in
rete.

Reinvio Test

Si pud inviare di nuovo un test dall'area di lavoro Revisione, senza cambiare
area di lavoro o iniziare una nuova domanda.
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Il software tratta il test reinviato come un nuovo test. Gli studenti ricevono un
nuovo test sulla parte superiore del documento aperto nel loro portatile o
palmare.

| dati del test vengono trattati come nuovi dati, e non sovrascrivono i dati del
test originale.

» Perreinviare il test appena mandato, cliccare su Inizia test @
» Perreinviare il test precedente, cliccare sul test nell'ordinatore di pagine e

quindi cliccare su Inizia Test @

Il test viene aggiunto all'ordinatore di pagine nell'ordine in cui € stato inviato.
L'indicatore di pagine indica che é stato reinviato.

* (Quick Poll 3 Resent

What did you hawe for breakfast?

@|Eqas
I | Cereal

L Z|'~'~’ar‘ﬁ55
@ Mothing

Student Diata
0 of 1 waorking
0 of 1 submitted

d4|

Invio di Test agli studenti mancanti

E possibile inviare il test piu recente agli studenti che non erano connessi
prima dell'interruzione del test.

Nota: L'opzione Invia a mancanti puo essere utilizzata solo con Il'ultimo test
inviato.
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1. Nell'ordinatore di pagine, cliccare sull'ultimo test inviato.
2. Cliccare File > Invia a mancanti.

Il test viene immediatamente inviato agli studenti che non erano connessi
quando il test & stato inviato in precedenza, ma che sono attualmente
connessi.

| dati raccolti dagli studenti mancanti sono aggiunti ai dati dell'ultimo test.

Salvataggio Test

E possibile salvare i risultati del Test rapido all'area di lavoro Portfolio, mentre
il test & ancora in corso, oppure & possibile salvare una serie completa di
documenti Test rapido come un file. tns.

E possibile salvare I'area di lavoro Portfolio dalle aree di lavoro Classe e
Revisione.

Quando si salvano i risultati nell'area di lavoro Portfolio, i testinviati in una sola
sessione di classe vengono salvati in una colonna.
Una nuova colonna viene iniziata quando un test supera le 30 domande, o
quando si avvia una nuova sessione di classe.
» Per salvare un Test rapido nell'area di lavoro Portfolio, cliccare su File >
Salva in Portfolio.
Nota: dopo il primo salvataggio, le successive modifiche al test vengono
aggiornate automaticamente in Portfolio fino a quando non si interrompe il
test.
E' possibile inoltre salvare una serie di Test rapidi come documento master
(file .tns). Un documento master contiene informazioni che possono essere
utilizzate come chiave di riscontro per la valutazione delle risposte raccolte
dagli studenti.
» Per salvare un Test rapido come documento master, cliccare su File >
Salva Test rapido impostato come documento.
Nota: dopo aver salvato come file .ins, le eventuali modifiche successive
che vengono apportate al test non sono aggiornate nel documento .tns.

Visualizzazione Risultati Test

| risultati di Test rapido vengono visualizzati nell'area di lavoro Revisione
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| test inviati in una sessione di classe sono contenuti in una scheda Test rapido
nell'area di lavoro Revisione. Ogni nuova domanda & aggiunta come nuova
attivita nell'ordinatore pagine, ed il software apre automaticamente I'ultima
domanda che & stata inviata. Una nuova scheda & avviata quando il test
supera le 30 domande.

- ] Pause Class 'I

Content Class Documents Review Partfolio

& - fied - % @stuu P | [ [E] show Correct Answer

A 1.1 B8 Class ABC,
] )
he slope follows an upward direction. |
® | True
Student Data
ol /| False
0 of 1 working
0 of 1 submitted
E5Class ABC, QP Set1,03-13 x| 4 b E

| risultati possono essere visualizzati come diagramma a barre, grafico o
tabella. | risultati vengono aggiornati automaticamente mano a mano che gli
studenti inviano le risposte, fino a quando non si interrompe il test.

L'esempio seguente mostra i risultati del test presentati in forma tabellare.

Student Response
Chopra, Laxmi y=3-x
Garcia, Rafe y=x-3
Moore, Jacob y=x+3
Ortega, Carlos y=3-x
Simmons, Nadine  y=3-x

Per ulteriori informazioni sulla visualizzazione e I'ordinamento dei risultati dei
test, vedere Ultilizzo dell'area di lavoro Revisione.
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Operazioni con documenti TI-Nspire™

Tutto il lavoro creato e salvato con le applicazioni TI-Nspire™ viene
memorizzato in un documento, che pud essere condiviso con altri che
utilizzano il software TI-Nspire™ e con quanti utilizzano i palmari. Esistono due
tipi di documenti:

*  Documenti TI-Nspire™ (file .tns)

*  Documenti PublishView™ (file .tnsp)

Documenti TI-Nspire™.

Un documento TI-Nspire™ si compone di una o piu attivita. Ogni attivita
contiene una o piu pagine. Nell'area di lavoro viene visualizzata una pagina
alla volta. Tutte le operazioni si svolgono nelle pagine delle applicazioni.

Poiché il software TI-Nspire™ e i palmari condividono le medesime
funzionalita, & possibile trasferire documenti TI-Nspire™ tra computer e palmari.
Quando si crea un documento, si seleziona una delle due dimensioni di
pagina.

*  Palmare. Dimensione: 320 x 217 pixel. Questa dimensione consente di
visualizzare i documenti su tutte le piattaforme. Il contenuto sara scalato
quando viene visualizzato su un tablet o uno schermo piu ampio.

*  Computer. Dimensione: 640 x 434 pixel. Il contenuto sara scalato quando
viene visualizzato su una piattaforma piu piccola. Alcuni contenuti
potrebbero non essere visibili su un dispositivo palmare.

E possibile convertire un documento da una dimensione di pagina a un'altra in
qualsiasi momento.

Documenti PublishView™

| documenti PublishView™ possono essere stampati su un normale foglio di
carta o pubblicati in un sito web o blog. | documenti PublishView™ possono
includere testo formattato, immagini e collegamenti ipertestuali oltre a tutte le
applicazioni TI-Nspire™.

Per ulteriori informazioni, vedere Operazioni con documenti PublishView™.
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Creazione di un nuovo documento TI-Nspire™

Quando si apre per la prima volta il software, I'area di lavoro Documenti viene
visualizzata con un documento vuoto contenente un'attivita. Aggiungendo
applicazioni e contenuto a questa attivita si crea un documento.

Nota: lo schermo Benvenuto viene visualizzato quando si apre il software con
I'opzione "Mostra sempre all'avvio" selezionata. Fare clic sull'icona di

un'applicazione per inserire un'attivita con un'applicazione attiva in un nuovo
documento.

Per creare un nuovo documento, procedere come segue:
1. Sul menu File di TI-Nspire™,

+ Selezionare Nuovo documento TI-Nspire™ - Dimensioni della pagina
per palmare.

Oppure

»  Selezionare Nuovo documento TI-Nspire™ - Dimensioni della pagina
per computer.

Il nuovo documento viene aperto nell'area di lavoro Documenti con la
richiesta di selezionare un'applicazione.
- B & insent - (@) o - 1 - B Document Preiew ~

Documents Toolbox
. . A .
Fl = ¢ = = 2-£-4

Insert an application to enable this view.

=1:Add Calculator
wi2:Add Graphs
N3:Add Geometry
:|4:Add Lists & Spreadsheet
145:Add Data & Statistics
6:Add Notes

§7:Add Vernier DataQuest™
Press menu

" Documents X 4@

Page Size: Handheld | 11 | Settings zoom: [150% ~| - +

2. Selezionare un'applicazione per inserire un'attivita nel documento.
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L'attivita viene aggiunta al documento.

Apertura di un documento esistente

Per aprire un documento esistente:

1. Fare clic su File > Apri documento.

—oppure—

Fare clic su ‘JS—-J

Viene visualizzata la finestra di dialogo Apri.

| 1| EXAMPLE TNS FILES -] BA®E ||

‘ . Circles_Equation_of_a_Circle tilb E Graph.ins

Test_Lesson_Bundle_2 tilb handheld tns

. Test_Lesson_Bundle tilb Max_Area_of_Inscribed_Rectangle_in_Para
[ Active_Documenttns notes_w_image.ins
Area_Formulas tns Poll 2 05-11.tns
ircle_Radius_Area_Per_CXins
efault_themes.tns

Loak In

Fountain_Parabola tns ‘§1 publishview html tnsp
|=| Fountain_Parabola2.tns ; PublishView Test emulatortnsp
(| G&G_with_image.ins [ QPDocumenttns
4 1] I 3
File Mame 'C\rc\e_Radlus_Area_F'er_CX.ms |
Files of Type: I.NI Supported Files (*.tns; *.tnsp; *.edc; *.fig) - |
| Open | | Cancel |

2. Utilizzare la finestra di gestione file per individuare il file da aprire e fare
clic su di esso per selezionarlo.

3. Fare clic su Apri.
I documento viene aperto nell'area di lavoro.

Nota: per effettuare la selezione dai 10 documenti piu recenti, selezionare File
> Documenti recenti, quindi selezionare dall'elenco visualizzato.

Salvataggio di documenti TI-Nspire™

Per salvare un nuovo documento:

1. selezionare File > Salva documento oppure fare clic su IEI .

Viene visualizzata la finestra di dialogo Salva documento TI-Nspire™.
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Save TI-Nspire™ Document

[ ExamPLE TNS FILES -] EAdEa

Save In:

. Circles_Equation_of_a_Circle.tilb
Test_Lesson_Bundle_2 filb
Test_Lesson_Bundle tilb

| Active_Document tns

| Area_Formulas.tns

|| Circle_Radius_Area_Per_CXins
=] default_themes.ins

E Fountain_Parabola.tns QPDocumentins

=] Fountain_ParabolaZ.ins gre-example.tns

] G&G_with_imags.tns || test_split_panes.ins

4 {11 13

Graph.ins

handheld tns
Max_Area_of_Inscribed_Rectangle_in_Paral
notes_w_image tns

Poll 2 05-11.ins

|| Problem1.ins

[i] Problem2.ins

3

3

E

3

[

T

File Name: |Document1

Files of Type ‘T\—Nsp\re“‘ Documents (*.tns) - |

|-—save—| |- cancel|

2. Evidenziare la cartella in cui si desidera salvare il documento oppure
creare una cartella in cui archiviare il documento.

Digitare un nome per il documento.
Fare clic su Salva per salvare il documento.
I documento si chiude e viene salvato con estensione .tns.

Nota: quando si salva un file, la cartella in cui si salva un file sara la prima in
cui il software cerchera un qualsiasi file che si desidera aprire.

Salvataggio di un documento con un nuovo nome
Per salvare un documento gia salvato in una nuova cartella e/o con un nuovo
nome:

1. Fare clic su File > Salva con nome.
Viene visualizzata la finestra di dialogo Salva documento TI-Nspire™.

2. Evidenziare la cartella in cui si desidera salvare il documento oppure
creare una cartella in cui archiviare il documento.

Digitare un nuovo nome per il documento.

4. Fare clic su Salva per salvare il documento con un nuovo nome.

Eliminazione di documenti

| file eliminati dal computer vengono trasferiti nel Cestino e possono essere
recuperati da questo, se non & stato svuotato.
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Nota: I'eliminazione di file dal palmare € un'operazione irreversibile e non puo
essere annullata, pertanto occorre essere certi di voler eliminare i file
selezionati.

1. Selezionare il documento da eliminare.

2. Fare clic su Modifica> Elimina oppure premere Elimina.
Viene visualizzata una finestra di dialogo di avvertenza.

3. Fare clic su Si per confermare I'eliminazione.

I documento viene eliminato.

Chiusura di documenti

» Per chiudere un documento, selezionare File > Chiudi oppure fare clic
sull'icona Chiudi nella scheda del documento sul margine inferiore dello
stesso.

" Circe_Radius_Area Per 0K %~ Fowsfain_Parabola X

» Se si utilizza la vista affiancata, fare clic sullicona Chiudi nell'angolo in alto
a destra della finestra documento.

Formattazione del testo in Documenti

Utilizzare lo strumento formattazione testo per formattare il testo nelle
applicazioni TI-Nspire™ che permettono l'inserimento di testi e per formattare
un testo in documenti PublishView™. Per impostazione predefinita, si apre la
barra degli strumenti formattazione nell'area superiore di un documento attivo.
Le opzioni nella barra degli strumenti sono attivate o disattivate a seconda
dell'applicazione attiva.

Ad esempio, I'immagine seguente mostra le opzioni disponibili in un
documento attivo Grafici e geometria.

%vﬁv vA-TI-NS;,JirE&Sans 11 v |A~ A B I U A A, Ase

-
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Opzione

Funzione

Fare clic su w per aprire il menu per
I'applicazione attiva. Questo strumento
permette di aprire il menu di
un'applicazione indipendentemente
dall'opzione selezionata nella casella degli
strumenti Documenti.

Fare clic su w per scegliere un colore di
sfondo per mettere in risalto un testo o per
scegliere un colore di riempimento per una
cella selezionata.

y

Fare clic su w per scegliere il colore della
linea di un oggetto. Ad esempio, in Grafici
e geometria, € possibile scegliere il colore
per una forma selezionata.

A

Fare clic su w per selezionare un colore
per un testo selezionato.

TI-Nspire Sans

utilizzare questo strumento per scegliere un

carattere e dimensione del carattere.

* Fare clic su w per selezionare un
carattere differente dal menu a discesa.

*  Perscegliere una dimensione specifica
del carattere, fare clic su w per
selezionare una dimensione dal menu
a discesa.

«  Fareclicsu A per aumentare le
dimensioni del carattere o fare clic su

A per diminuire le dimensioni del
carattere.

Fare clic sul pulsante corrispondente per
formattare il testo in grassetto, corsivo,
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Opzione Funzione

sottolineato, apice o pedice, o barrare il
testo.

In un documento PublishView™, utilizzare
questi strumenti per posizionare il testo
nell'intestazione o pié di pagine, 0 in una

I
[
i
([T
B

casella testo. cliccando ﬁ Viene
visualizzata la finestra di dialogo
collegamento ipertestuale.

Per ulteriori informazioni, vedere
Operazioni con documenti di PublishView™.

Visualizzazione e occultamento della barra degli strumenti di

formattazione

» Quando la barra degli strumenti di formattazione é visibile, fare clic su a
(situato sotto la barra degli strumenti) per nasconderla.

» Fare clic su w per visualizzare la barra degli strumenti di formattazione
quando € nascosta.

Utilizzo dei colori nei documenti

Nelle applicazioni TI-Nspire™ che consentono una formattazione, € possibile
utilizzare il colore per le aree piene di un oggetto, o le linee e il testo, a
seconda dell'applicazione che si sta utilizzando e di come é stato selezionato
I'elemento. Se dopo aver selezionato un elemento, l'icona o la voce di menu
che si desidera utilizzare non & disponibile (grigia), la colorazione non &
disponibile per I'elemento selezionato.

Il colore viene visualizzato sul computer e nei documenti aperti sul palmare
TI-Nspire™ CX. Se si apre un documento a colori sul palmare TI-Nspire™, i
colori sono visualizzati in sfumature di grigio.

Nota: per ulteriori informazioni sull'utilizzo dei colori nell'applicazione

TI-Nspire™, vedere il capitolo appropriato.

Aggiunta di colore da un elenco
Per colorare un'area da riempire, una linea o testo, procedere come segue:
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1. selezionare I'elemento.

2. Selezionare Modifica > Colore oppure selezionare dove si desidera
aggiungere colore (riempimento, linea o testo).

3. Selezionare il colore dall'elenco.

Aggiunta di colore da una tavolozza

Per aggiungere colore utilizzando la tavolozza, procedere come segue:
1. selezionare l'oggetto.

2. Fare clic sull'icona appropriata della barra degli strumenti.

3. Selezionare il colore dalla tavolozza.

Impostazione delle dimensioni della pagina e anteprima
del documento

Quando si crea un documento, se ne specificano le dimensioni di pagina come
Palmare o Computer, in base all'uso previsto del documento. | documenti di
entrambe le dimensioni di pagina possono essere aperti su entrambe le
piattaforme ed & possibile cambiare dimensioni di pagina in qualsiasi
momento.

*  Palmare. Dimensione: 320 x 217 pixel. Questa dimensione consente di
visualizzare i documenti su tutte le piattaforme. Il contenuto sara scalato
quando viene visualizzato su un tablet o uno schermo piu ampio.

*  Computer. Dimensione: 640 x 434 pixel. Il contenuto sara scalato quando
viene visualizzato su una piattaforma piu piccola. Alcuni contenuti
potrebbero non essere visibili su un dispositivo palmare.

Nota: le dimensioni della pagina sono indipendenti dall'anteprima del
documento. Cio significa che & possibile visualizzare i documenti di entrambe
le dimensioni di pagina utilizzando I'anteprima per Palmare o Computer.

Conversione delle dimensioni di pagina del documento corrente

» Nel menu principale File di TI-Nspire™, selezionare Converti in e quindi
selezionare le dimensioni della pagina.
Il software salva il documento corrente e crea una copia che utilizza le
dimensioni di pagina richieste.
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Visualizzazione del documento nell'anteprima Palmare

1. Sulla barra degli strumenti dell'applicazione, fare clic su
Anteprima documento e selezionare Palmare.

L'anteprima cambia. Questo non comporta modifiche alle dimensioni di
pagina di base del documento.

2. (Facoltativo) Fare clic sullo strumento Zoom sotto I'area di lavoro e
selezionare un valore di ingrandimento per I'anteprima.

Visualizzazione del documento nell'anteprima Computer

1. Sulla barra degli strumenti dell'applicazione, fare clic su
Anteprima documento e selezionare Computer.

L'anteprima cambia. Questo non comporta modifiche alle dimensioni di
pagina di base del documento.

2. (Facoltativo) Fare clic sullo strumento Nitidezza sotto I'area di lavoro e
selezionare un valore per aumentare o ridurre la nitidezza di testo e altri
elementi.

Impostazione di un'anteprima predefinita

Per impostazione predefinita, quando si apre un documento, questo viene
visualizzato automaticamente utilizzando I'anteprima corrispondente alle sue
dimensioni di pagina. E possibile ignorare questa regola e specificare
un'anteprima preferita.

1. Nel menu principale File di TI-Nspire™, selezionare Impostazioni >
Impostazioni di anteprima.

2. Selezionare l'anteprima che si desidera utilizzino i documenti alla loro
apertura.

Operazioni con pit documenti

Quando sono aperti pit documenti contemporaneamente, i rispettivi nomi sono
visualizzati nelle schede nella parte inferiore dell'area di lavoro. E attivo un
solo documento alla volta, e solo il documento attivo & suscettibile ai comandi
dei menu e degli strumenti.
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Per commutare tra documenti:

(1) Fare clic sulla scheda per visualizzare un documento nell'area
di lavoro. Questo documento diventa il documento attivo. Se &
attiva la vista Mostra i documenti affiancati le schede non sono
visualizzate.

(2] Utilizzare le frecce sinistra e destra per scorrere I'elenco di
documenti. Queste frecce sono attive solo quando ci sono
molti documenti e non rientrano nella finestra.

(3] Fare clic sull'icona Mostra elenco per elencare tutti i documenti
aperti. Cio € utile quando ci sono numerosi documenti aperti e
i loro nomi sulle schede possono apparire troncati.

Operazioni con pit documenti affiancati

Quando piu documenti sono aperti contemporaneamente, le rispettive
miniature sono visualizzate nell'area di lavoro Documenti. Per modificare la
vista:

» selezionare Finestra > Mostra documenti affiancati.

| documenti aperti sono visualizzati come miniature nell'area di lavoro e la
barra di scorrimento diventa attiva.
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La barra di stato resta disponibile; tuttavia i nomi dei documenti ora appaiono
nella vista miniature. Fare clic su Seleziona finestra> Mostra documenti come
schede per visualizzare i documenti uno alla volta nell'area di lavoro.

Operazioni con le applicazioni

La prima volta che si apre un nuovo documento, o si aggiunge una nuova
attivita a un documento, selezionare un'applicazione dal menu.

La seguente illustrazione mostra come appare un'attivita con l'applicazione
Foglio & elettronico nell'area di lavoro a destra nella finestra.

Operazionicon documenti TI-Nspire™ 231



&A B C D E = G

1

2

3

A

5

6

7

8

5 =

10

1 u‘lE

A7 -

— Documents x| " Documents x| 10 B

Page Size: Computer 1|2 Seﬂilngs | Boldness 'Wl - +
(1] 2] ©®© 0 (5] 6]

(1) Nome documento. Le schede mostrano il nome di tutti i
documenti aperti. Fare clic su un nome per renderlo il
documento attivo.

(2] Dimensioni pagina. Mostra le dimensioni pagina del documento
come Palmare o Computer. E possibile utilizzare il menu File di
TI-Nspire™ per convertire un documento da una dimensione
pagina a un'altra.

(3] Contatore attivita/pagina. Il primo valore rappresenta il numero
di attivita della pagina attiva, il secondo indica il numero di
pagina all'interno dell'attivita. Nell'esempio, il contatore
visualizza 1.2, a indicare Attivita 1, Pagina 2.

(4) Impostazioni. Fare doppio clic per visualizzare o modificare le
impostazioni del documento per il documento attivo o per
modificare le impostazioni del documento predefinite.

® Zoom. Attivo solo nell'anteprima Palmare (fare clic su

Anteprima documento sulla barra degli strumenti e selezionare
Palmare). Fare clic su ¥ e selezionare un valore di
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ingrandimento per l'anteprima.

(6) Nitidezza. Attivo solo nell'anteprima Palmare (fare clic su
Anteprima documento sulla barra degli strumenti e selezionare
Computer). Fare clic su ¥ e selezionare un valore per
aumentare o ridurre la nitidezza del testo e di altri elementi.

Operazioni con piu applicazioni in una pagina

E possibile aggiungere sino a quattro applicazioni a una pagina. Quando si
aggiungono piu applicazioni a una pagina, il menu dell'applicazione attiva
appare nella Casella degli strumenti Documenti. Per poter utilizzare piu
applicazioni contemporaneamente in una stessa pagina occorre:

» modificare il layout di pagina per consentire la presenza simultanea di piu
applicazioni.

* Inserire le applicazioni.

E possibile inserire pili applicazioni contemporaneamente in una stessa
pagina anche se & gia presente un'applicazione attiva.

Inserimento di pit applicazioni in una pagina

Per impostazione predefinita, ogni pagina contiene uno spazio per inserire
una applicazione. Per inserire ulteriori applicazioni nella pagina, completare la
procedura seguente.

1. Fare clic su Modifica > Layout pagina > Seleziona layout.

—oppure—
—

Fare clic su .

Viene aperto il menu del layout pagina.

.

‘HﬂHHﬂH]‘
|
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Sono disponibili otto opzioni di layout pagina. Un'opzione selezionata viene
visualizzata in grigio.

2. Evidenziare il layout da inserire nell'attivita o nella pagina, quindi fare clic
per selezionarlo.

Il nuovo layout viene visualizzato con la prima applicazione attiva.

Click here to add an application Click here to add an application

3. Nell'anteprima Palmare, fare clic su Premere menu per selezionare
un'applicazione per ciascuna nuova sezione dell'attivita o della pagina. In
vista computer, selezionare Fare clic qui per aggiungere un’applicazione.

Scambio di applicazioni

Per spostare alcune applicazioni in una pagina contenente piu applicazioni, &
possibile "scambiare" le posizioni delle applicazioni.

1. Selezionare Modifica > Layout pagina > Scambia applicazioni.

Nota: l'ultima applicazione attiva in cui si & lavorato viene
automaticamente selezionata come la prima applicazione da scambiare.

2. Fare clic sulla seconda applicazione da spostare.
Cosi facendo si effettua lo scambio di posizione.

Nota: quando ci sono solo due aree di lavoro, I'applicazione selezionata
viene spostata automaticamente nella posizione dell'altra applicazione
nell'area di lavoro.

Per annullare lo spostamento, premere Esc.
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Selezione e spostamento di pagine

Per spostare e riorganizzare rapidamente le pagine di un documento che
contiene piu pagine, utilizzare I'Ordinatore pagine che riporta le viste in
miniatura di tutte le pagine contenute nel documento.
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(1) Ordinatore pagine. Viene visualizzato facendo clic sul

pulsante Ordinatore pagine (=) sulla Casella degli strumenti
Documenti. Visualizza le miniature di tutte le pagine in tutte le
attivita del documento corrente. Utilizzare la barra di
scorrimento per visualizzare le pagine che non rientrano nello
schermo.

(2] Pagina attiva. E |la pagina evidenziata nell'Ordinatore pagine e
attiva nell'area di lavoro

(3] Contatore attivita/pagina. Riporta il numero di attivita, seguito
dal numero di pagina.

Selezione di pagine

L'Ordinatore pagine indica la pagina attiva nell'area di lavoro.

+ Se i sta lavorando in una pagina dell'area di lavoro, tale pagina &
evidenziata da un bordo colorato.

Operazioni con documenti TI-Nspire™
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+ Sesi sta utilizzando I'Ordinatore pagine, la pagina attiva visualizzata
nell'area di lavoro appare con un bordo colorato nell'Ordinatore pagine.

+ La pagina selezionata facendo clic nell'Ordinatore pagine, diventa la
pagina attiva e viene visualizzata nell'area di lavoro.

Ridisposizione delle pagine

Utilizzare I'Ordinatore pagine per modificare I'ordine delle pagine di un'attivita.

1. Fare clic per selezionare la vista in miniatura della pagina nell'Ordinatore
pagine.

2. Trascinare la pagina nella posizione desiderata e rilasciare il pulsante del
mouse per inserirla nella nuova posizione.

Raggruppamento di applicazioni
Per raggruppare fino a quattro pagine in una sola pagina:
1. selezionare la prima pagina della serie.
2. Fare clic su Modifica > Layout pagina > Gruppo.
La seconda pagina viene raggruppata con la prima. Il layout della pagina

si modifica automaticamente per visualizzare tutte le pagine del gruppo.

Per separare le pagine:
1. Selezionare le pagine raggruppate.
2. Fare clic su Modifica > Layout pagina >Dividi .

Vengono ripristinate le singole pagine e le singole applicazioni.

Eliminazione di un'applicazione da una pagina

1. Fare clic sull'applicazione da eliminare.
2. Fare clic su Modifica > Layout pagina > Elimina app.
L'applicazione viene eliminata.
Per annullare I'eliminazione, premere Ctrl + Z (Mac®: #+ 2Z).
Eliminazione di pagine
1. Selezionare la pagina da eliminare.
2. Fare clic su Modifica >Elimina.

—oppure—

Fare clic su %
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—oppure—

Fare clic con il pulsante destro del mouse e fare clic su Elimina.

Operazioni con attivita e pagine

Quando si crea un nuovo documento, viene aggiunta un'attivita composta da
una pagina. Quando un documento contiene un'attivita con piu pagine o piu
attivita, fare clic su = per aprire l'ordinatore pagine nella Casella degli
strumenti Documenti e visualizzare attivita e pagine.

Inserimento di un'attivita in un documento
Un documento puo contenere fino a 30 attivita.
1. Fare clic su Inserisci > Attivita.

—oppure—

s n
Fare clic su

2. Fare clic su Attivita.

Nel documento viene inserita una nuova attivita con una nuova pagina.

Aggiunta di una pagina a un'attivita

Ogni attivita puo contenere fino a 50 pagine.

1. Fare clic su Inserisci > Pagina.
—oppure—

s n
Fare clic su

2. Fare clic su Pagina.
Nell'attivita corrente viene inserita una nuova pagina.

3. Selezionare un'applicazione da inserire nella pagina.

Copia e incolla di un'attivita

E possibile copiare e incollare una singola attivita da una posizione in un‘altra
all'interno dello stesso documento o di un documento diverso.

1. Fareclicsu & per aprire I'Ordinatore pagine.

2. Fare clic su un'attivita per selezionarla.
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Fare clic su Modifica > Copia o premere Ctrl + C (Mac®: # + C).
4. Spostarsi sulla posizione in cui si desidera che appaia I'attivita.
5. Fare clic su Modifica > Incolla o premere Ctrl + V (Mac®: &+ V).

L'attivita viene copiata nella nuova posizione.

Eliminazione di un'attivita

Per eliminare un'attivita dal documento:

1. Fare clic su un'attivita per selezionarla.

2. Fare clic su Modifica > Elimina o premere Ctrl+X (Mac®: ¥ + X).

L'attivita viene eliminata dal documento.

Assegnazione di un nuovo nome a un'attivita

Per rinominare un'attivita:

1. Utilizzando I'Ordinatore pagine, selezionare il nome dell'attivita.

2. Fare clic con il pulsante destro del mouse e fare clic su Rinomina.
I nome dell'attivita viene cancellato dalla casella.

3. Digitare il nuovo nome e premere Invio.

I nuovo nome appare in grassetto, a indicare che € stato modificato.

Stampa di documenti

1. Fare clic su File > Stampa.
Viene visualizzata la finestra di dialogo Stampa.
2. Impostare le opzioni per il lavoro di stampa.
+  Stampante: selezionarla dall'elenco di stampanti disponibili
* Cosa stampare:
- Stampa tutto: stampa ogni pagina su un foglio separato

- Schermo visibile: stampa le pagine selezionate con ulteriori
opzioni di formato (vedere Formato, di seguito)

* Intervallo di stampa: fare clic su Tutte le pagine o su Intervallo pagine
e impostare la pagina iniziale e la pagina finale.

. Formato:
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I'orientamento (verticale o orizzontale)

Il numero di pagine (1, 2, 4, 0 8) di TI-Nspire™ da stampare su
ogni foglio (disponibile solo per I'opzione Schermo visibile). Il
valore predefinito & 2 pagine per foglio.

Se lasciare spazio per i commenti sotto ogni pagina stampata di
TI-Nspire™ (disponibile solo per I'opzione Schermo visibile)

Margini (da 0,63 cm a 5 cm). Il margine predefinito & 1,27 cm su
tutti i bordi.

. Informazioni sulla documentazione da includere:

Nome dell'attivita, inclusa I'opzione per raggruppare le pagine
fisicamente per attivita

Etichetta pagina (come 1.1 0 1.2) sotto ogni pagina
Titolo della pagina (fino a due righe)

Nome documento nel pi¢ di pagina

3. Fare clic su Stampa oppure su Salva come PDF.

Nota: per ripristinare le impostazioni predefinite per la stampa, fare clic su

Ripristina.

Utilizzo dell'anteprima di stampa

*  Fare clic sulla casella di controllo Anteprima per attivare/disattivare il
riquadro di anteprima.

»  Fare clic sulle frecce in fondo al riquadro di anteprima per scorrere
attraverso l'anteprima.

Visualizzazione delle proprieta del documento e delle
informazioni sul copyright

Nota: la maggior parte delle presenti istruzioni si applica esclusivamente al
Teacher Software.

Controllo delle dimensioni di pagina

1. Nel Teacher Software, andare nel menu File di TI-Nspire™ e selezionare
Proprieta documento.

2. Fare clic sulla scheda Dimensioni pagina.

Operazionicon documenti TI-Nspire™ 239



3. Unsegno di spunta indica le dimensioni della pagina correnti del
documento.

Visualizzazione delle informazioni sul copyright

Il Teacher Software e lo Student Software permettono all'utente di visualizzare
le informazioni sul copyright che sono state aggiunte a un documento.

1. Nel menu File di TI-Nspire™, selezionare Visualizza informazioni sul
copyright.

Viene aperta la relativa finestra di dialogo.

Copynght Information

Author: Mr. Teacher

© 2010 Any School 15D

Document copyright applies to the entire
document

except where Question Application copyright
already

exists.

Document copyright applies to the entire
document, except where Question
Application copyright already exists.

2. Fare clic su OK per chiudere la finestra.

Aggiunta di informazioni sul copyright a un documento

Utilizzando il Teacher Software, € possibile aggiungere informazioni sul
copyright singolarmente ai documenti creati oppure applicare le stesse
informazioni sul copyright a tutti i nuovi documenti.

1. Aprire il documento.

2. Nel menu File di TI-Nspire™, selezionare Proprietd documento.
3. Fare clic sulla scheda Copyright.

4. Modificare i seguenti campi per definire i dettagli del copyright:

*  Autore
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*  Copyright (selezionare Dominio pubblico o Copyright).

*  Anno (disabilitato se ¢ stato selezionato Dominio pubblico)

*  Proprietario (disabilitato se & stato selezionato Dominio pubblico)
+ Commenti

5. Peraggiungere le informazioni specificate a tutti i nuovi documenti da un
particolare punto in poi, selezionare Applica questo copyright a tutti i nuovi
documenti.

6. Fare clic su OK per applicare le informazioni sul copyright al documento.

Protezione di un documento (impostazione sola lettura)

Gli insegnanti possono proteggere i documenti per creare un documento per la
distribuzione agli studenti o per altro uso. Se uno studente riceve un
documento di sola lettura e vi apporta modifiche, viene visualizzata una
finestra di dialogo che chiede di salvare il documento con un nuovo nome file.

1. Aprire il documento.

2. Nel menu File di TI-Nspire™, selezionare Proprieta documento.

3. Fare clic sulla scheda Protezione.

4. Selezionare la casella di controllo accanto a Imposta sola lettura.
5

Fare clic su OK.
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Operazioni con documenti PublishView™

Utilizzare la funzione PublishView™ per creare e condividere documenti
interattivi con insegnanti e studenti. E possibile creare documenti che
includano testo formattato, applicazioni TI-Nspire™, immagini, collegamenti
ipertestuali, link a video e video incorporati in un formato idoneo per la stampa
cartacea, per la pubblicazione su un sito web o un blog, oppure per I'uso in un
foglio di calcolo interattivo.

PublishView™ offre funzioni di layout e modifica per la presentazione di
concetti matematici e scientifici in un documento, in cui applicazioni TI-Nspire™
possono essere collegate interattivamente e dinamicamente con supporti che
danno vita al documento. Con PublishView™:

+ Gliinsegnanti possono creare attivita e valutazioni interattive da
visualizzare sullo schermo.

* Gliinsegnanti possono creare materiali stampati a complemento dei
documenti utilizzati nei palmari TI-Nspire™ .

+ Durante la pianificazione delle lezioni, gli insegnanti possono:
- Creare un progetto di lezione da documenti del palmare esistenti o
convertire piani di lezione in documenti del palmare.
- Creare link a piani di lezione o documenti correlati.
- Incorporare testo esplicativo, immagini, video e collegamenti a risorse
web.
- Creare o interagire con applicazioni TI-Nspire™ direttamente dal
progetto di lezione.
+  Gli studenti possono creare rapporti 0 progetti quali rapporti di laboratorio

contenenti riproduzioni di dati, adattamenti a curve, immagini e video —
tutto nello stesso foglio.

»  Gli studenti possono stampare e consegnare elaborati su fogli standard.

»  Gli studenti impegnati negli esami possono utilizzare un unico strumento
per creare un documento che contenga: tutte le attivita dell'esame, testo,
immagini, collegamenti ipertestuali o video, applicazioni TI-Nspire™
interattive, screenshot e opzioni di layout necessarie per stampare un
documento.
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Nota: | documenti PublishView™ possono essere scambiati utilizzando il
sistema TI-Nspire™ Navigator™ NC. | documenti di PublishView™ possono
essere memorizzati nell'area di lavoro Portfolio e le domande di TI-Nspire™
all'interno di un documento di PublishView™ possono essere valutate
automaticamente dal sistema TI-Nspire™ Navigator™.

Creazione di un nuovo documento PublishView™,

1. Nell'area di lavoro Documenti, selezionare File > Nuovo documento
PublishView™

—oppure—

Fare clicsu 'l e quindi su Nuovo documento PublishView™.

* Nell'area di lavoro Documenti viene aperto un documento vuoto
(modello lettera). L'orientamento del documento & verticale e non puo
essere modificato.

* L'impostazione predefinita per i margini superiore € inferiore € 2,54
cm. Non ci sono impostazioni per i margini laterali.

+ Perimpostazione predefinita, viene inserita un'attivita nel documento.

+  Perimpostazione predefinita, il documento contiene il numero di
pagina nel formato "n. di n." nella parte inferiore del foglio.

* Le barre di scorrimento a destra e in fondo al foglio sono attive.

2. Aggiungere applicazioni TI-Nspire™ e oggetti PublishView™ secondo
necessita per completare il documento.
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Informazioni sui documenti PublishView™

Quando si lavora con documenti PublishView™, & importante tenere presente
guanto segue:

* |l documenti PublishView™ vengono salvati come file .tnsp, quindi in
formato diverso dai documenti TI-Nspire™ (file .tns).

. Quando si inseriscono oggetti PublishView™ in un documento, il testo,
I'immagine, il collegamento ipertestuale o il video incorporato sono
contenuti in riquadri che possono essere spostati e ridimensionati.

» Le applicazioni TI-Nspire™ che vengono inserite funzionano allo stesso
modo delle pagine di un documento TI-Nspire™.

* Inun documento PublishView™, gli oggetti possono sovrapporsi ed &
possibile impostare I'oggetto da visualizzare in primo piano e quello sullo
sfondo.

* Gli oggetti possono essere inseriti e posizionati in un documento
PublishView™ senza vincoli particolari.

+  E possibile convertire un documento TI-Nspire™ esistente in un
documento PublishView™ (file .tnsp).

* Quando si converte un documento PublishView™ in un documento TI-
Nspire™ (file .tns) vengono convertite le applicazioni TI-Nspire™. Gli oggetti
PublishView™ contenenti testo, collegamenti ipertestuali, video e immagini
non vengono convertiti.
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* Non é possibile creare o aprire un documento PublishView™ su un
palmare. Prima di inviare un documento PublishView™ a un palmare, &
necessario convertirlo in un documento TI-Nspire™.

Esplorazione di un documento PublishView™

Il seguente esempio mostra come si possono usare applicazioni TI-Nspire™ e
oggetti PublishView™ per creare un documento PublishView™. In questo
esempio, i bordi sono attivati per mostrare i contorni degli oggetti. | bordi visibili
consentono di lavorare facilmente con gli oggetti mentre si crea un documento.
Quando si é pronti per stampare o pubblicare il documento sul web, &
possibile nascondere i bordi.

If a Tree Falls... @
Problem 1 9

[ou have all heard the joke, “If a tree falls in a forest, will anyone hear t>” In this lesson, we explore
he algebra to a falling ree and answer the question, “Ifa tree falls in your neighborhaod, will it land on
your car or house?”

1. Explore []3. Graph It g
Below, explore what happens if a 16 meter pole Graph your formula as a function.
breaks by grabbing any of the twa open circles.

[How far away from the base of the poll will the Do all the: n apply 1o the
poll hit? tion t to bound
e.
h= L]

o 10
2. Solve It 4. Application
Can you write a formula for the distance (d) in When cutting down a tree, it might be good to
lterms of height (h)? figure out where the top of the tree will land!

flx):=)256-32:x
n2+d?={16-n)2

n21d23=256-32n+12

0
<

1of1 6

© Intestazione In questo esempio, l'intestazione contiene il titolo del
documento. Quando l'area dell'intestazione & attiva, &€ possibile digitare e
formattare il testo come desiderato.

@ Interruzione e nome dell'attivita. Nei documenti PublishView™, utilizzare le
interruzioni di attivita per controllare il layout della pagina. Le interruzioni
di attivita possono essere visualizzate o nascoste. Eliminando un'attivita
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se ne rimuovono il contenuto e lo spazio che la separa dalle altre attivita,
se presenti. Le interruzioni di attivita consentono inoltre di utilizzare
variabili nei documenti PublishView™. Variabili con lo stesso nome sono
tra loro indipendenti se vengono utilizzate in attivita differenti.

© Riquadri di testo. In questo esempio, il testo introduttivo e il testo nei
riquadri 1, 2, 3 e 4 & contenuto in riquadri di testo. E possibile inserire
testo e collegamenti ipertestuali in un documento PublishView™
utilizzando un riquadro di testo. | riquadri di testo possono essere
ridimensionati e posizionati secondo necessita. | riquadri di testo di
PublishView™ non vengono mantenuti quando si converte un documento
PublishView™ in un documento TI-Nspire™.

@ Applicazioni TI-Nspire™. In questo esempio, l'autore utilizza Grafici e
geometria per mostrare le funzioni matematiche. Quando un'applicazione
TI-Nspire™ ¢ attiva in un documento PublishView™, nella Casella degli
strumenti Documenti viene aperto il menu dell'applicazione appropriata. E
possibile lavorare in un'applicazione TI-Nspire™ cosi come si farebbe in
un documento TI-Nspire™. Quando si converte un documento
PublishView™ in un documento TI-Nspire™, le applicazioni vengono
mantenute.

@ Applicazione Notes. E possibile utilizzare anche I'applicazione Notes di
TI-Nspire™ per aggiungere testo a un documento PublishView™. Poiché
Notes € un'applicazione TI-Nspire™, essa verra mantenuta quando si
converte il documento PublishView™ in un documento TI-Nspire™. Notes
consente di utilizzare un editor di equazioni in cui inserire modelli
matematici e simboli di TI-Nspire™.

@ Video. Questo & un esempio di un video incorporato in un documento
PublishView™ all'interno di una cornice. Gli utenti possono avviare e
arrestare il video tramite gli appositi controlli. Le cornici contenenti video e
immagini possono essere ridimensionate e posizionate nel documento
secondo necessita.

@ Pie di pagina. Perimpostazione predefinita, I'area del pié di pagina
contiene il numero di pagina, che non pud essere modificato. E possibile
aggiungere altro testo sopra il numero di pagina, secondo necessita.
Come per l'intestazione, € possibile formattare il testo secondo necessita.
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Utilizzo della barra di stato in un documento PublishView™

Quando un documento PublishView™ & aperto, le opzioni sulla barra di stato
sono diverse dalle opzioni visualizzate quando si lavora in un documento
TI-Nspire™.

(1) (6]

l "~ Document1 X| " Document2 X| 4 b B 6

Page Size: Computer Settings Zoom: [100% ~| - + | Boldness: [100% ~| - +

(2] (3] 4] (5]

© | nomi dei documenti sono visualizzati come schede. Se sono aperti piu
documenti contemporaneamente, i nomi dei documenti vengono elencati.
E possibile avere aperti contemporaneamente documenti TI-Nspire™ e
PublishView™. In questo esempio, Documento 1 &€ un documento

TI-Nspire™ inattivo (__). Documento 2 & il documento PublishView™ attivo
-
(__). Fare clic sull'icona X per chiudere il documento.

@ Dimensioni pagina. Mostra le dimensioni pagina del documento come
Palmare o Computer. E possibile utilizzare il menu File di TI-Nspire™ per
convertire un documento da una dimensione pagina a un'altra.

© Fare clic su Impostazioni per cambiare le Impostazioni documento. E
possibile configurare impostazioni specifiche per il documento attivo
oppure impostazioni predefinite per tutti i documenti PublishView™.
Quando si converte un documento TI-Nspire™ in un documento
PublishView™, le impostazioni del documento TI-Nspire™ vengono
convertite sulle impostazioni definite per i documenti PublishView™.

@ Usare la scala dello Zoom per ridimensionare il documento attivo da 10%
a 500%. Per impostare uno zoom, digitare un numero specifico, utilizzare i
pulsanti + e - per aumentare o diminuire con incrementi del 10%, o in
alternativa utilizzare il menu a tendina per scegliere le percentuali
predefinite.

@ Nelle applicazioni TI-Nspire™, utilizzare il cursore scorrevole Nitidezza per
aumentare o diminuire la nitidezza del testo e lo spessore di linea nelle
applicazioni. Per impostare la nitidezza, digitare un numero specifico,
utilizzare i pulsanti + e - per aumentare o diminuire con incrementi del
10%, o in alternativa utilizzare il menu a tendina per scegliere le
percentuali predefinite.
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Per gli oggetti PublishView™, la nitidezza consente di far corrispondere il
testo nelle applicazioni TI-Nspire™ al testo nel foglio PublishView™. Pud
essere utilizzata inoltre per aumentare la visibilitd delle applicazioni
TI-Nspire™ nella presentazione di un documento alla classe.

@® Quando vi sono troppi nomi di documenti aperti per essere visualizzati

sulla barra di stato, fare clic sulle frecce avanti e indietro (<] ’) per
spostarsi tra i documenti.

o Fare clic su E per visualizzare un elenco di tutti i documenti aperti.

Salvataggio di documenti PublishView™

Salvataggio di un nuovo documento

1. Fareclic su File > Salva documento.

—oppure—

Fare clic su E’ .

Viene visualizzata la finestra di dialogo Salva documento TI-Nspire™.

Save TI-Nspire Document

Save In: Ih Fublishview_Documents

[ Ifa Tree Falls v2.insp
[E quanitfying Air Resistance v2.tnsp

File Name: |Document2

Files of Type: IPLIbliShViEW Documents (*.tnsp)

|- save—| |-cancei-|

2. Spostarsi sulla cartella in cui si desidera salvare il documento.
—oppure—

Creare una cartella in cui archiviare il documento.
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3. Digitare un nuovo nome per il documento.
4. Fare clic su Salva.
Il documento si chiude e viene salvato con estensione .tnsp.

Nota: Quando si salva un file, il software utilizza la cartella in cui il file & stato
salvato per cercare il prossimo file da aprire.

Salvataggio di un documento con un nuovo nome
Per salvare un documento gia salvato in una nuova cartella e/o con un nuovo
nome:
1. Selezionare File > Salva con nome dal menu.
Viene visualizzata la finestra di dialogo Salva documento TI-Nspire™.
2. Spostarsi sulla cartella in cui si desidera salvare il documento.
—oppure—
Creare una cartella in cui archiviare il documento.
3. Digitare un nuovo nome per il documento.
4. Fare clic su Salva per salvare il documento con un nuovo nome.

Nota: E anche possibile utilizzare I'opzione Salva con nome per convertire
documenti da file TI-Nspire™ in file PublishView™ oppure per convertire file
PublishView™ in file TI-Nspire™.

Esplorazione dell'area di lavoro Documenti

Quando si crea o si apre un documento PublishView™, questo viene aperto
nell'area di lavoro Documenti. Utilizzare le opzioni di menu e la barra degli
strumenti allo stesso modo di come si userebbero in un documento TI-Nspire™
per fare quanto segue:

*  Spostarsi su cartelle e documenti esistenti utilizzando Esplora contenuto
*  Aprire documenti esistenti

+  Salvare documenti

»  Utilizzare le opzioni Copia, Incolla, Annulla e Ripeti

*  Eliminare documenti

* Accedere a menu specifici delle applicazioni TI-Nspire™

*  Aprire il menu Variabili nelle applicazioni TI-Nspire™ che accettano
variabili
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» Accedere a modelli matematici, simboli, voci del catalogo ed elementi
delle librerie e inserirli in un documento PublishView™

Nota: Per ulteriori informazioni, consultare Utilizzo dell'area di lavoro

Documenti.

Esplorazione della Casella degli strumenti Documenti

Quando un documento PublishView™ & attivo, la Casella degli strumenti
Documenti contiene gli strumenti necessari per lavorare con documenti
PublishView™. E possibile aggiungere applicazioni TI-Nspire™ a un'attivita,

inserire parti di documenti TI-Nspire™ esistenti in un'attivita e inserire oggetti

PublishView™.

La Casella degli strumenti Documenti viene aperta ogni volta che si crea un

nuovo documento PublishView™ oppure si apre un documento PublishView™

esistente. Quando si lavora in un documento PublishView™, I'Ordinatore
pagine e I'emulatore TI-SmartView™ non sono disponibili.

Documents Toolbox
e o

T-Nspire Applications g

HYNE e
0538

TI-Nspire Documents 2

Choose your working document G
=[]

PublishView™ Objects

.B

Choose your working folder

18]

@ 'n un documento PublishView™:

« Fareclicsu ‘ﬂ'@ per aprire il menu e gli strumenti dell'applicazione
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necessari per lavorare con applicazioni TI-Nspire™ e oggetti
PublishView™.

« Fareclicsu E per aprire il riquadro Utilita da cui € possibile
accedere a modelli matematici, simboli, il Catalogo, operatori
matematici e librerie.

- Fareclicsu . peraprire Esplora contenuto.

Nota: Per ulteriori informazioni, consultare Utilizzo dell'area di lavoro
Documenti.

(2] P

per espanderlo.

© Applicazioni TI-Nspire™. Spostare un'icona in un'attivitd per inserire
un'applicazione:

b

Calcolatrice

Grafico

Geometria

Foglio elettronico

E () =

Dati e statistiche

Notes
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Vernier DataQuest™

DE

Domanda (Disponibile in TI-Nspire™ Teacher Software,
TI-Nspire™ Navigator™ Teacher Software e TI-Nspire™ Navigator™ NC
Teacher Software).

O Documenti TI-Nspire™. Utilizzare questo strumento per individuare e
inserire documenti TI-Nspire™ (file .tns) in un'attivita.

@ Oggetti PublishView™. Utilizzare questo strumento per spostare i seguenti
oggetti in un'attivita:

i

Immagine

9

Video

Riquadro di testo

2F]
o
mn

Collegamento ipertestuale

Utilizzo di menu e barra degli strumenti

Quando si lavora in un documento PublishView™, selezionare opzioni dai
menu o dalla barra degli strumenti nell'area di lavoro Documenti per lavorare
con il contenuto e gli oggetti. Un oggetto inserito in un documento
PublishView™ pud essere manipolato con gli stessi strumenti che si
utilizzerebbero in un documento TI-Nspire™. Nei documenti PublishView™ &
possibile:

»  Fare clic con il pulsante destro del mouse su un oggetto per aprire un
menu contestuale con le opzioni che possono essere applicate all'oggetto.

+ Utilizzare le opzioni Aggiungi, Inserisci e Incolla per aggiungere oggetti in
un documento PublishView™.
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» Utilizzare le opzioni Elimina e Taglia per rimuovere oggetti da un
documento PublishView™.

*  Spostare oggetti da un punto in un altro all'interno di un documento
PublishView™.

+  Copiare oggetti da un documento e incollarli in un altro documento
PublishView™.

* Ridimensionare e scalare oggetti quali riquadri di testo e immagini.

*  Modificare il carattere e la dimensione e applicare al testo formattazioni
quali corsivo, grassetto, sottolineato e colore.

Nota: Per ulteriori informazioni, consultare Utilizzo dell'area di lavoro
Documenti.

Utilizzo dei menu contestuali

Nelle applicazioni TI-Nspire™ e nei documenti PublishView™, i menu
contestuali forniscono un elenco di opzioni specifiche per I'operazione che si
sta eseguendo. Ad esempio, quando si fa clic con il pulsante destro del mouse
su una cella nell'applicazione Foglio elettronico di TI-Nspire™, viene aperto un
menu contestuale con I'elenco delle azioni che si possono compiere su quella
cella. Quando si fa clic con il pulsante destro del mouse sul bordo di un
riquadro di testo in un documento PublishView™, il menu contestuale fornisce
le azioni che possono essere eseguite sul riquadro di testo.

Menu contestuali nelle applicazioni TI-Nspire™

Quando si aggiunge un'applicazione TI-Nspire™ in un documento
PublishView™, il menu dell'applicazione e i menu contestuali a essa associati
diventano disponibili e funzionano allo stesso modo che in un documento
TI-Nspire™.

Menu contestuali nei documenti PublishView™

Nei documenti PublishView™, i menu contestuali forniscono delle scorciatoie
per le operazioni di uso frequente. | menu contestuali sono specifici di un
oggetto o di un'area:

« Il menu contestuale del foglio fornisce opzioni per lavorare con il layout
del foglio e del documento.

* I menu contestuali degli oggetti forniscono opzioni per manipolare gli
oggetti stessi.

* I menu contestuali sensibili al contenuto forniscono opzioni per lavorare
con il contenuto di un oggetto, ad esempio testo o un video.
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Operazioni con oggetti PublishView™

In un documento PublishView™, il testo, i collegamenti ipertestuali e i video
sono contenuti in oggetti PublishView™. Inoltre, in un documento PublishView™
€ possibile spostare, ridimensionare, copiare, incollare ed eliminare un
oggetto. Gli oggetti possono essere anche riposizionati in modo da

sovrapporsi.

In un documento, gli oggetti PublishView™ possono esistere in tre stati: non
selezionato, selezionato e interattivo.

Stato

Descrizione

Non
selezionato

Quando non & selezionato,
un oggetto € privo di
maniglie di
riposizionamento e
ridimensionamento. Per
deselezionare un oggetto,
fare clic con il pulsante
sinistro o destro del mouse
fuori dall'oggetto.

In questo esempio, i bordi

intorno all'oggetto sono
visualizzati.

Object in an unselected state. In this
example, the object is a text box.

Selezionato

Quando e selezionato, un
oggetto & contornato da
otto maniglie quadrate. Per
selezionare un oggetto,
fare clic sul suo bordo.
Quando ¢ selezionato,
I'oggetto puod essere
spostato e ridimensionato.
* Perspostare un
oggetto, fare clic su un
bordo e trascinare
l'oggetto nella nuova
posizione.

Ohject in a selected state. In this example, the
ohject is a text box.

Operazioni con documenti PublishView™
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Stato Descrizione

*  Perridimensionare un
oggetto, afferrare una
maniglia.

« Fareclicconil
pulsante destro del
mouse sul bordo per
aprire un menu
contestuale con le
opzioni per manipolare

l'oggetto.
Interattivo Uno stato interattivo & A B B, B, =
indicato da una cornice blu M =seq(ii0

. ' 1fuo 1 0 1.

intorno all'oggetto. Per B : ETOE:

attivare lo stato interattivo, 8n max 30 2 0.857553

fare clic con il pulsante 4 E Lo P

L. 5 4 0.79348

sinistro o destro del mouse 6 5 0.701369
su un punto qualsiasi del 7 6 0.7639% o
Al |u0 4>

corpo dell'oggetto. Quando
I'oggetto € in uno stato
interattivo, € possibile
lavorare con il suo
contenuto. Ad esempio, &
possibile aggiungere o
modificare testo in un
riquadro di testo o
completare funzioni
matematiche in
un'applicazione TI-Nspire™.
In uno stato interattivo, i
menu contestuali
contengono opzioni
specifiche al contenuto di
un oggetto.
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Inserimento di un oggetto

1. Nella Casella degli strumenti Documenti, assicurarsi che il menu Oggetti
PublishView™ sia aperto.

-

PublishView™ Objects

=08

Choose your working folder

| B

2. Utilizzare il mouse per fare clic su un'icona e trascinarla nel documento.

3. Rilasciare il pulsante del mouse per inserire l'oggetto nel documento.

| u |
Type your text here.

o = | riquadri di testo e le cornici selezionate
possono essere ridimensionati, spostati,
copiati, incollati ed eliminati.

= |
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4. Utilizzando il mouse, afferrare le maniglie per ridimensionare l'oggetto e
trascinarlo per posizionarlo nel documento secondo necessita.

Apertura dei menu contestuali degli oggetti

» Fare clic con il pulsante destro del mouse sul bordo di un oggetto in un
documento PublishView™.

Viene visualizzato il menu contestuale con le opzioni per eliminare,
copiarefincollare, tagliare e portare in primo piano/sullo sfondo l'oggetto.

a
"|3. Graph It Bring to Front
Graph your formula as a function. Send to Back
B 7hink: Do all values of the function apply to t & cut Ctrl+X
situation above? Modify the function t to bou S
the range so that it makes sense. Copy Ctri+C
= |
24 ?’ Delete Delete
i .
L Lot X
o g 1A

Ridimensionamento di un oggetto

1. Fare clic su un bordo dell'oggetto per selezionarlo. Il bordo si trasforma in
una linea blu spessa e le maniglie diventano attive.

2. Spostare il mouse su una delle maniglie per attivare lo strumento di
ridimensionamento.

7z

3. Afferrare una delle maniglie e trascinare nella direzione desiderata per
ingrandire o rimpicciolire I'oggetto.

4. Fare clic fuori dall'oggetto per salvare le nuove dimensioni.
Spostamento di un oggetto
Per spostare un oggetto in un altro punto della pagina:

1. Fare clic su un bordo dell'oggetto per selezionarlo. Il bordo si trasforma in
una linea blu spessa e le maniglie diventano attive.
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2. Spostare il cursore su uno dei bordi per attivare lo strumento di
posizionamento.

b

3. Fare clic per afferrare I'oggetto. Le guide di allineamento orizzontali e
verticali diventano attive nella parte superiore e inferiore dell'oggetto.
Utilizzare le linee della griglia per posizionare l'oggetto nella pagina.

@ guida di allineamento verticale
@ guida di allineamento orizzontale
4. Trascinare I'oggetto in una nuova posizione sulla pagina.

Rilasciare il pulsante del mouse per inserire I'oggetto nella nuova
posizione.

Sovrapposizione di oggetti

E possibile posizionare gli oggetti in modo che si sovrappongano. E inoltre
possibile controllare l'ordine di sovrapposizione per specificare quale oggetto
€ posizionato davanti o dietro all'altro. Gli oggetti sovrapposti hanno molteplici
usi pratici nella presentazione di informazioni alla classe. Ad esempio, &
possibile creare un "controllo a tenda" posizionando un riquadro di testo vuoto
sopra altri oggetti. Successivamente, € possibile spostare il riquadro di testo
per rivelare gli elementi sottostanti, uno alla volta.
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This text box is positioned to
overlap the image, which is
contained in frame.

Per modificare la posizione di un oggetto nell'ordine di sovrapposizione:

1. Fare clic sul bordo dell'oggetto da posizionare per selezionarlo, quindi
fare clic con il pulsante destro del mouse per aprire il menu contestuale.

This text box is positioned to b2
overlap the image, which is
contained in a frame. Bring to Front
o Send to Back
a4 cut Crl+X
B copy Ctrl+C
d Delete Delete

2. Fare clic su Invia in secondo piano o Porta in primo piano per portare
l'oggetto selezionato nella posizione desiderata.

Eliminazione di un oggetto
Per eliminare un oggetto da un foglio:

1. Fare clic su un bordo dell'oggetto per selezionarlo. Quando un oggetto &
selezionato, il bordo & blu e le maniglie sono attive.
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2. Premere il tasto Canc per eliminare il riquadro di testo.
—oppure—
Fare clic con il pulsante destro del mouse e quindi fare clic su Elimina dal

menu contestuale.

Scelta di una cartella di lavoro per gli oggetti PublishView™

Utilizzare il campo Scegliere cartella di lavoro nel riquadro Oggetti
PublishView™ per selezionare una cartella per I'archiviazione dei documenti
PublishView™ e dei file correlati.

1. Accertarsi che il riquadro Oggetti PublishView™ sia aperto.

PublishView™ Objects 3

HO028

Choose your working folder

| =

2. Fareclicsu |—|
Viene visualizzata la finestra di dialogo Scegliere cartella di lavoro.

Choose Your Working Folder > o
Lockin: [ PublishView_Objects - Bdm @B
File Name:  |CiDocuments and 1340421y D T-NspirelP ,_Objects |
Files of Type: | -

| open—| |- cancer|

3. Spostarsi sulla cartella in cui si desidera memorizzare i file dei video e
delle immagini.

4. Fare clic su Apri per scegliere la cartella di lavoro.

Operazioni con documenti PublishView™ 261



La cartella selezionata diventa la cartella di lavoro e il suo nome appare
nel campo Scegliere cartella di lavoro. Le anteprime delle immagini
supportate e dei file video archiviati nella cartella vengono visualizzate nel
riguadro Oggetti PublishView™.

b

PublishView™ Objects

2008

Choose your working folder

jocuments‘.TI—Nspire\oldGeometr‘ :

At

ntpict.jpg

5. Peraggiungere un'immagine o un file video a un documento
PublishView™, selezionare il file, quindi spostarlo nel foglio attivo.

Operazioni con applicazioni TI-Nspire™

Nota: Per ulteriori informazioni, vedere il capitolo appropriato del presente
manuale.

Aggiunta di un'applicazione in un'attivita

Per inserire un'applicazione TI-Nspire™ in un'attivita in un documento
PublishView™:

1. Scegliere una delle seguenti operazioni per selezionare un'applicazione:
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*  Nelriguadro Applicazioni TI-Nspire™ nella Casella degli strumenti
Documenti, utilizzare il puntatore del mouse per puntare
I'applicazione e trascinarla nell'attivita.

* Nella barra dei menu, fare clic su Inserisci e scegliere un'applicazione
dal menu a discesa.

»  Fare clic con il pulsante destro del mouse all'interno del foglio per
aprire il menu contestuale, fare clic su Inserisci e scegliere
un'applicazione dal menu a discesa.

L'applicazione viene aggiunta al foglio.

Lists & Spreadsheet Problen
=]

]

a
Al 4

Utilizzando il mouse, afferrare le maniglie per ridimensionare o
posizionare l'oggetto applicazione secondo necessita.

Fare clic all'esterno della cornice dell'applicazione per accettarne le
dimensioni.

Per aprire il menu dell'applicazione TI-Nspire™ attiva, fare clic all'interno
dell'applicazione.

Il menu si apre all'interno della Casella degli strumenti Documenti, al di
sopra del riquadro Applicazioni TI-Nspire™.

Fare clic con il pulsante destro del mouse su un elemento
dell'applicazione, ad esempio una cella o una funzione, per aprire il menu
contestuale relativo.
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Documents Toolbox

e

Lists & Spreadsheet & |r
@1 1:Actions »
A Zinsert L4
L33 3Data b
N 4 Statistics v

| 5:Table C

TI-Hspire Applications

T E
T

»

]
5. Perlavorare nell'applicazione, fare clic su un'opzione dal menu
=
applicazione. Fare clic su == per ridurre a icona il riquadro delle

applicazioni.

Aggiunta di documenti TI-Nspire™ esistenti

Utilizzare il riquadro Documenti TI-Nspire™ per aprire un documento
TI-Nspire™ esistente da inserire in un documento PublishView™. Quando si
apre un documento TI-Nspire™ esistente, tutte le pagine del documento
vengono visualizzate nel riquadro di anteprima. E possibile spostare intere
attivitd o singole pagine nel foglio di PublishView™.

Scelta di un documento di lavoro TI-Nspire™
Per scegliere un documento di lavoro:

1. Nella Casella degli strumenti Documenti, assicurarsi che il riquadro
Documenti TI-Nspire™ sia aperto.
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]

Tl-Nspire Documents

Choose your working document

2. Fareclicsu U

Viene visualizzata la finestra di dialogo Scegliere documento di lavoro.

Choose Your Working Document

Look In: [@ Examples '] =N 5

=3 MyLib B9 09 Statistics.tns B4 Plot Sequence Order2 CAS.tng
B 00 Getting Started.tns &3 10 Simple Machines.ins B Plot Sequence System CAStn
4 01 Percents tns 4 11 Optics Explorertns

& 02 Functions.ins & 12 Introducing CAS.ins

& 03 Linear Eqns.tns 3 Getting Started tns

2 04 Systems of Egns.tns & Plot Conics CAS.tns

i 05 Geometry.tns &2 Plot Differential Equation tns

i 06 Advanced Functions.tns 4 Plot Differential Equation CAS.ins

B2 07 Trig Functions.ins B Plot Sequence.tns

@ 08 Calculus.tns @ Plot Sequence Order! CAS.Ins

L] [

File Name: |

Files of Type: [TI—Nsp\re Documents (*.tns)

3. Selezionare la cartella in cui & memorizzato il documento TI-Nspire™:

Fare clic su w nel campo Cerca in: per utilizzare una finestra di
gestione file per trovare una cartella.

In una cartella aperta, fare clic su E
livello nella gerarchia delle cartelle.

per spostarsi in alto di un

Fare clic su @ per tornare alla cartella principale predefinita.

Fare clic su EE per aggiungere una nuova cartella alla cartella aperta
sul computer.
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+ Fareclicsu per elencare le cartelle e i file. Per visualizzare i
dettagli, fare clic su .
4. Selezionare il file e fare clic su Apri

I documento TI-Nspire™ viene aperto nel riquadro Documenti TI-Nspire™.

Tl-Hspire Documents #
Choose your working document
l*_.r DocumentsiTI-Nspire\Graph.tns |f ..
# Graph.tns
[+ | Problem 1
504820
(555 x_
| maly |
nl }
[ ,IF2|:?€:|=.J. A X
b |
12 I‘.
A
T T L) LU (LA B B B B B B B X
i R il
o -2 9
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5. Perinserire il documento TI-Nspire™ nel documento PublishView™,
spostare una pagina alla volta oppure un'attivita alla volta nel foglio
PublishView™.

Se si sta inserendo un'attivita contenente piu pagine, le pagine verranno
impilate una sopra l'altra nel foglio PublishView™. Spostare la pagina
superiore per vedere le altre pagine.

Operazioni con le attivita

Allo stesso modo di un documento TI-Nspire™, un documento PublishView™ si
compone di una o piu attivita.

Le attivita vengono utilizzate per controllare il layout di un documento
PublishView™ in modo da poter isolare le variabili. Quando si utilizzano
variabili con lo stesso nhome in piu attivita, le variabili possono avere valori
diversi. Per inserire un'attivita in documenti PublishView™, aprire il menu
contestuale del foglio oppure utilizzare le opzioni del menu Inserisci nell'area
di lavoro Documenti. Quando si inseriscono attivita, occorre tenere presenti le
linee guida seguenti:

*  Perimpostazione predefinita, un nuovo documento PublishView™
contiene una attivita.

+  E possibile inserire un'attivita alla fine di un'altra attivita.

* Non é possibile inserire un'attivita in mezzo a un‘altra attivita.

» Dopo l'attivita selezionata viene sempre inserita una nuova interruzione di
attivita.

* Inserendo un'interruzione di attivita si aggiunge uno spazio vuoto al di
sotto dell'interruzione.

* Qualsiasi oggetto tra due interruzioni di attivita appartiene all'attivita al di
sopra dell'interruzione.

+ L'ultima attivita include tutti i fogli e gli oggetti che si trovano al di sotto
dell'ultima interruzione di attivita.

* Leinterruzioni di attivita non sono relative ad alcun oggetto, il che
consente di spostare oggetti all'interno di un'attivita senza influire sulla
posizione dell'interruzione.

Inserimento di un'attivita
Per inserire un'attivita in un documento PublishView™ aperto:
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Fare clic con il pulsante destro del mouse su un punto qualsiasi del foglio,
quindi selezionare Inserisci > Attivita.

L'attivita viene aggiunta al documento al di sotto delle attivita esistenti.
L'interruzione di attivita fornisce un ausilio visivo per individuare la
separazione tra le attivita.

x

Per assegnare un nome a un'attivita, evidenziare il testo predefinito,
digitare un nome, quindi fare clic all'esterno della casella di testo per
salvarlo.

L'interruzione di attivita viene salvata.

Problem 1

Se un documento contiene piu attivita, utilizzare la barra di scorrimento a
destra del documento per spostarsi in alto e in basso tra le attivita.

Gestione delle interruzioni di attivita
Le interruzioni di attivitd consentono di separare attivita e gruppi di variabili.

Tutte le attivita hanno un'interruzione di attivita.

Un'interruzione di attivita diventa visibile quando si aggiunge un'attivita a
un documento.

Un'interruzione di attivita € rappresentata da una linea tratteggiata con il
nome dell'attivita a sinistra del foglio.

Per impostazione predefinita, il nome dell'attivita appare come <Nome
dell'attivita>. Evidenziare il testo predefinito per digitare un nuovo nome
per l'attivita.

I nomi delle attivita possono non essere univoci. Due attivita possono
avere lo stesso nome.

Visualizzazione e occultamento delle interruzioni di attivita

In un documento PublishView™ & possibile selezionare di visualizzare o meno
le interruzioni di attivita. Per impostazione predefinita, le interruzioni di attivita
sono visualizzate.

1.

Fare clic con il pulsante destro del mouse su un'area vuota del documento
(esternamente a qualsiasi oggetto) per aprire il menu contestuale del
foglio.

Fare clic su Opzioni di layout.
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4.

Viene visualizzata la finestra di dialogo Opzioni di Mostra/Nascondi.

Nota: E inoltre possibile selezionare Visualizza > Opzioni di layout
PublishView™.

Show/Hide Options
|w] Show problem breaks|

Show object borders

| OK |

Deselezionare I'opzione Mostra interruzioni di attivita per nascondere le
interruzioni di attivita nel documento. Selezionare nuovamente l'opzione
per ripristinare l'impostazione predefinita e visualizzare le interruzioni di
attivita.

Fare clic su OK per chiudere la finestra.

Rinomina di un'attivita

1.

2.
3.

Fare clic sul nome gia assegnato dell'attivita sulla linea dell'interruzione di
attivita.
Digitare un nuovo nome per l'attivita.

Fare clic fuori dal riquadro di testo per salvare il nuovo nome.

Eliminazione di un'attivita
Per eliminare un'attivitd, completare una delle seguenti azioni:

Selezionare l'interruzione di attivita e fare clic su % a destra nella linea di
interruzione.

Selezionare Modifica >Elimina.

Fare clic con il pulsante destro del mouse sull'interruzione di attivita e
selezionare Elimina.

Selezionare l'interruzione di attivita e premere il tasto Canc o Backspace
(Arretramento).

Quando si elimina un'attivita, tutti gli oggetti in essa contenuti vengono rimossi
e viene eliminato lo spazio tra l'interruzione dell'attivita selezionata e
l'interruzione di quella successiva.
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Organizzazione dei fogli di PublishView™

Un documento PublishView™ pud essere composto da piu fogli. Nell'area di
lavoro sullo schermo viene visualizzato un foglio alla volta. Tutto il lavoro si
svolge negli oggetti PublishView™ e nelle applicazioni TI-Nspire™ all'interno
dei fogli.

Inserimento difogliin un documento

Per aggiungere un foglio a un documento:

» Fare clic su Inserisci > Foglio.

Il foglio viene aggiunto al documento e la numerazione viene
incrementata di un'unita.

Apertura del menu contestuale del foglio

» Fare clic con il pulsante destro del mouse su un'area vuota (esternamente
a qualsiasi oggetto) in un foglio di PublishView™.

Viene visualizzato un menu contestuale con opzioni per inserire attivita,
pagine, applicazioni e oggetti PublishView™, modificare opzioni per
rimuovere spazi o eliminare una pagina e opzioni per nascondere e
visualizzare interruzioni di attivita e bordi degli oggetti.

Problem 1

Insert
Edit

Hide/Show

Numerazione delle pagine

In un documento PublishView™, la numerazione delle pagine & visualizzata
nel margine inferiore (pié di pagina). Per impostazione predefinita, la
numerazione appare al centro del foglio di PublishView™ nel formato "n. di n.".
Non & possibile modificare o eliminare la numerazione delle pagine.
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Operazioni con intestazioni e pié di pagina

I documenti PublishView™ presentano uno spazio nella parte superiore e nella
parte inferiore del foglio destinato all'inserimento di un'intestazione o di un pié
di pagina. Intestazioni e pie di pagina possono contenere la data, il nome del
documento, il nome del progetto di lezione, il nome della classe, il nome della
scuola o qualsiasi altra informazione necessaria per identificare un
documento.

Per impostazione predefinita, intestazioni e pie di pagina non hanno contenuti
e i loro bordi sono nascosti. Per attivare un'intestazione o un pié di pagina per
la modifica, fare clic all'interno del margine superiore o inferiore. Una volta
attivato, viene visualizzato un riquadro di testo con un bordo grigio chiaro.

Inserimento e modifica di testo in intestazioni e pie di pagina

1. Fare clic all'interno del margine superiore o inferiore.
I bordi del riquadro di testo all'interno del margine diventano visibili e lo
spazio dell'oggetto viene disabilitato. Il cursore viene posizionato

all'interno dello spazio dell'intestazione o del pié di pagina e la barra degli
strumenti di formattazione diventa attiva.

‘ - - - é - || TI-Nspire 12 - B I U £
‘ This is a header.|
2. Digitare il testo.
* Il carattere predefinito € TI-Nspire™ true type, 12 pt, normale.

»  Perimpostazione predefinita, il testo € centrato orizzontalmente e
verticalmente.

. Il testo puo essere allineato: a sinistra, al centro, a destra o
giustificato.
* lltesto che non rientra orizzontalmente nel riquadro di testo viene

inviato a capo alla riga successiva.

+ Il testo che non rientra verticalmente nel riquadro di testo non viene
visualizzato, ma rimane nel riquadro. (Se si elimina del testo, il testo
non visualizzato diventa visibile).

3. Completare una delle seguenti operazioni per salvare il testo:
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+  Fare clic su un punto qualsiasi all'esterno del riquadro di testo
dell'intestazione o del pié di pagina per salvare il testo.

+  Premere Esc per salvare il testo.

Il foglio di PublishView™ diventa attivo e il menu di formattazione si
chiude.

Visualizzazione e occultamento dei bordi

Per impostazione predefinita, i bordi vengono visualizzati quando si inserisce
un oggetto in un'attivita. Se si seleziona di nascondere i bordi, la selezione
viene applicata a tutti gli oggetti del documento e agli oggetti che si
inseriscono nel documento. Per nascondere un bordo:

1.

4.

Fare clic con il pulsante destro del mouse su un'area vuota del foglio
(esternamente a qualsiasi oggetto) per aprire il menu contestuale.

Fare clic su Opzioni di layout.
Viene visualizzata la finestra di dialogo Opzioni di layout.

Nota: E inoltre possibile selezionare Visualizza > Opzioni di layout
PublishView™.

Show/Hide Options
|+] show problem breaks|

Show object borders

| oK

Deselezionare I'opzione Mostra bordi degli oggetti per nascondere i bordi
degli oggetti dell'attivita. Selezionare nuovamente l'opzione per ripristinare
l'impostazione predefinita e visualizzare i bordi.

Fare clic su OK per chiudere la finestra di dialogo.

Inserimento e rimozione di spazio

Per organizzare la visualizzazione degli oggetti PublishView™ in un foglio, &
possibile inserire o eliminare spazio tra gli oggetti.
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Nota: E possibile inserire o rimuovere spazio verticale tra gli oggetti utilizzando
il seguente metodo. Per inserire o rimuovere spazio orizzontale tra gli oggetti,
spostare l'oggetto.

Inserimento di spazio

1. Fare clic con il pulsante destro del mouse esternamente a qualsiasi
oggetto sul punto in cui si desidera inserire spazio. Viene visualizzato il
menu contestuale.

2. Selezionare Modifica> Aggiungi/Rimuovi spazio. Lo strumento
Aggiungi/Rimuovi spazio viene attivato.

Text box

Strumento
Aggiungi/Rimuovi
spazio

o L —————

Trag down and press enter to add space

b 00:53 w0449 | o ca

Operazionicon documenti PublishView™ 273



3. Utilizzare il mouse per posizionare lo strumento nel punto esatto in cui si
desidera inserire lo spazio.

4. Fare clic sullo strumento, quindi trascinare verso il basso per selezionare
la quantita di spazio da inserire. Mano a mano che si trascina verso il
basso, lo spazio selezionato viene indicato in verde.

WTber bO PeTL0 Ve Space

5. Premere il tasto Invio per inserire lo spazio tra gli oggetti. E possibile
regolare la quantita di spazio trascinando verso il basso e verso l'alto
prima di premere Invio.

Rimozione di spazio

1. Fare clic con il pulsante destro del mouse esternamente a qualsiasi
oggetto nel punto in cui si desidera rimuovere lo spazio.
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Viene visualizzato il menu contestuale.
2. Selezionare Modifica > Aggiungi/Rimuovi spazio.

Lo strumento Aggiungi/Rimuovi spazio viene attivato.

Text box

Strumento
Aggiungi/Rimuovi
spazio

= L m————————

Thrag down and press enter to add space

3. Utilizzare il mouse per posizionare lo strumento nel punto esatto in cui si
desidera rimuovere lo spazio.

4. Fare clic sullo strumento, quindi trascinare verso l'alto per selezionare la
quantita di spazio da rimuovere. Mano a mano che si trascina verso l'alto,
lo spazio selezionato viene indicato in rosso.
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Drag up and press enter to 1

Trag down and press enter

A B C al
*
1
2
3
A =
Al 4| b

5. Premere il tasto Invio per imuovere lo spazio tra gli oggetti. E possibile
regolare la quantita di spazio trascinando verso il basso e verso l'alto
prima di premere Invio.

Nota: Se non vi € spazio sufficiente nel foglio per accogliere gli oggetti,
questi non verranno spostati quando lo spazio viene rimosso.

Eliminazione di fogli vuoti dalle attivita

E possibile eliminare da un'attivita un foglio che non contenga applicazioni
TI-Nspire™ o oggetti PublishView™. Per eliminare un foglio vuoto da un'attivita:

1. Eliminare tutte le applicazioni TI-Nspire™, gli oggetti PublishView™,
spostare o eliminare tutte le interruzioni di attivita dal foglio.

2. Posizionare il cursore sul foglio da eliminare.

3. Fare clic con il pulsante destro del mouse sul foglio vuoto per aprire il
menu contestuale.

4. Fare clic su Modifica >Elimina foglio.

Il foglio vuoto viene rimosso dall'attivita.
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Utilizzo di Zoom

La funzione zoom consente di ingrandire su qualsiasi oggetto o area nel
documento PublishView™ per la discussione e di rimpicciolire per avere una
panoramica della lezione. Lo zoom utilizza il centro dell'area visualizzabile per
ingrandire.

L'impostazione di defaulte 100%.

» Per modificare la percentuale di zoom, procedere in uno dei modi seguenti:
» Digitare il numero nella casella e premere Invio.

+  Utilizzare i pulsanti - e + per ridurre o aumentare la percentuale in
incrementi del 10%.

» Utilizzare la freccia dell'elenco a discesa per selezionare una
percentuale prestabilita.

Le impostazioni dello zoom sono mantenute quando si salva il documento.

Inserimento di testo in un documento PublishView™

In un documento PublishView™, & possibile inserire testo in tre modi diversi:

* Inserire un riquadro di testo di PublishView™ per introdurre testo non
formattato o per copiare testo da altre fonti nel documento. Ad esempio, &
possibile posizionare un riquadro di testo PublishView™ accanto a
un'immagine e digitarvi una descrizione. E inoltre possibile copiare e
incollare testo da file .doc, .txt, .rif. Utilizzare i riquadri di testo di
PublishView™ per dare risalto a un testo e formattarlo. | riquadri di testo di
PublishView™ non vengono convertiti quando si converte un documento
PublishView™ in un documento TI-Nspire™. E possibile utilizzare un
riquadro di testo di PublishView™ per inserire del testo che gli utenti dei
palmari non devono vedere.

»  Utilizzare I'applicazione Notes di TI-Nspire™. Si dovrebbe utilizzare
I'applicazione Notes ogni volta che occorre un editor di equazioni
avanzato e occorre utilizzare modelli matematici e simboli di TI-Nspire™.
Le formattazioni in apice e in pedice del testo sono piu facili da usare in
Notes. Si dovrebbe utilizzare Notes inoltre quando si pianifica di convertire
il documento PublishView™ in un documento TI-Nspire™ per utilizzarlo su
un palmare e si desidera che gli utenti del palmare vedano il testo.

* Inserire testo in applicazioni TI-Nspire™ con gestione del testo allo stesso
modo di come si farebbe in un documento TI-Nspire™.
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Inserimento di testo in un riquadro ditesto
1. Accertarsi che il riquadro Oggetti PublishView™ sia aperto.

PublishView™ Objects #

=028

Choose your working folder
| ——,

&

Utilizzare il mouse per fare clic su e trascinare l'icona nell'attivita.
Rilasciare il pulsante del mouse per inserire il riquadro di testo nell'attivita.

[ = |
Type your text here.

| = |
4. Utilizzando il mouse, afferrare le maniglie per ridimensionare il riquadro di
testo o per posizionarlo nell'attivita secondo necessita.

5. Fare clic fuori dal riquadro di testo per salvare le dimensioni e la
posizione.

6. Fare clic su "Digitare il testo qui."
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La barra di formattazione diventa attiva. Lo stato del riquadro di testo &
interattivo per linserimento o la modifica del testo.

- - - i - | Ti-Nspire ~[12 - B I U £

7. Digitare il nuovo testo.
—oppure—
Copiare e incollare testo da un altro file.
8. Applicare la formattazione secondo necessita.

9. Fare clic all'esterno del riquadro di testo per salvare il testo.

Formattazione e modifica di un testo

Le opzioni per la modifica e la formattazione di un testo sono incluse nella
barra degli strumenti di formattazione nella parte superiore del documento
attivo. Le opzioni di formattazione per la modifica del testo includono:

* Modifica del carattere, della dimensione e del colore relativi.
* Applicazione della formattazione in grassetto, corsivo e sottolineato.

» Applicazione delle seguenti opzioni di allineamento orizzontale del testo:
a sinistra, a destra, al centro e giustificato.

* Inserimento di collegamenti ipertestuali.

Attivazione della modalita di modifica
» Fare clic all'interno del riquadro di testo per attivare la modalita di modifica.
* Viene visualizzato il menu contestuale.

* |l testo & selezionabile per la modifica.

Apertura del menu contestuale del contenuto

» Fare clic con il pulsante destro del mouse all'interno di un riquadro di testo
contenente del testo o un collegamento ipertestuale.

Vengono visualizzati il menu di formattazione e il menu contestuale con le
opzioni Taglia, Copia e Incolla.
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Utilizzo dei collegamenti ipertestuali nei documenti
PublishView™

Nei documenti PublishView™, utilizzare i collegamenti ipertestuali per:

+ Collegare a unfile

+ Collegare a un sito web

E possibile inserire un collegamento ipertestuale in un documento aperto
oppure convertire qualsiasi testo all'interno di un riquadro di testo in un
collegamento ipertestuale. Una volta inserito, il testo del collegamento

ipertestuale viene formattato in blu sottolineato. E possibile modificare la
formattazione di questo testo senza perdere il collegamento.

Se si interrompe un link, facendo clic su di esso viene visualizzato un
messaggio di errore:

* Impossibile aprire il file specificato
* Impossibile aprire la pagina web specificata
Impossibile aprire la pagina web specificata

| collegamenti assoluti contengono il percorso completo del file collegato e non
dipendono dalla posizione del documento principale.

| collegamenti relativi contengono la posizione del file collegato relativo al
documento principale. In caso di piu lezioni in una singola cartella e se queste
sono tutte collegate utilizzando I'indirizzo relativo, € possibile spostare la
cartella in qualsiasi altra posizione (un'altra cartella locale, datashare, unita di
memoria flash, online) senza rompere i collegamenti. | collegamenti possono
inoltre rimanere intatti aggregando i documenti in un'unita didattica o
comprimendoli in un file zippato e condividendoli.

Nota: Il documento PublishView™ deve essere salvato prima di poter inserire
un collegamento ipertestuale relativo.

Creazione di un link a un file

E possibile creare un link a qualsiasi file presente sul computer. Se il tipo di file
€ associato a un'applicazione sul computer, il file verra avviato non appena si
fa clic sul link. Esistono due modi per creare un link a un file: digitando o
incollando l'indirizzo del file nel campo Indirizzo o selezionando un file.

Collegamento a un file utilizzando un indirizzo

1. Accertarsi che il riquadro Oggetti PublishView™ sia aperto.
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2.

b

PublishView™ Objects

=208

Choose your working folder

| =

Trascinare l'icona del collegamento ipertestuale sul documento.

Viene visualizzata la finestra di dialogo Collegamento ipertestuale.

Text | {

Address: ' |

15'_ Linkto a file on your computer or network drive.

e ) Linkto an Internet resource.
OK Cancel

Digitare il nome del link nel campo Testo. Ad esempio, si potrebbe inserire
lo stesso nome del documento.

Copiare il percorso del file per cui si desidera creare il collegamento e
incollarlo nel campo Indirizzo.

—oppure—
Digitare il percorso del file nel campo Indirizzo.

Nota: Digitare ../ per designare le directory superiori. Ad esempio:
.I.Nlessons/mathlesson2.tns.

Fare clic su OK per inserire il collegamento.
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Nel documento PublishView™ viene inserito un riquadro di testo contenente il
collegamento ipertestuale.

Collegamento a un file selezionandolo

1.

2.

Accertarsi che il riquadro Oggetti PublishView™ sia aperto.

PublishView™ QObjects b

=08

Choose your working folder

| =

Trascinare l'icona del collegamento ipertestuale sul documento.

Viene visualizzata la finestra di dialogo Collegamento ipertestuale.

Text:

Address: ' |

1;.5', Linkto a file on your computer or netwark drive.

¢

e ) Linkto an Internet resource.
QK Cancel

Digitare il nome del link nel campo Testo. Ad esempio, si potrebbe inserire
lo stesso nome del documento.

i
Fareclicsu — per selezionare Collegamento a un file sul computer o su
un'unita di rete.
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Viene visualizzata la finestra di dialogo Seleziona file da inserire come
collegamento ipertestuale.

Select a file to insert as hyperlink

LookIn: I..j TI-Mspire

|.:| Backups |2 new test folder .E_] Language C
|2 Circles_Equation_of_a_Circle tilb ) Restores EJ TempG181E
|2) Downloads |2 Screen Captures @ test_split_p
|5) Examples i Active_Documentins B2 testt.tns
|2 Linear_Equalities_in_Two_Yariables tilb @ color_notes.ins

I Logs —1] Diagnostics_LTX0134044 2010-10-07 zip

[ myLib @ Document1.ins

|) New Lesson Bundle1.tilb @ Document2.tns

I2) New Lesson BundleZ tilb B Examplet tns

|2) New Lesson Bundle3.tilb B9 image_testins

1

File Name: |Documentt tns
[

Files of Type:

| Insert || Cancel

5. Evidenziare e selezionare il file oggetto del link, quindi fare clic su
Inserisci.

I nome di percorso viene inserito nel campo Indirizzo della finestra di
dialogo Collegamento ipertestuale.

Se il software non & in grado di determinare se il collegamento € un
indirizzo relativo o assoluto, la finestra di dialogo Collegamento
ipertestuale si apre per poter modificare il tipo di collegamento.

Fare clic sull'opzione appropriata per cambiare il collegamento.
* Rendi assoluto l'indirizzo.
* Rendi relativo l'indirizzo.
6. Fare clic su OK per inserire il collegamento.
—oppure—

Fare clic su Reimposta per tornare alla finestra di dialogo Collegamento
ipertestuale e scegliere un file diverso per cui creare il collegamento o per
modificare i campi Testo o Indirizzo.

Nel documento PublishView™ viene inserito un riquadro di testo contenente il
collegamento ipertestuale.
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Example 1

| = |
7. Utilizzando il mouse, afferrare le maniglie per ridimensionare il riquadro di
testo.
—oppure—
Afferrare un bordo per posizionare il riquadro di testo nel documento

secondo necessita.

Creare un collegamento a un sito web
Esistono due modi per creare un link a un sito web: digitando o incollando

I'URL nel campo Indirizzo o selezionando un file.
Collegamento a un sito web utilizzando un indirizzo

1. Accertarsi che il menu Oggetti PublishView™ sia aperto.

2. Trascinare licona nel documento per aprire la finestra di dialogo
Collegamento ipertestuale.

3. Digitare o incollare 'URL per cui si desidera creare il collegamento nel
campo Indirizzo.

4. Fare clic su OK.

Nel documento PublishView™ viene inserito un riquadro di testo
contenente il collegamento ipertestuale.
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Collegamento a un sito web selezionandolo

1.

7.

Accertarsi che il menu Oggetti PublishView™ sia aperto.

Trascinare l'icona
Collegamento ipertestuale.

nel documento per aprire la finestra di dialogo

i
Fare clic su t’ per selezionare Collegamento a una risorsa Internet.
Il browser si apre sul sito web predefinito.

Spostarsi sul sito web o sul file nel sito web che si desidera collegare.

Copiare I'URL, quindi incollarlo nel campo Indirizzo della finestra di
dialogo Collegamento ipertestuale.

—oppure—
Digitare 'URL nel campo Indirizzo.
Fare clic su OK.

Nel documento PublishView™ viene inserito un riquadro di testo
contenente il collegamento ipertestuale.

Google

Utilizzando il mouse, afferrare le maniglie per ridimensionare il riquadro di
testo.

—oppure—
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Afferrare un bordo per posizionare il riquadro di testo nel documento
secondo necessita.

Madifica di un collegamento ipertestuale

Per modificare il nome di un collegamento ipertestuale, il percorso o I'URL,
completare la procedura seguente.

1.

3.

Utilizzando il mouse, fare clic con il pulsante destro sul testo del
collegamento ipertestuale, quindi selezionare Modifica collegamento
ipertestuale.

Viene visualizzata la finestra di dialogo Collegamento ipertestuale.

Text:

Address:

'iGoogIe

'http:www.google.com

I":.“-,. ‘ Linkto a file on your computer or network drive.

[ ‘ Linkto an Internet resource.

| OK || Cancel

Apportare le correzioni secondo necessita:

+ Digitare le correzioni al nome del collegamento ipertestuale nel
campo Testo.

I. . . . . . .
+ Fareclicsu = peraprire la finestra di dialogo Seleziona un file da
aggiungere come collegamento ipertestuale e utilizzare la finestra di
navigazione file per portarsi sulla cartella in cui € ubicato il file.

+ Fareclicsu ’!’ per aprire un browser e accedere a un sito web per
copiare e incollare I'URL nel campo Indirizzo.

Fare clic su OK per salvare le modifiche.

Conversione di un testo esistente in un collegamento ipertestuale

1.

Fare clic all'interno del riquadro di testo per attivare la modalita di modifica
e aprire il menu di formattazione.
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2. Selezionare il testo da convertire in collegamento ipertestuale.

3. Fareclicsu |__l

La finestra di dialogo Collegamento ipertestuale si apre con il testo
selezionato nel campo Testo.
4. Fareclicsu “= per selezionare un link a un file.

—oppure—

. 4 . . . .
Fare clicsu " per creare un link a una pagina di un sito web.

Rimozione di un collegamento ipertestuale

Utilizzare la seguente procedura per rimuovere un link dal testo di un riquadro
di testo. Il testo non viene rimosso dal documento.

1. Utilizzando il mouse, fare clic con il pulsante destro sul testo del
collegamento ipertestuale.

2. Fare clic su Rimuovi collegamento ipertestuale.

La formattazione del collegamento ipertestuale viene rimossa dal testo,
che non ¢ piu attivabile.

Nota: Per rimuovere il testo e la formattazione del collegamento ipertestuale,
eliminare direttamente il testo. Se un riquadro di testo contiene solo il testo
collegato, eliminare il riquadro di testo.

Operazioni con le immagini

Le immagini possono essere aggiunte a documenti PublishView™ come
oggetti PublishView™ oppure possono essere inserite in applicazioni
TI-Nspire™ che supportano immagini. | tipi di file supportati sono .bmp, .jpg,
.png.

Nota: Se c'é€ un'applicazione TI-Nspire™ attiva nel documento PublishView™,
I'immagine viene inserita nella pagina di TI-Nspire™ selezionando

Inserisci > Immagine dalla barra dei menu o dal menu contestuale. Se non ci
sono documenti TI-Nspire™ attivi, I'immagine viene inserita come oggetto
PublishView™. Solo le immagini contenute in applicazioni TI-Nspire™ vengono
convertite in documenti TI-Nspire™ (file .tns).
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Inserimento di un'immagine

1. Accertarsi che il riquadro Oggetti PublishView™ sia aperto.

PublishView™ Objects

=028

Choose your working folder

| =t

o
o

[

2. Fareclicsu , quindi trascinare l'icona nel documento.
Viene visualizzata la finestra di dialogo Scegli un'immagine da inserire in
PublishView™.

Nota: Per impostazione predefinita, viene visualizzata la cartella delle
immagini precaricate di Texas Instruments.

Choose animage fo insert into Publish\iew

LookIn: [@ Screen Captures

I3 12-30-2010 Image
&1 Blue nills.jpg

| problem2.jpg

=] sunsetipg

=] water lilies.jpg

£ winter jpa

File Name: [

Files of Type: [AII Images (*jpg, *jpeg, *.bmp, *.png)
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Aprire la cartella in cui si trova il file dell'immagine da caricare, quindi
evidenziare il nome del file.

Fare clic su Inserisci immagine.

L'immagine viene aggiunta al foglio di PublishView™.

Utilizzando il mouse, afferrare le maniglie per ridimensionare il riquadro di
testo.

—oppure—

Afferrare un bordo per posizionare il riquadro di testo nel documento
secondo necessita.

Spostamento di immagini

1.
2.

Fare clic sulla cornice che delimita I'immagine per selezionarla.

Spostare il cursore sopra il bordo dell'immagine per attivare lo strumento

di posizionamento. -'*‘lL
Spostare lI'immagine nella nuova posizione nel foglio di PublishView™.

Nota: Gli oggetti possono sovrapporsi in un foglio di PublishView™.

Ridimensionamento di immagini

1.
2.

Fare clic sulla cornice che delimita I'immagine per selezionarla.

Spostare il mouse su una delle maniglie blu per attivare lo strumento di

ridimensionamento. H
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3. Trascinare la maniglia per rimpicciolire o ingrandire I'immagine.

Eliminazione di immagini
» Fare clic sull'immagine per selezionarla, quindi premere il tasto Canc.
—oppure—

» Fare clic su una maniglia con il pulsante destro del mouse per aprire il
menu contestuale, quindi selezionare Elimina.

Operazioni con file video
E possibile incorporare file video in un documento PublishView™ e riprodurre il
video direttamente dal documento stesso. | formati video supportati includono:

*  File video Flash® (.flv) con video VP6 e audio MP3.

*  MP4 (contenitore multimediale MPEG-4) con compressione video
H264/AVC (Advanced Video Coding) e audio AAC.

Nota: & possibile inoltre inserire un link a un video che verra avviato in una
nuova finestra browser o in una finestra con un riproduttore di supporti. Per
ulteriori informazioni, vedere Operazioni con collegamenti ipertestuali.

Inserimento di un video
1. Accertarsi che il riquadro Oggetti PublishView™ sia aperto.

2. Fareclicsu G quindi trascinare l'icona nel documento.

Viene visualizzata la finestra di dialogo Scegli un video da inserire in
PublishView™.

%4 Choose a video to insert into PublishView™ @

LookIn: | |l Videos ~ BEA®E ||

[ § Eureka! Episode 20 Measuring Temperature.mp4 |

File Mame:

Files of Type: |All Videos (*flv, *.mp4) -

| Cancel |

3. Aprire la cartella in cui si trova il file video da inserire e selezionare il
nome del file.
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4. Fare clic su Inserisci video.

Un oggetto contenente un video incorporato viene inserito nel foglio di
PublishView™. Per impostazione predefinita, le maniglie di
ridimensionamento e di riposizionamento sono attive.

00:04

5. Utilizzando il mouse, afferrare le maniglie per ridimensionare l'oggetto
oppure afferrare un bordo per posizionare I'oggetto nel documento
secondo necessita. Ad esempio, & possibile riposizionare I'oggetto
contenente il video sopra o sotto il riquadro di testo contenente il testo di
presentazione del video.

6. Perriprodurre il video, fare clic sulla freccia di avanzamento oppure in
qualunque punto nella finestra di visualizzazione.

Utilizzo della console video

La console video consente all'utente di controllare il video.

00:03

(1] (2] (3]

© Awvia o arresta il video.
@ Mostra il tempo trascorso durante la riproduzione del video.

© Disattiva e annulla la disattivazione audio.
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Conversione di documenti

E possibile convertire documenti PublishView™ (file .tnsp) in documenti
TI-Nspire™ (file .tns) per la visualizzazione sui palmari. E anche possibile
convertire documenti TI-Nspire™ in documenti PublishView™.

Convertendo un documento si crea un nuovo documento: il documento
originale rimane intatto e non € collegato al nuovo documento. Se si apportano
modifiche a un documento, tali modifiche non vengono riflesse nell'altro.

Conversione di documenti PublishView™ in documenti TI-Nspire™
Non & possibile aprire un documento PublishView™ (file .tnsp) su un palmare.
Tuttavia, & possibile convertire il documento PublishView™ in un documento
TI-Nspire™ che pud essere trasferito e aperto su un palmare. Quando si
converte un documento PublishView™ in un documento TI-Nspire™:

» Solo le applicazioni TI-Nspire™ diventano parte del documento TI-Nspire™.

*  Gli oggetti PublishView™, quali per esempio riquadri di testo, immagini,
collegamenti ipertestuali e video, non vengono convertiti.

* Il testo contenuto nei riquadri di testo di PublishView™ non viene

convertito; tuttavia, viene convertito il testo in un'applicazione Notes di
TI-Nspire™.

»  Se sono contenute in un'applicazione TI-Nspire™, le immagini vengono
convertite; tuttavia, le immagini contenute in oggetti PublishView™ non
vengono convertite.

Completare la procedura seguente per convertire un documento PublishView™
(file .tnsp) in un documento TI-Nspire™ (file .tns).

1. Aprire il documento PublishView™ da convertire.
2. Fare clic su File > Converti in > Documento TI-Nspire™.

* Il nuovo documento TI-Nspire™ viene aperto nell'area di lavoro
Documenti.

* Solo le applicazioni TI-Nspire™ supportante fanno parte del nuovo
documento TI-Nspire™.

. Partendo dall'alto in basso, quindi da sinistra a destra, il layout del
documento TI-Nspire™ si basa sull'ordine delle applicazioni
TI-Nspire™ nel documento PublishView™.

- Nel documento TI-Nspire™ convertito ogni applicazione
TI-Nspire™ in un documento PublishView™ apparira come una
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pagina. L'ordine delle pagine nel documento TI-Nspire™ si basa
sul layout delle applicazioni TI-Nspire™ nel documento
PublishView™.

- Sedue o piu attivita sono allo stesso livello, I'ordine & da sinistra
a destra.

. Le interruzioni di attivita sono mantenute.

* Il nuovo documento TI-Nspire™ non & collegato al documento
PublishView™.

| |
3. Una volta terminato il lavoro nel documento, fare clic su D per salvare il
documento nella cartella corrente.

—oppure—

Fare clic su File > Salva con nome per salvare il documento in una cartella
diversa.

Nota: Se il documento non € mai stato salvato, entrambe le opzioni Salva
e Salva con nome consentono di salvare in una cartella diversa.

Nota: E possibile usare I'opzione Salva con nome per convertire un
documento PublishView™ in un documento TI-Nspire™.

Nota: Se si tenta di convertire un documento PublishView™ che non contiene
pagine o applicazioni TI-Nspire™, viene visualizzato un messaggio di errore.

Conversione di documenti TI-Nspire™ in documenti PublishView™

E possibile convertire documenti TI-Nspire™ esistenti in documenti
PublishView™ e sfruttare cosi il layout e le funzioni di modifica potenziate per
stampare, generare report degli studenti, creare fogli di lavoro e valutazioni e
pubblicare documenti su un sito web o un blog.

Completare la procedura seguente per convertire un documento TI-Nspire™ in
un documento PublishView™.

1. Aprire il documento TI-Nspire™ da convertire.
2. Selezionare File > Converti in > Documento PublishView™.

* Il nuovo documento PublishView™ viene aperto nell'area di lavoro
Documenti.

+ Perimpostazione predefinita, ci sono sei oggetti per ogni pagina.
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» Una volta convertita, ogni attivita del documento TI-Nspire™ avviera
un nuovo foglio nel documento PublishView™.

. Le interruzioni di attivita sono mantenute.

| =
Una volta terminato il lavoro nel documento, fare clic su D per salvare il
documento nella cartella corrente.

—oppure—

Fare clic su File > Salva con nome per salvare il documento in una cartella
diversa.

Nota: E anche possibile usare I'opzione Salva con nome per salvare un
documento TI-Nspire™ come un documento PublishView™.

Stampa di documenti PublishView™

E possibile stampare report, fogli di lavoro e valutazioni create utilizzando la
funzione PublishView™. Per stampare un documento:

1.

Selezionare File > Stampa.

Viene visualizzata la finestra di dialogo Stampa. A destra nella finestra di
dialogo viene visualizzata un'anteprima del documento.

Selezionare una stampante dal menu.

Nota: Il campo Stampa & disabilitato.

Selezionare Formato carta dal menu. Le opzioni disponibili sono:
+ Letter(8.5x11")

* Legal (8.5x14")

A4 (210 x 297 mm)

Selezionare il numero di Copie da stampare.

Nell'area Stampa intervallo, selezionare di stampare tutte le pagine del
documento, un intervallo di pagine o solo la pagina corrente.

Nota: Per impostazione predefinita, i margini superiore e inferiore sono
impostati su 2,54 cm e sono mantenuti tali anche per la stampa di un
documento PublishView™. Non ci sono margini laterali. | fogli di
PublishView™ vengono stampati cosi come appaiono nell'area di lavoro.

Se necessario, selezionare o deselezionare le caselle:

»  Stampa interruzioni e nomi di attivita.
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+  Stampa intestazioni
+  Stampa pié di pagina
* Mostra bordi degli oggetti

7. Fare clic su Stampa oppure su Salva come PDF.
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Utilizzo dell'area di lavoro Revisione

Utilizzare quest'area di lavoro per rivedere un gruppo di documenti ritirati,
gestire le risposte degli studenti, eseguire attivita in tempo reale e organizzare
dati.

Review Toolbox S

Which of these is not a rational number?

0.734'0

H P

®

Student Data

T E _ 3
0 of 3 submitted

3.33333'0

28 - T AigebraTestl X | " Concepts ofM..PSet1,11-02 X v B

@ Casella degli strumenti Revisione. Contiene gli strumenti di revisione,
I'Ordinatore pagine e gli strumenti di risposta degli studenti. Fare clic su
ciascuna icona per accedere agli strumenti disponibili. Visualizza inoltre
le opzioni dello strumento selezionato.

® Riquadro Visualizza dati. Visualizza i dati e le opzioni del test o del
documento che ¢ stato selezionato nella casella degli strumenti
Revisione. E possibile commutare la vista dati tra diagramma a barre,
tabella e grafico (se disponibile).

Il software mantiene la visualizzazione dei dati a cui era stato impostato
per ogni domanda quando si chiude e si riapre I'area di lavoro Revisione.
Tutti i dati nascosti e non nascosti, le impostazioni di visualizzazione
grafici, tabelle e diagrammi a barre e Mostra lavoro vengono mantenute
quando si chiude I'area di lavoro Revisione.

Utilizzo della Casella degli strumenti Revisione

La casella degli strumenti Revisione contiene gli strumenti necessari per
lavorare con i documenti ritirati € con i risultati di Domanda e di Test rapido.
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Icona Descrizione

“i:-\é; Gli Strumenti di revisione consentono di organizzare i dati
. delle risposte, utilizzare strumenti grafici, mostrare o
Strumenti . . .
di nascondere risposte e segnare le risposte di Domanda e Test
i . .
. rapido come corrette o sbagliate.
revisione
Visualizza tutte le attivita di un documento o Test rapido, tutte
ordinatore I<=T pagine di ciascuna attivita e le risposte dello studente per
. ciascuna domanda del documento.
pagine

E;Iil) Visualizza i nomi e le risposte degli studenti nel riquadro Vista
dati.

Riquadro

Studenti

Esplorazione degli Strumenti di revisione

Review Tools

QO0OOe

Organizza. Fare clic su p per organizzare i dati in viste diverse.

Strumenti Grafico. Fare clic su p per accedere agli Strumenti Grafico nella
vista grafico cartesiano.

Mostra selezionati. Mostra le risposte selezionate per la revisione nel
riquadro Vista dati.

© © ©o¢

Nascondi selezionati. Nasconde le risposte selezionate nel riquadro Vista
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Esplorazione dell'Ordinatore pagine

dati.

Segna le risposte come corrette. Selezionare una risposta nel riquadro
Vista dati e fare clic su Segna le risposte come corrette per
contrassegnarla come risposta esatta. E possibile contrassegnare piul di

una risposta come risposta esatta.

Segna le risposte come non corrette. Selezionare una risposta nel
riquadro Vista dati e fare clic su Segna le risposte come non corrette per
contrassegnarla come risposta sbagliata. E possibile contrassegnare pil
di una risposta come risposta sbagliata.

Utilizzare I'Ordinatore pagine per visualizzare le risposte dello studente alle

dom

ande nel documento.

Review Toolbox

=¥ Problem 1

Answer 2ach question for your Agebra exa

and |will callact it 2 the end of the class perod,

®

which of these is nat a rational numzer?)

Student Data

(1]

o

@ Fare clic sul segno meno (-) per comprimere la vista. Fare clic sul segno
piu (+) per espandere la vista e visualizzare tutte le pagine di un'attivita e
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(5]

tutte le attivita di un documento.

Pagine di un'attivita. Fare clic su una pagina per aprirla nel riquadro Vista
dati.

Risposte dello studente. Accanto a ogni domanda del documento &
visualizzata un'icona dati dello studente. Fare clic sull'icona per
visualizzare le risposte dello studente relative alla domanda nel riquadro
Vista dati.

Nei Test rapidi, Iicona mostra il numero di studenti che hanno effettuato
I'accesso quando il test € iniziato, il numero di quelli che hanno risposto e
il numero di coloro che hanno inviato la loro risposta. Nell'esempio che
segue, nove studenti hanno ricevuto il test, sette studenti hanno risposto
al test e nessuno studente ha inviato la risposta.

Nota: Se si invia un test agli studenti che mancavano, i numeri potrebbero
cambiare.

| Student Data

|

7 of @ waorking
0 of 9 submitted

Barra di scorrimento. La barra di scorrimento € attiva quando ci sono piu
pagine di quante ne possa mostrare il pannello.

Numeri di pagina. Fare clic su un numero di pagina per aprire la pagina
nel riquadro Vista dati.

Esplorazione del riquadro Studenti

Utilizzare il riquadro Studenti per:

Visualizzare gli studenti a cui € stato inviato il file
Visualizzare gli studenti che hanno risposto

Mostrare le risposte degli studenti

Contrassegnare le risposte come corrette o non corrette

Ordinare le risposte in base allo studente o alla risposta oppure in base al
tempo nei Test rapidi
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Review Toolbox

Ak

X

a

o” [] Display Student Responses & - @
Student Response  Time

Baker, Susan 5 11:50:18
Chopra, Laxmi  [0.734 | 11:50:14
Huang, Shen  ||5 11:50:36
Kapur, Samir J5 11:50:05
Li, Song 5 11:50:32
Lopez, Maria

Moore, Jacob J5 11:50:28
Simmons, Nadine

Thompson, Olivia g 11:50:25

(4]

Visualizza le risposte degli studenti. Selezionare questa casella per
mostrare le risposte di ogni studente. Deselezionare questa casella per
nascondere le risposte dello studente.

Studente, Risposta, € Tempo Colonne. La colonna Tempo & disponibile
solo nelle revisioni di Test rapidi.

Fare clic sulla colonna Studente per elencare gli studenti in ordine
alfabetico. Fare nuovamente clic per elencare gli studenti in ordine
alfabetico inverso.

Fare clic sulla colonna Risposta per elencare le risposte in ordine

alfabetico o numerico. Fare nuovamente clic per elencare le risposte
in ordine inverso.

Per aggiungere la colonna Tempo nelle revisioni di Test rapido, fare

clic sul menu Opzioni “* e scegliere Tempo.

Fare clic sulla colonna Tempo per elencare le risposte nell'ordine
temporale in cui sono state fornite (prima risposta in alto). Fare
nuovamente clic per invertire l'ordine delle risposte (prima risposta in
basso).

©® Nomi studenti. Elenca tutti gli studenti nella classe associata al
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documento correntemente aperto per la revisione. | nomi degli studenti
vengono visualizzati in base alla selezione effettuata nel menu
Classe > Formato home studente.

I nomi degli studenti in rosso segnalano gli studenti che non hanno
ricevuto il file o che non hanno risposto al Test rapido.

Deselezionare la casella accanto a un nome per nascondere la risposta
di quello studente.

O Risposte. Elenca tutte le risposte accanto al nome dello studente. Uno
studente puod essere elencato diverse volte se ha fornito piu risposte. La
colonna delle risposte puo variare se il documento rivisto € un documento
attivo di Test rapido o di Domanda che non & ancora stato salvato.

+ Se lo studente ha risposto, viene mostrata una risposta.
+ Selo studente non ha risposto, I'area delle risposte & vuota.

+ Se lo studente ha risposto e le risposte sono nascoste, si visualizza la
dicitura "Risposta".

+ Se lo studente non ha ancora risposta alla domanda aperta o al test
rapido attivo, si visualizza "Nessuna risposta".

» Selo studente ha modificato la propria risposta a un Test rapido ma
non I'ha ancora inviata, si visualizza "In corso".

@ Menu opzioni. Cliccare su w per aprire il menu delle opzioni che si
possono applicare alle risposte dello studente:
*  Visualizza le risposte degli studenti.
*  Visualizza solo i nomi degli studenti.
*  Visualizza solo le risposte.
*  Visualizza una colonna Tempo per i risultati di Test rapido.
»  Seleziona tutti gli elementi nell'elenco.
* Visualizza I'elemento selezionato.
+ Nascondil'elemento selezionato.
+ Contrassegna una o piu risposte come corrette.

+ Contrassegna una o piu risposte come non corrette.
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Esplorazione del riquadro Vista dati

& E-e B ] Show Correct Answer
Review Toolbox -
X s Which of these is not a rational tﬁ
= ¥ Quick Poll 1 Res B
| : number?
of? 0.73410
N —— 2}
] 3o
8
)
1ot awork
) 3.33333 [0 4
Goncepis P SelA, 1102 X| 5 Concepts of_PSet1,0301 x]4 b &
= 4 clients connected | 3 of 11 Students loggedin Data View: Ee

3]

@ Mostra risposta corretta. Selezionare questa casella per visualizzare la
risposta contrassegnata come corretta nel riquadro Vista dati. La risposta
corretta & evidenziata in verde.

@ Risposte. Mostra le informazioni scelte nell'Ordinatore pagine. Questo
esempio mostra le risposte ottenute selezionando un'icona Risposte degli
studenti. E possibile visualizzare o nascondere le risposte e
contrassegnarle come corrette o sbagliate.

@ Vista dati. Fare clic su un'icona per visualizzare i dati in forme diverse.
diagrammi a barre, grafici o tabelle. Una opzione "Mostra lavoro" &
disponibile per domande su espressioni ed equazioni.

Nozioni fondamentali su Vista dati

Il iquadro Vista dati visualizza la domanda nel documento aperto e le relative
risposte. In questo riquadro & possibile visualizzare i risultati in tempo reale. |
dati sono aggiornati mano a mano che gli studenti rispondono alle domande di
Test rapido e Risposta aperta, rappresentano graficamente le funzioni o
spostano punti in un grafico.

Le icone di Vista dati consentono di visualizzare le risposte nel riquadro Vista
dati in forma di diagramma a barre, grafico o tabella. Ogni vista visualizza le
risposte degli studenti e la frequenza di ciascuna risposta.

Le viste diagramma a barre e tabella sono disponibili per tutti i tipi di domanda
e nei documenti di Test rapido. La vista grafico & disponibile nelle domande
Equazione, Punti di coordinate e Lista.
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Le domande su espressioni ed equazioni dispongono di un'ulteriore vista dati
"Mostra lavoro", se la domanda per gli studenti & stata contrassegnata in tal
senso. La visualizzazione dati "Mostra lavoro" viene mantenuta quando si
chiude e siriapre I'area di lavoro di Revisione.

Gli esempi seguenti mostrano gli stessi dati visualizzati nelle diverse viste dati.

-
Cliccare su == per visualizzare i dati in un diagramma a barre.

y=x+3 3

yv=x+1 2

y=x-3 1

.2
Cliccare su % per visualizzare i dati in un grafico.

Nella vista grafico, sono disponibili gli Strumenti Grafico per lavorare con il
grafico. Le impostazioni nel grafico vengono mantenute quando si chiude e si
riapre l'area di lavoro di Revisione.
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Nelle viste diagramma a barre e grafico, soffermare il puntatore sopra una
risposta per visualizzare un elenco di studenti che I'hanno indicata.

- . E

Chopra, Laxmi

Lopez, Maria

Thompson, Olivia

y=x+3 [Thompson, Olivia]
y=x+3 [Lopez, Maria]
=x+3 [Chopra, Laxmi]

Cliccare su % per visualizzare i dati in una tabella.

La vista tabella & disponibile come tabella delle frequenze o come tabella
degli studenti.

» Pervisualizzare i dati in viste diverse, fare clic sullo strumento Organizza
nella Casella degli strumenti Revisione, quindi scegliere Tabella delle
frequenze oppure Tabella degli studenti.

Una tabella delle frequenze mostra le risposte e il numero delle relative

occorrenze. Fare clic sulla intestazione Risposta per ordinare le risposte in

ordine ascendente o discendente o in base alle domande. Fare clic sulla
intestazione Frequenza per ordinare in base alla frequenza di risposta.
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Response Frequency

y=3-x 3
y=x-3 1
y=x+3 1

Una tabella degli studenti mostra i nomi degli studenti con le relative risposte.
Fare clic sulla intestazione Studente per ordinare le risposte in ordine
alfabetico ascendente o discendente. Fare clic sulla intestazione Risposta per
ordinare le risposte in ordine ascendente o discendente o in base alle
domande.

Student Response
Chopra, Laxmi y=3-x
Garcia, Rafe y=x-3
Moore, Jacob y=x+3
Ortega, Carlos y=3-x
Simmons, Nadine  y=3-x

Le impostazioni per l'ordinamento e il dimensionamento delle colonne sono
mantenute per ogni documento quando si chiude e si riapre l'area di lavoro di
Revisione.

Apertura di documenti per la revisione

E possibile rivedere un documento che é stato ritirato dalla classe, un Test
rapido in corso o un Test rapido salvato. Non & possibile rivedere un
documento privo di domande.

306 Utilizzo dellarea dilavoro Revisione



Quando si avvia un Test rapido, viene attivata automaticamente I'area di lavoro
Revisione dove & possibile rivedere i dati mano a mano che gli studenti
rispondono. Se si arresta e si salva il test, & possibile aprirlo nell'area di lavoro
Revisione per rivedere le risposte salvate.

Se si utilizza il software per la prima volta, il riquadro Vista dati potrebbe
essere vuoto. Completare la procedura seguente per aprire un documento per
la revisione.

Apertura di un documento dall'area dilavoro Classe
Per aprire un documento per la revisione dall'area di lavoro Classe:

1.

Utilizzare il selettore dell'area di lavoro per selezionare I'area di lavoro
Classe.

Fare clic con il pulsante destro del mouse su un file nel record della classe
e selezionare Apri in area di lavoro Revisione.

Viene automaticamente visualizzata I'area di lavoro Revisione con il
documento selezionato aperto.

Nota: € possibile aprire i documenti ritirati B contenenti le domande e
Al

i Test rapidi I@J per la revisione nel record della classe.

Class Record

Action File Mame Status
53 AlgebraTest1 Qof10 b =
“ AlgebraTest1.tns 0of10 b
) AlgebraTest2.tns 0of10 »
o3 AlgebraTest! Sof10 b
Unprompted-12-01 (1 »
“l
53 Flot Differential Equation Qof1
| Flot Differential Equation tns 6of 10 D
&  Poll ttns 40f9 b
&  Poll6tns 1org b
&  Poll5tns 10f9 b
h5] ICECreamConeDocumentt.. 2of10 b
23 02 Functions Dofd b
i) HomeworkZ2.tns Dofg b
| Homework2.tns Dofg b
kS| 00 Getting Started.tns Oofg k
| Homework2 tns 0ofg b
<€ Mixed Files 30f3 b
< Mixed Files 3073 b
&  Poll4tns 30f11 b
Unprompted-11-18 (4} ¥
) 10 Simple Machines Dofd b
= 05 Geometry Ooft b «
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Apertura di un documento dall'area dilavoro Portfolio

Per aprire un documento per la revisione dall'area di lavoro Portfolio, attenersi

alla procedura seguente:

1. Utilizzare il selettore dell'area di lavoro per selezionare I'area di lavoro
Portfolio.

2. Fareclic con il pulsante destro del mouse su una cella di colonna o su una
cella nella riga dello studente, quindi fare clic su Apri nell'area di lavoro
Revisione.

& s &
S‘@Q Q?P)(" v\é@ &
i3 ~F ) &
i ARSI
Assignment Summary
Column Actions [0 T
Class Average == — 0% 0%
Date 12-08 12-08 12-08
2 Baker, Susan
& Chopra, Laxmi &= 0% 0%
& Garcia, Rafe L 2] 0% 0%
& Huang, Shen 5L EE] 0% 0%
‘_-5 Kapur, Samir
‘_-5 Li, Song
2 Lopez, Maria
2 Moare, Jacab
& Ortega, Carlos [iz) 0% 0%
£ simmons, Nadine 52 = 0% 0%

‘:3 Thompson, Olivia

Viene automaticamente visualizzata I'area di lavoro Revisione con il
documento selezionato aperto.

Visualizzazione dei dati

E possibile visualizzare dati nel riquadro Studenti o dal riquadro Vista dati. E
possibile scegliere uno studente per visualizzarne le risposte oppure scegliere
una risposta per visualizzare gli studenti che I'hanno indicata.

Visualizzazione dei dati dal riquadro Studenti

» Fare clic su un nome di studente nel riquadro Studenti per visualizzarne la
risposta nel riquadro Vista dati. E possibile selezionare piu student
contemporaneamente.

Il nomi degli studenti selezionati sono evidenziati in blu.
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Review Toolbox

hich of these is not a rational number?

[#] Display Student Responses g
Student = Response  Time
Baker, Susan J‘ 11:50:18

Chopra, Laxmi ~ 0.734  11:50:14
% Huang, Shen 5 11:50:36
¥ Kapur, Samir 11:50:05

e

¥ Lopez, Maria

LT
4 Moore, Jacob s 11:50:28

Simmons, Nadine 3‘33333|0

Thompsen, Olivia i 11:50:25

Se si commuta tra le viste diagramma a barre, grafico e tabella, vengono
mantenute le informazioni selezionate e le risposte degli studenti selezionati
rimangono evidenziate.

Nota: poiché le risposte degli studenti possono variare per le domande Lista,
non vengono visualizzate le risposte Lista degli studenti selezionati nel
riquadro Vista dati.

Visualizzazione dei dati dal riquadro Vista dati

» Fare clic su una risposta nel riquadro Vista dati per visualizzare gli studenti
che I'hanno indicata nel riquadro Studenti. E possibile selezionare piu
risposte contemporaneamente.

Il nomi degli studenti corrispondenti sono evidenziati in blu.

Review Toolbox
Which of these is not a rational number?

[¥] Display Student Responses

Baker, Susan
4 Chopra, Laxmi  0.734  11:50:14

H | Huang, Shen
-

Li, Song

Response ‘Frequency

0.734 1

. } 3.33333
Simmons, Nadine
Thompson, Olivia 11:50:25
[Epaia ] s x e
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Se si commuta tra le viste diagramma a barre, tabella e grafico, vengono
mantenute le informazioni selezionate e gli studenti che hanno indicato la
risposta selezionata rimangono evidenziati.

Nota: se le domande A scelta multipla hanno risposte multiple, sono indicate
da uno spazio blu accanto a tutte le risposte dello studente selezionato.

Response Frequency
0.734 0
3
5 1
{5 4 I/
3.3333 3 l

Nota: per le domande Lista, fare clic con il pulsante destro del mouse su un
punto qualsiasi della vista tabella e fare clic su Mostra colonna studenti per
visualizzare i nomi degli studenti accanto alla risposte.

Student ™ list1 list2
Thompson, Olivia 101 333 =
Thompson, Olivia 201 411
Thompson, Olivia 85 278 _
Kapur, Samir 444 411

Huang. Shen 101 145

Huang, Shen 201 411

Huang, Shen 85 275

Chopra, Laxmi 101 145 -

Modifica delle Proporzioni

L'area di lavoro Revisione visualizza i grafici in un'applicazione domanda
come appaiono sui palmari o sui computer degli studenti. A volte i grafici
possono apparire allungati dal momento che il grafico potrebbe avere le
proporzioni modificate per adattarsi al palmare.
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E possibile scegliere di visualizzare i grafici cosi come arrivano dagli studenti,
oppure & possibile mantenere le proporzioni del grafico come si presentava
quando é stato inserito nell'applicazione domanda.

Per impostazione predefinita, I'area di lavoro Revisione visualizza i grafici in
un'applicazione domanda come appaiono quando gli studenti li inviano.

Per mantenere le proporzioni di un grafico come si presentava quando € stato
inserito nella domanda, attenersi alla seguente procedura:

1.
2.

Visualizzare i dati in vista grafico.

Cliccare con il tasto destro del mouse sul grafico nel riquadro di
Visualizzazione dati e quindi fare clic su Strumenti grafico > Proporzioni.

— Oppure —

ol
b

Cliccare su #% nella casella degli strumenti Revisione, quindi cliccare su
Strumenti grafico > Proporzioni.

Quando la casella Proporzioni € selezionata, le proporzioni sono
conservate. Quando la casella non & selezionata, le proporzioni possono
variare.

Organizzazione delle risposte

E possibile configurare una lista di grafici per domande Lista, organizzare viste
di dati in diagrammi a barre e in tabelle, individuare le risposte degli studenti e
organizzare domande A scelta multipla con risposte multiple in gruppi di
risposte, risposte separate o risposte equivalenti.

Configurazione di una lista di grafici

Le impostazioni della lista di grafici consentono di impostare figure diverse per
i vari grafici per aiutare a seguire linee o riposte separate in un grafico.

Per regolare le impostazioni della lista di grafici, attenersi alla procedura
seguente.

1.

Nella vista grafico, fare clic su Strumenti Grafico nella Casella degli
strumenti Revisione.
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Review Toolbox

Review Tools

L% Graph Tools

2. Fare clic su Impostazioni elenco diagramma.

Si apre la finestra di dialogo Configura grafico/i.

Configure plots for list data
¥list yList

Flot 2 *[Chnnse... "l [Chnnse... vl

Flot 3 *[Chunse... 'l [Chnnse... 'l

Flot 4 A[Chnnse... 'l [Chnnse... 'l

Flots VIChunse... '] [Chnnse... ']

[ OK H Cancel ]
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3. Fare clic sulla freccia in basso accanto a una figura per scegliere la lista
da rappresentare (lista 1, lista 2, ecc.) per la lista X e la lista Y.

Nota: € possibile scegliere piu di una figura per ogni lista.

4. Fare clic su OK.

La vista grafico viene aggiornata con le figure selezionate.

Quando si modifica l'impostazione nella lista grafici dalla vista grafico e
successivamente si passa alla vista diagramma a barre, viene chiesto di
scegliere le liste da mostrare nel diagramma a barre. E possibile scegliere una
sola lista oppure una lista per la categoria e una per la frequenza.

Choose a single list to use for the Bar Chart

list1 =
() Categorical Lists
Choose a list for the Category and a list for the Frequency
Category List |list1 =
Frequency List |list2 =

oK Cancel
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5. Selezionare le opzioni applicabili e fare clic su OK.

Se si fa clic su Annulla, viene mostrato il diagramma a barre come
diagramma di una sola lista, per impostazione predefinita lista.

E possibile configurare la lista grafici in qualsiasi momento dalla vista
diagramma a barre.

Nota: Per configurare la lista grafici dalla vista diagramma a barre, fare clic
su Organizza nella Casella degli strumenti Revisione, quindi fare clic su
Impostazioni lista grafici.

Personalizzazione delle risposte degli studenti

E possibile cambiare il colore delle risposte di ogni studente in un grafico in
modo da poterne identificare le risposte. Cio & utile quando si esegue
un'attivita in tempo reale; € possibile visualizzare I'andamento dei singoli
studenti mano a mano che rappresentano graficamente le funzioni, spostano
punti in un grafico o rispondono a domande di Test rapido.

» Per cambiare il colore delle risposte degli studenti, fare clic su Strumenti
Grafico nella Casella degli strumenti Revisione e selezionare Personalizza
risposte degli studenti.

Il iquadro Vista dati visualizza le risposte in colori diversi.

k gk

% g
A

aX A

I
f

z

Organizzazione dei dati di lista

Nella vista diagramma a barre, & possibile organizzare i dati di lista in base a
Frequenza, Valore numerico o Alfabeticamente.
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Per organizzare i dati di lista, attenersi alla procedura seguente.
1. Nella vista diagramma a barre, fare clic sulla barra Strumenti Grafico.

Review Toolbox

Review Tools

L% Graph Tools »

2. Selezionare l'opzione desiderata per ordinare le barre in base a
Frequenza, Valore numerico o Alfabeticamente.

La vista diagramma a barre viene aggiornata nel riquadro Vista dati.

Organizzazione dei dati del diagramma a barre

Organizzando i dati come risposte separate vengono visualizzati i risultati di
ogni singola risposta. Ad esempio, tutte le risposte A, tutte le risposte B, tutte le
risposte C, ecc. Organizzando i dati come risposte raggruppate vengono
visualizzate tutte le risposte multiple fornite dagli studenti. Ad esempio, tutte le
risposte A piu B, tutte le risposte A piu C, ecc.

Organizzando i dati per equivalenza vengono combinati risultati simili in una
stessa barra. Per esempio, y=4-x, y= -x+4, e y= -(x-4) sarebbero tutti combinati
in un'unica barra o riga di tabella.

Per impostazione predefinita, le risposte multiple sono visualizzate come
risposte separate nella vista diagramma a barre.

Le impostazioni per I'organizzazione di risposte separate o di gruppo e per
I'organizzazione di equivalenza vengono mantenute quando si chiude e si
riapre l'area di lavoro Revisione.
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Per organizzare i dati come risposte raggruppate, attenersi alla procedura
seguente.

1. Fare clic sullo strumento Organizza nella Casella degli strumenti
Revisione.

Review Tools
é Organize L4

Grap nols L

2. Fare clic su Mostra le risposte dello studente raggruppate insieme.

Il riquadro Vista dati mostra le risposte raggruppate.

Which of these is not a rational number? Choose all
that apply.

52,3333 [ 2
25 .
8"E 1
= -
3.33333- 1

3. Perripristinare la vista predefinita, fare clic sullo strumento Organizza e
selezionare Mostra le risposte degli studenti separate.
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Il iquadro Vista dati mostra i dati come risposte separate.

Which of these is not a rational number? Choose all
that apply.

0.734|0
e |
. 1
5 R
333333 [ 5

Organizzazione dei dati per equivalenza

Organizzando i dati per equivalenza vengono raggruppate tutte le risposte
simili in un'unica barra o riga. Nella vista diagramma a barre, &€ sempre
possibile vedere le risposte separate facendo clic sulla barra.

Per organizzare i dati per equivalenza, attenersi alla procedura seguente.

1. Fare clic sullo strumento Organizza nella Casella degli strumenti
Revisione.

Review Tools
é Organize L4

Grap 0ol L
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Cliccare su Raggruppa risposte per equivalenza.
Il riquadro Vista dati mostra le risposte raggruppate.

Per ripristinare la vista predefinita, fare clic sullo strumento Organizza e
selezionare Forma barre per corrispondenze esatte.

Il iquadro Vista dati mostra i dati come risposte separate.

Nascondere e Visualizzare risposte

E possibile nascondere una o pitl risposte di studenti dal riquadro Studenti o
dal riquadro Vista dati. Quando si nasconde una risposta, i dati corrispondenti
vengono aggiornati e il riquadro Vista dati non mostra i dati nascosti. Le
impostazioni per nascondere o mostrare i dati vengono mantenute quando si
chiude e siriapre I'area di lavoro Revisione.

Quando si nascondono le risposte, nelle diverse viste si producono i seguenti
effetti.

Vista diagramma a barre. || diagramma a barre viene aggiornato e ri-
ordinato utilizzando i dati correnti.

Vista tabella. La tabella viene aggiornata e ri-ordinata utilizzando i dati
correnti.

Vista grafico. Il grafico viene aggiornato e ri-ordinato utilizzando i dati
correnti. Qualsiasi regressione inserita viene automaticamente ricalcolata
€ i nuovi valori vengono visualizzati.

Mostra lavoro. |l lavoro dello studente selezionato viene nascosto.

Occultamento delle risposte dal riquadro Studenti
Per nascondere le risposte, attenersi alla procedura seguente.

1.

Nel riquadro Studenti, selezionare gli studenti di cui si desiderano
nascondere le risposte.

Le risposte degli studenti selezionati vengono evidenziate in blu nel
riquadro Vista dati.
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Review Toolbox

R Edit the expression to change the slope from positive
to negative.

[#| Display Student Responses oo v

Student . Response
Chopra, Laxmi y=3-x
Huang, Shen y=3-x
Kapur, Samir
Li, Song y=3-x

Lopez, Maria

Thompson, Olivia

Fare clic sul menu delle Opzioni e quindi selezionare Nascondi
selezionati, oppure deselezionare la casella di controllo accanto al nome

dello studente.

Nel riquadro Vista dati vengono nascoste le risposte degli studenti
selezionati e vengono mostrate le risposte dei restanti studenti.

I nomi degli studenti selezionati appaiono in grigio.

iew Toolbox

Edit the expression to change the slope from positive
to negative.

Display Student Responses w -

Student & Response

Baker, Susan L/
Chopra, Laxmi y=3-x 1A
Huang, Shen y=3—x I
Kapur, Samir

Li, Song y=3—x 1

Lopez, Maria B
Moore, Jacob /]

Simmons, Nadine /]

Thompson, Olivia /

EIREIEEEEEE]

ElAlgebraTest1 xl ol 1 xl [BlalgebraTestz x| 4rmE

Nota: se una risposta & nascosta, fare clic sul nome di uno studente per
visualizzare la risposta. La risposta appare in blu nel riquadro Vista dati.
Tutte le viste diagramma a barre, tabella e grafico vengono aggiornate con
i dati selezionati. La risposta rimane visibile fino a quando non si
seleziona un altro studente.
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Review Toolbox -

" Edit the expression to change the slope from positive
to negative.
Display Student Responses & -
| Sfudent & Response
B Baker, Susan
Chopra, Laxmi y=3-x
Huang, Shen y=3-x
Kapur, Samir
Li, Song y=3-x
Lopez, Maria —|
B Moore, Jacob
8| Simmons, Nadine |

Thompson, Olivia

[PllgebraTest! x| —Pell1 x| PaigsbraTest2 x arm

Occultamento delle risposte dal riquadro Vista dati

E possibile nascondere le risposte nelle viste diagramma a barre, grafico o
tabella. Quando si nascondono le risposte, il riquadro Vista dati aggiorna i dati
e non visualizza le risposte nascoste. Nella vista Studenti, i nomi degli studenti
appaiono in grigio. Nella vista Ordinatore pagine, i documenti o le icone
rimangono invariati.

Per nascondere le risposte, attenersi alla procedura seguente.
1. Nelriquadro Vista dati, selezionare le risposte da nascondere.

Gli studenti selezionati vengono evidenziati in blu nel riquadro Studenti.

Review Toolbox -
% Edit the .expressinn to change the slope from positive
to negative.

[] Display Student Responses

Student Resuunse

72} Chopra‘ Laxmi y=3-x
Huang, Shen y=3-x
Kapur, Samir

Li, Song y=3-x

[} Lopez. Maria

Thompson Olivia

2. Fare clic con il pulsante destro del mouse sulla risposta e selezionare
Nascondi selezionati.
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Nel riquadro Vista dati vengono nascoste le risposte selezionate e
vengono mostrate le risposte dei restanti studenti.

I nomi degli studenti che corrispondono alle risposte selezionate appaiono
in grigio.

Review Toolbox
3 Edit the expression to change the slope from positive

to negative.
Display Student Responses W T

Student Response
Baker, Susan s
Chopra, Laxmi y=3-x 1/
Huang, Shen y=3-x
Kapur, Samir

Li, Song y=3-x 1

Lopez, Maria
Moore, Jacob %4
Simmons, Nedine /]
Thompson, Olivia /]

NDDR 8 8 @ © O

{PigebraTest1 X | = Poll1 x| @PAigebraTest2 X b B

Visualizzazione delle risposte
Per visualizzare le risposte nascoste, attenersi alla procedura seguente.

1. Nelriquadro Studenti, selezionare gli studenti di cui si desiderano
visualizzare le risposte.

2. Fare clic sul menu delle Opzioni ** e quindi selezionare Mostra
selezionati.

I nomi degli studenti appaiono in nero e le risposte degli studenti vengono
visualizzate nel riquadro Vista dati.

Contrassegnare le risposte come corrette o non corrette

E possibile utilizzare I'area di lavoro Revisione per contrassegnare le risposte
selezionate come corrette o non corrette. Se si sta rivedendo un documento
con una risposta corretta gia contrassegnata, la risposta corretta pud essere
modificata. In una domanda A scelta multipla con piu risposte, & possibile
aggiungere altre risposte corrette.

Se la casella Mostra risposta corretta € selezionata, le risposte contrassegnate
come corrette vengono evidenziate in verde.
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| dati vengono ricalcolati sulla base delle risposte corrette e il riquadro Vista
dati viene aggiornato per riflettere le modifiche.

Per contrassegnare una risposta come corretta:
» Nel riquadro Studenti, fare clic con il pulsante destro del mouse su uno
studente e scegliere Segha come corretta.

» Nelriquadro Vista dati, fare clic con il pulsante destro del mouse su una
risposta e fare clic su Segna la risposta selezionata come corretta.

» Nel riquadro Vista dati, fare clic su una risposta e selezionare Segna la
risposta selezionata come corretta nel riquadro Strumenti Revisione.

Nelle domande A scelta multipla con piu risposte, i segni di spunta sono

visualizzati accanto alle risposte.

» Fare clic su un segno di spunta per contrassegnare una risposta come
corretta.

Quando si contrassegna una risposta come non corretta, I'evidenziazione
verde viene rimossa.
Per contrassegnare una risposta come non corretta:

» Nel riquadro Studenti, fare clic con il pulsante destro del mouse su uno
studente e scegliere Rimuovi come corretta.

» Nel riquadro Vista dati, fare clic con il pulsante destro del mouse su una
risposta e fare clic su Segna la risposta selezionata come non corretta.

» Nelle domande A scelta multipla con piu risposte, fare clic sul segno di
spunta verde.

Nota: se si modifica una risposta come corretta o non corretta, gli eventuali

punteggi gia assegnati manualmente agli studenti per le risposte corrette o
non corrette non verranno cambiati.

Quando si contrassegnano le risposte, nei diversi tipi di domanda si
producono i seguenti effetti.

Tipi di matrice

domanda

Scelta multipla,  Risposta singola - Inserendo una nuova risposta si
Risposta sostituisce la risposta corrente. Rimuovendo una risposta
singola si lascia la domanda senza risposte corrette.
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Tipi di
domanda

matrice

Immagine
Etichetta,
Risposta
singola
Immagine
Punto su,
Risposta
singola

Scelta multipla,
risposte
multiple
Immagine
Etichetta,
Risposte
multiple
Immagine
Punto su,
Risposte
multiple

Inserendo una nuova risposta si aumenta l'insieme delle
risposte corrette. Ad esempio, una risposta "A e B"
diventa "A e B e C." Rimuovendo una risposta si riduce
I'insieme delle risposte corrette.

Risposta
aperta:
Descrizione
Risposta
aperta:

Corrispondenza

di testo
Equazione: f(x)
ey=

Per Punti di
coordinate:

Espressione:
Variabile

Inserendo una nuova risposta si aumenta l'insieme delle
risposte corrette. Rimuovendo una risposta si lascia la
domanda senza risposte corrette.

Utilizzo dell'area dilavoro Revisione 323



Tipi di matrice

domanda

Chimica

Espressione: L'aggiunta di una nuova risposta, con o senza tolleranza,
Numerica sostituisce la risposta corrente. Rimuovendo una risposta

si lascia la domanda senza risposte corrette.

Gli esempi che seguono mostrano risposte contrassegnate come corrette in
diverse viste dati.

3
g"IO

e  _E
33035 v [ >

Vista diagramma a barre, domanda A scelta multipla con piu risposte e due
risposte corrette, organizzata in base a Mostra le risposte degli studenti separate
e nessuno studente selezionato nel riquadro Studenti.
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3.33333 % - 2

Vista diagramma a barre, domanda A scelta multipla con piu risposte e due
risposte corrette, organizzata in base a Mostra le risposte degli studenti separate
e uno studente selezionato nel riquadro Studenti.

a .k
5233333 [ :

1T,J5_|0

Vista diagramma a barre, domanda A scelta multipla con piu risposte e due
risposte corrette, organizzata in base a Mostra le risposte degli studenti
raggruppate e nessuno studente selezionato nel riquadro Studenti.

Utilizzo dell'area dilavoro Revisione 325



T |
5 3.3333 [ 2
TT,,E | 0

Vista diagramma a barre, domanda A scelta multipla con piu risposte e due
risposte corrette, organizzata in base a Mostra le risposte degli studenti
raggruppate e uno studente selezionato nel riquadro Studenti.

Response Frequency
0.734 0
1
1
3.33333 2

Vista tabella delle frequenze, domanda A scelta multipla con una risposta
corretta e nessuno studente selezionato nel riquadro Studenti.

Student/ Response
Chopra, Laxmi 5
Garcia, Rafe 3.33333

Ortega, Carlos 3.33333

Simmons, Nadine

Vista tabella degli studenti, domanda A scelta multipla con una risposta corretta e
uno studente selezionato nel riquadro Studenti.
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Vista grafico, domanda Equazione y= con una risposta corretta € nessuno
studente selezionato nel riquadro Studenti.

Vista grafico, domanda Equazione y= con una risposta corretta e uno studente
selezionato nel riquadro Studenti.

Inserimento di dati dell'insegnante

A volte pud accadere di voler inserire dati personali in un grafico che si sta
rivedendo in classe. Gli Strumenti Grafico consentono di inserire in un grafico
punti ed equazioni dell'insegnante, di regolare le impostazioni di lista grafici e
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di personalizzare le risposte degli studenti.

| dati dell'insegnante appaiono piu grandi e di colore diverso rispetto ai dati
degli studenti.

Quando si inseriscono dati dell'insegnante, i dati vengono ricalcolati e il
riquadro Vista dati viene aggiornato per riflettere le modifiche.

E possibile nascondere o visualizzare i dati dell'insegnante ma non & possibile
contrassegnare le risposte dell'insegnante come corrette o non corrette.

Inserimento di punti dell'insegnante
1. Fare clic sugli Strumenti Grafico nella Casella degli strumenti Revisione.

Review Toolbox

Review Tools

L% Graph Tools »

2. Fare clic su Aggiungi punto insegnante.

Si apre la finestra di dialogo Aggiungi punto insegnante.
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Add Teacher Point

&
)

l oK H Cancel ‘

3. Digitare le informazioni nei campi.
Fare clic su 5] per aprire i modelli matematici e i simboli che si possono
introdurre nei campi.

4. Fare clic su OK.

Il punto viene visualizzato nel grafico e il nome Insegnante viene aggiunto
ai nomi del riquadro Studenti.

Nota: L'insegnante puo avere piu voci.

Review Toolbox

2 Edit the expression to change the slope from positive to negative.

[] Display Student Responses o

Student = Response
Chopra, Laxmi ~ y=3—x

Garcia, Rafe y=x-3
Lopez, Maria

Moore, Jacob y=x+3
Ortega, Carlos ~ ¥=37x
Simmons, Nadine v=3-x
Teacher (2,3)

FIEIEEEEENE]

Inserimento di equazioni dell'insegnante

1. Fare clic sugli Strumenti Grafico nella Casella degli strumenti Revisione.
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2.

Review Toolbox

Review Tools

L% Graph Tools k

Fare clic su Aggiungi equazione insegnante.

Si apre la finestra di dialogo Aggiungi equazione insegnante.

Add Teacher Equation

Digitare le informazioni nel campo.

Fare clic su 5] per aprire i modelli matematici e i simboli che si possono
introdurre nei campi.

Fare clic su OK.

La linea viene visualizzata nel grafico e il nome Insegnante viene aggiunto
ai nomi del riquadro Studenti.

Nota: L'insegnante pud avere piu voci.
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Salvataggio nell'area di lavoro Portfolio

E possibile salvare documenti che contengono domande e Test rapidi
nell'area di lavoro Portfolio, dove € possibile rivedere e analizzare le singole
risposte e assegnare o modificare la valutazione di uno studente.

Quando si salvano Test rapidi in Portfolio, gli studenti possono continuare a
inviare risposte al Test rapido fino a quando il test non viene terminato. Il Test
rapido salvato in Portfolio si aggiorna automaticamente senza doverlo
nuovamente salvare.

Note: se il file & stato aperto dall'area di lavoro Portfolio, oppure se & gia stato
salvato in Portfolio, non viene richiesto di specificare un nome file. Il file viene
salvato nell'area di lavoro Portfolio con il nome file esistente e vengono
aggiornate tutte le valutazioni assegnate agli studenti. E possibile accedere
all'area di lavoro Portfolio e modificare una valutazione in qualsiasi momento.

Per salvare un file nell'area di lavoro Portfolio:

[ 1]
1. Fare clic su File > Salva in Portfolio, oppure fare clic su .

Si apre la finestra di dialogo Salva in Portfolio. Per default, il nome del file
€ visualizzato nella casella Nome Portfolio. Se il file € un Test rapido non
ancora salvato, il nome predefinito € <Nome classe, Test rapido n. serie ,
gg-mm.ins>. Ad esempio: Algebra1 - sig.ra Smith, T.r. serie 2, 26-10.tns.

(® Add as new portfolio column

TN EV T Trigonometry Poll 4 03-01.

| Save || Cancel

» Peraggiungere una nuova colonna di Portfolio, selezionare Aggiungi
come nuova colonna di Portfolio. E possibile utilizzare il nome
esistente oppure digitarne uno nuovo.
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»  Peraggiungere i file in una colonna di Portfolio esistente, selezionare
Aggiungi a colonna di Portfolio esistente. Fare clic sulla freccia giu per
selezionare la colonna desiderata.

Nota: i test rapidi non possono essere aggiunti a colonne esistenti.
2. Fare clic su Salva.

Il file viene salvato nell'area di lavoro Portfolio.

Salvataggio dati come nuovo documento

E' possibile prendere i dati raccolti dagli studenti, vederli in formato tabella, e
salvarli come documento di Foglio elettronico. Questo documento pud essere
utilizzato come aiuto didattico o pud essere inviato agli studenti per ulteriori
analisi.

Nota: Se i dati provengono da una domanda Liste, i titoli di colonna nella
Visualizzazione tabella vengono utilizzati come nomi per le variabili della lista.
Se i nomi delle variabili non sono utilizzabili, il software li rinomina. Per
esempio, se il nome ha uno spazio il software lo sostituisce con un underscore
(segno di sottolineatura).

1. Persalvare i dati in un nuovo documento Foglio elettronico, assicurarsi
che si sta visualizzando i dati in formato tabella.

2. Cliccare con il tasto destro del mouse su qualsiasi punto della tabella e
quindi cliccare su Invia tabella ad un nuovo documento.

Nota: | dati nascosti non sono inviati. Se i dati sono ordinati, I'ordine
stabilito viene mantenuto nel nuovo documento.

I documento Foglio elettronico viene aperto nell'area di lavoro Documenti.
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Utilizzo dell'area di lavoro Portfolio

Utilizzare quest'area di lavoro per salvare, rivedere, modificare valutazioni, e
gestire elaborati degli studenti.

S S s S /
S
& - & S & S S &
= & s @ s® &
o F § & F F &
= . ¢
ralReviewfor Assignment Summary = v » < » 3 &
2101 - MGentry, OP Set 1, 11-18.1ns T — Kl s = PR =
Class Average - % — - %% — 9%
[ entry, QP Set 1, 11-16.1ns
) e B BTy S A Date 11498 1198 1118 146 1102 1102
= Getting Started 3.0 A susanBaker 100% ] 100% = 100%
8 songLi 20% 100% 0%
A shen Huang 100% 100% = 100%
& samirKapur 100% 80% 90%

& Rate Garcia

& olivia Thompson
& Nadine Simmons
& Maria Lopez

& Laxmi Chopra

A 1arah Manra

100%
98%
2%

100% 8%

100%

2
FIEIE

I8 FR 1 EEEEEREEELEE
¥

[ 0 T I A S I IS N
F

F
[

o Riquadro Compiti. Selezionare i compiti per visualizzare gli studenti € i
voti. E possibile ridistribuire, rinominare o rimuovere un compito.

@ Area di Lavoro. Elenca gli studenti nella classe selezionata e mostra i voti
ricevuti per ogni compito. Consente di visualizzare i compiti di uno
studente o della classe; ordina per compito, voto o studente e modifica i
voti dei compiti.

Esplorazione del riquadro Compiti

| ‘i\f'@

(1 JER2ssionments summan|

: AlgebralReviewforAlgebrall

/'H Algebra 101 - MGentry, QP Set 1, 11-18.tns
" DeterminingArea

@ f{? Algebra 101 - MGentry, QP Set 1, 11-16.tne
% Algebra 101 - MGentry, QP Set 1, 11-02.tns
" Getting Started 3_0

o

o Riepilogo compiti. Elenca i nomi dei compiti salvati nell'area di lavoro
Portfolio. Mostra una media dello studente e della classe nell'area di
lavoro.

Fare clic sul segno meno (-) per comprimere I'elenco dei compiti dello
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studente e visualizzare solo il Riepilogo compiti.

Fare clic sul segno piu (+) per mostrare I'elenco dei compiti dello
studente.

@ Compiti dello studente. Fare clic su un compito per visualizzare i voti
dello studente per quel compito.

© Menu opzioni. Disponibile quando si seleziona un compito dello
studente. Fare clic su % per aprire un menu che permette di:
»  Aprire il documento nell'area di lavoro Revisione.

* Ridistribuire il compito alla classe corrente.

* Rimuovere il compito dall'area di lavoro Portfolio. Il compito esiste
ancora in altre aree di lavoro.

*  Rinominare il compito

Esplorazione delle viste dell'Area di lavoro

L'aspetto dell'area di lavoro dipende da cio che ¢ stato selezionato nel
riguadro Compiti.

Vista Riepilogo compiti
Questa area di lavoro si apre quando si seleziona Riepilogo compiti nel
riquadro Compiti.

o
,§@§ m\@ . \(@Y m@ ,D\Q\ (‘}é& o (5)
P P & ) & & e

o\ Assignment Summary — » »° o #© o ~

Column Actions ﬂ - = & - 5 —@
@-C\ass Average = a7% = = 96% — 9%

Date 11-18 11-18 11-18 11-16 11-02 11-02
9/ /4 Susan Baker = 100% B 100% = 100%

£ Song Li =] 80% B 100% 0%

£ Shen Huang =] 100% = 100% = 100% 6
o A samir Kapur B 100% = 80% 90%

£ Rafe Garcia =] 100% = 100% = 100%

A Olivia Thompson ] 95% = 100% =] 98%

2 Nadine Simmons ] 100% = 85% =] 92%

A Maria Lopez. = 95% | 100% 98%

£ Laxmi Chapra (] 100% = 100% = 100%

A tarnh Manra

o Azioni colonna. Consente di eseguire determinate azioni su una colonna.
Fare clic sull'icona di un file su questa riga per:
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®e o ©

*  Aprire un elaborato per la revisione nell'area di lavoro Revisione.

« Ordinare gli elaborati in ordine alfabetico ascendente o discendente
in base allo studente.

*  Aprire il documento master nell'area di lavoro Revisione.
* Rimuovere da Portfolio
* Rinominare il compito

Media della classe. Mostra il voto medio della classe per il compito in
quella colonna.

Data. Mostra la data in cui il file € stato ritirato. La data dell'ultimo ritiro
viene mostrata nella prima colonna a sinistra.

Studenti. Elenca tutti gli studenti nella classe.

Intestazione di colonna. Mostra il nome del compito salvato nell'area di
lavoro Portfolio. Nell'intestazione di colonna & possibile effettuare le
stesse azioni consentite sulle azioni colonna. Fare clic con il pulsante
destro del mouse per aprire il menu.

L'intestazione colonna Punteggio Mediomostra il punteggio medio di tutti i
compiti e il punteggio medio di tutti i compiti di uno studente. Fare clic con
il pulsante destro del mouse sulla colonna Punteggio Medio per ordinare
i voti in ordine ascendente o discendente.

Icona File. Mostra il tipo di file. | tipi di file visualizzati sono:

Al

=

— PublishView™

(Mostrati solo nel TI-Nspire™ Navigator™ NC Teacher Software)

Test rapido

TI-Nspire™
L) Altri tipi di file
(Mostrati solo nel TI-Nspire™ Navigator™ NC Teacher Software)
Voti dello studente. Se una domanda viene valutata automaticamente, i

voti vengono visualizzati qui. E possibile modificare un voto di uno
studente per un compito.
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Vista Compito dello studente

Questa area di lavoro si apre quando si seleziona un singolo compito nel
riguadro Compiti. Per visualizzare questarea di lavoro, il compito da aprire
deve essere un file tns. che contiene una o pit domande.

Nota: nel TI-Nspire™ Navigator™ NC Teacher Software & possibile aprire un file
nsp.

(5]
AlgebraTest2B 1 2 3 +Points Total - % %
g—Total Possible ... 10.0 100 50 75.0 100.0 Raw Final
Moore, Jacob 10.0 100 50 750 100.0 100% 100% [=
Chopra, Laxmi 100 100 50 750 100.0 100% 100%
9 Ortega, Carlos 100 100 50 750 100.0 100% 100% —@
Lopez, Maria 10.0 9.0 50 750 99.0 99% 99%
Simmons, Nadi... 9.0 100 50 750 99.0 99% 99% =
Garcia, Rafe 8.0 100 50 750 98.0 98% 98%
Huang, Shen 10,0 100 3.0 70.0 93.0 93% 93% —0
Thompson, Olivia
Kapur, Samir I
Li, Song -
o—ﬁvsrage 96% 99% 94% 74 28571428 98.4285714.. 98% 98%
1 ] 3

0 Nome del compito selezionato.

@ Totale possibile. Questa riga mostra i punti per queste categorie:

« i Punti possibili complessivi per ogni domanda nel compito. E
possibile modificare questo numero.

« Il numero totale di punti extra possibili per il compito. E possibile
modificare questo numero.

* | punti totali per il compito.

+ Punteggio grezzo in base al numero di punti che lo studente ha
ricevuto diviso per il totale punti possibili.

*  Percentuale finale. Questo numero si aggiorna quando si modificano
i punti possibili o i punti extra. E possibile modificare questo voto. I
voto finale & lo stesso del voto non elaborato, se questo non viene
modificato.

+ Se si modifica il voto finale, questo non si aggiornera piu se gli altri
punti cambiano.

@ Nomi studenti. Tutti gli studenti che hanno ricevuto il compito selezionato.
Fare clic con il pulsante destro del mouse e modificare il documento
nell'area di lavoro Documenti oppure aprire il documento per la revisione
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nell'area di lavoro Revisione.

G Media. Mostra il voto medio per tutti gli studenti, cosi come la media dei
punti totali, voto grezzo e voto finale.

@ Domande nel compito. Se il compito conteneva piu domande, ogni
domanda viene visualizzata in quest'area insieme al voto totale possibile
per quella domanda.

@ Voti. Elenca il voto ricevuto da ogni studente per il compito selezionato.
Ogni pagina nel compito puo avere un voto separato. Fare clic con il
pulsante destro del mouse per modificare il voto, aprire il compito
nell'area di lavoro Documenti oppure aprire il documento nell'area di
lavoro Revisione.

0 Barra di scorrimento. Appare quando sono presenti pit domande da
visualizzare in un compito oppure piu studenti da visualizzare.

Salvataggio di un elemento nell'area di lavoro Portfolio

Se si sta utilizzando il software TI-Nspire™ per la prima volta, I'area di lavoro
Portfolio potrebbe essere vuota. E necessario salvare i file nell'area di lavoro
Portfolio per visualizzare e modificare i voti ed eseguire altre operazioni sul
file.

E possibile salvare file ritirati, non sollecitati e di Test rapido nell'area di lavoro
Portfolio. E possibile salvare I'area di lavoro Portfolio dalle aree di lavoro
Classe e Revisione.

Quando si salvano Test rapidi in Portfolio, gli studenti possono continuare a
inviare risposte al Test rapido fino a quando il test non viene terminato. Il Test
rapido salvato si aggiorna automaticamente senza doverlo nuovamente
salvare.

Nota: se il file & stato aperto dall'area di lavoro Portfolio, oppure se € gia stato
salvato nell'area di lavoro Portfolio, non viene richiesto di specificare un nome
file. Il file viene salvato nell'area di lavoro Portfolio con il nome file esistente e
vengono aggiornate tutte le valutazioni assegnate agli studenti. E possibile
modificare una valutazione nell'area di lavoro Portfolio in qualsiasi momento.
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Per salvare un file nell'area di lavoro Portfolio, attenersi alla procedura
seguente.

1.

2,

3.

Selezionare i file da salvare.

+ Dalla Registrazione della classe nell'area di lavoro Classe, fare clic
su } , e quindi fare clic su Salva selezionati in Portfolio.

+ Daunfile aperto nell'area di lavoro Revisione, fare clic su File > Salva

in Portfolio, oppure fare clic su 1.

Viene visualizzata la finestra di dialogo Salva in Portfolio.

Save to Portfolio

(®) Add as new portfolie column

Porfolio name: |

(©) Add to gxisting portfolio column

Existing column:

Cancel

Salvare i file in una nuova colonna di Portfolio oppure inserirli in una
colonna di Portfolio esistente.

+  Peraggiungere i file in una nuova colonna di Portfolio, selezionare
Aggiungere come nuova colonna di Portfolio. E possibile utilizzare il
nome esistente oppure digitarne uno nuovo.

* Persalvare ifile in una colonna di Portfolio esistente, selezionare
Aggiungi a colonna di Portfolio esistente. Fare clic sulla freccia verso
il basso per selezionare la colonna desiderata dall'elenco a discesa.

Nota: i test rapidi non possono essere aggiunti a colonne esistenti.
Fare clic su Salva.

Il file viene salvato nell'area di lavoro Portfolio.

Nota: i file salvati nell'area di lavoro Portfolio rimangono nella Registrazione
della classe fino a quando non li si rimuove con il comando Rimuovi.

Se un file viene eliminato dalla Registrazione della classe, I'eliminazione non
ha effetto sulla copia salvata nell'area di lavoro Portfolio. La copia rimane
nell'area di lavoro Portfolio fino a quando non viene eliminata.
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Importazione di un elemento nell'area di lavoro Portfolio

E possibile importare un file .tsn dal computer a una cella del Portfolio di uno
studente.

1. Fare clic su Riepilogo compiti.
2. Evidenziare una cella nella riga dello studente in cui si desidera importare
il file.
Nota: & possibile importare un file per un solo studente alla volta.
3. Fare clic su File > Importa elemento.
Viene visualizzata la finestra di dialogo Apri
4. Evidenziare e fare clic sul file da importare.
Fare clic su Importa.

Se in quella cella esiste gia un file, viene richiesto di confermare la
sostituzione del file.

. Per sovrascrivere il file esistente con quello nuovo, fare clic su
Sostituisci.

»  Fare clic su Mantieni esistente per mantenere il file esistente e
cancellare la funzione di importazione file.

Modifica dei voti

Potrebbe essere necessario modificare il voto di uno studente. Per esempio,
un compito a risposta aperta contiene una domanda che richiede la parola
"Autumn" (Autunno) come risposta corretta. Uno studente ha inserito "Fall."
(Autunno) Se si desidera assegnare allo studente un credito parziale o pieno,
sara necessario cambiare il voto dello studente per la domanda.

Oltre a modificare il voto di uno studente individuale, &€ possibile modificare i
punti totali possibili per ogni domanda, i punti extra e la percentuale finale.

» Utilizzare numeri interi per modificare i voti. Per esempio, digitare 75 per
dare un voto del 75%, digitare 100 per dare un voto del 100%, e cosi via.

Nota: se si digita un voto e non si preme Invio, la modifica non viene effettuata
e rimane effettivo il voto precedente.
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Anteprima Risposta Studente

E' possibile visualizzare I'anteprima della risposta di uno studente ad una
domanda nel Riquadro Anteprima. Questo consente di rivedere le domande,
risposte e modifica dei voti in modo rapido, semplice ed efficiente.

Nota: il compito da aprire deve contenere almeno una domanda per poter
visualizzare l'anteprima.

1. Fare clic sul compito di uno studente nell'elenco Riepilogo compiti.

2. Selezionare la cella della domanda di cui si desidera visualizzare
I'anteprima.

Final
10 100%  100%

10 100%  100% §
10 100%  100% -
04 % 9%

Le informazioni seguenti vengono visualizzate nel Riquadro Anteprima.

+ D#Domanda. Domanda originale con un'icona che segnala la
risposta corretta o sbagliata

* Risposta dello studente. Risposta dello studente

* Risposta corretta Risposta corretta dell'insegnante (vuoti se non c'é
risposta corretta)

Nota: in relazione alla domanda inviata, potrebbero essere visualizzate
altre informazioni,

Modifica un voto di uno studente per un compito.

E possibile modificare il voto per un compito dalla vista Riepilogo compiti
oppure e possibile modificare il voto per domande individuali in un compito
dalla vista Compiti dello studente. Questi passaggi descrivono il modo per
modificare un voto dalle viste.

1. Nellariga dello studente, selezionare il voto che si desidera modificare.

2. Fare clic con il pulsante destro del mouse sulla cella e fare clic su Modifica
voto.

3. Digitare il voto sostitutivo e premere Invio. Per cancellare, premere Esc.
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Modifica dei punti totali possibili per una domanda

E possibile modificare il voto totale possibile per le domande di uno studente o
per punti extra.

1.
2.

4.

Selezionare una cella nella riga Totale possibile.

Fare clic con il pulsante destro del mouse sulla cella e fare clic su Modifica
voto.

Digitare i punti per la domanda o per i punti extra e premere Invio.

Il software chiede se si vogliono mantenere i voti dello studente per la
domanda, o rivalutare i voti per ogni studente. L'impostazione predefinita
rivaluta i voti per ogni studente.

Changes to Question Tofals

|, Thetotal being edited has been used for assesment of student responses for this
question.

© Leave student assigned credit for this question intact
No changes will be made to credit awarded to students for this question

(®) Reassess question for each Student
The student responses will be reassessed and awarded credit using the new total

Student scores can be updated manually at any time

| cancel |

+ Per mantenere i voti degli studenti senza effettuare modifiche,
selezionare Lascia intatto il credito assegnato allo studente per
questa domanda.

»  Per stimare nuovamente il voto di ogni studente, selezionare Rivaluta
domanda per ogni studente.

Fare clic su OK.

Madifica del voto finale in percentuale

1.

3.

Nella vista Compiti dello studente, selezionare lo studente di cui si vuole
modificare il voto.

Fare clic con il pulsante destro del mouse sulla cella nella colonna Finale
e fare clic su Modifica voto.

Digitare il voto sostitutivo e premere Invio. Per cancellare, premere Esc.

Nota: se si modifica il voto finale, si conserva il valore modificato e non viene
piu aggiornato se si modificano altri valori nella riga.
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Esportazione dei risultati

Se l'insegnante o il distretto scolastico utilizzano reportistica e archiviazione di
valutazioni elettroniche, potrebbe essere necessario esportare le valutazioni a
questi programmi. E' possibile esportare i risultai dall'area di lavoro Portfolio
tramite un file CSV. L'azione di esportazione include tutti i voti per tutti gli
studenti per il compito selezionato o per tutti i compiti.

Il file .csv contiene tutte le colonne e le righe nell'area di lavoro a eccezione
della riga Azioni colonna. Se uno studente presenta una cella vuota senza voti,
il file .cvs visualizza una cella vuota.

Esporta vista corrente

Questo permette di esportare tutti i dati presenti nell'area di lavoro Portfolio per
un singolo compito.

1. Selezionare un compito dall'elenco.
Fare clic su File > Esporta Dati oppure fare clic su '@.
Selezionare Esporta vista corrente.
Viene visualizzata la finestra di dialogo Esporta dati.

* La cartella predefinita € Documenti.

* Il nome predefinito € il nome del compito.
Export Data [ ]
Save In: |1 Deskiop - &= @

Downloads
Khronos
PersReferencelnfo
TortoiseSVN

4, ClassRosterMGentry3 csv

File Name:  |Algebra 101 - MGentry.csv |

Files of Type: |CSV File (*.csv) -

|--save| [-Cancel-|

4. Aprire la cartella in cui si desidera salvare il file.

5. Fare clic su Salva.

Esportazione personalizzata

L'Esportazione Personalizzata permette di esportare i voti finali per uno o piu
compiti. E' utile per segnalare i punteggi in un intervallo di date con solo
I'esportazione del nome dello studente e il punteggio finale.
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. i . . (=
1. Fare clic su File > Esporta Dati oppure fare clic su [
2. Selezionare Esportazione personalizzata.
Viene visualizzata la finestra di dialogo Esportazione personalizzata.

Custom Export xJ

Select an assignment. You may select multiple assignments.

Algebra 101 - MGentry, QP Set 1, 11-16.tns 2l
Algebra 101 - MGentry, QP Set 1, 11-02.tns
Getting Started 3_0

Clear All

| Export H Cancel |

3. Selezionare il compito che si intende esportare.
» Selezionare la casella di controllo secondo il nome del compito.
*  Fare clic su Seleziona tutto Per selezionare tutti i compiti
»  Fare clic su Annulla tutto per annullare le selezioni.
4. Fare clic su Esporta.
Viene visualizzata la finestra di dialogo Esporta.
» La cartella predefinita € Documenti.
* Il nome predefinito & il nome del compito.
5. Aprire la cartella in cui si desidera salvare il file.

6. Fare clic su Salva.

Ordinamento delle informazioni nell'area di lavoro Portfolio

1. Fare clic sull'intestazione di colonna in base alla quale ordinare I'elenco.

L'elenco selezionato viene organizzato in ordine ascendente, discendente
o per nome studente.

2. Fare clic di nuovo sull'intestazione della colonna per ordinare in un altro
modo.
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Apertura di un elemento Portfolio in un'altra area di lavoro

E possibile aprire il file .tns nell'area di lavoro Documenti per modificarlo
oppure & possibile aprire un file .tns o Test Rapido nell'area di lavoro
Revisione per visualizzare le risposte dello studente nelle viste diagramma a
barre, tabella o grafico.

Nota: in TI-Nspire™ Navigator™ NC Teacher Software & possibile aprire un file
nsp.

Apertura di un elemento nell'area di lavoro Documenti

1.

Fare clic sul file da aprire.
Per aprire un file per tutti gli studenti:
+ dall'elenco Riepilogo compiti, fare clic sul file.

» Dalla vista Riepilogo compiti, fare clic sull'icona nella riga Azioni
colonna oppure fare clic sull'lntestazione colonna.

Per aprire un file per studenti selezionati:

» dalla vista Riepilogo compiti, selezionare una cella in una riga dello
studente selezionato. E possibile aprire piu di un file in una colonna
ma non € possibile aprire piu file da colonne diverse.

. Dalla vista Compiti dello studente, selezionare una cella nella riga
dello studente selezionato.

Fare clic su File > Apri per modifica oppure fare clic con il pulsante destro
del mouse e cliccare Apri per modifica.

Il file viene aperto nell'area di lavoro Documenti.

Apertura di un elemento nell'area di lavoro Revisione

1.

Fare clic sul file che si desidera aprire utilizzando uno dei seguenti metodi:
+ dall'elenco Riepilogo compiti, selezionare il file.

» Dalla vista Riepilogo compiti, fare clic sull'icona nella riga Azioni
colonna oppure fare clic sull'lntestazione colonna.

+ Dalla vista Riepilogo compiti, fare clic su una cella in una riga dello
studente selezionato. E possibile aprire pit di un file in una colonna
ma non € possibile aprire piu file da colonne diverse.

+ Dalla vista Compiti dello studente, fare clic su una cella nella riga
dello studente selezionato.
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Nota: ogni metodo selezionato per aprire il file nell'area di lavoro
Revisione apre il file con tutte le risposte dello studente. Non € possibile
aprire un file solo per uno studente. Tuttavia, & possibile rivedere le riposte
per uno studente individuale nell'area di lavoro Revisione.

2. Fare clic su File > Apri nell'area di lavoro Revisione oppure fare clic con il
pulsante destro del mouse e selezionare Apri nell'area di lavoro
Revisione.

Il file viene aperto nell'area di lavoro Revisione.

Apertura di un documento master

Un Documento master € il documento originale inviato agli studenti e contiene
la soluzione delle risposte per valutare le risposte ritirate dagli studenti.
Quando si salva un documento in una colonna nell'area di lavoro Portfolio,
generalmente un Documento master & associato a quel file.

E possibile aprire il Documento master dall'area di lavoro Portfolio nella vista
Riepilogo Compiti. Il Documento master viene aperto come file di sola lettura
nell'area di lavoro Documenti.

1. Nella riga Azioni colonna, fare clic sull'icona corrispondente al file che si
desidera aprire.

2. Fare clic con il pulsante destro del mouse sull'icona e quindi fare clic su
Apri Documento master.

I documento viene aperto come file di sola lettura nell'area di lavoro
Documenti.

Aggiunta di un documento master

In alcune occasioni potrebbe essere necessario sostituire un Documento
master esistente oppure aggiungere un Documento master a un compito che
ne & privo. Per esempio, una domanda € stata contrassegnata con una
risposta errata e gli studenti non hanno ricevuto alcun credito per quella
risposta. E possibile dare un credito agli studenti cambiando la risposta a
quella domanda e conservando il Documento master come registrazione
permanente della risposta corretta.

Nota: € possibile aggiungere o sostituire un Documento master per un file .tns
ma non per un file Test rapido.
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I nuovo Documento master viene utilizzato per valutare i voti dello studente.
La valutazione avviene nel modo seguente:

. se una domanda & stata cambiata, le risposte degli studenti sono valutate
per la nuova domanda.

* Seil nuovo Documento master ha delle domande non presenti nel
vecchio Documento master, vengono valutate queste domande. Gli
studenti potrebbero ricevere un credito pari a zero per quelle domande se
non sono state visualizzate.

Per aggiungere o sostituire un Documento master, seguire questi passaggi:

1. nellariga Azioni colonna, fare clic sull'icona corrispondente al file .tns da
aprire.

2. Fare clic su File > Aggiungi Documento master.
Si apre una finestra di dialogo in cui € possibile selezionare un file.

3. Selezionare il file .tns che si desidera usare come nuovo Documento
master e fare clic su Apri.

Il software visualizza un messaggio che avverte che la sostituzione del
Documento master provochera una rivalutazione dei voti degli studenti da
parte del software.

4. Fare clic su Aggiungi/Sostituisci Master per assegnare il nuovo
Documento master oppure fare clic su Cancella per cancellare I'azione.

Ridistribuzione di un elemento di Portfolio

La ridistribuzione di un file alla classe &€ un modo utile per restituire i compiti
valutati o per restituire i compiti per ulteriori attivita. La classe deve essere in
corso per ridistribuire un file.

Nota: non & possibile ridistribuire un file di Test rapido.

1. Fare clic con il pulsante destro del mouse sull'elemento che si desidera
ridistribuire.

2. Fare clic su Ridistribuisci alla classe oppure fare clic su v

A ciascuno studente connesso alla rete TI-Nspire™ Navigator™ viene
inviato il file relativo.
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Ritiro di file mancanti dagli studenti

Puo accadere, in fase di archiviazione nell'area di lavoro Portfolio, che un
gruppo di file degli studenti sia incompleto perché al momento del ritiro alcuni
studenti non erano presenti, o non avevano il file pronto per il ritiro o non erano
connessi. La sessione della classe deve essere attiva per poter ritirare un file.

1. Selezionare un singolo file, oppure fare clic su un'icona di file nella riga
Azioni colonna per selezionare tutti i file della colonna.

Nota: & possibile ritirare solo una colonna di file alla volta.
2. Fare clic su Ritira mancanti.

| file mancanti vengono ritirati dagli studenti che sono connessi alla rete e i
cui file non erano stati inizialmente ritirati.

Invio di file mancanti agli studenti

Pud accadere, in fase d'invio di un gruppo di file agli studenti, che l'invio sia
incompleto perché al momento dell'invio alcuni studenti non erano presenti o
non erano connessi o era stato aggiunto un nuovo studente alla classe. La
sessione della classe deve essere attiva per poter inviare un file mancante.

1. Selezionare un singolo file, oppure fare clic su un'icona di file nella riga
Azioni colonna per selezionare tutti i file della colonna.

Nota: € possibile inviare solo una colonna di file alla volta.
2. Fare clic su Invia mancante.

I file mancanti vengono inviati agli studenti che sono connessi alla rete e i
cui file non erano stati inizialmente ricevuti.

Modifica del nome di un elemento di Portfolio

E possibile modificare il nome di un compito dal riquadro Compiti o
dall'intestazione colonna.

1. Fare clic sul nome del compito o sull'intestazione della colonna per
modificare il nome.

2. Fare clic con il pulsante destro del mouse e fare clic su Rinomina.
La finestra di dialogo Rinomina colonna Portfolio si apre.
Digitare il nuovo nome.

Fare clic su Rinomina. Fare clic su Cancella per annullare la richiesta.
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La colonna si visualizza nell'intestazione colonna e nel riquadro Compiti
con il nuovo nome.

Rimozione di colonne da Portfolio

Puo accadere di voler eliminare dei file da Portfolio. Ad esempio, un file
sbagliato che & stato inviato o ritirato da una classe. E possibile rimuovere un
compito dal riquadro Compiti o dall'intestazione colonna.

1. Fare clic sul nome del compito o sull'intestazione della colonna per
rimuovere.

2. Fare clic con il pulsante destro del file e fare clic su Rimuovi da Portfolio.
La finestra di dialogo Rimuovi da Portfolio si apre.

3. Fare clic su Rimuovi per eliminare il file. Fare clic su Cancella per
annullare la richiesta.

Nota: se un file viene salvato nell'area di lavoro Portfolio e successivamente
eliminato dalla Registrazione della classe, I'eliminazione non ha effetto sulla
copia salvata in Portfolio. La copia rimane nell'area di lavoro Portfolio fino a

quando non viene eliminata.

Rimozione di file dello studente da Portfolio

In alcuni casi potrebbe essere necessario eliminare un singolo file o alcuni file,
ma non tutti i file, da un elenco colonne. Ad esempio, un file sbagliato che &
stato ritirato da uno studente. Rimuovere i file dello studente dall'area di lavoro
nella vista Riepilogo Compiti.

Fare clic sul file o sui file all'interno di una singola colonna da eliminare.
2. Premere Elimina.
La finestra di dialogo Rimuovi documentol/i selezionato/i si apre.

3. Fare clic su Rimuovi per eliminare i file. Fare clic su Non rimuovere per
annullare l'operazione.

PRiepilogo delle opzioni del tipo di file

tns .tns con .tnsp Test Altri
domande rapido tipidi
file
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Salva in Portfolio v v v v v

Salva selezione nel Vv v v v v
Portfolio

Modifica voto v v v v
Apri nell'area di v

lavoro Revisiona

Apri per modifica v v v Ve
Ridistribuisci alla v v v v
classe

Apri documento v/ v v v v
master

Aggiungi v v

documento master

Esporta dati Ve e Ve v v
Invia/Ritira v v v v
mancanti

Rinomina la v v v v v
colonna Portfolio di

File

Rimuovila colonna v/ v v v v
Portfolio di File

v Il file si apre nel programma che il sistema operativo

ha associato al tipo di file.

v Vuoto, non valutato e "Altri tipi di file" mostrano
"Nessun voto" nella cella quando esportati.
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Operazioni con le immagini

Le immagini possono essere utilizzate nelle applicazioni TI-Nspire™ come
riferimento, come strumento di valutazione e per dare spiegazioni. E possibile
aggiungere immagini alle seguenti applicazioni TI-Nspire™:

+  Grafici e geometria

+ Dati e statistiche

* Notes

. Domanda, incluso Test rapido

Nelle applicazioni Grafici e geometria e Dati e statistiche, le immagini sono
poste nello sfondo dietro agli assi e altri oggetti. Nelle applicazioni Notes e
Domanda, I'immagine & posta in posizione del cursore in linea con il testo (in
primo piano).

E possibile inserire i tipi di file immagine seguenti: .jpg, .png, or .bmp.

Nota: la funzione Transparency (Trasparenza) del tipo di file .png non &
supportata. Gli sfondi trasparenti sono mostrati in bianco.

Operazioni con immagini nel software

Quando si lavora con il software TI-Nspire™, € possibile inserire, copiare,
spostare ed eliminare immagini.

Inserimento diimmagini

Nelle applicazioni Notes e Domanda e in Test rapido, € possibile inserire piu
di un’immagine su una pagina. Nelle applicazioni Grafici e geometria e Dati e
statistiche & possibile inserire solo un’immagine su una pagina.

1. Aprire il documento in cui si vuole aggiungere un’immagine.
2. Fare clic su Inserisci > Immagine.

Si visualizza la finestra di dialogo Inserisci immagine.

Operazionicon le immagini 351



Insertimage

Look In: ';.3 Images

¥ Arch at Mational Parkjpg
| Arch of Bridge.jpa
¥ Bridge.jpa

¥ Bridge2.jpa

¥ Bridge3.jpa

| Fence jpg

¥ Ferris Wheel jpg
|71 Fountain jpg

| HotairBalloons jpa
1] manhole Cover jpa
€] Tutip jpg

File Name:

Files of Type: I.A\II Images (*jpg, *jpeq, *.bmp, *.png)

3. Cercare la cartella in cui si trova 'immagine e selezionare 'immagine.

4. Fare clic su Apri.

* Nelle applicazioni Grafici e geometria e Dati e statistiche, 'immagine
¢ inserita sullo sfondo dietro all’asse.

* In Notes, Domanda e Testrapido, 'immagine € inserita nella
posizione del cursore. E possibile digitare del testo sopra o sotto
I'immagine e spostare I'immagine in alto o in basso nelle pagine.

Nota: € possibile inserire le immagini copiando un’immagine negli Appunti e
incollandola nell’applicazione.

Spostamento di immagini

In applicazioni quali Notes e Domanda, dove I'immagine si trova nella
posizione del cursore, & possibile riposizionare 'immagine spostandola su
una nuova linea, uno spazio vuoto o collocandola all’interno di una linea di
testo. Nelle applicazioni Grafici e geometria e Dati e statistiche, le immagini
possono essere spostate in qualsiasi posizione della pagina.

1. Selezionare 'immagine.
* Nelle applicazioni Notes e Domanda, fare clic sul’'immagine per
selezionarla.

* Nelle applicazioni Grafici e geometria e Dati e statistiche, fare clic con
il pulsante destro del mouse e quindi fare clic su Seleziona >
Immagine.
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2. Fare clic sullimmagine selezionata e tenere premuto il pulsante del
mouse.

* Seun’immagine € in primo piano, il cursore cambia in ﬁ .

+

3. Trascinare 'immagine nella nuova posizione e rilasciare il pulsante del
mouse per collocare I'immagine.

+  Seun’immagine é sullo sfondo, il cursore cambia in

Se un’immagine € in primo piano, il cursore cambia in £ quando ci si
sofferma su una posizione in cui si trova una nuova linea o uno spazio. Le
immagini sullo sfondo possono essere spostate e posizionate ovunque
nella pagina.

Ridimensionamento di immagini

Per mantenere le proporzioni di un’immagine, ridimensionare afferrando
I'immagine a uno dei suoi quattro angoli.

1. Selezionare I'immagine.

* Nelle applicazioni Notes e Domanda, fare clic sull'immagine per
selezionarla.

* Nelle applicazioni Grafici e geometria e Dati e statistiche, fare clic con
il pulsante destro del mouse e quindi fare clic su Seleziona >
Immagine.

2. Spostare il cursore su uno dei quattro lati dell'immagine.

Il cursore cambia in X (una freccia direzionale a quattro punte).

Nota: trascinando il cursore su un bordo dell’immagine, questo cambia in

"I" (una freccia direzionale a due punte). Se si trascina un’immagine da
uno dei suoi bordi per ridimensionarla, 'immagine risulta distorta.

3. Fare clic sull’angolo o sul bordo dellimmagine.

Si attiva lo strumento @l.

4. Trascinare verso l'interno per ridurre 'immagine o verso I'esterno per
ingrandirla.

5. Rilasciare il mouse quando la dimensione dellimmagine ¢ corretta.
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Eliminazione di immagini
Per eliminare un’immagine da un documento aperto, completare i seguenti
passaggi.

1. Selezionare I'immagine.
+ Seun’immagine & in primo piano, fare clic su di essa per selezionarla.

* Seun’immagine ¢ sullo sfondo, fare clic con il pulsante destro del
mouse e quindi fare clic su Seleziona > Immagina.

2. Premere Elimina.

L’immagine viene rimossa.

354 Operazionicon le immagini



Scrittura di script Lua

L'Editor di script consente di creare e presentare simulazioni collegate in modo
dinamico, utilita flessibili ed efficaci e altri contenuti formativi per esplorare
concetti matematici e scientifici. Quando si apre un documento contenente uno
script, gli script si avviano automaticamente come programmato. Per
visualizzare l'applicazione dello scriptin funzione, la pagina contenente
I'applicazione dello script deve essere attiva.

L'Editor di script € concepito per insegnanti e altri autori che hanno familiarita
con le operazioni in un ambiente di scripting Lua. Lua & un linguaggio di
scripting efficace, veloce, leggero pienamente supportato dai documenti
TI-Nspire™ e PublishView™. | documenti contenenti applicazioni di script
possono essere aperti su palmari TI-Nspire™ e nel Riproduttore di documenti
TI-Nspire™. L'applicazione di script funziona su un palmare o un Riproduttore
di documenti ma non & possibile visualizzare o modificare lo script.

Fare riferimento a queste risorse per utilizzare I'Editor di script e creare degli

script:

+  Premere F1 per accedere alla guida TI-Nspire™ che include la guida
all'Editor di script.

*  Premere F2 per ulteriori risorse TI-Nspire™ quali campioni di scripte un
link a Libreria di scripting API di TI-Nspire™. (Queste informazioni sono
inoltre disponibili su education.ti.com/nspire/scripting.)

»  Visitare lua.org per maggiori informazioni su Lua.

Descrizione dell'Editor di script

Con I'Editor di script, € possibile inserire, modificare, salvare, eseguire ed
eseguire il debug delle applicazioni di script nei documenti TI-Nspire™ (file
.tns) e Publishview™ (file .tnsp).

* Le applicazioni di script funzionano all'interno di documenti, attivita e
pagine allo stesso modo delle altre applicazioni di TI-Nspire™.

. Quando si crea un nuovo documento o se ne apre uno esistente, &
possibile inserire o modificare un'applicazione di script all'interno di una
pagina o all"interno di un'area di lavoro di una pagina suddivisa.
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+ Nel layout della pagina suddivisa, & possibile aggiungere un'applicazione
di script a ogni area di lavoro di una pagina. Una pagina pud essere
suddivisa in un massimo di quattro quadranti.

+  E possibile aggiungere immagini ad applicazioni di script. Vedere il
capitolo Inserimento di immagini.

+  Se sichiude il documento di TI-Nspire™ o PublishView™ senza salvarlo,
tutto il lavoro effettuato con I'Editor di script viene perso.

Esplorazione dell'interfaccia dell'Editor di script

La finestra dell'Editor di script si visualizza quando si apre una nuova
applicazione di script o se ne modifica una esistente in un documento
TI-Nspire™ o PublishView™.

Selezionare le opzioni per creare nuovi script 0 modificare script esistenti dal
menu Inserisci nell'area di lavoro Documenti quando un documento € aperto.

Nota: anche se non € etichettata, in TI-Nspire™ Student Software e TI-Nspire™
CAS Student Software, I'area di lavoro Documenti € I'area di lavoro predefinita.

La figura seguente mostra I'Editor di script con uno script esistente.

o File Edit Debug View Help

" = & = A
2 0D C S i
Suspend Set  Focus Enable Set
Seript Seript Seript Breakpoints Permissions
@J image Example | are
| 1bridge = image.new( R.ING.bridge)
2 function on.paint (gc)
0 3 ge:drawImage (bridge, 30, 30)
4end

@J Console | Glabals | Callstack Locals Resources 408

Search ‘ + =

Image Name

‘ i},. {”“ \

oy

7V Z

L7 S

@Dncumemﬂ 44 | Running 9 Insert

@ Barra dei menu. Contiene opzioni per lavorare con I'Editor di script.

@ Barra degli strumenti. Fornisce gli strumenti per le funzioni comuni
dell'Editor di script. Vedere il capitolo Utilizzo della barra degli strumenti.
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© Titolo script. Mostra il titolo dello script. Fare clic con il pulsante destro del
mouse sul titolo per cambiarlo oppure fare clic su Modifica > Imposta
Titolo script.

Casella di testo. Fornisce uno spazio per digitare il testo dello script.

o~

Pannello degli strumenti. Mostra i dati dello script. Vedere il capitolo
Utilizzo del pannello degli strumenti.

@® Barra di stato. Visualizza lo stato operativo dello script. Vedere il capitolo
Utilizzo della barra di stato.

Utilizzo della barra degli strumenti

La tabella seguente spiega le opzioni della barra degli strumenti.

Nome Strumento Descrizione Strumento
Sospendilo Sospende l'esecuzione dello script.
I, script
> Riprendi lo Riprende I'esecuzione dello script.
4 script. Durante I'esecuzione del debug, lo script

continua a essere eseguito fino al punto di
interruzione successivo o la fine dello script.

[ "‘ Imposta lo Inizia l'esecuzione dello script

= script
= Metti a fuoco Imposta il fuoco sulla pagina nel documento a
_-@ lo script cui l'applicazione dello script & allegata.

¢ Inun documento TI-Nspire™, imposta il
fuoco sulla pagina.

. In un documento PublishView™, imposta il
fuoco sulla cornice della pagina.

Accedere a Durante I'esecuzione del debug, esegue
I'istruzione corrente. Se l'istruzione chiama una
qualsiasi funzione, il debugger si ferma alla

il
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Nome Strumento Descrizione Strumento

prima linea di ogni funzione.

Oltrepassare Durante I'esecuzione del debug, esegue
l'istruzione corrente.

Tl

Se l'istruzione chiama una qualsiasi funzione, il
debugger non si ferma all'interno della funzione
a meno che questa non contenga un punto di
interruzione.

—:'-I:i- Abilita i punti Passa dalla modalita normale alla modalita di
— di debug.
interruzione

— Disabilita i Ripassa dalla modalita di debug alla modalita
—& punti di normale e riprende lo script.
interruzione

@ Imposta Imposta i livelli di autorizzazione su Protetto,
autorizzazioni | Solo visualizzazione o Non protetto e consente
di impostare una password per lo script.

Utilizzo del Pannello strumenti

Nella parte inferiore della finestra, il Pannello strumenti mostra i dati dello
scripting. Per ulteriori informazioni, consultare il capitolo Esecuzione del debug
degli script.

Tabulazione | Visualizzazione della finestra

Console Gli errori dello script vengono stampati qui.

Anche le istruzioni di stampa incorporate nello script sono
stampate qui.

Globali Si visualizzano le variabili globali selezionate.

Per selezionare una variabile globale per la
visualizzazione, fare clic su Clicca per aggiungere una
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Tabulazione | Visualizzazione della finestra

nuova variabile di visualizzazione in fondo al Pannello
degli strumenti.

Stack di Visualizza la struttura delle chiamate per la funzione

chiamate attualmente in esecuzione.

Locali Sono visualizzate le variabili locali nell'ambito della
funzione.

Risorse Caricare, inserire e gestire le immagini.

Utilizzo della barra di stato

La barra di stato in fondo alla finestra mostra i dati di base dello script, come
descritto nell'esempio seguente: stopwatch, 1.1, 4:1, 1In
esecuzione.

* Nome del documento a cui € allegata I'applicazione dello script
(stopwatch)

*  Numero di attivita e di pagina (1.1)

* Riga e carattere dello script, (4:1 riga di descrizione 4 e carattere 1)

+  Stato operativo dello script (In esecuzione). Notare i possibili stati:
- Modalita Normale: In esecuzione, In pausa o Errore

- Modalita Debugging In esecuzione (debugging), In pausa o Errore

Inserimento di nuovi script

Per inserire una nuova applicazione di script e nuovi script, seguire i passaggi
successivi.

1. Aprire il documento in cui si vuole aggiungere lo script. Pud essere un
documento nuovo o esistente.

2. Fare clic su Inserisci > Editor dello script > Inserisci script.

Viene inserita un'applicazione di script e visualizzata la finestra di dialogo
Titolo dello script.

Nota: TI-Nspire™ Student Software e TI-Nspire™ CAS Student Software si
aprono automaticamente nell'area di lavoro Documenti.

Scrittura discript Lua 359



7.

Digitare un titolo dello script. (La lunghezza massima di questo campo &
32 caratteri)

Fare clic su OK.
La finestra dell'Editor di script si apre mostrando uno script vuoto.
Digitare il testo nelle righe dello script.

Nota: alcuni caratteri "wide" UTF-8 non standard potrebbero non essere
visualizzati correttamente. Per questi caratteri, si raccomanda vivamente di
utilizzare la funzione string.uchar.

Quando lo script &€ completo, fare clic su Imposta script per eseguirlo.

. In un documento TI-Nspire™, I'applicazione di script viene inserita in
una nuova pagina. Quando la pagina che contiene 'applicazione
dello script € attiva, la Casella degli strumenti Documenti & vuota.

. In un documento PublishView™, una cornice contenente
I'applicazione dello script viene aggiunta alla pagina attiva. E
possibile spostare o ridimensionare questa cornice allo stesso modo
di un oggetto di PublishView™ e aggiungere altri oggetti di
PublishView™ alla pagina.

Per visualizzare I'applicazione di script, fare clic su Metti a fuoco lo script.

Modifica degli script

Completare la seguente procedura per modificare uno script esistente.

1.

Aprire il documento di TI-Nspire™ o PublishView™ che contiene lo script.
La pagina che contiene lo script deve essere attiva.

Selezionare la pagina e I'area di lavoro che contiene lo script.
Fare clic su Inserisci > Editor di script > Modifica script.

L'Editor di script si apre mostrando lo script. Se I'area di lavoro selezionata
nella pagina non contiene uno script, Modifica script viene visualizzata in
grigio.

Se lo script & protetto da password, la finestra di dialogo Protetto da
password si apre richiedendo una password.

Apportare le modifiche desiderate.

*  Perindicare commenti, utilizzare trattini doppi (--) all'inizio di ogni riga
di commento.
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*  Per modificare il titolo, fare clic su Modifica > Imposta titolo dello script
oppure fare clic con il pulsante destro del mouse sul titolo e
selezionare Imposta titolo dello script.

Note:

» alcuni caratteri UTF-8 non standard potrebbero non essere
visualizzati correttamente. Per questi caratteri, si raccomanda
vivamente di utilizzare la funzione string.uchar.

+ Lafunzione di stampa potrebbe produrre risultati inattesi per caratteri
non-UTF-8.

» Alcuni caratteri non stampabili restituiti dalla funzione on.save
saranno scartati.

Per eseguire lo script, fare clic su Imposta script.
Eventuali errori sono visualizzati nell'area Console nel Pannello strumenti.

Per visualizzare I'applicazione dello script (script in esecuzione), fare clic
su Metti a fuoco lo script.

Modifica delle opzioni di visualizzazione

Per cambiare le opzioni di visualizzazione:

| 4

Per eliminare i dati di scripting nel Pannello degli strumenti e ripristinare i
valori predefiniti dell'editor, fare clic su Visualizza > Ripristino delle
impostazioni predefinite di Editor.

Per visualizzare il titolo dello script nel documento e prima di ogni
istruzione di stampa nella Console, fare clic su Visualizza > Titolo in Vista
Documento.

Per nascondere o mostrare le etichette della barra degli strumenti, fare clic
su Visualizza > Barra degli strumenti etichette di testo.

Per nascondere o mostrare il Pannello degli strumenti o le sue aree, fare
clic su Visualizza > Pannello degli strumenti e selezionare |'opzione
appropriata.

Per creare gruppi di schede quando piu script sono aperti, fare clic con il
pulsante destro del mouse su un titolo e selezionare Nuovo gruppo
orizzontale o Nuovo gruppo verticale.
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Impostazione del livello APl minimo

Ogni versione del software T-Nspire™ include un supporto APl per un set
specifico di funzionalita di script Lua. L'impostazione del livello API minimo per
uno script consente di specificare un set minimo di funzionalita necessarie per
uno script.

Se un utente cerca di eseguire uno script su un sistema che non soddisfa il
livello API minimo dello script, riceve una notifica e I'esecuzione dello script
non puo essere effettuata.

Per impostare il livello APl minimo per uno script:
1. Determinare il livello minimo richiesto dallo script.

- L'impostazione di un livello troppo basso per il set di funzionalita dello
script pud comportare un errore di script su una versione software
precedente.

- L'impostazione di un livello troppo alto puo far si che lo script si rifiuti
di avviarsi su una versione software precedente che supporta il set di
funzionalita.

2. Nel menu File Editor di script, selezionare Imposta livello APl minimo.

3. Nellafinestra di dialogo, digitare il livello minimo utilizzando il formato
principale .secondario. Per esempio, € possibile digitare 2. 3.

Per eseguire lo script sara necessario questo livello APl o un livello
superiore.

Salvataggio delle applicazioni di script

Selezionando Imposta script si ripristina (aggiorna) un'applicazione di scriptin
un documento TI-Nspire™ o PublishView™. Tuttavia, lo script e I'applicazione di
script non vengono salvati fino al salvataggio del documento. Se si chiude il
documento o il software TI-Nspire™ senza salvare, il documento sullo script
viene perso.

Per accertarsi che I'applicazione di script svenga salvata al termine del lavoro,

seguire i passaggi seguenti.

1. Dalla finestra dell'Editor di script, fare clic su Imposta script per
reimpostare (aggiornare) l'applicazione di script nel documento.

2. Daun documento aperto, fare clic su File > Salva documento per salvare
le modifiche al documento TI-Nspire™ o PublishView™.
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Nota: per accertarsi che venga eseguito il back-up dello script, impostare lo
script e salvare il documento frequentemente.

Gestione delle immagini

Per inserire un'immagine in un'applicazione di script, seguire i passaggi
seguenti.

Aggiungere un'immagine a Risorse
1. Fare clic sulla scheda Risorse.

2. Fareclic sul pulsante .

3. Fare clic sul nome del file immagine.
4. Fare clic su Apri.
5

Accettare il nome predefinito dellimmagine o rinominare Iimmagine
digitando un nuovo nome nella casella. (Ad es: nuovaimmagine)

6. Fareclic su OK.

Nota: la miniatura dell'immagine sara visualizzata nell'angolo in basso a
destra dello schermo. Il nome del file immagine apparira in un elenco di
immagini nella parte inferiore sinistra dello schermo.

7. Fare clic con il pulsante destro del mouse sul nome di un'immagine per
rinominare, copiare il nome, visualizzare un'anteprima o rimuovere

limmagine. E anche possibile fare clic sul pulsante
un'immagine.

per rimuovere

Aggiungere pil immagini a Risorse

1. Fare clic sulla scheda Risorse.

2. Fareclic sul pulsante .

3. Selezionare Valori separati da virgola (*.csv) dal menu Tipo di file.
4. Selezionare il file .csv desiderato.

Nota: il formato .csv € costituito da due colonne separate da virgola. La
prima colonna si riferisce al nome locale della risorsa immagine utilizzata
nel codice. La seconda colonna si riferisce al percorso assoluto
all'immagine sul sistema corrente.

Esempio per Windows:
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bridge,C:\images\bridge.jpg
house,C:\images\house.jpg
Fare clic su Apri.

Fare clic con il pulsante destro del mouse sul nome di un'immagine per
rinominare, copiare il nome, visualizzare un'anteprima o rimuovere

limmagine. E anche possibile fare clic sul pulsante = per rimuovere

un'immagine.

Creare uno script per richiamare un'immagine

1.

Digitare uno script nella casella della riga dello script nel modo seguente:
myimage = image.new(_R.IMG.img_1)
function on.paint (gc)
gc.drawlmage (myimage, 30, 30)
end
Nota: sostituire img_1 (sopra) con il nome della propria immagine.

Per salvare lo script, fare clic su Imposta script. L'immagine sara
visualizzata nella schermata Anteprima documento.

Fare clic su Metti a fuoco lo script per impostare lo stato attivo perla
pagina nel documento dove si desidera fissare I'applicazione di script.

Nota: un documento TI-Nspire imposta lo stato attivo per la pagina; un
documento PublishView™ imposta lo stato attivo per la cornice della
pagina.

Creare uno script per richiamare piu immagini

1.

Digitare uno script nella casella della riga dello script nel modo seguente:
myimg = {}
for name, data in pairs (_R.IMG)
myimg [name] = image.new(data)
end
function on.paint (gc)

gc:.drawlmage (myimg[imagename], 30, 30)
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end

Per salvare lo script, fare clic su Imposta script. L'immagine sara
visualizzata nella schermata Anteprima documento.

Fare clic su Metti a fuoco lo script per impostare lo stato attivo per la
pagina nel documento dove si desidera fissare I'applicazione di script.

Nota: un documento TI-Nspire imposta lo stato attivo per la pagina; un
documento PublishView™ imposta lo stato attivo per la cornice della
pagina.

Impostazione delle autorizzazioni per gli script

E possibile impostare i livelli di autorizzazione per uno script e specificare una
password per proteggere uno script. Utilizzare i seguenti passaggi.

1.

4.

Nella finestra Editor dello script, fare clic su File > Imposta autorizzazioni.
Viene visualizzata la finestra di dialogo Imposta autorizzazioni.

Nell'area Livello di autorizzazione, selezionare il livello di sicurezza
appropriato.

*  Protetto. Lo script pud essere eseguito ma non visualizzato o
modificato.

*  Solavisualizzazione. Lo script pud essere visualizzato ma non
modificato.

*  Non protetto. Lo script pud essere visualizzato e modificato.
Per proteggere uno script, indicare una password nell'area Sicurezza.

Nota: prestare attenzione nell'impostare le password perché non possono
essere recuperate.

Fare clic su OK.

Facendo clic successivamente su Inserisci > Editor di script > Modifica script,
una finestra di dialogo Protetto da password si aprira richiedendo la password.
Fare clic su una di queste opzioni:

Per modificare lo script, inserire la password e fare clic su OK.

Per la sola visualizzazione dello script, non inserire la password e fare clic
su Visualizza.
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Esecuzione del debug degli script

E possibile eseguire il debug degli script per individuare errori runtime e
tracciare il flusso dell'esecuzione. Durante I'esecuzione del debug, i dati sono
visualizzati nel Pannello degli strumenti.

>

Per abilitare la modalita debugging o disabilitarla tornando a quella
normale, fare clic su Debug > Abilita i punti di interruzione o Disabilita i
punti di interruzione.
Nota: quando si disabilitano i punti di interruzione, I'esecuzione dello
script viene sempre ripresa.

Durante I'esecuzione del debug, fare clic su Accedere a e Oltrepassare
come appropriato. Vedere il capitolo Esplorazione dell'interfaccia
dell'Editor di script.

Per impostare i punti di interruzione, fare doppio clic nello spazio
all'estrema sinistra del numero della riga. | punti di interruzione sono
disabilitati fino a quando non viene selezionato Abilita punti di interruzione.

Fare attenzione a questi fattori durante l'esecuzione del debug:
* | punti diinterruzione nei programmi collaterali non sono supportati.
+  Seun punto di interruzione € impostato in una funzione che & una

richiamata, il debugger potrebbe non fermarsi nel punto di
interruzione.

+ lldebugger potrebbe non fermarsi in funzioni quali per esempio
on.save, on.restore e on.destroy.

Nella barra degli strumenti, Accedere a e Oltrepassa sono attivi quando i
punti di interruzione sono abilitati.

Per sospendere e riprendere I'esecuzione dello script, fare clic su Sospendi
lo script e Riprendi script. Quando lo script viene ripreso, viene eseguito
fino al punto di interruzione successivo riscontrato o fino alla fine dello
script. Uno script pud essere sospeso in modalita normale o debugging.
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Informazioni sulla normativa

Conformita alla normativa dell'Unione Europea e dellEFTA

Il presente dispositivo pud essere attivato in questi paesi che comprendono gli
stati membri dell'Unione Europea e dell'EFTA (Associazione europea di libero
scambio). Si intendono afferenti alla Comunita Europea i Paesi elencati nel
paragrafo che segue, in tutto il presente documento:

AUSTRIA, BULGARIA, REPUBBLICA CECA, DANIMARCA, FINLANDIA,
FRANCIA, GERMANIA, GRECIA, IRLANDA, ITALIA, LUSSEMBURGO, PAESI
BASSI, NORVEGIA, PORTOGALLO, SLOVACCHIA, SLOVENIA, SPAGNA,
SVEZIA, SVIZZERA, REGNO UNITO

Il punto di accesso a TI-Nspire™ Navigator™ comunica con un alloggiamento
wireless TI-Nspire™ Navigator™ o una scheda di rete wireless TI-Nspire™ CX
tramite un link wireless 802,11 b/g per fornire capacita WLAN (wireless local
area networking) e con un PC mediante un cavo USB standard. Il punto di
accesso a TI-Nspire™ Navigator™ include lo standard radio 802,11b/g/n.

Il punto di accesso a TI-Nspire™ Navigator™ CX comunica con un
alloggiamento wireless TI-Nspire™ Navigator™ o una scheda di rete wireless
TI-Nspire™ CX - v2 tramite un link wireless 802,11b/g per fornire capacita
WLAN (wireless local area networking) e con un PC mediante un cavo USB
standard. Il punto di accesso a TI-Nspire™ Navigator CX supporta il
funzionamento da 2,412 GHz a 2,462 GHz per 802,11b/g/n 2,4GHz + il
funzionamento da 5,150 GHz a 5,250 GHz per 802,11 a/n 5GHz.

Dichiarazione di Conformita
Il contrassegno rappresentato da questo simbolo:

ce®

indica conformita ai requisiti essenziali della Direttiva R&TTE dell'Unione
Europea (1999/5/EC).

Il presente dispositivo risponde ai seguenti requisiti di conformita:
Sicurezza: EN 60950-1:2006 + A11:2009

EMC: EN 55022:2006, EN 55024:1998 + A1:2001 + A2:2003, N 301 489-1
V1.8.1/2008-4, EN 301 489-17 V2.1.1/2009-5, CISPR22:1997, CISPR24
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Compresi: EN 61000-3-2, -3-3, -4-2, -4-3, -4-4, -4-5, -4-6 e -4-11. |l prodotto &
autorizzato anche in base ai requisiti indicati da standard specifici di altri paesi,
come richiesto per il Mercato internazionale.

Radio: EN 300-328 v.1.7.1 (2006-10)

Compatibilita elettromagnetica e spettro radio (ERM); Sistemi di trasmissione a
banda larga; Dispositivo di trasmissione dati operante nella banda a 2,4 GHz
ISM che impiega tecniche di modulazione a banda larga. Le certificazioni sono
armonizzate agli standard EN, che rispondono ai requisiti fondamentali
presenti all'articolo 3.2 della Direttiva R&TTE. La conformita comprende
I'attivita di test con I'antenna integrale fornita.

SAR: EN62209-2:2010

Dichiarazione di Conformita della Comunita Europea

Con la presente Texas Instruments dichiara che i seguenti prodotti sono
conformi ai requisiti fondamentali e ad altri provvedimenti della Direttiva
1999/5/EC.

*  Punto di accesso a TI-Nspire™ Navigator™

+ Alloggiamento wireless TI-Nspire™ Navigator™
* Scheda di rete wireless TI-Nspire™ CX

»  Scheda direte wireless TI-Nspire™ CX - v2

*  Punto di accesso a TI-Nspire™ CX Navigator™

English Hereby, Texas Instruments declares that the TI-Nspire™
Navigator™ Access Punto, TI-Nspire™ Navigator™ wireless
cradle, and TI-Nspire™ CX Wireless Network Adapter, TI-Nspire™
CX Wireless Network Adapter - v2, and TI-Nspire™ CX
Navigator™ Access Punto are in compliance with the essential
requirements and other relevant provisions of Directive
1999/5/EC.

E possibile consultare la Dichiarazione di Conformita alla
pagina Product Stewardship (Gestione responsabile del
prodotto) all'indirizzo education.ti.com.

Bvnrapusa |Texas Instruments geknapupa, ye TI-Nspire™ Navigator™ Touka
3a pocTbn, 6e3xuyeH nonka TI-Nspire™ Navigator™ u TI-Nspire™
CX 6e3xmnyHa mpexosa kapTa, TI-Nspire™ CX 6e3xuyHa
MpexoBa KapTa - V2 1 Touka 3a poctbn Ha TI-Nspire™ CX
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Navigator™ ca B CbOTBETCTBME C OCHOBHUTE NU3NCKBAHUA U
OpyruTe cboTBETHM pa3nopenbu Ha Oupekmmsa 1999/5/E0.
JexnapauusTa 3a CbOTBETCTBUE MOXE [a Ob/le KOHCYNTUpaH B
CTpaHuuaTta Ha npoaykTa ctonaHuceaHe B education.ti.com.

Ceska
republika

Texas Instruments timto prohlasuje, Zze TI-Nspire™ Navigator™
pfistupovy bod, bezdratovy stojan TI-Nspire™ Navigator™ a
TI-Nspire™ CX bezdratovy sitovy adaptér, TI-Nspire™ CX
bezdratovy sitovy adaptér - v2 a TI-Nspire™ CX Navigator™
pfistupovy bod jsou v souladu se zakladnimi poZzadavky a
dal8imi pfisluSnymi ustanovenimi smérnice 1999/5/ES.

ProhlaSeni o shodé miize byt konzultovan v na strance Product
Stewardship education.ti.com.

Dansk

Texas Instruments erklaerer hermed, at TI-Nspire™ Navigator™
adgangspunktet, den tréddlgse TI-Nspire™ Navigator™ holder,
den TI-Nspire™ CX Navigator™ adgangspunktet, den tradlgse
TI-Nspire™ CX netvaerksadapter og den tradlgse TI-Nspire™ CX
netvaerksadapter - v2 er i overensstemmelse med de essentielle
krav og andre relevante bestemmelser i direktiv 1999/5/EF.

Du kan lzese overensstemmelseserklaeringen pa
produktforvaltningssiden p& education.ti.com.

Norsk

Texas Instruments erklaerer herved at TI-Nspire™ Navigator™
tilgangspunkt, TI-Nspire™ CX Navigator™ tilgangspunkt,
TI-Nspire™ Navigator™ tradlgs bordholder, TI-Nspire™ CX
Wireless Network Adapter og TI-Nspire™ CX Wireless Network
Adapter - v2 overholder de vesentlige kravene og andre
relevante bestemmelser i direktivet 1999/5/EC.

Samsvarserklaeringen kan leses pa siden Produktforvaltning pa
education.ti.com.

Suomi

Texas Instruments vakuuttaa, ettd TI-Nspire™ Navigator™-
lityntapiste, TI-Nspire™ CX Navigator™-liityntapiste, langaton
TI-Nspire™ Navigator™-kelkka, TI-Nspire™ CX Wireless Network
Adapter ja TI-Nspire™ CX Wireless Network Adapter - v2
tayttavat direktiivin 1999/5/EY oleelliset vaatimukset ja ja muut
asianmukaiset ehdot.

Vaatimustenmukaisuusvakuutus on tarkasteltavissa
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tuotevastuusivulla osoitteessa education.ti.com.

Francais

Texas Instruments déclare que le pointd’accés TI-Nspire™
Navigator™, le point d’accés TI-Nspire™ CX Navigator™, le socle
de synchronisation TI-Nspire™ Navigator™, I'adaptateur de
réseau sans fil TI-Nspire™ CX et 'adaptateur de réseau sans fil
TI-Nspire™ CX - v2 sont conformes aux exigences essentielles et
aux autres clauses applicables de la Directive 1999/5/CE.

La Déclaration de conformité peut étre consultée a la page
Geérance du produit a education.ti.com.

Deutsch

Texas Instruments erklart hiermit, dass der TI-Nspire™
Navigator™ Zugangspunkt, TI-Nspire™ CX Navigator™
Zugangspunkt, die drahtlose TI-Nspire™ Navigator™
Basisstation, der drahtlose TI-Nspire™ CX Netzwerkadapter
drahtlose und der TI-Nspire™ CX Netzwerkadapter - v2 mit den
wesentlichen Anforderungen und anderen relevanten
Bestimmungen der Richtlinie 1999/5/EG konform sind.

Die Konformitatserkldrung kann auf der Seite “Engagement fur
die Umwelt” unter education.ti.com angezeigt werden.

EAAGOa

Me tnv napouoa, Texas Instruments dnAwvel 6TL TO Onueio
npocpacng TI-Nspire™ Navigator™, agUppaTto Aikvo nAonyog
TI-Nspire™ kat TI-Nspire™ CX acUppato npocappoyea dIKTUou,
TI-Nspire™ CX agUppaTo npocappoyeéa SIKTUOU - V2, Kal onueio
npoéopaong TI-Nspire™ CX Navigator™ ivalt cUp@wva pe TIG
BooIKEG aNALTACELG KAl TIG AOLNEG OXETIKEG BLOTAEELG TNG 0dnyiag
1999/5/¢ek.

AAAWONG CUPUOPPWONG UNopoUV va cupBoulelovTal ath
oeAida Alaxeipion npoidvtwy oto education.ti.com.

Italiano

Con la presente, Texas Instruments dichiara che il punto di
accesso TI-Nspire™ Navigator™, il punto di accesso TI-Nspire™
CX Navigator™, la base di ricarica wireless TI-Nspire™
Navigator™, la basetta wireless TI-Nspire™ CX e la basetta
wireless TI-Nspire™ CX - v2 sono conformi ai requisiti
fondamentali e ad altri provvedimenti della Direttiva 1999/5/CE.

E possibile consultare la Dichiarazione di conformita alla pagina
Product Stewardship (Gestione responsabile del prodotto),
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all'indirizzo education.ti.com.

Nederlands

Hierbij verklaart Texas Instruments dat het TI-Nspire™
Navigator™ accesspoint, de TI-Nspire™ CX Navigator™
accesspoint, de TI-Nspire™ Navigator™ draadloze slede, de
TI-Nspire™ CX draadloze netwerkadapter en de TI-Nspire™ CX
draadloze netwerkadapter - v2 voldoen aan de essentiéle
vereisten en andere relevante bepalingen van Richtlijn
1999/5/EC.

De verklaring van overeenstemming kan worden geraadpleegd
op de pagina Product Stewardship (Productbeheer) op
education.ti.com.

Portugués

A Texas Instruments declara, pela presente, que o ponto de
acesso TI-Nspire™ Navigator™, o ponto de acesso TI-Nspire™
CX Navigator™, a base sem fios TI-Nspire™ Navigator™, o
adaptador de rede sem fios TI-Nspire™ CX e o adaptador de
rede sem fios TI-Nspire™ CX - v2 estdo em conformidade com os
requisitos essenciais e outras disposi¢oes relevantes da
Directiva 1999/5/CE.

A Declaragao de Conformidade pode ser consultada na pagina
Administragdo do Produto em education.ti.com.

Espaiiol

Mediante el presente documento, Texas Instruments declara
que el punto de acceso TI-Nspire™ Navigator™, el punto de
acceso TI-Nspire™ Navigator™ CX, el soporte inalambrico
TI-Nspire™ Navigator™, el adaptador de red inalambrica
TI-Nspire™ CX y el el adaptador de red inaldmbrica TI-Nspire™
CX - v2 cumplen con los requisitos esenciales y otras
disposiciones relevantes de la directiva 1999/5/CE.

Puede consultar la declaracion de conformidad en la pagina
Administracion de producto en education.ti.com.

Svenska

Texas Instruments deklarerar harmed att TI-Nspire™ Navigator™
anslutningspunkt, TI-Nspire™ CX Navigator™ anslutningspunkt,
TI-Nspire™ Navigator™ tradls tillkopplingsenhet, TI-Nspire™ CX
tradlés natverksadapter och TI-Nspire™ CX tradlos
natverksadapter - v2 uppfyller de vasentliga kraven och 6vriga
relevanta bestammelser enligt direktivet 1999/5/EG.
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Deklarationen om dverensstimmelse kan ldsas pa sidan
Produktansvar pa webbplatsen education.ti.com.

Slovensko |Texas Instruments vyhlasuje, ze TI-Nspire™ Navigator™ Access
Point, bezdrotovy kolisky TI-Nspire™ Navigator™ a TI-Nspire™ CX
bezdrotovy sietovy adaptér, TI-Nspire™ CX bezdrétovy sietovy
adaptér - v2 a TI-Nspire™ CX Navigator™ pristupovy bod su v
sulade so zakladnymi poziadavkami a inymi prisluSnymi
ustanoveniami smernice 1999/5/EC.

Vyhlasenie o zhode k nahliadnutiu na strdnke produktu
spravcovstvo v education.ti.com.

Slovenija |Texas Instruments izjavlja, da TI-Nspire™ Navigator™ dostopno
tocko, TI-Nspire™ Navigator™ wireless zibelka in TI-Nspire™ CX
brezzi¢no omrezno kartico, TI-Nspire™ CX brezzi¢no omrezno
kartico - v2in TI-Nspire™ CX Navigator™ vstopne toc¢ke so v
skladu z bistvenimi zahtevami in drugimi ustreznimi doloebami
Direktive 1999/5/ES.

Izjava o skladnosti se lahko posvetuje nadzor izdelkov na strani
education.ti.com.

Paesi di operativita e Restrizioni d'uso nella Comunita Europea

Utilizzo operativo dei canali compresi tra 2.400 e 2.4835 GHz nella Comunita
Europea

L'installatore e/o I'utente finale sono tenuti a utilizzare I'utilita di configurazione
fornita con il prodotto per verificare il canale operativo corrente, il livello atteso
di potenza di trasmissione, e per confermare che il dispositivo opera in
conformita alle regole di utilizzo dello spettro radio per il Paese della Comunita
Europea selezionato. Se si verifica un funzionamento al di fuori di canali
ammessi come indicato in questa guida, il prodotto deve cessare
immediatamente I'attivita e I'installatore é tenuto a consultare lo staff di
assistenza tecnica della zona di competenza per la rete wireless.

Questi dispositivi sono progettati per funzionare in tutti i Paesi della Comunita
Europea. E consentito I'uso di frequenze associate a canalida 1a 13 nella
banda compresa tra 2,400 e 2,4835 GHz, sia in ambienti chiusi che all'aperto,
in tutti i Paesi della Comunita Europea, ad eccezione delle localita indicate:
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. In Grecia, Italia, Lettonia e Spagna l'utente finale & tenuto a richiedere una
licenza presso l'autoritd nazionale di regolamentazione delle
radiofrequenze per attivare il dispositivo all'aperto.

+  Siprega di consultare il Manuale TI-Nspire™ Navigator™ Teacher Software
per ulteriori informazioni relative alle restrizioni e alle condizioni di
funzionamento per le configurazioni all'aperto.

Affermazioni di avviso

Avvertenza Installare il punto di accesso a TI-Nspire™ Navigator™ o il punto di
accesso a TI-Nspire™ CX Navigator™ in modo tale da mantenere una distanza
minima di 20 cm (7,9 pollici) tra I'elemento o gli elementi di radiazione e le
persone. Questo avviso di sicurezza & conforme ai limiti di esposizione della
frequenza radio FCC.

Avvertenza Non toccare o spostare il punto di accesso a TI-Nspire™ Navigator™
o il punto di accesso a TI-Nspire™ CX Navigator™ quando le antenne
trasmettono o ricevono.

Avvertenza |l punto di accesso a TI-Nspire™ Navigator™, alloggiamento
wireless TI-Nspire™ Navigator™, la scheda di rete wireless TI-Nspire™ CX, il
punto di accesso a TI-Nspire™ CX Navigator™ e la scheda di rete wireless
TI-Nspire™ CX - v2 si intendono esclusivamente per uso in ambienti chiusi.
Non installare o utilizzare il dispositivo all'aperto.

Avvertenza | radiatori intenzionali, come il punto di accesso a TI-Nspire™
Navigator™, I'alloggiamento wireless TI-Nspire™ Navigator™, la scheda di rete
wireless TI-Nspire™ CX. Il punto di accesso a TI-Nspire™ CX Navigator™ e la
scheda di rete wireless TI-Nspire™ CX - vZnon sono operativi con antenna/e
diversal/e da quelle fornite da Texas Instruments. Un radiatore intenzionale puo
essere operativo esclusivamente con antenna/e autorizzata/e.

Avvertenza | punti di accesso radio a TI-Nspire™ Navigator™ e i punti di
accesso radio a TI-Nspire™ CX Navigator™ vengono disabilitati per
impostazione predefinita e possono essere abilitati esclusivamente tramite
I'amministratore di sistema utilizzando I'applicazione software di gestione.

Avvertenza La banda di frequenza radio, i canali operativi e la potenza di
trasmissione dipendono dal Paese in cui vengono specificate le operazioni
dall'amministratore di sistema durante l'installazione e la configurazione
tramite il software di gestione.
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Avvertenza L'installazione deve essere eseguita esclusivamente da personale
qualificato. Leggere e seguire tutte le avvertenze e le istruzioni presenti sul
prodotto o incluse nella documentazione.

Importante per il funzionamento sicuro di un adattatore CA

Oltre alla particolare attenzione dedicata agli standard di qualita nella
realizzazione del prodotto T, la sicurezza € un fattore determinante nella
progettazione di ogni prodotto. Tuttavia, sicurezza significa anche
responsabilita dell'utente. Questa sezione elenca informazioni importanti utili
per assicurare la fruizione e I'uso corretto di questo prodotto Tl e delle
apparecchiature accessorie. Leggere attentamente prima di far funzionare e
utilizzare il prodotto.

Installazione

«  Leggere e seguire le istruzioni: E necessario leggere tutte le istruzioni per
il funzionamento e di sicurezza prima di mettere in funzione il prodotto.
Seguire tutte le istruzioni per il funzionamento.

«  Conservare le istruzioni: E necessario salvare tutte le istruzioni per il
funzionamento e di sicurezza per farvi riferimento in futuro.

+ Attenzione: Osservare tutte le avvertenze sul prodotto e nelle istruzioni per
il funzionamento.

«  Utilizzare I'adattatore CA consigliato. E necessario utilizzare I'adattatore in
dotazione con il prodotto.

»  Verificare le sorgenti di alimentazione: L'adattatore CA per il prodotto Tl
deve essere utilizzato con una presa di alimentazione AC100V-230 V 50
Hz/60 Hz. Se non si € sicuri del tipo di alimentazione erogata nella propria
abitazione, consultare il fornitore o la societa di energia locale.

+  Attenzione al sovraccarico: Non sovraccaricare le prese a muro o le
prolunghe, poiché questo potrebbe comportare un rischio di incendio o
scossa elettrica. Il sovraccarico di prese CA, prolunghe, cavi di
alimentazione consumati, cavi danneggiati e prese rotte sono pericolosi.
Esaminare con cadenza periodica il cavo e qualora vi siano segni di
danno o deterioramento, provvedere alla sostituzione a opera di un
tecnico della manutenzione.

»  Proteggere i cavi di alimentazione: Disporre i cavi di alimentazione in
modo che non vengano calpestati o schiacciati da elementi collocati
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intorno o contro di essi. Prestare particolare attenzione ai cavi collegati a
spine e connettori ed esaminare il punto in cui il cavo di alimentazione si
collega al prodotto TI.

Verificare la ventilazione: Le fessure e le aperture nella custodia sono
fornite per la ventilazione cosi da assicurare il funzionamento affidabile
del prodotto Tl e a proteggerlo dal surriscaldamento. Non bloccare o
coprire tali aperture. Non bloccare mai queste aperture posizionando il
prodotto Tl su un letto, un divano, un tappeto o altre superfici simili. Non
collocare mai il prodotto Tl accanto o sopra un radiatore o un diffusore di
aria calda o su qualsiasi altra sorgente di calore (inclusi amplificatori). Non
collocare il prodotto Ti in un'installazione incassata, come una libreria o
una scaffalatura in assenza di un'adeguata ventilazione.

Non utilizzare gli accessori: Non utilizzare attacchi, salvo quando
raccomandato da TI, poiché potrebbero causare rischi di incendio e
scossa elettrica.

Non utilizzare vicino all'acqua: Non utilizzare il prodotto Tl vicino all'acqua,
per esempio, vicino a una vasca da bagno, un lavandino o un lavello, in
un seminterrato umido o nei pressi di una piscina.

Non collocare vicino a una sorgente di alta temperatura: Non utilizzare il
prodotto Tl vicino a una sorgente di calore come un fornello, un caminetto
o un calorifero.

Prestare attenzione durante il montaggio del Prodotto Tl: Non collocare il
prodotto Tl su una superficie instabile. Il prodotto Tl potrebbe cadere,
provocare ferite gravi a bambini o adulti nonché gravi danni al prodotto TI.

Non utilizzare accanto a attrezzature mediche: Non mettere in funzione il
prodotto accanto ad attrezzature che potrebbero essere soggette a
interferenza elettrica o utilizzate per finalita mediche. Non utilizzare il
prodotto accanto a un pacemaker o a un'area di assistenza sanitaria in un
ospedale.

Infolmportanti

Attendere almeno 10 secondi tra lo scollegamento e il ricollegamento del
prodotto Tl con l'adattatore CA.

Scollegare il prodotto dalla presa a muro prestando attenzione;
I'adattatore CA potrebbe essere caldo.
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Uso e manutenzione

Scollegare I'alimentazione prima di effettuare la pulizia: Non utilizzare
detergenti liquidi o spray. Utilizzare un panno umido per la pulizia.

Allontanare gli oggetti dalle aperture: Non spingere mai oggetti di alcun
tipo all'interno del prodotto Tl attraverso le aperture come i fori di
ventilazione, poiché potrebbero entrare in contatto con circuiti dell'alta
tensione e provocare un cortocircuito in altri componenti causando incendi
o scosse elettriche. Non versare mai sostanze liquide sul prodotto TI.

Proteggere dai fulmini: Scollegare il prodotto Tl durante temporali o
quando viene lasciato incustodito o inutilizzato per un lungo periodo.
Rimuovere 'adattatore dalla presa a muro e scollegare il sistema di cavi.
Cio previene eventuali danni a causa di fulmini e sovraccarichi di
voltaggio. Fare attenzione a non toccare la parte metallica del prodotto Tl
o i cavi durante un temporale.

Manutenzione

La manutenzione deve essere effettuata da personale qualificato addetto
alla manutenzione nelle condizioni sottoelencate:

- Seil cavo di alimentazione & danneggiato.

- Se é stato versato del liquido o se degli oggetti sono caduti all'interno
del prodotto.

- Seil prodotto & stato esposto a pioggia o acqua.

- Se il prodotto non funziona normalmente seguendo le istruzioni per
l'uso.

- Seil prodotto & caduto o la custodia & stata danneggiata.

- Quando il prodotto mostra evidenti variazioni nelle prestazioni, come
lincapacita di completare il suo controllo automatico.

Controllo di sicurezza: Al termine di ogni servizio di manutenzione o

riparazione del prodotto, richiedere al servizio assistenza di effettuare i

controlli di sicurezza necessari al fine di valutare se il prodotto sia in
condizioni operative adeguate.
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Servizi e assistenza di Texas Instruments

Home Page: education.ti.com
Domande via e-mail: ti-cares@ti.com
KnowledgeBase e domande education.ti.com/support
e-mail:

Informazioni internazionali: education.ti.com/international

Informazioni su servizi e garanzia

Per informazioni sulla durata e i termini della garanzia oppure sui servizi per i
prodotti, fare riferimento alla garanzia inclusa con questo prodotto oppure
contattare il rivenditore/distributore locale di Texas Instruments.
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